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1 Get started as a Tekla
Structures administrator

To get started as a Tekla Structures administrator, you should familiarize
yourself with the concepts related to installation, licensing and customization.

+ Installation from the point of view of an organization's Tekla Structures
administrator is explained in Tekla Structures installation for
administrators (page 11).

+ License administration tasks are explained in Manage licenses (page 27).

* You can customize Tekla Structures extensively and distribute the
customized configurations using various configuration files. Basic
customization tasks are explained in Implementation guide for
administrators (page 107) and Environment, company, and project settings
for administrators (page 119). See Files and folders in Tekla Structures
(page 244) for more detailed information on the file and folder structure.

1.1 Information sources for administrators

Tekla User Assistance

Tekla User Assistance provides help information for all levels of users,
including administrators. You can access the Tekla Structures help material in
Tekla User Assistance by pressing the F1 button in Tekla Structures. If you
have a dialog box open, Tekla Structures takes you straight to the related
topic.

By default, all help content is online. Offline help installation packages are
available in Tekla Downloads. We recommend that you use the online help
when possible as it is updated constantly.

The help is also available when Tekla Structures is not running. Depending on
your Windows operating system, through the Start menu or Start screen,
select the Tekla Structures <version> and click Documentation.
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Release notes and Administrator's release notes

Release notes and Administrator's release notes are published in Tekla User
Assistance for each new main and intermediate version of Tekla Structures.
They contain very useful information that you can use when upgrading to a
newer version of Tekla Structures.

Release notes contains information about the new features, improvements
and fixes to existing features. Administrator's release notes contains useful
information on how to localize and start using the new features in Tekla
Structures.

Tekla Discussion Forum

Tekla Discussion Forum is a useful place to share experiences, ask questions,
and discuss with advanced users. You need a Trimble Identity to log in.
Tekla Structures training

To use Tekla Structures to its full potential we strongly recommend users to
attend training courses held by the local Trimble Solutions office or a reseller.
Your local support

If you have a valid maintenance contract, you can e-mail or phone your local
support for help.

You can find the email address and phone number of your local support in
Tekla User Assistance when you are logged in and your account is connected
to your organization's group.
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2 Tekla Structures installation for
administrators

You can install Tekla Structures on a workstation using the standard
installation packages or by creating your own centralized installation using MSI
packages. You can also run Tekla Structures in a Citrix virtual environment.

To use Tekla Structures, you also need to install a license server.

2.1 Installation requirements

Trimble Identity

Tekla Online services use Trimble Identity for identification. You can use your
Trimble Identity with other Trimble services, such as Trimble Connect and
SketchUp 3D Warehouse.

Each organization has at least one account administrator, who is responsible
for managing the organization group used in Tekla Online services. Several
people in your organization can be administrators. The first user is invited by a
Trimble representative, and that person is then responsible for adding other
users and administrators as necessary.

As an administrator, you:

+ Invite or approve employees to your organization's user group to allow
them maintenance user access in allTekla Online services.

« Add external license users.
+ Select who has access to your organization's Online licenses.

*  Remove people from your organization's user group when they no longer
belong to your organization.

For more information, see Trimble Identity for Tekla Online services and
Manage Trimble Identities and Tekla Online licenses.
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Operating system and hardware recommendations
Tekla Structures can be installed on recent 64-bit Windows operating systems.

If the operating system is not one of the supported versions of Windows, the
installation is cancelled. The installation also requires that Microsoft .NET
Framework 4.7.2 or newer is installed on the computer. The installation

of .NET Framework 4.7.2 is included in the Tekla Structures installation
package, and it is executed if needed. If you create a customized installation
package, make sure that the .NET Framework is installed on the client
computers. Also see.

For more information on recommended operating system and hardware
specifications, see .

2.2 Installing Tekla Structures

You can download Tekla Structures software and environments from Tekla
Downloads. To have the latest software in use, we recommend that you install
the latest service pack of Tekla Structures. Service packs include
improvements and fixes to the latest or to a previous main version or service
pack of Tekla Structures. Service packs are available for all users with a valid
maintenance contract.

NOTE You need to install Tekla Structures with administrator rights.

When you do a centralized installation, the end users do not need
administrator rights for the installation.

Tekla Structures installers are .msi installers. Environment .ms1i installers
include sets of . tsep installers that contain the actual environment files and
settings. When installing a new version of Tekla Structures, install the software
first and then the environments. The .ms1 installers are installed to your
computer before opening Tekla Structures.

When you run the environment .msi installer, the installer creates the
environment folder and copies the . tsep installers to the. .\Tekla
Structures\<version>\Extensions\To be installed folder. The
installer also creates the RemoveEnv.bat and ToBeRemoved. txt files, and
places them to the . . \Environments\<environment> folder. These files are
used when uninstalling an environment.

When running the environment .ms1i installer, you can select in the
installation wizard that the . tsep installers are run immediately when running
the environment installer. If you do not select to do this, the . tsep installers
are run when you open Tekla Structures for the first time after the installation.
In this case, Tekla Structures opens a dialog box that shows the installation
progress of the . tsep installers.

Tekla Structures installation for administrators 12 Installing Tekla Structures


https://download.tekla.com/
https://download.tekla.com/

Running the . tsep installers does not require administrator rights. The . tsep
installers install the environment files to the . .\Tekla Structures
\<version>\Environments\<environment> folder.

If you are installing several environments for the first time, we recommend
that you do not select to run the . tsep installers with the .msi installer. Some
of the . tsep packages are used in more than one environment and the same
version of a . tsep package is only installed once. Note that starting Tekla
Structures for the first time after installation can take a long time particularly if
you have installed several environments, as all the . tsep installers are run.

Tekla Structures installation wizard has detailed instructions about the
installation. For more information, see also .

2.3 Folder structure

Folder structure on local computer

See for information on how the folder structure on the local computer is set
up.

Company folder structure

We recommend using a central file folder for storing the models and setup
files for the company-specific settings and the project-specific settings. Tekla
Structures then reads the settings from the central file server. When
upgrading to a new Tekla Structures version, or updating the company logo,
for example, the files only need to be replaced in one place. This way taking
backups and upgrading is easier.

For more information, see Create project and firm folders (page 245).

Backup

With all valuable information and work your company stores, it is important to
take backups of the model folders, and firm and project settings. If your
company has a system for taking automatic scheduled backups, schedule your
system to take the backups at night time, outside working hours to prevent
any possible conflicts in the model. Do not forget to also take a backup of the
license entitlements and your active licenses.

Virus protection

Virus protection software has sometimes caused problems in saving models
and drawings to the model folder. These problems may occur especially if you
have your model saved on a network drive. We strongly recommend that you
add Tekla Structures into the safe list of your antivirus system, and set up your
virus protection in a way that actions in your model folder are not blocked or
scanned.
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2.4 Tekla Structures settings in the Windows registry

Windows registry is a hierarchical database that stores configuration settings
and options in Microsoft Windows operating systems. Registry settings are
used during a Tekla Structures session and during a Tekla Structures
installation.

WARNING Do not change the registry settings. Changing the settings can
cause the operating system to fail. It is possible to view the
registry settings using the Registry Editor.

User settings

Some of the Tekla Structures user settings, for example, general options, and
dialog box locations and sizes are stored in the registry. The settings are saved
in a registry key named after the Tekla Structures version number in the
registry branch HKEY CURRENT USER\Software\Trimble\Tekla
Structures\<VERSION>.

Tekla Structures uses the hardcoded default settings when opened for the first
time after the installation. If you change a setting during a Tekla Structures
session, Tekla Structures saves the change during the session, or when you
exit Tekla Structures. When you open the same version of Tekla Structures
again, the changed setting is used.

When upgrading to a newer Tekla Structures version, you can use the
Migration Wizard tool to copy the settings you have changed.
Installation settings

The Tekla Structures installation saves information to the
HKEY LOCAL MACHINE\SOFTWARE\Trimble\Tekla Structures
\<VERSION> registry key.

2.5 Centralized installation of Tekla Structures

Installing Tekla Structures centrally across the company network saves time in
a large company when there are many Tekla Structures users.

Centralized installation allows you to run the Tekla Structures installation
silently in the background so that the users do not see the installation wizard
dialog boxes. For detailed information on centralized installation, see
Centralized distribution of Tekla Structures 2020.
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2.6 Installation in a virtual environment

You can also run Tekla Structures in a Citrix virtual environment. Application
and desktop virtualization allow users to run software from a Citrix server on
the network without locally-installed Tekla Structures on their workstation. For
detailed information on virtualized installation, see Using Tekla Structures with
application and desktop virtualization (page 23).

2.7 Installing the license server

If you only use one license of Tekla Structures, you can install the license
server on the same computer as Tekla Structures, making the license available
on this one workstation. In an environment with multiple licenses and users,
you install the license server in your company network, which allows for more
flexible and efficient use of your licenses according to need.

Before users can start using Tekla Structures, you must:
+ Install and set up a license server on a computer.
+ Save the entitlement certificate and activate the licenses.

+ Connect each client computer with Tekla Structures to the license server
either manually, through a customized installation or by instructing the
users.

For more information, see Tekla Structures licensing system (page 28).

2.8 Installing .tsep packages

Tekla Structures extension packages, . tsep packages, are Tekla Structures
extensions or additional environment content installers. . tsep packages are
available for download in Tekla Warehouse.

You can install . tsep packages in three different ways.

Direct installation
1. Double-click the . tsep installer that you have downloaded.

2. The Tekla Structures extension manager dialog box opens with the
name of the extension that is going to be installed.

By default . tsep installers are opened with Tekla Structures extension
manager. Some . tsep installers are run directly from Tekla Warehouse
with the Insert into model option.

3. Select the Tekla Structures versions to which you want to import and click
the Import button. The next time you start Tekla Structures, the extension

Tekla Structures installation for administrators 15 Installing the license server



is automatically installed, and it is shown in Tekla Structures extension
manager.

NOTE If the . tsep installer is not set to open with Tekla Structures
extension manager by default, you can set it manually. Right-click on
the . tsep installer and select Properties. In Opens with, select
Change and browse to TsepFileDispatcherLauncher.

Installation in Tekla Structures extension manager

You can also install a . tsep installer from Tekla Structures extension
manager in Tekla Structures.

1. Inthe Applications & components catalog, click E > Manage
extensions --> Extension manager to open Tekla Structures extension
manager.

2. Click Import and browse to the . tsep installer that you want to install.

3. Click Open.

The imported . tsep is installed the next time you start Tekla Structures. It
is shown in Tekla Structures extension manager, and is ready for use in
the Applications & components catalog.

Uninstall .tsep packages
To uninstall . tsep packages, do one of the following:

+ In Tekla Structures extension manager, select the . tsep packages that
you want to uninstall (use Ctrl or Shift to select more than one), and click
Remove. The . tsep packages are removed when you restart Tekla
Structures.

* Browseto ..\Program Files\Tekla Structures\<version\nt\bin\
and double-click the TeklaExtensionPackage.Builder.exe to open the
Tekla Structures Extension Package (TSEP) builder and test runner
dialog box.

Go to the Uninstall TSEP based extensions tab, select the . tsep
packages that you want to uninstall (use Ctrl or Shift to select more than
one), and click Uninstall selected. This will remove all the selected . tsep
packages. You do not need to restart Tekla Structures.

Centralized installation

You can centrally install a batch of . tsep installers across company
workstations. This method is meant for system administrators.

By default, the . tsep installers waiting for installation are stored in
\ProgrambData\Trimble\Tekla Structures\<version>\Extensions\To
be installed. To install centrally, you need to copy the . tsep installers to
the $XSDATADIR%\Extensions\To be installed folder. Create the \To
be installed folder if it does not exist yet.
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When Tekla Structures starts, it checks the available . tsep installers from the
\To be installed folder and installs them automatically. If there is an older
version of the same extension package, it is uninstalled before installing the
new version. Installation is cancelled if the same or newer version has already
been installed.

+ Theinstalled . tsep installers are stored in the $XSDATADIR%\Extensions
\Installed folder.

* Invalid . tsep installers are uninstalled and moved to the $XSDATADIRS%
\Extensions\Invalid installations folder.

* Cancelled . tsep installers are stored in $XSDATADIR%\Extensions
\Cancelled installations.

Copying . tsep installers

We recommend that you use ROBOCOPY from the command prompt
(cmd.exe) to copy the . tsep installers. More information on ROBOCOPY can be
found on the Microsoft website, for example.

The basic syntax for ROBOCOPY is: robocopy <Source> <Destination>
[<File>[ ...]] [<Options>]

For example, to copy . tsep installers in Tekla Structures 2020:

robocopy
"\\Serverl\prod\TeklaStructures\2020.0\Environments TSEP"
"C:\ProgramData\Trimble\Tekla Structures\2020.0\Extensions\To be
installed"”

*.tsep

"C:\Program Files\Tekla Structures\2020.0\nt\bin
\TeklaExtensionPackage.TepAutoInstaller.exe"

2020.0 "C:\ProgramData\Trimble\Tekla Structures\2020.0" "2020"

This command will take all . tsep installers from the \Serverl network
directory and copy them to the local user's \To be installed folder. After
copying, TepAutoInstaller.exe installs all . tsep installers from the local

user's \To be installed folder. Installing the packages allows users to start
Tekla Structures without first waiting for the installations to complete.

18
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Centralized uninstallation

You can uninstall . tsep packages in batches by creating an empty file without
an extension, with the name RemoveExtensionOnStartup, in
\ProgrambData\Trimble\Tekla Structures\<version>\Extensions
\Installed\ [Extension To Be Uninstalled].The extensions are
removed the next time Tekla Structures is started.

2.9 Collaborative modeling

Several people can simultanously work in the same Tekla Structures model.

If your company takes part in external projects, or if more than one user works
with the same model at different locations, we recommend that you use Tekla
Model Sharing. With Tekla Model Sharing, the users in your company can work
with the same shared model, offline and with high performance, and
synchronize the changes with other team members even in a low-speed
network.

If you work in a local team and prefer not to use Internet while working on
your models, you can use the multi-user mode.

For model coordination and exchange of other project files, we offer Trimble
Connect. To find out more and set up collaboration in your organization, see
Tekla Model Sharing and multi-user for administrators (page 371) and Working
collaboratively within a Tekla Structures model.

2.10 Upgrading Tekla Structures

You can install service packs on top of the existing installation of Tekla
Structures. You can update to new service packs without updating the existing
licenses. A new Tekla Structures version installs as a separate instance and can
exist on the same workstation with other Tekla Structures versions. An update
to a new version requires that you also update your licenses, as the licenses
have a highest allowed version.

If you already have an older version of Tekla Structures installed on your
computer, you can use Migration Wizard to copy the personal settings to the
new version. With the Migration Wizard you can choose to copy any of the
following settings and values:

* user.ini file

+ Registry values, such as:
+ Toolbars
+ Dialog boxes
* General options
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When you customize Tekla Structures, for example, add or change drawing or
report templates and catalog entries, we strongly recommend that you create
project and firm folders for the customized files. This is useful if you want to
store the files for future use, or if you want to retain them when you install a
new release.

Tekla Structures does not replace files in the project and firm folders when
you install a new release. You can retain your customized files without having
to copy and paste, or export and import from the previous versions. This
makes upgrading faster and easier. If you have customized previous Tekla
Structures versions without using firm or project folders, you will need to
transfer the customized information to the next Tekla Structures version.

Before you start using a new Tekla Structures version, always test that the old
company settings work.

TIP If you want to copy the settings later, you can start Migration Wizard manually
by double-clicking the MigrationWizard.exe inthe \Tekla Structures
\<version>\nt\bin\applications\Tekla\Migrations folder. You can
select the version from which the settings are copied and the version to which
the settings are copied.

2.11 Create start-up shortcuts with customized
initializations
You can use shortcuts to start teklastructures.exe with customized
initializations. You can use this functionality to create shortcuts for different
purposes, for example, to have customized setup files depending on the client

you are working for in a project. The Tekla Structures installation automatically
creates shortcuts for the selected environments.

NOTE We recommend that only administrators create the customization and the
necessary shortcuts. Otherwise, your settings may differ from the settings
defined for your firm, or for the particular project you are working for.

Create a start-up shortcut with customized initialization
1. Openthe user.ini file using any standard text editor.

2. Save the file with a new name, for example, customer.ini or
project.ini.

3. Moadify the file by adding the required settings.
Save the modified initialization file.

5.  Open the Windows Start menu and select All Programs --> Tekla
Structures <version> .
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6. Right-click Tekla Structures <version> and select Copy.
7. Paste the shortcut to your desktop.
8. Select the shortcut, right-click and select Properties.
9. Modify the Target of the shortcut by adding the required project
initialization information to it.
First enter the path to the current teklastructures.exe, then the
desired parameters.
Use the quotation marks (") in the path to avoid possible problems if the
path contains spaces. If you have installed Tekla Structures to a path that
does not contain spaces, there will be no problems even if you remove
the quotations marks, for example, C:\TeklaStructures\. If you have
installed Tekla Structures to a path that contains spaces, the quotation
marks are needed, for example, C: \Program Files\Tekla
Structures\.
Target type: Application
Tanget location: bin
Tanget: ‘eklaStructures exe" 4 "C\MyProject project 1.ini"
Start in: C:Program Files*Tekla Structures' 2076 nt bin*"
Shortcut key:  Mone
Rurn: l MNormal window N I
Comment:
I Open File Location J I Change lcon... I I Advanced. .. I
The maximum length of a shortcut is 256 characters. If you have problems
with the length, you can call all other necessary initialization files from
your customized initialization file instead of adding them to the shortcut.
10. To override the settings defined in the shortcuts, use the parameter -1
<initialization file>intheuser.ini and option.ini files.
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Available parameters in shortcuts
The table below lists the parameters you can use in the start-up shortcuts.

The parameters can be used in combinations. You can set the parameters to
automatically bypass the Tekla Structures - Choose setup dialog box, open a
model and run a macro, for example.

Parameter

Description

-1
<ini file pat
h>

The given . ini file is loaded before the
environment . ini files. This parameter can be specified
multiple times.

This parameter can be used to bypass the Tekla
Structures - Choose setup dialog (the login dialog).

Example:

"C:\Program Files\Tekla Structures
\<version>\nt\bin\TeklaStructures.exe"
-I "C:\ProgramData\Trimble\Tekla
Structures\<version>\Environments\uk
\Bypass.ini"

-1
<ini file pat
h>

The given . ini file is loaded after the role . ini files.
This parameter can be specified multiple times.

Example:

"C:\Program Files\Tekla Structures
\<version>\nt\bin\TeklaStructures.exe"
-i "C:\TeklaStructures\MySettings.ini"

To open an
existing model

<model path>

The given model is opened after start-up.

Example:

"C:\Program Files\Tekla Structures
\<version>\nt\bin\TeklaStructures.exe"
"C:\TeklaStructuresModels\My model"

To open an
existing,
autosaved model

<model path>
/autosaved

The given autosaved model is opened after start-up.

Example:

"C:\Program Files\Tekla Structures
\<version>\nt\bin
\TeklaStructures.exe""C:\TeklaStructure
sModels\My model" /autosaved

To create a new
model without a

A new model is created after start-up.

Example:
model template P
/ "C:\Program Files\Tekla Structures
\<version>\nt\bin\TeklaStructures.exe"/
create:<model create:"C:\TeklaStructuresModels\My
path> model"
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Parameter Description

To create anew | A new model using a model template is created after

model using a start-up.
model template Example:
/

"C:\Program Files\Tekla Structures
\<version>\nt\bin\TeklaStructures.exe"/
_path> / create:"C:\TeklaStructuresModels\My
modelTemplate model" /modelTemplate:"Cast-in-Place"

create:<model

:<template na
me>

To create a new | A new multi-user model is created after start-up.
multi-user model

Example:
/ \ \
"C:\Program Files\Tekla Structures
r :<m 1 ; .
create ode \<version>\nt\bin\TeklaStructures.exe"/
_path> / create:"C:\TeklaStructuresModels\My
server:<serve model" /server:"my-server:1234"

r name>

Torunamacro | The given macro is executed after start-up.

after start-up The example below opens Tekla Structures, sets the

-m environment, role and configuration from the
<macro_file p |Bypass.ini file, opensthe model, and reads in and saves
ath> the model by using the Example Macro: Model Sharing

Read in and Save from the BIM Publisher tool that is
available in Tekla Warehouse.

"C:\Program Files\Tekla Structures
\<version>\nt\bin\TeklaStructures.exe"
-I "C:\ProgramData\Trimble\Tekla
Structures\<version>\Environments
\<environment>\Bypass.ini"
"C:\TeklaStructuresModels\<model>" -m
"C:\ReadInSave2016.cs"

Example of an initialization file

Below is an example of a customized project initialization file that calls other
initialization files.

MyProject.ini

//The project is based on the default UK settings

call C:\ProgramData\Trimble\Tekla Structures\2019.0\Environments\uk
\env_UK.ini

//..but our company policy requires these changes

call c:\CompanySettings\OurPolicy.ini

//..and the fabricator requires something

call c:\Fabricators\Fabricatorl.ini

//..and then we let users to make some changes (color etc.)

call c:\Users\user $USERNAMES%.ini

The project shortcut for this initialization file:
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"C:\Program Files\Tekla Structures\<version>\nt\bin\TeklaStructures.exe" -
i "\\MyServer\MyProject\MyProject.ini" "\\MyServer\MyProject\MyModel\"

2.12 Using Tekla Structures with application and desktop
virtualization

Using Tekla Structures with the Citrix application and desktop virtualization is
a flexible and safe way to quickly add users to Tekla Structures projects
without locally installing Tekla Structures and copying project data to a user's
computer. Citrix application and desktop virtualization products are products
of Citrix Systems, Inc.

The image below shows the main concepts in Tekla Structures virtualization.

Citrix thin clients
running on various
operating systems

e N
Secure display data
connection over the internet

AN J

~

Virtualization platform

instances running on (hypervisor layer)

Microsoft Windows )

[ Virtual Tekla Structures

Data center

Streaming applications from the server enables the use of Tekla Structures on
client computers, tablets and smartphones that have different hardware and
software configurations. Tekla Structures runs on Windows on the remote
server and the virtualization solution allows client devices to be used for
display and user input.

Users connect through a secure connection to the data center located in your
premises or in the cloud. The project data is protected as everything is stored
only on the server. Using Tekla Structures from a centralized location ensures
that all users in the project are using the same project environment set-up.
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Prerequisites for using Tekla Structures in a virtual

environment

Citrix virtualization is set up either on a physical server or on a virtual server.
Recommended hardware is described in Hardware recommendations for
running Tekla Structures on Citrix and .

For detailed instructions on installing and setting up XenApp and XenDesktop,
see the Citrix documentation.

The image below shows the main components in Tekla Structures

virtualization.
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1. Thin client application: users can access Tekla Structures with Citrix
Receiver through Citrix XenApp client or Citrix XenDesktop desktop viewer
on any supported operating system and hardware. Multiple concurrent
clients may share one virtual machine instance.

A good internet connection is required. Recommended network
bandwidth is 1 Mbps or more.

2. Each TeklaStructures.exe running on the virtual machine needs a

valid license.

Local, enterprise, or cloud Tekla license server can be used, and the
license server can be hosted in or out of the data center.

3. Read/write project files from network-attached storage (NAS). Fast disk
access is needed. Never use the local disk of the virtual server for saving

model folders.

Accessing any files from the client's local file system requires uploading
the files to the server, which may be very slow and should be avoided as
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much as possible. Project data including environments should be stored
on another (server) machine in the data center or file system inside the
company network.

The key components for using Tekla Structures with the Citrix application and
desktop virtualization are:

High-end Windows server that can serve multiple concurrent users. The
server is typically set up by the company's IT department.

A file server that provides fast access to project files from the virtualization
server.

Tekla Structures installed on the server or on the virtual machine running
on the server.

A reliable connection from the virtual hosts to Tekla license server as each
Tekla Structures user needs a valid Tekla Structures license

Delivery groups (user groups) and access rights, which are defined on the
server with Citrix Studio.

+ Delivery groups are set up by the administrator of the virtualization
environment.

+ Access rights for delivery groups must be defined by the administrator
on the server.

Citrix Receiver installed on client computers. The Citrix Receiver is typically
delivered through an Internet browser and installed by the end-user.

Set up the virtual environment for Tekla Structures

You need to set up the server, define delivery groups, install the Tekla
Structures software and environments on the server, and Tekla Structures
users need to install the Citrix Receiver on their computers.

1.

Set up the server.

The server must be a high-end computer with a fast graphics card, a fast
processor, and enough main memory for each user depending on the size
and level of detail of the projects they are working on. See Hardware
recommendations for running Tekla Structures on Citrix for more detailed
information.

For detailed instructions on installing and setting up XenApp and
XenDesktop, see the Citrix documentation.

2. Install Tekla Structures software and the needed environments on the
server.
NOTE Storing models on the virtual computer local disk may cause
access problems. Use a dedicated file server for models, and
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remember to select the correct network location for the model
folder during the Tekla Structures installation.

Tekla Structures environment settings are the same for all users
that use the same virtual computer. In the same manner as with
normal desktop installations, you still have to make sure that the
environments on different virtual machines are the same or
matching.

We strongly recommend that you use standard Tekla Structures
environments and amend them with company or project-specific settings
(on the network file server).

3. Install the Citrix Receiver on the Tekla Structures client computer:
We recommend that you use the Citrix Receiver web user interface.
a. Open the Citrix Receiver web user interface in your web browser.
Use the https address provided by your company's administrators.

b. Install the Citrix Receiver client software by following the steps in the
installation wizard. Do not create an account, or login in the
installation wizard, but finish the installation and return to the web
user interface.

c. After the installation, return to the Citrix Receiver web user interface
and log in with the credentials provided by your company's
administrators.

d. Select the desired virtual desktop. If the virtual desktop does not start
automatically, run the downloaded Citrix (. ica) file.

You can now start using Tekla Structures on the virtual desktop, in the
same manner as if it was installed on your own computer.

« When you use the virtual desktop for the first time, you can give read
and write access to your local files in the file access dialog box.

+ Note that referencing local files from your computer directly in Tekla
Structures is not recommended. If you need to access those files in
Tekla Structures, you should copy them to a shared network location
first.

« Note that model folders are not copied to the client computers.

The Citrix Receiver client is updated frequently. Always install the latest
client when the web user interface suggests you to do so.
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3 Manage licenses

There are two main types of licenses in Tekla Structures:

On-premises licenses licenses that you activate locally on your license
server. These are used for activating most configurations.

Online licenses that are used for activating additional features, such as
Tekla Model Sharing and some special configurations, such as Tekla
Structures learning and partner configurations.

For online license instructions, see Manage Trimble Identities and Tekla
Online licenses.

To get started with standard license administration:

1.

Make sure you understand how licensing works, see Tekla Structures
licensing system (page 28).

Install the license server as explained in Installing Tekla license server
(page 42).

Make sure the license server can connect to Trimble's activation server
and clients can connect to the license server, see Allowing Tekla license
server to operate through Windows Firewall (page 51).

Activate your licenses on the server as explained in Activate Tekla licenses
(page 62).

Test that licensing works and connect the clients to the license server as
explained in Preconfigure license server settings for users (page 66).

Additionally, you can ensure that the correct types of licenses are available to
the users who most need them by defining access rights for using and
borrowing licenses as explained in Modify Tekla license access rights
(tekla.opt) (page 71). This can prevent situations where there are no licenses
available for users that need them because someone else has reserved or
borrowed a license that they do not really need.
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3.1

When you renew licenses and when you need to make hardware changes on
the license server, you must deactivate your licenses as explained in
Deactivate Tekla licenses (page 67).

If your licenses have become untrusted or disabled, they cannot be used and
you need to repair them. For information about how to do this, see Repair a
license (page 76).

See also
Troubleshoot Tekla licensing (page 77)

Tekla Structures licensing system

Tekla Structures uses FlexNet (FlexNet Publisher License Management)
licensing system by Flexera Software. We provide our own Tekla-specific tools
for managing the licenses on top of the common FlexNet platform, replacing
some of the standard tools you may have encountered when using other
software products that use FlexNet for licensing.

The license server software is compatible with several versions of Tekla
Structures. To see which license server version to use with your current Tekla
Structures version, see Hardware recommendations for Tekla 2020 license
server. The licenses are also compatible with older versions of Tekla Structures
in addition to the highest allowed version stated in the license. The license is
sent to you attached in an email as an entitlement certificate HTML file.

NOTE Keep backup copies of your license entitlements in a safe place.

The standard FlexNet licensing is complemented by online licenses, which are
connected to the users' Trimble Identity login. These are used for special
configurations of Tekla Structures, such as the Partner and Learning
configurations, and some additional features, such as Tekla Model Sharing. For
more information about licensing Tekla Structures Learning Edition, visit the
Tekla Campus site.

Local licensing on your workstation

If there are few users in your organization and you do not need to share the
same licenses between users, you will install a license server directly on the
Tekla Structures workstation. When you activate a license on the local license
server, Tekla Structures always uses that license and you can also start Tekla
Structures offline without borrowing a license. If you want to use this type of
setup, see.

For organizations with many users, it is not optimal to install and manage a
license server on each workstation because of the extra work involved, lack of
visibility and inability to flexibly share licenses between users. In this situation,
it is better to set up a central license server in your internal network.
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License server in your local area network (floating licenses)

The illustration below shows how licensing works in a typical corporate setup
where licenses are activated on a centrally-managed license server.

Tekla Structures users

Tekla Structures

License borrow tool (optional)

@

Online licenses

Tekla license server
License administration tool
(FlexNet & LMTOOLS)

@ g License entitlement via email ]

Main user / IT administrator

1. An administrator (main user or IT administrator) receives entitlement
certificates for new and updated FlexNet licenses as email attachments.

2. The administrator activates and manages the FlexNet licenses in the Tekla
License Administration Tool on the license server installed at your
organization.

For successful activation, the system must be able to contact Trimble's
online license activation service.

3. The administrator adds users to your organization and allows access to
your purchased online licenses in the Tekla Online Admin tool.

Exception: users must get their free learning license themselves at the
Tekla Campus site.

4. Tekla Structures installations on the end-users' workstations reserve a
license on the license server or in the cloud when a user starts Tekla
Structures or joins Tekla Model Sharing. When the user stops using Tekla
Structures, the license reservation is revoked.

* You can optionally allow users to borrow licenses for a set period of
time, which allows the user to start Tekla Structures without network
access to the license server. To borrow a license, the user must have
the license borrow tool installed on their workstation.

* Online licenses cannot be borrowed; users must have internet access
to start Tekla Structures with an online license. For more information
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about online licenses, see Manage Trimble Identities and Tekla Online
licenses.

Tekla Structures holds licenses in trusted storage. This means that Tekla
Structures does not support three-server redundancy, where licenses are held
in license files. However, you may have any number of license servers, and use
search paths for defining and finding them.

Using multiple license servers in one company

You may want to spread your license pool on several servers in your company.
You may have offices in many cities, each office with its own license server, or
you may simply want to divide the license pool to minimize disruption caused
by server downtime.

ﬁ License entitlement - 20 seats }

( OfficcA-10licenses | [ OfficeB-10licenses |

& & &

[ Office Ausers | [ Office Cusers |

[ Office Busers |

You do not have to activate all of the licenses on the same license server even
if they are on the same entitlement certificate. For example, you can divide
your total license entitlement on several servers simply by activating one half
of your licenses on one server and the other half of the licenses on another
server. Or, as another example, you can activate some of the licenses on a
common server and the rest locally on each user's computer. You can easily
change the location of the licenses by deactivating them on one license server
and activating on another so you can adjust the number of licenses to changes
in your user base over time.

In Tekla Structures, you can define two server addresses separated by a
semicolon (;). This way, if there is a maintenance break on one of the servers,
users can obtain the license from the other server.
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Tekla Structures X

® Use your on-premises license server

27001 @Server-A; 27001@Server-B| Check licenses >>

Use your Tekla online license

Teklar
Structures

& Trimble

Contact your system administrator if you are unsure of which server to use.

OK Cancel

NOTE Defining several license servers may slow down the starting of Tekla
Structures. Therefore, we do not recommend defining more than two
servers.

License server hardware

The Tekla license server does not need high performance hardware. However,
it is important to ensure that the network connection and server hardware are
reliable, and to maintain the server system carefully.

NOTE Deactivate your licenses before you make changes to the hardware
or perform a major operating system upgrade on the license server
computer. Keep copies of your license entitlement certificate(s) in a
safe place in case something goes wrong, so that you can easily and
quickly activate the deactivated licenses on a different system. You
can only activate the same licenses again if they have first been
deactivated on the previous system. If the license server system
becomes permanently inoperable with the licenses still activated,
contact your local Tekla support for assistance.

See Tekla license server 2020 hardware recommendations for information on
operating systems and virtual machine platforms.

Configuration features

You have fine-grained control over the license use:

* You can control license use based on the license type (enterprise/domestic)
or Tekla Structures configuration.

* You can define minimum and maximum numbers of licenses users/user
groups have available.
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* You can allow or prevent license borrowing from named users/user
groups.

The configurations can be done based on host addresses, individual user
names or by user groups. See Modify Tekla license access rights (tekla.opt)
(page 71) for more information.

Checklists for licensing implementation

There are several prerequisites the administrator needs to take into account
before starting with FlexNet licensing. Take a look at the following listings:

+ Checklist of Trimble deliverables needed in Tekla licensing (page 32)

+ Checklist of IT resources needed in Tekla Structures licensing (page 33)

+ Checklist for the Tekla license server administrator (page 34)

* Rights needed for performing administrator's tasks in Tekla Structures
licensing (page 35)

Additional information sources

In addition to Tekla Structures specific documentation, you can find useful
information on the FlexNet system in the documents provided with the
installation and in Tekla Downloads. The following FlexNet License
Administration Guides by Flexera Software are generic guides that contain,
for example, instructions on how to create user groups and manage access
rights:

* C:\Tekla\License\Server\fnp LicAdmin.pdf

* C:\Tekla\lLicense\Server\LicenseAdministration.pdf

See also
Distributing and managing Tekla licenses (page 35)
Examples of different Tekla Structures licensing system setups (page 37)

Installing Tekla license server (page 42)

Checklist of Trimble deliverables needed in Tekla licensing
To get started with the FlexNet licensing, the administrator needs to have the
following items provided by Trimble:

+ Entitlement certificate

Trimble has sent the license entitlement certificate in an e-mail to the
person in your organization who has made the license purchase, or to
someone named as the contact person. The entitlement certificate lists all
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the Tekla Structures licenses you are entitled to use and includes the
activation IDs for entitled licenses.

For entitlement requests, contact your local Tekla representative.
+ Tekla license server installation package

The Tekla license server installation package is available on Tekla
Downloads product download service. The installation package contains
the license server files and Tekla License Administration Tool.

* License Administration Guide

This guide by Flexera Software is a general guide that contains, for
example, instructions on how to create user groups and manage access
rights. This guide is provided in the license server installation package and
is installed in the folder where you install the license server in the .pdf
format.

Checklist of IT resources needed in Tekla Structures
licensing

You need to take into account the following IT resource related requirements:
* Supported operating system

The FlexNet licensing system for Tekla Structures runs in Windows
operating system. The support for virtual servers is limited. For more
information, see Tekla Structures Hardware recommendations in Tekla
User Assistance.

*  Windows user account with administrator rights
Your Windows login user name should not contain any special characters.

You need to have administrator rights to install and manage the license
server. For more information, see Rights needed for performing
administrator's tasks in Tekla Structures licensing (page 35).

« TCP/IP port 27007 for license server

Tekla licensing service (1mgrd) is automatically run in the TCP/IP port
27007. This port should be dedicated for Tekla licensing service only. If
required, you can manually set a different TCP/IP port for the licensing
service, see Modify the license file tekla.lic manually (page 48).

* Local area network

The license server and the client computers need to be in the same local
area network. The clients need to be able to contact the license server. If
there is no local area network in your company, we recommend that you
install the license server on each computer that has Tekla Structures and
activate one license on each computer.
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Internal firewall and direct communication

The internal firewall of your company (for example, Windows Firewall) must
allow the communication between the server computer and the computers
with Tekla Structures. You must allow the applications tekla.exe and
1lmgrd.exe to operate through the firewall. For more information, see
Allowing Tekla license server to operate through Windows Firewall

(page 51).

Direct communication from the server computer to the Internet needs to
be allowed when the license server at your company contacts the
activation server at Trimble Solutions. The activation communication uses
SOAP over HTTPS on the TCP/IP port 443.

Your firewall should not block any incoming or outgoing information during
the activation. To allow the activation communication, use the activation
server address in your firewall settings:

https://activate.tekla.com:443/flexnet/services/ActivationService?wsd|

If direct communication from the server computer to the Internet is not
allowed, contact your local Tekla Structures support for manual activation.

System backup settings

If you have an automatic backup and restore system in your company,
configure your system so that it does not overwrite your actual Trusted
Storage with the backup copy. Trusted Storage is the place where the
licensing information is stored on the server computer, and it is located in
C:\ProgramData\FLEXnet depending on the operating system.

Checklist for the Tekla license server administrator

Your company or organization should assign an administrator for the license
server. The license server administrator's primary responsibilities are:

Install the Tekla license server: Installing Tekla license server (page 42)

If automatic installation is not possible, manually install and configure
Tekla license server: Install Tekla license server - manual installation
(page 45), Configure Tekla license server manually (page 49), Modify the
license file tekla.lic manually (page 48)

Save the entitlement certificate on the license server computer and activate
licenses on the server to make the licenses available for Tekla Structures
users, or for yourself, if the license server is installed on your own
computer: Activate Tekla licenses (page 62)

Inform users of the license server name and port number so that they can
connect Tekla Structures to the server: Preconfigure license server settings
for users (page 66)
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+ If necessary, modify the firewall settings to allow licensing traffic: Allowing
Tekla license server to operate through Windows Firewall (page 51)

+ If necessary, modify license access rights in the tekla.opt options file:
Modify Tekla license access rights (tekla.opt) (page 71)

+ Export a customized product ID files for license borrowing and deliver
them to offline users: Provide offline users with a customized product ID
file (page 101)

+ Inform users of the license policy of the company and monitor license use.

Rights needed for performing administrator's tasks in Tekla
Structures licensing

You need to have Windows administrator rights to install and manage the
license server. Some applications also need to be run as administrator
separately. This depends on the Windows version you are using.

* In Windows 7, Windows 8/8.1 and Windows 10, you need to log in as
administrator. In some cases, you need to run applications as
administrator. To do this, go to the folder containing the application, right-
click the application and select Run as administrator from the pop-up
menu.

* In Windows Server you need to log in as administrator. In some cases, you
need to run applications with unrestricted rights. To do this, right-click the
application, select Run as, and clear the Run this program with
restricted access check box.

Distributing and managing Tekla licenses

The FlexNet licensing system offers several options for distributing licenses to
users. The way you distribute the licenses depends on the size of the company
or organization, and the amount of Tekla Structures users.

There are two basic ways of distributing licenses to users:

+ The licenses are available for multiple users on a common license server.

+ The licenses are activated on each user's own computer.

You can also use a combination of license distribution methods. For example,
you can activate one license on a separate computer and activate the rest of
your licenses on a common license server.

The following table shows what is typical for managing the licenses that are
activated separately on each computer, and for licenses that are activated on a
common license server.

Manage licenses 35 Tekla Structures licensing system



Licenses are activated on user's
own computer

Licenses are activated on a
common license server

No need for an assigned license
server administrator.

Each user manages the license server
that is installed on the user's own
computer.

Centralized maintaining and
administration of licenses is needed.

A license server administrator
maintains the license server and
manages the license use.

Typically, there are a few Tekla
Structures main users in a company.
The main users are good candidates
for license server administrators,
because they are already familiar with
Tekla Structures. For more
information on the responsibilities of
the license server administrator, see
Checklist for the Tekla license server
administrator (page 34)

No need to manage license access
rights.

Each user activates only the licenses
that are needed.

By default, all license configurations
activated on the server are available
for all Tekla Structures users.
However, centralized access rights
management is possible.

The license server administrator can
give different users access to different
configurations. The license server
administrator needs to modify the
tekla.opt options file to manage
the license access rights. For more
information on managing license
access rights, see Modify Tekla license
access rights (tekla.opt) (page 71).

Tekla Structures can be used out of
office.

If the user's license is activated on a
computer, license borrowing or a VPN
connection is not needed.

Tekla Structures can be used out of
office.

A user needs to borrow a license from
the common license server or use a
VPN connection to the license server
to use Tekla Structures out of office.

Licenses are used only by one person.

Users have access only to the licenses
that are activated on their own
computer. If a user needs a license
that is activated on another
computer, the user needs to use the
other computer. Another option is to
deactivate licenses on one computer
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Licenses are checked out frequently
by several users.

When the licenses are activated on a
common server, they are available for
multiple users. The licenses are
checked out from the license server
only when they are needed. When a
user does not need a license, the user
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Licenses are activated on user's
own computer

Licenses are activated on a
common license server

and activate them on another, which
requires effort.

closes Tekla Structures and the
license becomes available for another
user. Switching from using one
license to another is simple.

Rules of license usage

Tekla Structures users should accept
common rules or an internal
company policy. The rules should
contain regulations of managing the
licenses, for example, who is allowed
to borrow licenses. Usage of common
rules minimizes the amount of
conflicts in license management.

Examples of different Tekla Structures licensing system

setups

The purpose of the following examples is to provide guidelines for license
management in companies or organizations of different sizes.

Example 1: One Tekla Structures user, all licenses activated on one

computer

Only one user in the company uses Tekla Structures. The user installs Tekla
Structures and the license server on the same computer.

+ Installing the license server is straightforward, and the default license
server settings can be used. The user does not need to modify the license
server settings, because the user runs the license server and Tekla

Structures on the same computer.

+ Because the user installs the license server on a computer, the user does
not need to borrow a license or use a VPN connection to use Tekla

Structures out of office.
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Example 2: Three Tekla Structures users, necessary licenses activated
separately on each computer

There are three Tekla Structures users in a company. Because the users use
different Tekla Structures configurations, each user installs a license server
separately on the user's own computer and activates only the needed licenses.

* Alicense server administrator is not needed, the users maintain their
license servers.

+ Because the users install the license servers on their computers, they do
not need to borrow a license or use a VPN connection to use Tekla
Structures out of office.
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Example 3: Ten Tekla Structures users, necessary licenses activated on a
common license server and one user's computer

There are ten Tekla Structures users in a compan

Trimble Solutions
icense activation
Sernver

License
activation

Licenze
activation

License server

!
w9 9

& A

& Tekla Structures user|  |Tekla Structures user
Tekla Structures ysers gaing out of office weho travels often

License
barrosving

v

License server

y.
Because the users use different configurations, the company uses a common
license server.

+ The company has an internal policy for license use containing regulations
for managing the licenses.

* One of the main users is assigned as the license server administrator. The
administrator installs the license server and informs the other users of the
hostname and port number of the server. The license server administrator
also performs other server maintenance duties.

+ One of the users travels a lot and needs Tekla Structures on the journeys. A
license server is installed separately on the user’s computer, so the user
does not need to borrow a license or use a VPN connection for offline use
of Tekla Structures.

« Other users borrow licenses from the license server when they need to use
Tekla Structures offline.
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Example 4: Fifty Tekla Structures users in two offices, necessary licenses
activated on two separate servers

There are fifty Tekla Structures users in two separate offices. Both offices have
their own license servers.

Both offices have assigned license server administrators. The license server
administrators install the license servers and perform license server
maintenance duties.

The company has an internal policy for using licenses. The policy contains,
for example, the rules that define who is allowed to borrow licenses.

Because the amount of Tekla Structures users is large, the license server
administrators create tekla.opt options files for controlling the access
rights for different licenses.

Only a couple of users need to use Tekla Structures offline. The license
server administrators modify the option files to enable the license
borrowing only for those users who need to borrow licenses.

If one server fails, the users can connect to the license server at the other
office. If there are licenses available on the license server, the users can use
the licenses.
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3.2 Installing Tekla license server

The Tekla license server installation package contains license server files,
applications for license management and guides. To install the license server
software, download the license server installation package with the latest

updates from Tekla Downloads product download service.

You have two choices in installation:

Automatic default installation: Select automatic installation for normal

setup. Automatic installation is recommended.

For detailed installation instructions, see Install Tekla license server -

automatic installation (page 44).
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+ Manual installation: Use manual installation if you need to separately
install the license server, modify the license file, configure the license
service, and start the server software. This is needed if you want to use
another TCP/IP port than the one used in the automatic installation, for
example. Use manual installation only if you are an advanced user of
FlexNet or FlexIm licensing.

For detailed installation instructions, see Install Tekla license server -
manual installation (page 45).

Before installing Tekla license server
+ Install the license server using administrator's rights.

* Turn off the internal firewall and pause the antispyware/antivirus
protection.

* Ensure that you have access to the Internet. The Internet connection is
needed during the license activation process. An unreliable connection
speed may cause errors.

+ If you are using other FlexNet licensing services, you need to stop them
before you install the Tekla license server. When you have completed
installing the Tekla license server, you can restart the other licensing
services.

See also

Problems in Tekla license server installation and connecting to the license
server (page 79)

Activate Tekla licenses (page 62)

Allowing Tekla license server to operate through Windows Firewall (page 51)

Which license server version to use

Check the table below to see which license server version to use with your
current Tekla Structures version. Also check if you need to upgrade to a new
service pack or progress release.

For information about updating the license server, see Update the Tekla
license server.

Tekla Structures License Server 2016 License Server 2017 or
version SP1 later

2018 or later

2017i - all versions

2017 - all versions

2016i - all versions

AN
ANANANEN
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Tekla Structures License Server 2016 License Server 2017 or
version SP1 later

2016 SP5/PR5 or later v v

2016 up to SP4/PR4 v Upgrade to 2016
SP5/PR5 or later

21.1 SR7 or later v v

21.1 up to SR6 v Upgrade to 21.1 SR7 or
later

21.1 all PV versions v v

21.0 or earlier v v

For instructions on how to install the license server, see .

Install Tekla license server - automatic installation
Before you start license server installation, stop FlexNet licensing services and
other licensing services.

For more information about which license server version to use, see Hardware
recommendations for Tekla 2020 license server.

To install the default setup of the Tekla license server to a computer that does
not have a previous version of Tekla license server installed:

1. Download the license server installation package with the latest updates
from Tekla Downloads product download service.

2. Select the installation language.

3. Select Automatic as the licensing service installation type to install the
default setup.

4. Select the folder where you want to install the license server and
complete the installation.

Tekla license server is installed.

In automatic license server installation, the license server address is
automatically set to 27007@your hostname, where 27007 is the port and
your hostname is the computer name/hostname. 27007@your hostname is
used as the license server address in every Tekla Structures installation.

When you have installed the license server, you need to do the following:

« Save the entitlement certificate and activate the licenses. For more
information, see Activate Tekla licenses using automatic server notification.

« Connect Tekla Structures to the license server. For more information, see
Preconfigure license server settings for users (page 66).
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* You can also change the language of the user interface in Tekla License
Administration Tool by opening the tool and clicking Language.

See also
Install Tekla license server - manual installation (page 45)

Problems in Tekla license server installation and connecting to the license
server (page 79)

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Install Tekla license server - manual installation

Use manual installation if you want to separately install the license server,
modify the license file, configure the license server, and start the license server
software. In manual installation of Tekla license server, you also install two
files: installanchorservice.exe and uninstallanchorservice.exe.
You need these files when you manually install or uninstall FlexNet Licensing
Service.

For example, you need to install the license server manually if the default
TCP/IP port 27007 is already in use by other services or applications, and you
need to define another port in the license file tekla.lic.

Before you start license server installation, stop other FlexNet licensing
services.

To install the license server manually:

1. Download the license server installation package with the latest updates
from Tekla Downloads product download service.

2. Select the installation language.

3. Select Manual as the licensing server installation type and complete the
installation.

4. Go to the Start menu or Start screen (depending on your Windows
operating system) and open Command Prompt as administrator.

5. Atthe command prompt, enter the following commands:
a. cd /d $SYSTEMDRIVE®\Tekla\License\Server

b. installanchorservice.exe
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The licensing server is installed.

oo Administrator: Command Prompt

icrosoft Windows [Wersion 6.3.76H881]
{c>» 20813 Microsoft Corporation. All rights reserwved.

NUsersSAdministrator?ed ~#d %SYSTEMDRIUEx\Tekla\License“Server

:NTeklasLicensesServer>installanchorservice .exe

Installed FLEXnet Licensing Service for publizher Tekla. product TeklaStructures
LicensefAdministrationTool.
The FLEBnet Licensing Service was installed on the machine.

:\TeklasLicensesServer>

Modify the license file to include the hostname or IP address of the server,
and the correct TCP/IP port:

a. Openthe ..\Tekla\License\Server folder on the server
computer.

b. Openthe tekla.lic (license file) file with a text editor.

C. Replacetext localhost ontheline SERVER localhost ANY with
the hostname (computer name) or IP address of the license server.

d. Enter the TCP/IP port number after text SERVER server hostname
ANY.

e. Save the changes and close the text editor.

Go to Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

On the Service/License File tab, click Configuration using Services.
On the Config Services tab to configure the licensing service:

a. Inthe Service Name box, enter the name of the service exactly as
follows: Tekla Licensing Service.

b. Click the Browse buttons to locate the 1mgrd. exe (license server
manager), tekla.lic and tekla debug. log files.

By default, lmgrd.exe, tekla.lic and tekla debug.log are
located inthe C:\Tekla\License\Server folder.

Note that if you set Path to the debug log file outside the
"C:\ProgramData\..." folder, you get an error message:
"Windows preferred path <SystemDrive>\ProgramData to store
service data is not set." This error message can be ignored.

c. Select the Use Services check box to run the licensing service as a
Windows service.

d. Select the Start Server at Power Up check box to start the licensing
service automatically after Windows startup.

e. Click Save Service to save the settings.
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LMTOOLS by Flexera — X

File Edit Mode Help
Service/License File | System Settings | Ltilties | Start/Stop/Reread | Server Status | Server Diags Config Services | Baomowing |

Configure Service
Save Service |
Service Name |Tekla Licensing Service ;I
Remave Service |

Path to the Imgrd exe file |C:\Tekla\License\Senrer\Imgrd.a:e ﬂl
- - - Browse |
Path to the license file IC.\Tekla\l_lcense\Senrer\tekla.||c
Path to the debug log file |+C:\Tekla\l_icense\Semer\tekla_debug log Browse | View LOQ---l Close Log |
[ Start Server &t Power Up W Use Services | FlexNet Licensing Service Details |

10. Go to the Start/Stop/Reread tab and click Start Server to start the
license server.

LMTOOLS by Flexera - X

File Edit Mode Help
Service/License Fie | System Settings | Utities Stan/Stop/Reread | Server Status | Server Diags | Config Services | Bomowing |

License servers installed as Windows services on this

computer
Sart Server Stop Server ReRead License Fle
] [~ Force Server Shutdown
- NOTE: This box must be checked to shut down a license server

when licenses are bormowed.

|Usung License File: C:\Tekla'\License\Server\tekla lic

11. Go to the Server Status tab and click Perform Status Enquiry.

In the status list, the line License server status shows the TCP/IP
port and hostname of the license server.

Now you can activate the licenses and connect Tekla Structures to the
license server.

You can also change the language of the user interface in Tekla License
Administration Tool by opening the tool and clicking Language.
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See also

Modify the license file tekla.lic manually (page 48)

Activate Tekla licenses (page 62)

Configure Tekla license server manually (page 49)

Problems using LMTOOLS in Tekla licensing (page 88)

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Modify the license file tekla.lic manually
If you selected the Automatic installation option, the license server is set to
your hostname: 27007@server hostname (port@hostname).

The licensing system automatically searches for an available TCP/IP port and
uses the first available port detected. The Automatic installation sets the port
to 27007.

You need to modify the tekla.lic license file if you:

+ Select the Manual license server installation option

+  Want to change the TCP/IP port of the licensing server

+ Want to use the IP address of your computer instead of the hostname
To modify the license file tekla.1lic manually:

1. Gotothe ..\Tekla\License\Server folder on the server computer.
2. Openthe tekla.licfilein a text editor.

3. Make the necessary changes:

« To use hostname or IP address: Replace text on the first line between
words SERVER and ANY with the hostname or IP address of your
license server.

Do not delete texts SERVER and ANY when you enter the hostname or
IP address of the license server.

The following formats are valid:

Hostname:server hostname

Domain name: server hostname.mycompany.com

IP address: 10.0.0.12
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E tekla.lic - Notepad \;‘i-

File Edit Format Wiew Help
SERVER server hostname ANY ]
VENDUK tekla

USE_SERVER

FEATURE TeklaServer tekla 1 31-dec-2825 1 SIGN="1@E5 B774 BDF3 B934
80C9 20DA 9E84 ES1E ESDB D37C FedF FE7S ECA@ 2FED @EFD 162F 1\

2851 AAF4 6314 7oCP@ AB53 1@5F E481 D92A EDBC 735E C5F2 9CD@
2CC4 2Ca9”

You can check the hostname of the license server in LMTOOLS on the
System Settings tab. Go to Tekla Licensing --> LMTOOLS through the

Start menu or Start screen, depending on your Windows operating
system.

* To set the TCP/IP port manually: Enter the TCP/IP port number after
text SERVER server hostname ANY.

The port number can be any free port in the range of 0 - 64000.

E tekla.lic - Notepad = I:'-
Eile Edit Format View Help

SERVER server_hostname ﬁNYlZ?B@?I »
VENDOR tekla

USE_SERVER

FEATURE TeklaServer tekla 1 31-dec-2825 1 SIGN="1@E5 B774 BDF3 B934
88C9 20DA 9E84 EB1E ESDB D37C F6AF FE73 ECA@ 2FED @EFD 162F

2851 AAF4 6314 7eCl AB53 1@5F E481 D92A EDBC 735E C5F2 9CD@
2CC4 2Cae9"

4. Save the changes and close the text editor.

5. Restart the Tekla Licensing Service in LMTOOLS or Windows Services for
the changes to take effect.

See also

Install Tekla license server - manual installation (page 45)
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Configure Tekla license server manually

If you encounter problems during the Tekla license server installation, the
license server may not start automatically. If this happens, you need to
configure the license server manually using LMTOOLS.

To configure the Tekla license server manually:

1.

Go to Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system. Start LMTOOLS
with administrators rights.

Go to the Service/License File tab and select Configuration using
Services.

Go to the Config Services tab and do the following:

Service Name: Select the licensing service. When working with Tekla
license server, always select Tekla Licensing Service.

Path to the Imgrd.exe: Click Browse and locate 1mgrd.exe. This file is
by default located in the Cc:\Tekla\License\Server folder.

Path to the license exe: Click Browse and locate tekla.lic. This file is
by default located in the C:\Tekla\License\Server folder.

Path to the debug log file: Click Browse and locate tekla debug.log.
This file is by default located in the C:\Tekla\License\Server folder.

To append the logging entries in the debug log file, start the debug log file
name path with the plus sign (+), like by default for tekla debug.log. If
the plus sign is missing, the log file will be rewritten each time the service
is started.

Note that if you set Path to the debug log file outside the
"C:\ProgrambData\..." folder, you get an error message: "Windows
preferred path <SystemDrive>\ProgramData to store service data is not
set." This error message can be ignored.

Use Services: Select the check box to run the licensing service as a
Windows service.

Start Server at Power Up: Select the check box to start the licensing
service automatically after Windows startup.

Click the Save Service button to save the settings.
Go to the Utilities tab and do the following:
Vendor Name: Enter tekla (all letters lowercase).
Path: Enter the name of the license server.

« Ifyou run the license server and Tekla Structures on the same
computer, enter @localhost. You can also enter the TCP/IP port, for
example, 27007@1localhost.
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3.3

+ Ifyou run the license server and Tekla Structures on separate
computers, enter the hostname of the license server, for example,
@server hostname.

* You can also enter the TCP/IP port of the license server, for example,
27007@server hostname. You must define the port if you use
another port than the default port.

* You can also enter several license servers. Separate the server names
with a semicolon. For example,
27007@server hostname;27007@localhost.

6. Click the Override Path button to replace the existing license servers
displayed in the status list on the Server Status tab.

7. Go to the Start/Stop/Reread tab and start the license server by clicking
Start Server.

The status bar should display a message telling that server start was
successful.

8. Go to the Server Status tab and enquire the license server status by
clicking Perform Status Enquiry.

The status list displayes the TCP/IP port and hostname of the license server.
The list should indicate that license server is up and vendor daemon tekla is
up. The list also displays all the activated licenses on the server.

Vendor dasmsn status [(on localhoet

Faariie usage infc

Unare of TeklaSsrver: Iotal of 1 licenss issusd; Total of O licensss in uss

:'Jnﬁ; Licerse File: C\Tekda Structures’ Lconse' Serverlokda ke

See also
Installing Tekla license server (page 42)
Problems in Tekla licensing: Error codes and their descriptions (page 93)

Allowing Tekla license server to operate through
Windows Firewall

When you set up Tekla license server in your network, you may also need to
configure the firewall and antivirus settings:

* You need to allow the applications tekla.exe and lmgrd.exe to operate
through the firewall on the license servers and on the client computers.
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+ Theinternal firewall at your company must allow the communication
between the license server computer and the computers with Tekla
Structures.

+ In addition to allowing the exceptions in your actual firewall, you may need
to configure exceptions for Windows Firewall. Windows Firewall may be set
on without you being aware of it, because some Windows updates may
automatically turn on the Windows Firewall.

For instructions on how to modify the firewall settings so that the Windows
Firewall on the license server allows licensing traffic, see:

+ Allow exceptions in firewall for Imgrd.exe and tekla.exe: Windows 7, 8, 8.1,
10 and Windows Server 2012 (page 52)

+ Allow traffic in fixed TCP/IP ports: Windows 7, 8, 8.1, 10 and Windows
Server 2012 (page 53)

In addition to Windows Firewall, the information given also applies to firewalls
from other vendors.

Allow exceptions in firewall for Imgrd.exe and tekla.exe:
Windows 7, 8, 8.1, 10 and Windows Server 2012

You need to allow the applications tekla.exe and lmgrd.exe to operate
through the firewall on the license server computer to enable licensing traffic.
The instructions below apply to Windows 7, 8, 8.1, 10 and Windows Server
2012.

To allow exceptions for 1mgrd.exe and tekla.exe on the license server
computer:

1. Press the Windows logo key + R on your keyboard to show the Run
dialog box, then type firewall.cpl and press Enter.

2. Inthe left pane, click Allow a program or feature through Windows
Firewall or Allow an app or feature through Windows Firewall
(depending on the operating system).

3. In Allowed programs or Allowed apps (depending on the operating
system), click Change settings.

Administrator permission is required. If you're prompted for an
administrator password or confirmation, enter the password or confirm.

4. Click Allow another program or Allow another app (depending on the
operating system).

5. Click Browse to browse for the \server folder on the computer, select
1lmgrd.exe and click Open.

By default, the pathis .. .\Tekla\License\Server.
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6. Click Add to add 1mgrd.exe to the Allowed programs or Allowed apps
and features list (depending on the operating system).

7. Select both Home/Work (Private) or Private (depending on the
operating system) and Public check boxes next to 1mgrd.exe.

8. Allow the exceptions also for tekla.exe by repeating the steps 4 - 7.

9. Click OK to confirm the changes.

See also

Allowing Tekla license server to operate through Windows Firewall (page 51)

Allow traffic in fixed TCP/IP ports: Windows 7, 8, 8.1, 10 and
Windows Server 2012

You need to modify the firewall settings to allow traffic through fixed TCP/IP
port. The following instructions apply to Windows 7, 8, 8.1, 10 and Windows
Server 2012.

To allow traffic in fixed TCP/IP ports in Windows 7, 8, 8.1, 10 and Windows
Server 2012 on the license server computer:

1.

Ensure that no other software or service is using the ports that you are
about to set fixed.

Use the command line command netstat -anp TCP to find out which
ports are in use.

The numbers in the Local Address column after the colon (:) are the port
numbers that are in use.

o Administrator: Command Prompt =
sUsers“Administratornetstat —anp TGP
Active Connections

Local Address

Q

DEAEIEEEREIIEY
DEEEEEEEE

reign Address State
.A.A:@ LISTENING
H ) LISTENING
5] LISTENING
5] LISTENING
A LISTEMNING
H 5] LISTEMNING
H ) LISTENING
H) LISTENING
5] LISTENING
5] LISTENING
5] LISTENING
5] LISTENING
5] LISTENING

a.

a.a
a.a
a.a
a.8
a.8
6.0
0.8
0.8
0.8
a.a

0.0.0.8:49175
TCP  192.168.24.142:139

IEOEDEEEIEEEEET

sUzerswAdministrator?

Browse for tekla.1lic, and open it using a text editor.
By default, the path is . .\Tekla\License\Server.

To set a fixed port for Imgrd. exe, enter the TCP/IP port number at the
end of the SERVER row.
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The Automatic installation option sets the port to 27007.

) tekla.lic - Notepad = =] =
File Edit Format View Help

SERVER WINZK125RV1 ﬁNY|2TBB7|

VENDOR tekla

USE_SERVER

FEATURE TeklaServer tekla 1 31-dec-2825 1 SIGN="1BE5 B774 BDF3 B93A \
88C9 20DA 9E84 ES81E E8DB D37C Fe4F FE73 ECAD 2FED BEFD 162F ©

2851 AAF4 6314 7eCe AB53 1@5F E481 D924 EDBC 735E C5F2 9CDB A
2CC4 2Ca9”

4. Enter the text port=free port at the end of the VENDOR row, for
example, port=1234.

4 tekla.lic - Notepad = =] %
File Edit Format View Help

SERVER WIN2K1 27087 ~
VENDOR teklafport=1234

USE_SERVER

FEATURE TeklaServer tekla 1 31-dec-2025 1 SIGN="1BE5 B774 BDF3 B93A \
80C9 28DA 9E84 ES1E ESDB D37C Fed4F FE72 ECAB 2FED @EFD 162F

2851 AAF4 6314 7e(CB® AB53 185F E481 D92A EDBC 735E C5F2 9CD@ Y\
2CC4 2Ce9”

Defining the TCP/IP port number on the VENDOR row may slow down the
restart time of Tekla Licensing Service.

5. Save the changes and close tekla.lic.
6. Update your license server with the changes:

a. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

b. On the Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.
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LMTOOLS by Flexera Software LLC = || =] 28
File Edit Mode Help
] System Settings ] Ltilties ] Start/Stop/Reread ] Server Status ] Server Diags ] Corfig Services ] Bomowing ]

Services allow FlexMet Servers to run in the background.
Server List
" Configuration using License File

* Corfiguration using Services

Another Licet
Tekla: Licer

nsing
2ing

Service

[~ LMTQOLS ignores licenss fils path environment varables

Go to the Start/Stop/Reread tab and click Stop Server to stop the
license server, and then start the server again by clicking Start
Server.

Click the Windows logo key on your keyboard to show the Start menu or
Start screen, depending on the operating system.

Type wf .msc and press Enter. The Windows Firewall with Advance
Security MMS snap-in is displayed.

In the navigation tree, select Inbound Rule, and then in the Actions pane,
click New Rule.
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' Windows Firewall with Advanced Security =8| x
File  Action

4

Inbound Rules Actions

MName ~

.BranchCache Content Retrieval (HTTP-In)
] L .BranchCache Hosted Cache Server (HTT.. | _
4 'E' Menitoring .BranchCache Peer Discovery (W5SD-In) ||| ¥ Filter by Profile
.COM+ Metwork Access (DCOM-In) S Filter by State
.COM+ Remote Administration (DCOM-In) T Filter by Group
@Core Metworking - Destination Unreacha..
@Core MNetworking - Destination Unreacha...
(@) Core Networking - Dynamic Host Config... |G Refresh
@Core MNetworking - Dynamic Host Config... |5+ ExportList...
@Core MNetworking - Internet Group Mana...

@Core MNetworking - IPHTTPS (TCP-In)
@Core Networking - IPv6 (IPv6-In)

@Core MNetworking - Multicast Listener Do...
@Core Metworking - Multicast Listener Qu...
@Core Metworking - Multicast Listener Rep...
@Core MNetworking - Multicast Listener Rep...
@Core Metworking - Meighbor Discovery A..
@Core Metworking - Meighbor Discovery 5.
@Core Metworking - Packet Tee Big (ICMP..
@Core MNetworking - Parameter Problem (1.,
@Core Metworking - Reuter Advertisement...

(@) Core Networkina - Router Salicitation (1C...
< m >||[< [ m ] >

®a Connection Security Rules

* v v v

View

Help

10. On the Rule type panel, select Port and then click Next.
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4 New Inbound Rule Wizard 5

Rule Type
Select the type of firewall rule to create.

Steps:
@ Rule Type What type of rule would you like to create?
@ Protocol and Ports
@ Action ) Program
@ Profie Rule that controls connections for a program.
@ Name ® Port
Rule that controls connections fora TCP or UDP port.
) Predefined:

BranchCache - Contert Retrieval (Uses HTTF)

Rule that controls connections for a Windows experience.
) Custom

Custom rule.

< Back [ Mexdt > || Cancel |

11. On the Protocol and Ports panel, select TCP, enter the TCP/IP port
numbers that you set in steps 3 and 4 in Specific local ports, and then
click Next.
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7 New Inbound Rule Wizard &
Protocol and Ports

Specify the protocols and ports to which this rule applies.

Steps:

@ Rule Type Does this rule apply to TCF or UDP?

@ Protocol and Ports

@ Action
@ Profile
® Name Does this rule apply to all local ports or specific local ports?

O All local ports

® Specific local ports: I]2?DD?. 1234 ]

Example: 80, 443, 5000-5010
cBack || Ned> || cancel
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12. On the Action panel, select Allow the connection, and then click Next.

4 New Inbound Rule Wizard X

Action

Specify the action to be taken when a connection matches the conditions specified in the rule.

Steps:

@ Rule Type What action should be taken when a connection matches the specified conditions?
» Protocol and Ports .

_ (@ Allow the connection
BEien This includes connections that are protected with IPsec as well as those are not.
» Profile -
) Allow the connection if it is secure

& Name

This includes only connections that have been autherticated by using IPsec. Connections
will be secured using the settings in IPsec properties and rules in the Connection Security
Rule node.

) Block the connection

[ <Back || Mew> || cancel |

13. On the Profile panel, select the appropriate profiles, and then click Next.
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4 New Inbound Rule Wizard 5
Profile

Specify the profiles for which this rule applies.

Steps:
@ Rule Type When does this rule apply?
@ Protocol and Ports
@ Action Domain
& Profie Applies when a computer is connected to its corporate domain.
@ Name Private
Appliez when a computer is connected to a private network location, such as a home
or work place.
Public

Applies when a computer is connected to a public network location.

[ <Back || MNed> J[ cancel |

14. On the Name panel, enter the name of the rule, and then click Finish.
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4 New Inbound Rule Wizard 5

Name

Specify the name and description of this rule.

Steps:
& Rule Type
@ Protocol and Ports
@ Action

y MName:
@ Profile

l Tekdla Licensin

& Name J I

Description (optional):

[ <Back || Enmsn || cancel

The rule is created and automatically enabled.
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i Windows Firewall with Advanced Security = || =] =2
File Action View Help

= #E= = B

B3 Inbound Rules . . N
&% Outbound Rules . . Inbound Rules
@ Tekla: Licensing "

;"5. Eﬂonr?tect.ion Security Rulesf ) . 2l (HTTP-In) . )
b % Menttering .BranchCache Hosted Cache Server (HTT... v
.BranchCache Peer Discovery (W5D-In) T Filter by State
.COM+ MNetwork Access (DCOM-In) T
.COM+ Remote Administration (DCOM-In)

Mew Rule...

Filter by Profile

Filter by Group

v v v v

. . View
@Core Metworking - Destination Unreacha...
(@ Core Networking - Destination Unreacha... |G Refresh
@Core MNetworking - Dynamic Host Config... 5» Export List...
@Core Metworking - Dynamic Host Config.. Help

@Core Networking - Internet Group Mana...
@Core Metworking - IPHTTPS (TCP-In)
@Core Networking - IPvE (IPvE-In)

@Core Networking - Multicast Listener Do...
@Core Metworking - Multicast Listener Qu...
@Core Networking - Multicast Listener Rep...
@Core Networking - Multicast Listener Rep...
@Core Metworking - Meighbor Discovery A...
@Core Networking - Meighbor Discovery 5...
@Core Metworking - Packet Teo Big (ICMP...
@Core Networking - Parameter Problem (1.

) Core Networkina - Router Advertisement...|
£ (] > <l m *

Tekla Structures

Allow exceptions in firewall for Imgrd.exe and tekla.exe: Windows 7, 8, 8.1, 10
and Windows Server 2012 (page 52)

Allowing Tekla license server to operate through Windows Firewall (page 51)

Activate Tekla licenses

You need to activate the licenses on the license server to be able to use them.
There is no activation for online licenses (such as licenses for Tekla Model
Sharing).

How license activation works
When you activate the licenses, your license server contacts the activation

server at Trimble Solutions, and the license rights are transferred to the
license server in your company network or on your computer. You can activate
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licenses in Tekla License Administration Tool, which is installed together with
the license server.

+ Internet access is required in license activation because the license server
at your company needs to contact the activation server at Trimble
Solutions.

* The activation server at Trimble Solutions tracks the activation status of
your licenses. You are not allowed to activate any version of the same
license again without first deactivating it. Deactivate the licenses before
you make any major changes to the computer that runs the Tekla license
server.

* You do not need to activate all the licences at once. You can activate part of
the licenses now and part of the licenses later on some other computer, for
example. Different configurations and different versions need to be
selected for activation separately.

Activate licenses

To activate a license, you must have the corresponding license entitlement
certificate file EntitlementCertificate.html. The entitlement certificate is
sent in an e-mail to the person in your organization who has made the license
purchase, or to someone they have named as the contact person. The
entitlement certificate states the configurations, quantities and identifiers of
the licenses you are entitled to use.

+  We recommend that you save the entitlement certificate file
EntitlementCertificate.html tothe ..\Tekla\License\Server
folder. You will need the file again if you later need to move the licenses to
a different computer.

If you have licenses in several entitlement files, rename the files as
necessary to avoid overwriting.

* You can activate licenses using either manual or automatic server
notification. Do not use automatic notification if you are using some other
FlexNet license and license server administration tool, such as FlexNet
Manager. Otherwise, we recommend using automatic notification. You can
find the instructions for both procedures below.

Activate Tekla licenses using automatic server notification
You can activate Tekla Structures licenses in Tekla License Administration Tool,
which is included in the license server installation. To activate the license, the
license server at your company contacts the activation server at Trimble
Solutions through the internet.

NOTE Do not use automatic notification if you are using some other FlexNet
license and license server administration tool, such as FlexNet
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Manager. To notify the license server about license changes manually,
see Activate Tekla licenses (page 62).
To activate the licenses and notify the license server automatically:

1. Go to Tekla Licensing --> Tekla License Administration Tool through
the Start menu or Start screen, depending on your Windows operating
system.

2. Make sure the automatic license server notification is enabled. Check the
-
status on the A Notify Server button in the toolbar and click the
button if necessary.

3. Click Open and openthe EntitlementCertificate.html file that
contains the license. The license information is displayed in the Entitled
Licenses area.

Entitled Licenses

Activate Quantity Order ID Activation ID  Description Configuration Version Type 5tart Date Expiration Date
1 Tekla HQ 04C1-3F1E-5... FUD-C Full 20 1.5.2015 31.5.2015
2 Tekla HQ 4B73-A2E9-.. STD-C SteelDetailing |20 1.5.2015 31.5.2015

4. Click the Activate cell and select the number of licenses to activate.

Entitled Licenses

Activate  Quantity OrderID Activation ID  Description Configuration Version Type Start Date Expiration Date
1 Tekla HQ 04C1-3F1E-5... FUD-C Full 20 1.5.2015 31.5.2015
1 2 Tekla HQ 4B73-A2E9-.. STD-C SteelDetailing |20 1.5.2015 31.5.2015

5. Click the Activate button.

Your license server contacts the license activation server at Trimble
Solutions.

+ The activated licenses are displayed in the Activated Licenses area.

*  We recommend that you back up the trusted storage (. . \ProgramData
\FLEXnet\) in a safe place away from the computer running the license
server. Backups can help you restore your licenses on the same server if
active licenses are accidentally erased.

*  When you open Tekla License Administration Tool later on, it detects
expired and broken licenses you may have and asks if you want to
deactivate or repair them. If you select Yes, an automatic deactivation or
repair is run.

See also
Problems in Tekla license activation (page 82)

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Activate Tekla licenses using manual server notification
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You have to use manual notification if you are using some other FlexNet
license and license server administration tool, such as FlexNet Manager.

To activate the licenses and notify the server manually:

1. Goto Tekla Licensing --> Tekla License Administration Tool through
the Start menu or Start screen, depending on your Windows operating
system.

2. Make sure the automatic license server notification is disabled. Check the

status on the £ Notify Server button in the toolbar and click the button
if necessary.

3. Click Open and openthe EntitlementCertificate.html file that
contains the license. The license information is displayed in the Entitled
Licenses area.

Entitled Licenses

Activate Quantity Order ID Activation ID  Description Configuration Version Type 5tart Date Expiration Date
1 Tekla HQ 04C1-3F1E-5... FUD-C Full 20 1.5.2015 31.5.2015
2 Tekla HQ 4B73-A2E9-... STD-C SteelDetailing |20 1.5.2015 31.5.2015

4. Click the Activate cell and select the number of licenses to activate.

Entitled Licenses

Activate  Quantity Order [D Activation ID  Description Configuration Version Type Start Date Expiration Date
1 Tekla HQ 04C1-3F1E-5.. FUD-C Full 20 1.5.2015 31.5.2015
1 2 Tekla HQ 4B73-A2ES-.. STD-C SteelDetailing |20 1.5.2015 31.5.2015

5. Click the Activate button.

Your license server contacts the license activation server at Trimble
Solutions.

6. Next, you need to notify the server. This has to be done each time you
activate a license.

a. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start

screen, depending on your Windows operating system.

b. On the Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

In the LMTOOLS dialog box, go to the Start/Stop/Reread tab.
d. Click ReRead License File.
The license server reads the license information.
+ The activated licenses are displayed in the Activated Licenses area.

+  We recommend that you back up the trusted storage (. . \ProgramData
\FLEXnet\) in a safe place away from the computer running the license
server. Backups can help you restore your licenses on the same server if
active licenses are accidentally erased.
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*  When you open Tekla License Administration Tool, it detects expired and
broken licenses you may have and asks if you want to repair or deactivate
them. If you select Yes, an automatic deactivation or repair is run.

See also
Problems in Tekla license activation (page 82)

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Preconfigure license server settings for users

When the license server is on a separate server in the network, Tekla
Structures connects to the license server to fetch a license. To be able to do
this, the license server address must be defined on each computer. This can
be done by typing in the address when starting the software for the first time
or you can include the address in an intialization file that you distribute as part
of your customized installation. You can also predefine the license,
environment and role with a customized startup shortcut and intialization file.

By default, when Tekla Structures starts for the first time on a computer, the
system asks for the address of your Tekla license server unless Tekla
Structures can find a license server with an active license installed on the same
computer. To avoid this manual process, you can include the Tekla license
server address in your customized configuration. Similarly, you can also select
the license for the user, and if you also preset the environment and role, the
user does not need to make any selections when starting Tekla Structures. To
set up this for your users, see the instructions in Implementation guide for
administrators (page 107).

Tekla Structures X

® Use your on-premises license server

27001 @Server-A; 27001@Server-B| Check licenses >>

Use your Tekla online license

Tekla
Structures

- Trimble 'l Cancel

Contact your system administrator if you are unsure of which server to use.
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See also
Modify the license file tekla.lic manually (page 48)

Deactivate Tekla licenses

License deactivation releases license rights from a license server, which allows
you to activate a new version of the same license or to activate the same
license on different hardware. There is no deactivation for online licenses
(such as licenses for Tekla Model Sharing).

The activation server at Trimble Solutions tracks the activation status of your
licenses. You are not allowed to activate any version of the same license again
without first deactivating it.

When you deactivate licenses, your license server contacts the activation
server at Trimble Solutions, and the license rights are transferred away from
your Tekla license server.

When you need to deactivate licenses

+ Before you upgrade or reinstall the operating system or before you change
the hardware components of any computer that has a license server
installation with active licenses.

+ Before you activate a replacement license, including licenses that entitle
you to run a new version of Tekla Structures and replacement licenses for
any temporary licenses.

+ Before you activate the same license on a different license server, for
example, when you want to change from one license server computer to
another.

+ Before you change the IP address on the license server computer.

+ Before you format the hard drive of or decommission your server
computer.

When you do not need to deactivate licenses

You do not need to deactivate licenses before uninstalling and reinstalling the
Tekla license server software.

Deactivate licenses

* Internet access is required in license deactivation.
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Deactivation must be done on the license server containing the active
license. If your license server fails and cannot be recovered, contact your
local support for assistance.

To deactivate licenses:

1.

6.

Start the Tekla License Administration Tool app with administrator rights.
This tool is installed together with the Tekla license server and you can
find it through the Windows Start menu on the computer that is hosting
your license server.

In the Tekla License Administration Tool dialog box, go to the Statistic
tab and ensure that no one is using the licenses.

License server statistics

Configuration Description Total In Use Borrowed Free
SteelDetailing 5TD-C 1 0 0 1

NOTE Before you deactivate licenses, ensure that the licenses are not in
use or borrowed. The borrowed licenses must be returned before
they can be deactivated.

If you have not activated the automatic server notifications (the Notify
Server option in Tekla License Administration Tool), you need to stop
the license server manually in LMTOOLS:

a. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system. Start
LMTOOLS with administrator rights.

b. On the Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

c. Go to the Start/Stop/Reread tab and click Stop Server.
In Tekla License Administration Tool, go to the Licenses tab.

The Activated Licenses area lists the active licenses.

Activated Licenses
Deactivate Trust Status Enabled Quantity Borrowed Configuration WVersion Expiration Date Type  ActivationID OrderID
b HITIR] @ |1 0 SteelDetailing 20 31.5.2015 Enter... 4B73-A2E9-.. Tekla HQ

Select the Deactivate check box to select the license for deactivation.

If you activated more than one license of the same type in one go, you
cannot deactivate those licenses one by one, but you need to deactivate
all of the licenses in one go.

The Deactivate button is activated, click it.

The license server contacts the activation server at Trimble Solutions. Internet
access is required at this stage. After a successful deactivation you will see the
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license successfully deactivated message, and the Tekla License
Administration Tool is updated to reflect the deactivation.

See also
Problems in Tekla license deactivation (page 86)

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Maintain Tekla licenses

After the licensing is set up, you can verify that you have the correct number of
licenses and that the licenses are used correctly by monitoring the license use
(page 69).

You need to make changes in the following situations:

+ If users are selecting incorrect license types or secondary users are
reserving too many licenses, you can ensure that the correct types of
licenses are available to the users who most need them by defining access
rights for using and borrowing licenses, see Modify Tekla license access
rights (tekla.opt) (page 71).

* You need to deactivate your existing licenses (page 67):

*  When you start using a new version of Tekla Structures, which requires
activating renewed licenses.

+ Before you activate a changed version of the same license (for example,
the number of concurrent users is changed).

+ Before you make hardware changes that affect the license server.
+ If you want to move the licenses to a different license server (page 75).

+ If your licenses become untrusted or disabled, you can repair them a
limited number of times as explained in Repair a license (page 76).

See also
Troubleshoot Tekla licensing (page 77)
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Monitor Tekla license use

You can get a report of how many Tekla Structures licenses are currently in
use in your company with the LMTOOLS software that is delivered with the
Tekla license server.

The LMTOOLS application requires Windows administrator privileges to run.

To view which licenses are currently in use:

1.

Go to Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

If the correct Tekla license server is not defined, switch to the Utilities tab
and add the license server path:

a. Type tekla in the Vendor Name box.
b. Type your license server address as port@host in the Path box.
c. Click Override Path.

LMTOOLS by Flexera Software LLC — k4
File Edit Mode Help
Service./License Fie | System Setings  Utilties |&M.-'Rnn-'ﬁanud|5¢'\rﬁ9:m| Server Diags | Corfig Services | Bomowing |

Find out the version of Flexciet Licenaing lnked with a fle. Useful for dagnosing emom

Fbe Name: | Bowse | FindVeson |
S the spacified vendor nams or all Visndor Name: I'Hu | Path: I;z:-c.:qgm._.q I J
wandoms to a new path location

NOTE: Inpath cannct changs envirorment sefings. [ AJ Vandor Paths|  Add Vendor Path Crvemds Path I
oty Windows regstry | |

[Using Licanss Fie: C:\TeidaStnuctureshLicense'Sanver'teida bo

On the Server Status tab, click Perform Status Enquiry. You will receive
a listing of how many licenses and which configurations are activated on
the server, and how many of the licenses are in use at the moment of
enquiry.

The status enquiry uses abbreviations of Tekla Structures configurations,
which are explained here (page 72). You can also find the description of
the abbreviations in your entitlement certificate or in Tekla License
Administration Tool.

For a comprehensive description of the status enquiry syntax, see.
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Modify Tekla license access rights (tekla.opt)

The license server administrator may grant different users and user groups
different rights to use licenses by modifying the tekla.opt options file. This
can prevent situations where there are no licenses available for users that
need them because someone else has reserved or borrowed a license that
they do not really need.

The licensing options file tekla.opt is located in the . .\Tekla\License
\Server folder.

The most common configuration options include the following:

You can define the access rights for specific usernames or hostnames/IP
addresses either individually or using groups that you define. You can use
the same username or hostname in several groups.

You can reserve a number of licenses for a specific configuration (e.g.,
Steel detailing) for exclusive use by a specific user or user group. If
necessary, the users in the group can reserve more licenses than the
reserved quota. Other users can only use one of the remaining free
licenses outside the reserved quota.

You can define a maximum (max) number of licenses that a user or group
can simultaneously use. Users who are not included in this limitation can
use any free license.

You can include (allow) a user or group in the exclusive use of all licenses
for a specific configuration. Other users are prevented from using the
configuration.

You can exclude (disallow) specific users from using any licenses for a
specific configuration. All other users are allowed to use the configuration.

You can include and exclude users from borrowing licenses.

To modify access rights in the tekla.opt file:

1.
2.
3.

Gotothe ..\Tekla\License\Server folder.
Open the tekla.opt file in a text editor.
Enter your definitions for license access rights and restrictions.

The definition string consists of the following parts: [keyword] [Tekla
Structures feature] [user type] [name]

When you write the definition, follow the rules below.
+ Note that the options file is case sensitive.
+ If you need to define user groups and host groups, define them first.

Use Windows user names when defining user groups and hostnames
or IP addresses when defining host groups.
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+ Enter one definition per row. A definition consists of the following
things:

* An options keyword that defines the actions.
+ Afeature, such as a configuration, that is affected by the keyword.
+ The type that is affected by the keyword.

The options are: USER, GROUP, HOST, and HOST GROUP.

« The name of the user, user group, host, or host group that is
affected by the keyword.

You can use the hostnames or IP addresses of the computers with
the HOST and HOST GROUP keywords.

+ Todisable a row in the options file, enter # in the beginning of the row.
Examples of definitions:

INCLUDE PCD-C USER scarlett (Only the user scarlett is allowed to
use the Precast Concrete Detailing configuration.)

RESERVE 1 RCD-C USER vera (One license of the Rebar Detailing
configuration is reserved for the user vera.)

For details about the allowed keywords and configuration codes together
with more examples, Configuration codes and keywords used in access
right definitions (page 72).

4. Save the changes and close the text editor.

5. Go to Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

6. In LMTOOLS, go to the Start/Stop/Reread tab and click the ReRead
License File button to update the changes in the license file and in the
options file.

Useful links

For more information about limiting certain Tekla Structures versions to
certain users, see the following Support Article in Tekla User Assistance: How
to limit certain Tekla Structures version to certain users

Configuration codes and keywords used in access right definitions
When you define access rights in tekla.opt, you need to use correct
abbreviations (codes) for the configurations, otherwise the definitions do not
work. The access rights are defined using certain keywords.

Configuration codes

When you define access rights for different Tekla Structures configurations in
the tekla.opt options file, you need to add a proper code for each
configuration in the definition.
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NOTE The configuration codes are backward compatible, and the codes
used for licensing in older Tekla Structures versions still work.
However, the commercial product name of the configuration may
change between versions. For example, the commercial product name
for STDL-C used to be Steel Detailing Limited, but now it is Primary.

The codes for the Tekla Structures configurations are listed below:

Configuration code

Configuration

CM-C Construction Modeling
DEV-C Developer

DFR-C Drafter

EDU-C Educational

FUD-C Full

PCD-C Precast Concrete Detailing
RCD-C Rebar Detailing

SDE-C Engineering

STD-C Steel Detailing

PPC-C Production Planner - Concrete
STDL-C Primary

VIE-C Project Viewer

Most common keywords

The most common keywords that are used for defining license access rights
and restrictions in the tekla.opt options file are listed and described below:

Keyword Description Usage information
EXCLUDE Prevent access to a Tekla| Use with the
Structures configuration. | abbreviation of the
configuration.
EXCLUDE ENTITLEMENT | Prevent license Use with the activation
borrowing. ID of the license.
EXCLUDEALL Prevent access to all
Tekla Structures
configurations.
GROUP Define a user group for | Use with Windows user
use with any options. names (separated with
spaces).
HOST GROUP Define a host group for | Use with computer
use with any options. hostnames or IP
addresses (separated
with spaces).
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Keyword

Description

Usage information

INCLUDE

Allow a user to use a
Tekla Structures
configuration.

Use with the
abbreviation of the
configuration.

INCLUDE ENTITLEMENT

Allow a user to borrow a

Use with the activation

license. ID of the license.
INCLUDEALL Allow a user to use all
Tekla Structures
configurations.
MAX Limit the usage of a Use with the number of
configuration. licenses and the
abbreviation of the
configuration.
RESERVE Reserve licenses for a Use with the number of

user/host or a group of
users/hosts.

licenses and the
abbreviation of the
configuration.

*  When somebody is allowed to use a configuration with the INCLUDE
keyword, other users are automatically prevented from using the

configuration.

*  When somebody is denied to use a configuration with the EXCLUDE
keyword, other users are automatically allowed to use the configuration.

* If norules exist, everybody is allowed to use the configuration.

Some examples of definitions in a tekla.opt options file are given below:

Options file definition

Description

INCLUDE PCD-C USER
scarlett

Only the user scarlett is allowed to use the
Precast Concrete Detailing configuration.

EXCLUDE FUD-C USER justin

The user justin is not allowed to use the
Full configuration. Other users are allowed
to use the Full configuration.

GROUP tsusers jessica joe
neil

INCLUDEALL GROUP tsusers

The users jessica, joe and neil belong to
the group tsusers. Only the group tsusers
is allowed to use all configurations.

EXCLUDEALL HOST pcrobert

No configuration is allowed to be used on
the computer pcrobert.

INCLUDE ENTITLEMENT
gwer—-1234-asdf-5678-zx
USER gwen

Only the user gwen is allowed to borrow a
license whose activation ID is qwer-1234-
asdf-5678-zx.

EXCLUDE ENTITLEMENT
rtyu-9876-fghj-5432-cv
USER matt

The user matt is not allowed to borrow a
license whose activation ID is rtyu-9876-
fghj-5432-cv.
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Options file definition Description

GROUP students amy chloe |The users amy, chloe, andy, and dean
andy dean belong to the group students. The limit to
the usage of the Educational configuration

MAX 3 EDU-C GROUP . .
for the group students is three licenses.

students

RESERVE 1 RCD-C USER vera|One license of the Rebar Detailing
configuration is reserved for the user vera.

GROUP STUDENTS userl The users user1 user2 user3 belong to the
user2 user3 group STUDENTS. 3 licenses of the Project
Viewer configuration are reserved for the
group STUDENTS.

STUDENTS is a group name.

RESERVE 3 VIE-C GROUP
STUDENTS

user1 - user 3 are Windows user names
separated with spaces.

The number 3 is the number of licenses to
reserve.

VIE-C is the configuration code for the
Project Viewer configuration.

Note that any licenses reserved for a group
are dedicated to that group. Even when

that group is not actively using the licenses,
the licenses are unavailable to other users.

INCLUDE VIE- Only the user john is allowed to use the
C:VENDOR STRING=Enterpris |Project Viewer configuration which is of
e USER john type Enterprise.

Useful links

For more information about limiting certain Tekla Structures versions to
certain users, see the following Support Article in Tekla User Assistance: How
to limit certain Tekla Structures version to certain users

Move licenses between license servers

You can transfer a license from one license server to another. Moving licenses
can be necessary, for example, if you are switching to new hardware or if you
want to consolidate licenses from several workstations to a central server.

1. Deactivate the licenses that you want to move (page 67) in the Tekla
License Administration Tool on the computer that currently contains the
licenses.

Activated Licenses
Deactivate Trust Status Enabled Quantity Borrowed Configuration WVersion Expiration Date Type  ActivationID Order ID
» WIT]R] @ 1 0 SteelDetailing 20 31.5.2015 Enter... 4B73-AZE9-.. Tekla HQ
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2. Ifthe license entitlement certificate file containing these licenses is not
available on the other computer, find the
EntitlementCertificate.html file that contains the license and copy
it to the computer on which you want to activate the licenses.

« Entitlement certificate files are sent over email. In the installation
instructions, we recommend storing the entitlement files in the license
server installation folder (. . \Tekla\License\Server)), from where
you can copy it to the same folder on the other computer.

* Rename the files as necessary to avoid overwriting different
entitlement certificate files with each other.

+ There can be several licenses in one file, so you can activate different
licenses on different computers using the same entitlement certificate
file.

3. Activate the licenses (page 62) in the Tekla License Administration Tool on
the other computer to complete the move.

Entitled Licenses

Activate  Quantity Order D Activation ID  Description Configuration Version Type Start Date Expiration Date
1 Tekla HQ 04C1-3F1E-5... FUD-C Full 20 1.5.2015 31.5.2015
1 2 Tekla HQ 4B73-A2E9-.. STD-C SteelDetailing |20 1.5.2015 31.5.2015

We recommend that you back up the trusted storage (. . \ProgramData
\FLEXnet\) in a safe place away from the computer running the license
server. Backups can help you restore your licenses on the same server if active
licenses are accidentally erased.

See also

Installing Tekla license server (page 42)

Repair a license

If your licenses have become untrusted or disabled, they cannot be used and
you need to repair them.

The license trust status is indicated in the Activated Licenses area in Tekla
License Administration Tool. If a trust status symbol is green, the information
is trusted, if red, the information is untrusted.

WARNING Because of technical and security reasons, you can repair an
Activation ID only a limited number of times, which at the
moment is two times a year. Therefore it is important that you
inform your local Tekla Structures representative about the
license repairs you have been performing, and keep count of the
repairs.

The status can be one of the following:
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+ Ared H (Host) indicates whether the server has been moved to another
computer, or whether the computer hardware has changed radically.

The Host trust status of your license is not trusted:

Trust Status

Hi

NOTE Licenses that have the Host trust status untrusted cannot be
repaired.

* Avred T (Time) indicates whether the system clock has been tampered with.
The Time trust status of your license is not trusted:
Trust Status
(HRAR

+ Ared R (Restore) indicates whether the license is obtained from a backup
copy.
The Restore trust status of your license is not trusted:
Trust Status
W R
To repair a license:

1. Go to Tekla Licensing --> Tekla License Administration Tool through
the Start menu or Start screen, depending on your Windows operating
system.

The Activated Licenses area displays the activated licenses.
2. Click Repair.

The license server contacts the activation server at Trimble Solutions.
After successful repairing the trust status in Tekla License Administration
Tool dialog box is updated.

For more information about the status of the activated licenses in the trusted
storage, see instructions in the following Support Articles in Tekla User
Assistance:

Checking the status of the activated licenses in the trusted storage

Checking the status of the activated licenses in the trusted storage (including
borrowing info)
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Troubleshoot Tekla licensing

Click the links below for help in solving problems encountered in the following
areas:

+ View and diagnose errors in Tekla Structures license activation,
deactivation and borrowing (page 78)

+ Problems in Tekla license server installation and connecting to the license
server (page 79)

* Problems in FlexNet (page 81)

* Problems in Tekla license activation (page 82)

* Problems in Tekla license deactivation (page 86)

* Problems in Tekla license borrowing (page 86)

* Problems in Tekla license trusted storage (page 87)

* Problems using LMTOOLS in Tekla licensing (page 88)
* Problems in starting Tekla Structures (page 90)

* Problems with options file tekla.opt (page 92)

For more information about error messages starting with an error code, see
Problems in Tekla licensing: Error codes and their descriptions (page 93).

View and diagnose errors in Tekla Structures license activation,
deactivation and borrowing

Tekla License Administration Tool and Tekla License Borrow Tool both give
error messages when errors occur. The tools automatically create packages of
all necessary files required for diagnosing the errors.

If you have a problem with activating or deactivating licenses, or borrowing or
returning licenses, Tekla License Administration Tool and Tekla License Borrow
Tool display an error message in the Activating Licenses(s), Deactivating
License(s), Borrowing License(s) or Returning Borrowed License(s) dialog
boxes, depending on the subject of the error.

* You can view more detailed information about an error by clicking the
View button in an error dialog box.

+ Tekla License Administration Tool and Tekla License Borrow Tool
automatically create zip packages of all necessary files required for
diagnosing the errors in the C:\Tekla\License\Server\Reports folder
and in the $TEMP%\Tekla License Borrow Tool\Reports folder. Click
Browse in the error dialog box to browse for the folder containing the
error report package. You can send the package to your local support to
get help.

The error report package contains the following files:
tekla debug.log - Tekla license server debug log file
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error.txt - error report, contains error information. The Tekla License
Borrow Tool zip package only contains this file.

tekla.opt - access rights options file

tekla.lic - Tekla license file

See also
Troubleshoot Tekla licensing (page 77)
Problems in Tekla licensing: Error codes and their descriptions (page 93)

Problems in Tekla license server installation and connecting to the
license server

&

License server installation fails, and the following message is displayed:
"A newer version of this application is already installed on this computer.
If you wish to install this version, please uninstall the newer version first.
Click OK to exit the wizard."

Reason: You have a newer version the license server installed.

Solution: You should not install an old version of the license server. Check the
latest available license server release on the Tekla Downloads product
download page.

The license server version is not dependent on Tekla Structures. However, if
you need to use an older version of the license server for some reason,
uninstall the newer version on your computer before installing the older
version.

5l
License server installation does not finish (no error message)

Reason: Another software using the FlexNet licensing system is running on
the computer.

Solution: Stop all licensing services in LMTOOLS, then install the Tekla license
server and restart the licensing services you stopped earlier:

1. Go to Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

2. Onthe Service/License File tab, ensure that Configuration using
services is selected, select a license service from the services list, go to
the Start/Stop/Reread tab and click Stop Server.

Do the same for all the services you need to stop.
3. Install the Tekla license server.

4. In LMTOOLS, start the licensing services you stopped earlier.
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&

Problem in license server connection. The following message is displayed:
"Error when connecting to the license server. Contact your system
administrator or try another server".

Reason: This problem is often related to firewall settings.

Solution: Check that your firewall allows the client to contact the license
server.

i

License library initialization failed with error: The licensing service is not
installed.

Reason: The error occurs when you are starting Tekla License Administration
Tool, or when you are trying to run serveractutil.exe command line tool.

Solution: If you selected the Manual option for Tekla Licensing Service
installation then you need to manually install FLEXnet licensing service:

1. If you have some other FlexNet licensing service running on the server,
stop it before entering the commands.

2. Go to the Start menu or Start screen, depending on your Windows
operating system, and open Command Prompt as an administrator.

3. Atthe command prompt, type the following commands:
cd /D full path to installation directory

For example, if you install Tekla license server to the default folder, you
need to enter cd /D C:\Tekla\License\Server.

installanchorservice.exe

i
Cannot connect to the license server.

Solution: For the first time that you connect to the Tekla license server a client
computer that has a new version of Tekla Structures installed, you need to do
the following:

* Ensure that both (the client computer and the license server) are in the
same domain.

* Ensure that Local Area Network connection is established. The license
server and the client computers need to be in the same Local Area
Network.

« Turn off the firewall and pause the antispyware/antivirus protection of your
computer.

After the steps above do the following on your company's license server:

1. Make sure that no one is using Tekla Structures (ask all users to close
Tekla Structures).
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2. GotocC:\Tekla\License\Server and openthe tekla.lic filein atext
editor.

3. Add a free TCP/IP port for the licensing service at the end of the first row,
if it does not exist by default. Note that the automatic installation option
sets the port by default to 27007.

Example of the first row: SERVER MYSERVER ANY 27007, where
MYSERVER is the license server and 27007 is the port.

Save and close the file after changes.

5. Go to Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

6. On the Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

7. On the Start/Stop/Reread tab, click Stop Server. Wait couple of seconds
and click on Start Server.

After defining the server and the port, do the following on your Tekla
Structures workstations:

1. Start Tekla Structures.

2. When you are asked for a server, add the port to the front of the server
definition and click OK.

Example: 27007@MYSERVER

&
Cannot start the Tekla licensing service.

Reason: The tekla-debug. log file may be locked, thus preventing the
service from starting.

Solution: Delete the tekla-debug. log and restart the computer.

See also
Problems in Tekla licensing: Error codes and their descriptions (page 93)
Installing Tekla license server (page 42)

Allowing Tekla license server to operate through Windows Firewall (page 51)

Problems in FlexNet

&,
An internal error occurred. FlexNet internal error.

Reason: There is a problem with the Tekla license server installation.

Solution: This error can often be fixed by performing the steps below:
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1. Uninstall all existing Tekla license server installations.

2. Check that all the files are deleted from the Tekla license server

installation folder: .. \Tekla\License\Server.

3. Install the latest Tekla license server. Check for the latest version in Tekla
Downloads.

See also

Installing Tekla license server (page 42)
Uninstall Tekla Structures (page 377)

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Problems in Tekla license activation

&
The following message is displayed: "Error reading entitlement file".

Reason: The .NET Framework is not working for some reason.

Solution: Reinstall the existing .NET Framework, or install the latest .NET
Framework version that is available for your operating system.

&

License activation fails, and the following message is displayed: "Unable
to activate more licenses than you are entitled to".

Reason: There are a couple of possible reasons for the problem:

* You may have activated licenses on another computer. You cannot activate
more licenses than you are entitled to.

* You tried to activate a renewed temporary license or a permanent license
without deactivating the previous temporary license.

Solution: There are two possible solutions:

+ Deactivate a license on another computer and then activate the license on
your computer.

+ Deactivate the existing temporary license and then activate the succeeding
linked license.

For more information about deactivating licenses, see Deactivate Tekla
licenses (page 67).

&

The amount of activated licenses in Tekla License Administration Tool
and LMTOOLS does not match.
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Activated Licenses
Deactivate Trust Status Enabled | Quantity | Borrowed Configuratii
E [ HITTR @ |2 0 Viewer

LMTQOOLS by Acresso Software Inc,
File Edit Mode Help

ServicedLicenze File | System Settings | Ltilities | Sthit/Stop/Feread  Server Status

Helpz to monitar the status of network, icensing actsities ]
Optionz

Individual D aemon

Perform Statuz Enguing Individual Faature

Server Mame

tekla: UP wll. 4
Faarure Wwiays info:

Users of TeklaServer: (Tetal of 1 .l:ictnl:e‘:sued.; Total of O licenses 5

Uzers of VIE-C: [ [Total of 1 license issued; IIOI:n]. of O liconses im use)

|L|$ing Licenge File: C:ATeklaStructures\Licenze\Serveritekla lic

Reason: The licensing service is not updated with new license information.
Solution 1: Reread the license file in LMTOOLS:

1. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

2. On the Start/Stop/Reread tab, click ReRead License File.

Solution 2: If you are connected to several license servers, rereading the
license file may not work. In that case, you need to stop the license server and
then restart it in LMTOOLS:

1. Ensure that no one is using Tekla license server.

2. Onthe Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

3. On the Start/Stop/Reread tab in LMTOOLS, select the Force Server
Shutdown check box and click Stop Server.

Check that the status is "Stopping server". Wait for a few minutes.
5. Click Start Server, and ensure that "Server Start Successful" is displayed.
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TIP To avoid the problem in the future, ensure that the license server is
automatically notified when you activate, deactivate, or repair licenses.

To enable the automatic notification functionality in Tekla License
Administration Tool, click the Notify Server button.

For more information about starting and stopping server and rereading
the license file, see .

For more information about activating licenses, see Activate Tekla
licenses (page 62).

&

No warning is displayed, even though the temporary license will expire
within one month.

Reason: The expiry warning message appears only when someone uses the
expiring license. Probably there are several permanent licenses (that have
been activated first) and some temporary licenses that have been activated
after the permanent ones.

When somebody starts Tekla Structures, the system uses licenses in the order
of activation. For example, if you have 10 permanent and 2 temporary
licenses, all 10 licenses must be in use before someone obtains the temporary
license, and receives the warning about the expiring license.

i

When you try to open the entitlement certificate in Tekla License
Administration Tool, nothing is shown.

Reason 1: You have not downloaded the attached entitlement certificate from
your e-mail application, but opened the certificate in an Internet browser and
saved it as an .html file from the browser.

Solution: Open the e-mail containing the entitlement certificate attachment
EntitlementCertificate.html. Download the entitlement certificate to
the . .\Tekla\License\Server folder from e-mail. Then try to open it again
in Tekla License Administration Tool by clicking Open.

For more information, see Activate Tekla licenses (page 62).

Reason 2: The virus protection system of your computer has removed the
Trimble Solutions logo from the license entitlement certificate.

Solution: The sender of the entitlement certificate should zip the entitlement
certificate file. Unzip the entitlement certificate file on the computer where the
licenses are going to be activated.

i

License was activated successfully, but the following error message is
displayed when you run the command line command “serveractutil -
view": "Activation library initialization failed."
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Reason: The license server installation was not successful.
Solution: Do the following:
1. Stop other FlexNet licensing services in LMTOOLS.

2. Runthe installanchorservice.exe atthe command prompt, restart
the license server.

After doing this you will be able to activate your licenses and use Tekla
Structures.

If the above did not work, you need to uninstall the license server and reinstall
the recent version once again with administrator rights.

For more information about uninstalling and installing the license server, see
Uninstall Tekla Structures (page 377) and Installing Tekla license server
(page 42).

&

The automatic notification functionality in Tekla License Administration
Tool does not work: nothing happens when you click the Notify Server
button

Reason: One of the reasons why the Notify Server button does not work in
Tekla License Administration Tool might be that Tekla Licensing Service is not
started on the computer.

Solution: To solve the issue, open Windows Control Panel --> Administrative
Tools --> Services . Ensure that the Tekla Licensing Service status is Running .
The Startup Type of the service should be set either to Automatic or to
Automatic (Delayed Start).

A

Your licenses no longer appear as activated licenses, or old version
licenses are activated, but they do not work.

Reason: Windows system restore may cause problems for licensing. For more
information, see Windows system restore might affect your model and
licensing.

Useful links

For more information about the status of the activated licenses in the trusted
storage, see instructions in the following Support Articles in Tekla User
Assistance:

Checking the status of the activated licenses in the trusted storage

Checking the status of the activated licenses in the trusted storage (including
borrowing info)

See also

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Manage licenses 85 Maintain Tekla licenses


http://teklastructures.support.tekla.com/en/support-articles/windows-system-restore-might-affect-your-model-and-licensing
http://teklastructures.support.tekla.com/en/support-articles/windows-system-restore-might-affect-your-model-and-licensing
http://teklastructures.support.tekla.com/en/support-articles/checking-status-activated-licenses-trusted-storage
http://teklastructures.support.tekla.com/en/support-articles/checking-status-activated-licenses-trusted-storage-including-borrowing-info
http://teklastructures.support.tekla.com/en/support-articles/checking-status-activated-licenses-trusted-storage-including-borrowing-info

Problems in Tekla license deactivation

B
Unable to select a license for deactivation.

Activated Licenses

Deactivate Trust Status Enabled Quantity| Borrowed | Configuration Version Expiration Date Type  ActivationID OrderID
b [H]T IR ] e 2018 |15.11.2018 I IB73-AZEC Tekla HQ

Reason: You cannot select a license for deactivation if the license is still
borrowed.

Solution: Return the license and then deactivate the license.

See also
Problems in Tekla licensing: Error codes and their descriptions (page 93)

Deactivate Tekla licenses (page 67)

Problems in Tekla license borrowing

&
Unable to select a date from the calendar in the Borrow Until box.
Reason: The maximum borrowing period is one month.

Solution: In Tekla License Borrow Tool, select a date that is within one month
from the date of borrowing:

1. Goto Tekla License Borrow --> Tekla License Borrow Tool through the
Start menu or Start screen, depending on your Windows operating
system.

2. Inthe Products area, click the Borrow Until box and select from the
calendar the expiration date that is within one month from the date of
borrowing.

&,
Tekla Structures does not start up with the borrowed license.
Problem: You borrowed a license and disconnected from the network. When

you open Tekla Structures, the licensing dialog box is displayed, but Tekla
Structures does not find the borrowed license.

Solution: If Tekla Structures does not start up with the borrowed license,
please type only an asterisk character (*) into the server box in the licensing
dialog box.

This will force Tekla Structures to search for all possible locations for the
license. It might take some time until it finds the license.
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&

The computer that is running a borrowed license crashed, what should |
do?

Solution: If your computer only needs rebooting, you can use the borrowed
license again after rebooting. If your computer completely breaks down, the
license will automatically be available on the license server when the
borrowing period expires.

See also
Problems in Tekla licensing: Error codes and their descriptions (page 93)

Set up license borrowing for offline use (page 100)

Problems in Tekla license trusted storage

B
A license cannot be used.

Trust Status

H U

Reason: The Host (H) trust status of your license is not trusted. Hardware
setup of your server computer has changed radically.

Solution: The licenses with the untrusted H trust status cannot be repaired.
Contact your local support.

We recommend that you run your license server on a proper server computer
that is regularly maintained. You need to deactivate your licenses before
performing any maintenance actions on your server computer. However,
unnecessary deactivations should be avoided due to technical and security
reasons.

For more information, see Repair a license (page 76).

&
A license cannot be used.
Trust Status
W
Reason: The Time (T) trust status of your license is not trusted. Time settings
of your server computer have changed radically.

Solution: You need to set the correct system date and time and after that
repair the license in Tekla License Administration Tool.

Do not manipulate system clock settings of the server computer that has
activated licenses.

For more information, see Repair a license (page 76).
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&
A license cannot be used.
Trust Status
W R
Reason: The Restore (R) trust status of your license is not trusted. Your
backup system may have overwritten some licensing information.
Solution: You need to repair the license in Tekla License Administration Tool.

We recommend that you configure your system backup settings so that the
existing licensing software, tools and files are not automatically overwritten or
replaced with the restored ones.

For more information, see Repair a license (page 76).

See also
Problems in Tekla licensing: Error codes and their descriptions (page 93)

Repair a license (page 76)

Problems using LMTOOLS in Tekla licensing

Fi
LMTOOLS does not reread the license file.

Reason: Rereading the license file does not work if you are running a licensing
service locally on your computer and you are connected to another license
server at the same time.

Solution: You need to stop and restart the licensing service. Do the following:

1. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

2. Onthe Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

3. Onthe Start/Stop/Reread tab, click Stop Server and wait a few seconds
for the service to stop.

4. Click Start Server.

A

LMTOOLS is unable to stop the license server, and the message "Unable
to Stop Server" is displayed in the LMTOOLS message bar.

Reason: You may have selected an incorrect licensing service.

Solution: You need to select Tekla Licensing Service as the licensing service.
Do the following:
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1. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

2. On the Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

3. Go to the Start/Stop/Reread tab, and click Stop Server.

If this does not help, select the Force Server Shutdown check box and
click Stop Server again.

&
LMTOOLS is unable to stop the license server.
Reason: You did not run LMTOOLS with administrator rights.

Solution: Run LMTOOLS with administrator rights. For more information, see
Rights needed for performing administrator's tasks in Tekla Structures
licensing (page 35).

A

Starting or stopping the server or rereading the license file cannot be
performed, and the message "No Server Selected" is displayed.

Reason: You have not selected the licensing service.

Solution: You need to select Tekla Licensing Service as the licensing service.
Do the following:

1. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

2. Onthe Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

3. Goto the Start/Stop/Reread tab and start or stop the server or reread
the license file.

i)
Starting or stopping the server or rereading the license file is not
possible.

The status list in LMTOOLS indicates that the license server manager (Imgrd)
has not been started: "Error getting status: Cannot connect to license server
system. The license server manager (Imgrd) has not been started yet, the
wrong port@hostname or license file is being used, or the port or hostname in
the license file has been changed".

Reason: LMTOOLS points to the wrong Imgrd.exe.
Solution: You need to modify the settings in LMTOOLS. Do the following:

1. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.
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2. Onthe Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

3. Go to the Config Services tab, and click Browse to locate the 1mgrd.exe
file.

By default, the file is installed in the . . \Tekla\License\Server folder.
Click Save Service.

Go to the Start/Stop/Reread tab and click Stop Server.

Click Start Server to restart the server.

The changes are applied.

&
LMTOOLS does not show the licensing service status.

The status list on the Server status tab in LMTOOLS indicates that the license
file cannot be found: "Error getting status: Cannot find license file. The license
files (or license server system network addresses) attempted are listed below.
Use LM_LICENSE_FILE to use a different license file, or contact your software
provider for a license file".

Reason: You are trying to perform a status enquiry of a licensing service that
is not running.

Solution: You need to start Tekla Licensing Service. Do the following:

1. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

2. Onthe Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

3. Goto the Start/Stop/Reread tab and click Start Server.
4. Go to the Server Status tab and click Perform Status Enquiry again.

See also
Install Tekla license server - manual installation (page 45)
Configure Tekla license server manually (page 49)

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Problems in starting Tekla Structures

% Tekla Structures does not start. The following message is displayed:
"Error when connecting to the license server. Contact your system
administrator or try another server".

Reason: You are not connected to the license server.
Solution: Check the following:
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* Check that your network connection is working.
+ Check that you have entered the license server name correctly.

For more information, see Preconfigure license server settings for users
(page 66).

* Check that license information in LMTOOLS is correct. If not, reread the
license file in LMTOOLS and try to start Tekla Structures again.

For more information about LMTOOLS, see .

&

Tekla Structures does not start. The following message is displayed:
"License server system does not support this feature".

Reason: Your license server may not be up to date.
Solution: Update the status of your license server. Do the following:

1. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system. Start LMTOOLS
using administrator rights.

2. Onthe Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

3. On the Start/Stop/Reread tab, click Stop Server and wait a couple of
seconds.

4. Click Start Server.
5. Start Tekla Structures.

If the problem still persists, contact your local Tekla Structures support. The
support will need a copy of the following files: tekla.lic, tekla.opt, and
tekla debug.log files.

&

Tekla Structures does not start occasionally.
The following message is displayed: "Cannot connect to license server system.
The license server manager (Imgrd) has not been started, the wrong

port@host or license file is being used, or the port and hostname in the license
file has been changed".

Reason: There may be communication problems between your license server
and Tekla Structures client computers if the port of the license server is not
defined.

Solution: Define the port for the license server. Do the following:

1. Goto Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

2. Onthe Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.
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On the license server computer, define a free port for the license server in
the tekla.1lic file. For more information, see Modify the license file
tekla.lic manually (page 48).

Go to the Start/Stop/Reread tab and stop the license server by clicking
Stop Server.

Click Start Server.
Start Tekla Structures on a client computer.

In Tekla Structures, click Tools --> Change License Server . Define the
port and hostname of the license server.

Close Tekla Structures.
Repeat steps 5 to 7 on all Tekla Structures client computers.

See also

Preconfigure license server settings for users (page 66)

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Problems with options file tekla.opt

A

The tekla.opt file does not take effect.

Reason: The licensing service has not read the options file.

Solution: Do the following:

1.

Go to Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

On the Service/License File tab, ensure that Configuration using
services and Tekla Licensing Service are selected.

On the Start/Stop/Reread tab, click ReRead License File.

Browse to the . .\Tekla\License\Server folder and open the
tekla debug.log file and the tekla.opt file with a text editor.

Check that the tekla debug.log file contains the same keyword strings
as the tekla.opt file.

If this does not help, please contact your local support.
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Q’ C\TeklaStructurest\License\Server\tekla.opt - Notepad++ EI@

File Edit Search View Encoding Language Settings Macro Run  Plugins  Window 7 X
e s Bl 2ciny < | BEEIEECEHCENEGE E
B tekla_debug log = tekla opt t3|
1 [ INCLUDE VIE-C USER pahal

Q’ Ch\TeklaStructures\License\Server\tekla_debug.log - Notepad++ EI@
File Edit Search View Encoding Language Settings Macro Run  Plugins  Window 7 X
o = OO@' |5") |ﬂi;ﬁi'|‘§'3|-'l.cl.| ‘—JB“EHEIEIE—E”@
= tekla_debug log t3|EJtakIa.-:-|:-t |
1 20:49:14 (Imgrd) Started tekla (pid 1364)
2 20:49:14 (tekla) Flexnet Licensing version v11.4.100.0 build 50818 _n3
3 20:49:14 (tekla) Using options file "C:\TeklaStructures\License\Serverhtekla.opt™
4 20:49:44 (tekla) Server started on localhost for: TeklaServer
5 20:49:44 (tekla) EXTERNAL FILTERS ARE CFF
& 20:50:12 (lmgrd) tekla using TCP-port 1074
7 21:59:38 (tekla) TCP_NODELAY NOT enabled
8 22:05:30 (lmgrd) Rereading license file... Requested for pahal2-paha
g 22:05:30 (tekla) Rereading license file...
1 22:05:30 (lmgrd) Done rereading
11 22:05:30 (lmgrd) ...Finished rereading
1 22:05:31 (tekla) Server started on localhost for: TeklaServer
13 22:05:31 (tekla) VIE-C
14 22:05:31 (tekla) 3r r
15 22:05:31 (tekla) [Rereading options file...
16 22:05:31 (tekla) [INCLUDE USER paha VIE-C
17 22:05:31 (tekla) |...Finished rereading
See also

Modify Tekla license access rights (tekla.opt) (page 71)
Problems in Tekla licensing: Error codes and their descriptions (page 93)

Problems in Tekla licensing: Error codes and their descriptions

Error 6

Problem: License library initialization failed with error: Activation Library
Initialization error #6. Please, contact software vendor to resolve the
problem.

Reason: Tekla license server installation folder contains .d11 files that are
from the previous Tekla license server version.

Solution: To resolve the problem, do the following:

1. Close Tekla License Administration Tool and stop the Tekla license server
in LMTOOLS by clicking Stop Server on the Start/Stop/Reread tab.

Uninstall all existing Tekla license server installations.

If the Tekla license server installation folder contains any .d11 files,
remove the files manually.

4. Now you can install Tekla license server to the same folder where the
uninstalled version was.
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For more information about license server installation, see Installing Tekla
license server (page 42).

NOTE Deactivation is not needed in this case. Licenses are kept safe in a
specific Flexera Software location outside Tekla license server
installation directory.

Error 20
Problem: Error 20: The licensing service is not installed.

Reason: The error occurs when you are starting Tekla License Administration
Tool, or when you are trying to run serveractutil.exe command line tool.

Solution: If you selected the Manual option for Tekla Licensing Service
installation then you need to manually install FLEXnet licensing service:

1. If you have some other FlexNet licensing service running on the server,
stop it before entering the commands.

2. Go to the Start menu or Start screen, depending on your Windows
operating system, and open Command Prompt as an administrator.

3. Atthe command prompt, type the following commands:
cd /D full path to installation directory

For example, if you install Tekla license server to the default folder, you
need to enter cd /D C:\Tekla\License\Server.

installanchorservice.exe

Error 109

Problem: There are no activated licenses to return. Another program
may have modified the activated licenses rights concurrently. (109)
Unable to return as there is no licenses in Trusted Storage.

Reason: The trusted storage has been modified, probably by some other
program.

Trust Status

W " The red Restore (R) trust status of your license is not trusted. The
license is broken, therefore it cannot be returned.

Solution: The license will become available on the server machine
automatically when the borrow period ends.

Error 123 or error 50030

Problem: Message 1: Row n: An error occurred but FLEXnet Licensing did
not return an error number. (123)

Message 2: Failed to load trusted storage or specified ASR. (50030)
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Reason: These error messages indicate that the trusted storage cannot be
loaded, and your trusted storage is corrupted.

Solution: Your licenses need to be replaced. Contact your local Tekla
representative for a replacement along with some instructions.
Error 1316

Problem: License server installation fails.

The following message is displayed: "A network error occurred while
attempting to read from the file C: \Documents and Settings\<user>
\Local Settings\Application Data\Downloaded Installations
\...\Tekla Structures License Server v1.01l.msi".

Reason: You have an older version of the license server installed.

Solution: Uninstall the old version and then install the new version of the
license server.

For more information about uninstalling the server, see Uninstall Tekla
Structures (page 377).
Error 7174

License activation fails, and the following message is displayed:
"Unspecified FLEXnet Error with code 7174 Only deployed entitlement
line item can be fulfilled.”

Reason: You are trying to activate an obsolete license.

Solution: You should have received a new entitlement certificate from your
local Tekla representative. Try the activation again with the new entitlement
certificate, and move the old obsolete entitlement certificate in an archive
folder.

For more information, see Activate Tekla licenses (page 62).

Error 7284

Problem: Unspecified FLEXnet Error with code 7284. Cannot perform
support actions on inactive fulfillment record
FID OO0 XXXXXXXXXXX_ XXXX.

Reason: Trusted Storage has been restored from an old backup copy. The
license with fulfillment ID FID_ XXXXXXXX_XXXXXXXXXXX__XXXX has been
deactivated already.

Solution: You need to restore trusted storage files from the most recent
backup copy and then repair licenses if needed.

For more information about repairing licenses, see Repair a license (page 76).

Error 7288 and error 111

Message 1: The activation of the fulfillment is denied by the activation
policy because fulfill count exceeded the available seat count.
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Message 2: The activation of the fulfillment is denied by the activation
policy because number of copies left is zero.

Reason 1: You may be trying to activate some licenses that have been
activated before on another server/computer.

Solution: Deactivate the licenses from the other computer, and then activate
the licenses on the new server/computer.

Reason 2: You may be trying to activate a renewed temporary license or
permanent licenses without deactivating the previous linked activated
licenses.

Solution: Deactivate the existing temporary licenses first and then activate the
succeeding linked licenses.

For more information about deactivating licenses, see Deactivate Tekla
licenses (page 67).

Error 7343

Problem: Unspecified FLEXnet Error with code 7343 Entitlement line item
has expired on <date> <time>.

Reason: License has expired. It is not possible to activate or repair expired
licenses.

Error 7466

Problem: License deactivation fails, and the following message is
displayed: "The return of the fulfillment is denied by the return policy
because max return exceeded".

Reason: You have deactivated the license too many times in a 30 days period.

Solution: You can deactivate the license again when 30 days have passed
since the first deactivation of the license in the past 30 days. The number of
deactivations of a license within a given time period is limited due to technical
and security reasons.

Error 7581

Problem: Unspecified FLEXnet Error with code 7581. Online Return/Repair
Request for the activationld XXXX-XXXX-XXXX-XXXX-XXXX-XX is not
originated from the original client machine.

Reason and solution: The computer is not the same where the licenses were
originally activated, and you need to return/repair licenses from the original
computer. Another reason might be that the computer has changed so much
that activation server at Trimble Solutions no longer recognizes it as the same
one, in which case you need to replace your licenses.

For more information about returning and repairing licenses, see Returning a
borrowed license (page 105) and Repair a license (page 76).
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Error 9999

Problem, reason and solution:: Licensing server at Trimble Solutions is
down. Wait for a while and retry.

Error 50005

Problem: Error (5005) License Activation failed - Initialization of API
Failed.

Problem: The activated licenses are not visible and it is not possible to activate
new licenses.

Reason: The installation package has failed to initialize or register some of the
software components.

Solution: Do the following:
1. Log in with administrator's rights.
2. Close Tekla License Administration Tool.

3. Stop Tekla license server and other license servers on the same computer
on the LMTOOLS --> Start/Stop/Reread tab.

4, Goto..\Tekla\License\Server folder.
5. Double-click installanchorservice.exe.

6. Start Tekla license server and other license servers on the same computer
on the LMTOOLS --> Start/Stop/Reread tab.

7. Open Tekla License Administration Tool. The message should not be
displayed anymore.

Error 50018

Problem: License borrowing fails.

Reason: Wrong product ID file is used.

Solution: Do one of the following:

+ Export a product ID file in Tekla License Administration Tool and use the
file for borrowing.

Error 50033

Problem: License borrowing fails.

Reason 1: Your license server may not have up-to-date license information.

Solution: In LMTOOLS, stop and then restart the server.

Reason 2: The INCLUDE keyword in the options file prevents the borrowing of
the configuration.

Solution: You need to add a dummy user "ACTIVATED LICENSE(S)" into the
group of the included users to enable the borrowing. Do the following:

1. Open tekla.opt using a text editor.
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2. Add "ACTIVATED LICENSE (S)"inthe group of the included users, for
example:

GROUP steel "ACTIVATED LICENSE(S)" userl user?2 user3
user4

INCLUDE STD-C GROUP steel

3. Save the changes you made in tekla.opt.

4. In LMTOOLS, reread the license file or stop the server and then start the
server.

Error 50035

Problem: License borrowing fails.

Reason: The user tried to borrow a license that is not activated on the license
server. For example, the user tried to borrow a version 20 license and there
are only version 21 licenses activated on the server.

Solution: Do the following:

* Check that the product ID file is up to date. If not, export a new product ID
file in Tekla License Administration Tool ( File --> Export ) and send this file
to the user for borrowing. Then ask the user to save the new product ID
file, open the Tekla License Borrow Tool, click Open and browse for the
new . tpi file and try borrowing again.

+ Check that your license information is up to date in LMTOOLS. If not,
reread the license file.

Error 50036

Problem: License borrowing fails.

Reason: You are not allowed to borrow the license.
Solution: Do one of the following:

* The options file (tekla.opt) needs to be modified so that the borrowing
of the license is allowed. For more information, see Modify Tekla license
access rights (tekla.opt) (page 71).

* Borrow another license.

Error 50037
Problem: License returning fails.

Reason: You tried to return the license to a different license server than it was
borrowed from.

Solution: You need to return the license to the same license server that it was
borrowed from. Do the following:

1. Goto Tekla License Borrow --> Tekla License Borrow Tool through the
Start menu or Start screen, depending on your Windows operating
system.
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Click Setup and enter the name of the license server where you originally
borrowed the license from and click OK.

Select the Return check box in the Borrowed Licenses area to select the
license for returning.

Click the Return button to return the license.

After successful returning of licenses, the Borrowed Licenses area is
updated.

Error 50040 or error 50041

Error 50040 or error 50041, problem 1: License activation, deactivation or
repairing fails

Reason: Your license server was not able to connect to activation server at
Trimble Solutions correctly. Usually this is a temporary problem in online
activation.

Solution: Do the following:

Check that your Internet connection is working. An Internet connection is
needed during license activation and deactivation. A low connection speed
may also cause errors.

Close Tekla License Administration Tool and try to activate the license a
while later.

Try to activate another license.

Your firewall may block the activation communication. Check your firewall
settings. For more information, see Allowing Tekla license server to operate
through Windows Firewall (page 51).

Check that you have the latest Tekla license server version.

This error could be caused by unfinalized Windows updates on the server
computer. Reboot the server and try again.

Your Windows login user name may contain special characters. Try to log in
with another user name, for example, administrator.

Check that your Internet connection is working.

Contact your local Tekla Structures support and ask for a manual
activation.

Error 50040 or error 50041, problem 2: License borrowing fails.

Reason: You are not connected to the license server.

Solution: Do the following:

Check that your network connection is working.

Start Tekla License Borrow Tool and check that you have entered the
correct license server information.
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3.8

See also

View and diagnose errors in Tekla Structures license activation, deactivation
and borrowing (page 78)

Problems in Tekla license activation (page 82)
Problems in Tekla license borrowing (page 86)

Problems in Tekla license deactivation (page 86)

Set up license borrowing for offline use

Users who want to work in a location that does not have a reliable connection
to the license server can borrow an activated license from the Tekla license
server before leaving the office. The user receives a temporary local license file
valid for a set time period.

Users can borrow Tekla Structures licenses for offline use in Tekla License
Borrow Tool. Users need to have a network connection to the license server to
borrow and return a license.

Borrowed licenses are reserved for the duration of the borrowing even when
they are not in use, so the borrowed license is not available for other users.

Configuration files

A product ID (. tpi) file is needed for borrowing licenses. If you use the
licensing options file (tekla.opt) for managing license access rights, you
must always provide a customized product ID file for users. The default file
that lists all configurations will technically work in other cases, but
administrators should still provide a customized product ID file. The
customized file makes it easier for the users to select a license, because it
includes just those licenses that you have actually activated on the server. For
more information, see Provide offline users with a customized product ID file
(page 101).

You can define which licenses are available for which users in the licensing
options file (tekla.opt) on the license server. For more information, see
Modify Tekla license access rights (tekla.opt) (page 71).

How license borrowing works

License borrowing reserves and releases the licenses like this:

«  The maximum license borrow period is one month. The user defines the
borrow expiration date when borrowing the license. The borrowed licenses
are unavailable to other users until they are returned or the license borrow
period ends.

+ The user can return a license before the license borrow period is over
through the license borrow tool on the borrowing computer. Make sure
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your users return all borrowed licenses before a major operating system
upgrade, reinstallation or major hardware changes on their computer.

+ Borrowed licenses must be returned before you deactivate those licenses
on the license server, for example, to upgrade the licenses to a new version
or to move the license server to new hardware. You can see who has
borrowed which licenses by enquiring the license status in the LMTOOLS
application on the license server.

NOTE If you do not follow the guidelines above, all users may lose the use of
the borrowed licenses until the end of the license borrowing period,
including the users who originally borrowed the licenses.

1. Install the Tekla License Borrow Tool on the users' computers with
customized product ID file(s).

2. To borrow a license, users must open the Tekla License Borrow Tool
installed on their computer when they are still online and can connect to
the Tekla license server.

The version of Tekla License Borrow Tool should be the same as the
version of Tekla license server.

3. After borrowing a license, users can go offline and freely work with, close
and reopen Tekla Structures within the license borrow period.

4. When the users are back online, they should return the borrowed licenses
to the license server.

If a user does not return the license, it becomes available for other users
on the license server after the license borrow time is over. However, the
license is still listed in the license borrow tool for the user until the user
returns it.

For detailed instructions, see Set up Tekla License Borrow Tool for Tekla
Structures offline use (page 102).

For end-user instructions, see Borrow a license from Tekla license server
(page 104) and Return a borrowed Tekla license (page 105).

See also
Problems in Tekla license borrowing (page 86)

Problems in Tekla licensing: Error codes and their descriptions (page 93)

Provide offline users with a customized product ID file
Tekla License Borrow Tool needs the activation IDs of the licenses during
borrowing. When you export a product ID file (. tpi) in Tekla License
Administration Tool, the activation IDs of the activated licenses are written in
the file. Then you can send the file to offline users.
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When you install Tekla License Borrow Tool, the standard. tpi file is
automatically installed in the . .\Tekla\License\Borrow folder. This default
product ID file lists all Tekla Structures configurations and their product IDs.
However, users can only borrow the licenses that are activated on the license
server.

You can create a customized product ID file that only lists the activation IDs of
the activated licenses available for borrowing. You need to export the product
ID file on the license server computer using Tekla License Administration Tool
and save the file on the computers of the users who borrow licenses. The
activation IDs are encrypted.

WARNING Product ID files are not updated automatically. If you deactivate
borrowable licenses or activate new licenses for borrowing, you
need to export a new product ID file and send it to Tekla
Structures offline users who borrow licenses.

To export the product ID file on the Tekla license server computer:

1. Goto Tekla Licensing --> Tekla License Administration Tool through
the Start menu or Start screen, depending on your Windows operating
system.

2. Click Export.

3. Inthe Save Product ID file As dialog box, enter the name of the product
ID file or keep the default file name, select a folder where you want to
save the file and click Save.

4. Send the product ID file to the Tekla Structures users who need to borrow
licenses and inform the users about the usage of the file.

If the name of the file is standard. tpi and the file is saved in
the . .\Tekla\License\Borrow folder on the user's computer, the file is
opened automatically when the user starts Tekla License Borrow Tool.

See also
Set up Tekla License Borrow Tool for Tekla Structures offline use (page 102)

Set up Tekla License Borrow Tool for Tekla Structures
offline use

You can use Tekla Structures offline by borrowing Tekla licenses with Tekla
License Borrow Tool.
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Before you start, download and install the latest Tekla License Borrow Tool
from the Tekla Downloads product download page.

You can use the same Tekla License Borrow Tool for borrowing licenses for
different Tekla Structures versions. The version of Tekla License Borrow Tool
should be the same as the version of Tekla license server.

To set up Tekla License Borrow Tool for Tekla Structures offline use:

1. Goto Tekla License Borrow --> Tekla License Borrow Tool through the
Start menu or Start screen, depending on your Windows operating
system.

2. Inthe Setup dialog box, enter the port number and the hostname
(computer name) of the license server in the Server box in the format
port@hostname, for example, 27007@server hostname.

3. Stillin the Setup dialog box, click Browse and select the product ID file.
Click OK.

The Products area in the Tekla License Borrow Tool is updated.

g Tekla License Borrow Tool [27001 @Server]

0 Setup Bormow Return w Language.. ™ “ Help *
Product ID file path:  D\prodistructuresisncilicense-borrow-toolbin\x86\Release\standard.tpi Lastupdate 21,12.201810:37 |':J Refresh |
Products

Borrow Until  Configuration Wersion Activation ID In Use

CaonstructionMaodeling 2018
Developer 2018
Drafter 2018
Engineering 2018
Ful 20&
FullEducational 2018
PrecastConcreteDetailing 2018
Primary 2018
ProductionPlannerConcrete 2018
RebarDetailing 2018
SteelDetailing 2018
ErojectViewer 2018

Borrowed Licenses

Return  Trust Status Enabled Configuration Version Borrow Until Port Borrowed From

5. Inthe Tekla License Borrow Tool dialog box, click Language and change
the language of the Tekla License Borrow Tool user interface, if necessary.

NOTE When you start Tekla Structures, and if Tekla Structures does not start with
the borrowed license, enter an asterisk (*) in the server box of the licensing
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dialog box. This will force Tekla Structures to search for all possible locations
for the license. This may take a while.

See also

Problems in Tekla license borrowing (page 86)

Borrow a license from Tekla license server

In Tekla License Borrow Tool, you can borrow licenses from Tekla license
server when you want to work offline. Borrow the license on the same
computer that you will use for offline work.

Before you can borrow a license, you need to install Tekla License Borrow
Tool, connect the computer with Tekla Structures to the license server and
open the product ID file.

For more information about the prerequisites, see Set up Tekla License
Borrow Tool for Tekla Structures offline use (page 102).

To borrow a license:
1. Close Tekla Structures.

2. Goto Tekla License Borrow --> Tekla License Borrow Tool through the
Start menu or Start screen, depending on your Windows operating
system.

3. Click the Setup button at the top of the dialog box.

In the Setup dialog box, enter the port number and the hostname
(computer name) of the license server in the Server box in the format
port@hostname, for example, 27007@server hostname.

You need to use exactly the same port and host name as when starting
Tekla Structures.

Still in the Setup dialog box, click Browse and select the product ID file.
6. Click OK.

In the Products area, click the Borrow Until box and select the expiration
date for the borrowing period from the calendar.

The maximum borrowing period is one month. The exact maximum
borrow period varies between 29 to 32 days depending on the borrowing

date.

Products

Barrow Until Configuration  Version Activation ID In Use Start Date Expiration Date
[15.11.2018 ||Stee|Deta|'|ing 2018 @ 1112018 30.11.2018

8. Click the Borrow button to borrow the license.
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The borrowing progress is displayed in the Borrowing License(s) dialog
box. After successful borrowing, the Borrowed Licenses area shows the
borrowed license.

Borrowed Licenses

Return  Trust Status Enabled  Configuration Version Borrow Until  Borrowed From

[HIT AR o SteelDetailing | 2018 15.11.2018  Z-USERX

9. To ensure that the borrowing succeeded, disconnect your computer from
the license server and start Tekla Structures with the borrowed license.

See also
Problems in Tekla license borrowing (page 86)
Problems in Tekla licensing: Error codes and their descriptions (page 93)

View and diagnose errors in Tekla Structures license activation, deactivation
and borrowing (page 78)

Set up license borrowing for offline use (page 100)

Return a borrowed Tekla license

You can return a borrowed license back to the Tekla license server before the
expiration date.

A borrowed license is automatically available on the license server on the day
following the expiration date.

However, the Borrowed Licenses area in Tekla License Borrow Tool is not
automatically updated. The license should be returned to the server that has
the same name as the name of the server from which the license was
borrowed. We recommend that you always return the expired licenses when
you want to stop borrowing a license.

To return a borrowed Tekla license:
1. Ensure that you are connected to the license server.
2. Close Tekla Structures.

3. Goto Tekla License Borrow --> Tekla License Borrow Tool through the
Start menu or Start screen, depending on your Windows operating
system.

4. Select the Return check box in the Borrowed Licenses area to select the
license for returning.

5. Click the Return button to return the license.

After successful returning of licenses, the Borrowed Licenses area is
updated.
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See also

Problems in Tekla licensing: Error codes and their descriptions (page 93)
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4 Create and distribute
customized configurations

To create your customized Tekla Structures configurations and use them in
different projects and on different computers:

+ Get familiar with the different configuration files and some basic ways to
change how Tekla Structures works, see Implementation guide for
administrators (page 107).

* You can use Trimble's default settings as well as create your company's
general settings and project-specific settings, see Environment, company,
and project settings for administrators (page 119).

Many of the configurations you distribute are closely linked to working in Tekla
Structures and you find the instructions related to the configuration files you
can distribute as part of the documentation of each feature. Additionally, you
can find some general configuration tasks in this section:

* You can distribute customized ribbons (page 125), tabs (page 127),
property pane layouts (page 129), and toolbars (page 130).

* You can customize the catalogs of materials (page 131), profiles (page 139),
shapes (page 202), bolts (page 210), reinforcement (page 227), and
applications and components.

4.1 Implementation guide for administrators

Tekla Structures administrator is the person responsible for ensuring that the
company standards are used and set up in Tekla Structures. The following
sections explain how you can customize Tekla Structures.
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Customizing Tekla Structures

Each new version of Tekla Structures introduces new features and
functionalities to improve the overall process used for completing a project.
Tekla Structures has multiple environments to suit the needs and
requirements of specific markets. Many features are localized in each Tekla
Structures version. Most of the changes in versions are focused on making the
default saved attributes more consistent, organized, simplified, and practical.

Your local technical team is dedicated to improving your knowledge and
experience of each new version. The team aims at enhancing your user
experience of Tekla Structures by performing tasks that have been identified
as essential by the existing users, new users, and potential users.

Before you start customizing Tekla Structures to suit the needs of your
company and your projects, collect the needed information, such as drawing
standards, used profiles, grades and materials, company logos, and naming
conventions.

The overall localization of Tekla Structures can be divided into four different
layers:

+ Tekla Structures environment

+ Company-level settings

* Project-level settings

*  Multi-user settings

The three last ones are mainly managed by company administrators.

Setting up the standard that a company uses, and the standards that a specific
project needs will make the designing process much more efficient because
the end user can concentrate on the design process.

Tekla Warehouse

Tekla Warehouse has a lot of additional content, such as application tools and
environment content. You can download Tekla Warehouse offline content that
includes the catalog content of environments, such as profiles, bolts,
materials, and reinforcement.

The offline catalog content is under Tekla Structures collections in Tekla
Warehouse. The content is in . tsep packages that are installed when opening
Tekla Structures.

You can also create a local collection for your company, and share it for your
organization in your internal network. You can manage the access rights on
the folder and collection level in the collections. json file on each user's
computer. Copy the file to the same location on each user's computer. The file
is located in C:\Users\Public\Public Documents\Trimble\Tekla
Warehouse\collections. json.

The image below shows an example of the collection paths with four Tekla
Structures collections:
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Overview of environments, roles and licenses

Tekla Structures is one product that has many different configurations. The
licenses you have determine which configurations you can use.

A Tekla Structures environment is set up for the materials, grades, profiles,
drawing settings, component settings, . ini file settings that are used in a
specific market. There are over 30 different environments in Tekla Structures.
By choosing a specific environment when starting Tekla Structures you will get
the settings for that market. You can install several environments, and add
missing environments later.

The blank project listed in the environments is an empty platform for your
own environment or project settings. It includes standard parametric profiles,
undefined bolt, material and rebar grades, basic drawing layouts and so on,
which you can complement from your own firm or project folders and Tekla
Warehouse.
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Tekla Structures >

Choose your Tekla Structures setup

Environment

UK A
Role
Engineer v

Configuration

Engineering v

Tekla
Structures

@ Trimble oK Cancel

Some environments give you the opportunity to select a role when logging in.
The role is independent from the licenses that are used. The purpose of the
roles is to make the user interface and settings clearer, easier and faster for
the user's tasks.

In practice, this means that settings, filters, reports and the user interface is
set up for the role the user has. For example, preloaded settings in object
properties that are not relevant for the role are not shown, making the list of
options shorter and clearer.

Role selection is primarily meant to be configured by Trimble and reseller
localization personnel, and be part of the Tekla Structures installation package.
However, advanced users and Tekla Structures system administrators can also
create their own roles inside their company organization. Additional content is
available in the Tekla Warehouse offline and online collections. Note that you
need to have a Trimble Identity for downloading or installing from the online
collections. For more information, see Trimble Identity for Tekla Online
services.

Folder structure

Tekla Structures software and environments are separated into different
locations due to the requirements for Windows certification. By default, the
files are installed in the following folders:

« Software is installed under the \Program Files\Tekla Structures
folder.
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* Environments and extensions are installed under the \ProgrambData
\Trimble\Tekla Structures folder.

+ User settings are installed under the \Users\<username>\AppData
\Local\Trimble\Tekla Structures folder.

Project and firm folders

Project and firm folders are meant for storing the customized files. For any
company, we strongly recommend setting up firm and/or project folders on a
shared file server accessible to all users. If multiple teams on different sites
are working on the same project, you can set up a project or firm folder in a
folderina.

Having the hierarchy of project and firm folders will make it much easier to
update company settings, ensure that everyone uses the same settings in a
project, and upgrade to a newer version of Tekla Structures.

All the settings that are used on the company level (for example, company
logo and drawing standards) should be stored in a firm folder, and all the
settings used on a specific project should be stored in the corresponding
project folder. Property files are always saved in the \attributes folder
under the current model folder, like, \TeklaStructuresModels

\<my building>\attributes. These files should then be copied to the
project or firm folder, or to user-defined sub-folders under the project or firm

folder.
The company file server .
pany epbondir - MNotepsd = |- i)
4 |, TedaStnecturesSettings File Edit Format View Help
Company_Settings X5_FIRMe' Tek]asTrucutressettings \ Compamy_Settin

5
XE_PROJECT='Teklastrucutressertings) Projects H?_pu'njﬂr.t_nir
# Projects

113 project ABC
456_project DEF
T&_project_GHI

To use the saved settings in a firm and a project folder, set the path to the
folder by using the xs PROJECT and XS FIRM advanced options. These
advanced options should be put in the initialization, . ini, files. You can have
several different . ini files. You can define in the Tekla Structures shortcut
which . ini files to run and which settings to apply.

One of the most important advantages of using firm and project folders is that
Tekla Structures does not replace files in the project and firm folders when
you install a new version. This means that you retain your customized files
without having to cut and paste, or export and import from previous versions.
This makes upgrading to a newer version of Tekla Structures easier. When you
store files in one place, it is also easier to update the settings and ensure that
everyone in a project uses the same settings.

Example:
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In the current project, 123_project ABC, you have set up the properties for the
concrete column, and saved them as column_ABC. To make these saved
settings available for everyone working in the 723 _project ABC project, copy
column ABC.ccl fromthe \attributes folder under the model folder to
the \123 project ABC project folder or on your file server, or to a user-
defined sub-folder under the \123 project ABC project folder. Ensure that
everyone in the project has the correct path for the xs PROJECT advanced
option in the . ini file.

For more information, see Create project and firm folders (page 245) and Files
and folders in Tekla Structures (page 244).

Folder search order

When you open a model, Tekla Structures searches for the associated files in
specific folders in a set order. It is important that you place the files in the
correct folders. Once Tekla Structures finds the associated files, it stops
searching. This means that the files that have the same name but are located
lower down the search order are ignored.

The basic folder search order is the following:

Folder Defined by
Model folder Currently open model
Project XS PROJECT
Firm XS FIRM
System XS SYSTEM

You can specify more than one system folder, and this way define specific
settings for each role. Use the role options defined in the
env_<environment>.ini to point to the roles when specifying the system
folders in the XS_SYSTEM advanced option. Enter the options pointing to the
roles and separate them by semicolons, for example: set XS SYSTEM=

$XS STEEL%; $XS_ENGINEERINGS%; $XS CONTRACTORS; $XS GENERAL

%; $XSDATADIR%\environments\common\system\

There are some exceptions to this search order. The exceptions are listed in
Folder search order (page 334).

NOTE Do not store customized files in the system folder. Tekla Structures replaces
these files when you install a new version.

Initialization files

Initialization files (page 246) (. in1i) are used for launching Tekla Structures.
They can contain many advanced options that you can use to configure Tekla
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Structures for different standards and your own style of working. Tekla
Structures automatically creates the necessary . ini files during installation.
The number of . ini files it creates depends on how many country-specific
environments you choose to install.

Why are .ini files needed?

There are numerous settings to be made when Tekla Structures starts.
Advanced options are used to determine the appearance and the behavior of
Tekla Structures, for example, the language used, behavior of part marks on
drawings, and the location of your model folder. Advanced options are set
through the . ini files. The different . ini files and what they do, and how
they are related to each other are described below.

Different types of .ini files
The default reading order (page 247) of the . ini files is as shown in the image

below:
env_global_defaultini |
"
= environment.ini
3_: .
= rale.ini
' ™
E user.ini
— e
Ll o
5 options.ini
o
R
'
e
o
L =

1. teklastructures.ini
Initializes the settings needed for Tekla Structures to run.

The teklastructures.ini filein the \bin folder starts Tekla
Structures. We recommend that you do not make any changes to this file.

2. env _global default.ini

Sets the global default settings.

The env <your environment>.ini fileis located in the
\Environments subfolder and it contains all the environment-specific
settings. These files are set by your area office or reseller.
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3. environment.ini
Sets the environment-specific settings.

You can define specific settings for roles in your environment and store
these settings in role-specific folders. Organizing the folder structure
based on roles is useful for keeping the role content up to date. Note that
the folder structure and content may vary depending on the environment.

In the env <environment>.ini file, each role has an option where you
can add the paths that point to the folders in which you have stored the
role settings. For example, XS STEEL (\Steel), XS CONCRETE
(\Concrete), XS ENGINEERING (\Engineering)and XS PRECAST
(\Precast) each point to the folders that contain settings specific to that
role. An example for steel role could be as follows:

set XS STEEL=%XSDATADIR%\environments\Steel\master drawings\;$XSDATADIR%

\environments\Steel\model filters\;%XSDATADIR%\environments\Steel

\model settings\
XS_GENERAL points to the \General folder that has content common for
all roles and settings that are specific to modeling and drawings, for
example.

When defining role settings in XS_SYSTEM, you use the role options
defined in the env_<environment>.ini to point to the role-specific
settings. Note that you do not need to add the folder paths in XS SYSTEM
as they are defined in the env_<environment>.ini.

4, role.ini
Sets the settings defined for a role.

The role <role>.ini fileislocated in the \Environments subfolder
and it contains the settings specific for a chosen role. For example, the
role Engineer.ini filein the \Environments\uk folder contains all
the settings for the Engineering role in the UK environment.

5. user.ini
Sets the settings specified by the user.

The user.ini file contains your personal settings. The advanced options
inuser.ini override those in other . ini files. For example, if you have
set the same advanced option in an . ini file, in a file in the environments
subfolder and the user. ini file, Tekla Structures uses the value in the
user.ini file. The user.ini is located in the C:\Users\<user name>
\AppDatal\Local\Trimble\Tekla Structures\<version>
\UserSettings folder.

6. options.ini
Sets the settings specified for the company/project/model.

If there are several settings for the same advanced option, the later setting in
the reading order overrules the previous one. This means that the settings in
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user.ini overrule the settings in env_global default.ini, and the
settings in user.in can be overruled by the settings in options.ini.

The lang enu.ini is the initialization file for the English language settings.
The file is located with the other installed languages in the \Tekla
Structures\<version>\nt\bin folder.

We recommend that you make all your customizations in the options.ini
file under the model folder, or in the user. ini file. This way the
customizations are kept when you install the next version of Tekla Structures.

Setting advanced options in .ini files

Tekla Structures contains three kinds of advanced options: user-specific
advanced options, system-specific advanced options, and model-specific
advanced options.

NOTE Changing an advanced option value in . ini files located outside the model
folder does not affect the existing models. You can only update the advanced
options in the Advanced options dialog box or in the options.ini file
located in the model folder, not from an options. ini file located in folders
defined for the xS FIRMor xS PROJECT advanced option. The . ini files are
also read when you open an existing model, but only new advanced options
that do not exist in options model.db Or options drawings.db are
inserted, for example, such options that are not yet in the Advanced Options
dialog box, but have been added in the software.

User-specific advanced options set your personal preferences, for example
the appearance of the Tekla Structures window. Tekla Structures saves user-
specific advanced option settings in the options <your username>.ini
file, located in the C: \Users\<user name>\AppData\Local\Trimble
\Tekla Structures\<version>\UserSettings folder.

The options.ini file contains the settings for model-specific advanced
options. It is located in the current model folder. To share your settings with
other people, copy the options.ini file to the system, project or firm folder.

The system-specific advanced options are stored in all other . ini files.

Setting advanced options
There are two methods for setting advanced options:

+ The advanced options are grouped in different categories according to
their usage in the Advanced Options dialog box. To access the dialog box,
click File --> Settings --> Advanced options. See more in .

* The .ini files are plain text files that can be edited with a text editor, for
example Notepad. The settings will then be saved in the options.ini file
under the model folder for the model that you have open. The settings can
then easily be copy-pasted into another . ini file. See more in File storing
options and advanced options (page 254).
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We recommend that you only use one of these methods to set advanced
options. The settings in the Advanced Options dialog box override those in
the .ini files. Some advanced options need a Tekla Structures restart to
activate the new setting.

To set an advanced option in the user. ini file:

1. Locate the user.ini file in the C:\Users\<user name>\AppData
\Local\Trimble\Tekla Structures\<version>\UserSettings
folder.

2. Select and right-click the user. ini file in Windows Explorer and click
Open with. You can open the file in any standard text editor.

3. Check that the advanced option is set to the value you want. If it is, you
can stop here.

4. To change or add the advanced option, on a new line, type set, add a
space and the name of the advanced option followed by its value in a
single line.

Tekla Structures only reads lines in the initialization file that start with set,
for example, set $XS DIR%=C:\TeklaStructures\2019 .

5. Savethe user.ini file.

Creating shortcuts

To use the correct . ini files for a specific project, the easiest way is to create
a shortcut for the project on the desktop. Shortcuts are used to start
teklastructures.exe with the defined initializations.

1. Make a copy of the default shortcut: In the Windows Start menu or Start
screen, find Tekla Structures <version>, then right-click the Tekla
Structures <version>.

Select Copy from the pop-up menu.
Paste the shortcut to your desktop.

Select the shortcut and right-click.

Select Properties from the pop-up menu.

o vk N

Modify the Target of the shortcut by adding the required project
initializations to it.
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Target type: Application

Target location: bin

Target: |n'-.TekIa Structures exe” focreate:"C: A\ Tekla Structm|

Start in: |"C:'-.F‘n:ugram Files" Tekla Structures*2019.0nt '-J:uir|

Shortout key: | MNone |

Run: MNormal window w
Comment: | |
Open Fle Location Change lcon... Advanced...

For example, you can use the following parameters in shortcuts:

* -iInitializationFile: Initialization file to be read during startup, for
example: -i \\MyServer\MyProject\Projectl.ini.You can repeat
this parameter as many times as you need.

* ModelToBeOpened: Full path to the model to be opened automatically.

* /create:ModelToBeCreated: Full path to model to be created
automatically.

.ini files tell where things can be found and in which order, depending on
the folder structure that the company has set up. See more in Create start-up
shortcuts with customized initializations (page 19).

Bypassing the login screen

You can bypass the login screen by using a separate . ini file where you set
the following advanced options:

+ to setthe remote license server address.
*  XS_DEFAULT_LICENSE to set the default license for a user role.

+  XS_DEFAULT_ENVIRONMENT points to the environment-specific . ini file,
for example $XSDATADIR$\Environments\uk\env UK.ini

+ XS_DEFAULT_ROLE points to the role-specific . ini file, for example
$XSDATADIR%\Environments\uk\role Engineer.ini

Define the startup shortcut using the parameter -1 (capital i), for example, -1
$XSDATADIR%\Environments\uk\Bypass.ini. When you do this, an
additional initialization file is read BEFORE the environment . ini.

The content of such a file could be, for example:
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set XS _LICENSE SERVER HOST=27007@MY LICENSE SERVER NAME

set XS DEFAULT LICENSE=FULL

set XS DEFAULT ENVIRONMENT=%$XSDATADIR%\Environments\uk\env UK.ini
set XS DEFAULT ROLE=%XSDATADIR%\Environments\uk\role Engineer.ini

See more in Create start-up shortcuts with customized initializations (page 19).

User-defined attributes

User-defined attributes are attributes set to an object in a model or a drawing.
These user-defined attributes can be used for many purposes, such as in
filters, drawings, reports, export, import, fabrication, erection, and revision
handling.

& Tekla Structures Column (1) *
Structural infermation Unitechnik Mountpart General design Tekla Structural Designer
£ Steel column @ X Parameters Workflow End conditions Analysis IFC export
% | comer [ —
¥ General Preliminary mark l:l
Mame COLUMM Preliminary assembly mark l:l
Profile HEA400 | Lodked
Material s235IR B (Estataicgnans ]
EnEh User field 1 l:l
Class [r—— - User field 2 l:l
¥ Custom properties Userfield 3 l:l
User field 4 l:l
More More User Phase (affects numbering) l:l
Iic=ition Fixed drawing main view
» Numbering series Product code l:l
» Deforming Product description l:l
Product website l:l
Product weight l:l
Product unit l:l
Execution class
oK Apply Madify Get VT Cancel

You can create your own user-defined attributes (page 282) that you need in
your company, or for a specific project. The user-defined attributes can be
numbers, text, lists, or dates. They can be set to be unique for an object or
allowed to be copied; they can also be ignored by numbering or affect
numbering.

The user-defined attributes are defined in ocbjects. inp files. These files are
located in different folders following the Tekla Structures folder setup, and
they are merged together during startup. The objects. inp file reads the
user-defined attributes in order from the folders listed below, starting from
the model folder:

Folder defined by Advanced option
advanced option
Model Current model folder
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Folder defined by Advanced option
advanced option
Project XS PROJECT (your defined project folder)
Firm XS_FIRM (your defined firm folder)
System XS SYSTEM (your defined system folder)
inp XS_INP (your defined inp folder)

The files are merged so that if there are user-defined attributes in any of the
files, they are displayed in the user interface. Tekla Structures merges the files
so that duplicate attributes are removed. If Tekla Structures encounters the
same attribute name in different objects. inp files, the attribute from the
first read objects. inp file will be used.

If you need to have several objects. inp files in the same folder, you can use
a suffix in the file name to use all the files. This enables having several
objects <suffix>.inp filesin the same folder. The file name could be
objects precast.inp, for example.

4.2 Environment, company, and project settings for
administrators

Environment settings

Common settings

All settings and files that are the same in all environments are located in the
\Tekla Structures\<version>\Environments\common folder. Files and
settings that are specific to an environment are located in separate
environment folders.

The env_global default.ini fileis also located in the \common folder. The
file determines the standard settings, and it is the first file that is read. Other
initialization files (page 246) are read after this file, and if the other files
contain the same settings, they will override the previous settings.

Country-specific settings

The country-specific settings are located in the environments folders, and they
are localized by your local Trimble office/reseller. The folder structure of the
environments can vary, but the same kind of settings exist. For example, the
settings that are localized include profile database, material database, reports,
selection filters, view filters, components and custom components, macros,
user-defined attributes, and drawings settings.
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Company settings

Company-level settings are mainly settings that are used throughout the
company for all projects. These settings are set using Xxs_SYSTEM and
XS FIRM.

For a larger company with subsidiaries, the settings could be used as follows:

* XS SYSTEM may contain multiple paths, and it points to general settings
inside the company. These can be company logo, reports, printer settings,
drawing settings, templates, for example. These are settings that very
seldom change, and are stored on a server available for all. For example, if
the company logo is updated, it only has to be replaced in one place.

* XS _FIRM points to the firm folder set up by the company, or a subsidiary.
The folder contains all the company settings used at the particular office.
These can be logos, drawing settings, templates, reports, or printer
settings, for example. The firm folder can also have user-defined sub-
folders for storing property files.

* XS PROJECT points to the project folder. The folder contains project
settings, such as logos for contractors and fabricators, or drawing settings,
for example. The project folder can also have user-defined sub-folders for
storing project-specific property files.

For more information on the folder search order, see Folder search order
(page 334).

You can also use Tekla Warehouse company-specific collections online or
offline, in your own network. Use Trimble Identity for downloading or installing
from the online collections. See also Trimble Identity for Tekla Online services.

The offline collection access is managed with folder rights in your network,
and on the collection level in the collections.json file on each user's
computer.

"collections"
"\\\\server-A\\company\\Tekla Structures collection"

The collections.json file can be shared to selected persons by copying it
to the C:\Users\Public\Documents\Tekla\Tekla Warehouse)\ folder.

Model templates

You can save a model with the desired settings and use the model as a
template when you create new models. This can be very useful if your
company has different kinds of projects, such as, parking garages, office
buildings, bridges, and industrial.

When you create a model template, always start by creating a new empty
model. This is because old models that have been used in live projects cannot
be completely cleaned. They may contain excess information that increases
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the size of the model even if you delete all objects and drawings from the
model.

To create a model template:

1.
2.

Create a new model and give it a unique name.

Add in the model the desired profiles, custom components, and other
necessary items.

On the File menu, click Save as --> Save.

You need to save the model to include custom components in the
xslib.dbl file. If you do not save the model, custom components will not
be included in the model template.

On the File menu, click Save as --> Save as model template.

Enter a name for the model template, and select which catalogs, drawing
templates, report templates, and model subfolders you want to include in
the model template.

Click OK.

By default, the model template folder is saved in your environment folder,
under . .ProgramData\Trimble\Tekla Structures\<version>
\environments\<your environment>\.The exact folder location may
vary depending on your environment and role. Use the advanced option
XS_MODEL_TEMPLATE_DIRECTORY to define a different location.

You can download, share, and store model templates in Tekla Warehouse. The
image below shows an example of a model template in Tekla Warehouse.
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@ Trimble

"r- TEk|a WAREHOUSE SEARCH ABOUT MY WAREHOLUSE
Warehouse

(| E cLoBaL " f

Start model offshore

GROUP: Model setup files
CATEGORY: Offshore

The Insert into model button in Tekla Warehouse installs the model template
directly in the folder pointed by xS MODEL TEMPLATE DIRECTORY.YOU can
immediately use the template when creating a new model.

Model templates in Tekla Structures version update

We strongly recommend that you update your model templates in Tekla
Structures version upgrade.

To update a model template:
1. Create a new model using an existing model template.

2. Give the model the same name as in the previous Tekla Structures
version.

3. Opena3D view.
On the File menu, click Diagnose and repair --> Diagnose model.

5. On the View tab, click Screenshot --> Project thumbnail to create a
project thumbnail, or add a custom image named thumbnail.png in the
model folder.

The preferred size of the image is 120 x 74 pixels.
6. On the File menu, click Save as --> Save.

If you do not do this, a message may appear warning about the model
being created with a previous version.

7. Onthe File menu, click Save as --> Save as model template.
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8. Select which catalogs, drawing templates, report templates, and model
subfolders you want to include in the model template.

9. Click OK.

10. Remove manually all *. db files (environment database, options database
files) from the model folder.

The * .bak, *.1log and xs_user files are automatically removed from the
model folder.

Do not remove the .idrmfiles (db.idrmand xslib.idrm) as they are
part of the model.

The model template is saved in a location pointed by
XS MODEL TEMPLATE DIRECTORY.

You now have a sample image for your model template. The Applications
& components catalog is now also in order and easy to use.
Customizing reports and drawings

If your company already has graphical templates in the DXF, DWG, or DGN
format, you can convert these templates to Tekla Structures templates. For
detailed instructions on how to do this, see the information on AutoCAD and
Microstation files in the Template Editor Help.

For information on how to create your own templates and reports, see the
Template Editor Help, and and Templates (page 339).

Cloning templates for drawings

You should consider cloning drawings when:

+ There are several similar parts, assemblies, or cast units in the model.

* You need to produce single-part, assembly, or cast-unit drawings of similar
parts, assemblies, or cast units.

* The drawings need a lot of manual editing.

For example, you can create a drawing for one truss, edit the drawing, and
then clone it for similar trusses. Then you only need to modify the cloned
drawings where the trusses differ.

The cloned drawing may contain more parts than the original drawing. Part
properties, marks, associative notes and related text objects are cloned from a
similar part in the original drawing.

Clone templates in Master Drawing Catalog

You can clone drawings by using the Master Drawing Catalog templates. A
cloning template in the Master Drawing Catalog can also be used in other
models. They can be used in projects that have the same kind of drawings.

To create cloning templates:

1. Select a drawing in Document manager.
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2. Right-click and select Add to Master Drawing Catalog, and then fill in the
required properties.

The cloning template can be found under Cloning templates in the Master
Drawing Catalog. To use cloning templates in other models, open the Master

=3

Drawing Catalog in the model, click the ¥ button on the toolbar, and add
the model where the templates are saved.

For more information on the Master Drawing Catalog and cloning templates,
see.

Project settings

Create your own component folder

Usually, only a few different connections and components are used in a
project. To ensure that everyone in the project uses the same components
and finds the components faster, we recommend that you create a
component folder of your own.

1. Click the Applications & components button E in the side pane to
open the Applications & components catalog.

2. Create a new group for the project: Right-click in the catalog and select
New group.

3.  Add components to the group: Select the components in the catalog,
right-click and select Add to group. Then select the group to which the
components are added. You can also drag the selected components to
another group.

4. Hide the groups that you do not need: Select the group, right-click and
select Hide/Unhide.

TIP In the Applications & components catalog, use the commands in

Access advanced features E > Catalog management to modify
catalog definitions. For more information, see Customize the
Applications & components catalog (page 237) and XS_COMPONENT_
CATALOG_ALLOW_SYSTEM_EDIT.

For more information on the Applications & components catalog, see .

Define project properties

Project information is needed many times during a project. Define the project
information at the beginning of a project to make reports and drawings
display the correct information automatically. You can also update the project
properties during the project.

1. Onthe File menu, click Project properties.
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2. Edit the project properties.

When you edit the properties, Tekla Structures highlights the modified
properties in yellow.

3. When you are ready with the modifications, click Modify to apply the
changes.

Create and modify templates and reports

You can modify existing reports and templates, or create your own templates
(page 339) by using Template Editor. To open Template Editor, click File -->
Editors --> Template editor, or double-click an existing table in an open
drawing to open the tool. For more information, see Template Editor User's
Guide.

Note that if your templates are located in a protected folder, the templates are
read-only, and you cannot save a modified template in a protected folder. In
this case, run Tekla Structures as an administrator.

Set up printers

Tekla Structures uses Windows drivers to write the print data directly to the
Windows print device interface. You can print drawings as PDF files, save them
as plot files ( .plt)for printing with printer/plotter, or print them on a
selected printer. To print to several paper sizes, you need to modify the
drawingsizes.dat file, see morein . You can also change the line width of
the printed drawings, see more in and .

You can affect the way Tekla Structures automatically names the .pdf files
and plot files by using certain drawing-type-specific advanced options, see
more in .

4.3 Distribute customized ribbons using a firm or
environment folder

You can distribute customized ribbon files to other users in the company by
placing the ribbon files in a firm or environment folder (not in the project
folder). For example, the administrator can create company ribbons and save
them in the firm folder. These ribbons will be displayed in the Tekla Structures
user interface for all users who use the same firm folder.

Add ribbons to the firm or environment folder

1. In the Ribbon editor, create the modeling and drawing ribbons that you
want to share.
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The ribbons are saved in the . . \Users\<user>\AppData\Local
\Trimble\Tekla Structures\<version>\UI\Ribbons folder.

If you cannot find the folder, ensure that you are able to view the hidden
files and folders (page 337) on your computer.

2. Copy the entire \Ribbons folder either to your company's firm folder or
to the system folder.

3. Ifthe ribbon contains user-defined commands, create a subfolder named
\Commands on the same level as the \Ribbons folder, and copy the
UserDefined.xml file from the . .\Users\<user>\AppData\Local
\Trimble\TeklaStructures\<version>\UI\Commands folder to the
\Commands folder you just created.

4. Restart Tekla Structures.

Loading order of custom ribbons

Tekla Structures loads the ribbons in the following order:
1. Tekla Structures default ribbon

2. Company ribbons in the environment folders

3. Company ribbons in the firm folder

4. User-defined ribbons under $1ocalappdata$%

Note that the ribbons which are loaded later will override previously loaded
ribbons that have the same configuration + editing mode combination. For
example, a ribbon defined in the firm folder will take precedence over the
ribbons in the environment folders.

If you have a customized ribbon in the . .\Users\<user>\AppData\Local
\Trimble\Tekla Structures\<version>\UI\Ribbons folder, it will take
precedence over company ribbons. To override this, open the Ribbon editor
and click Restore. The ribbon in the environment or firm folder will now be
used. Alternatively, you can remove or rename your own customized ribbons.

Naming convention for ribbon files

The customization tool saves the custom ribbons as . xm1 files. The naming
convention for these files is:

<Tekla-Structures-configuration identifier>--<Tekla-
Structures-editing-mode>.xml

The name consists of an internal configuration name, a separator of two dash
characters (--), an internal editing mode name, and the file name

extension .xml. For example, the Full license modeling ribbon is called

albl up Full--main menu.xml.
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Create and distribute customized configurations

Configuration identifier Name
albl up Construction Modeling | Construction Modeling
albl up Developer Developer
albl up Drafter Drafter
albl up Educational Educational
albl up Engineering Engineering
albl up Full Full

albl up PC Detailing

Precast Concrete Detailing

albl up Rebar Detailing

Rebar Detailing

albl up Steel Detailing

Steel Detailing

albl up Tekla Structures Prim
ary

Primary

albl up Viewer

Project Viewer

Editing mode

Purpose

main_menu

Modeling ribbon

edit draw menu

Drawing ribbon

plan main menu

Importing ribbon

environment folder

4.4 Distribute customized tabs using a firm or

As an alternative to customized ribbon files, which override the existing
ribbon, you can import external custom tabs to the ribbon. The customized
tabs are automatically appended to the end of the ribbon for all users who use
the same firm or environment folder. This means that an administrator can
distribute customizations to all users in the company while still allowing
individual users to customize their ribbons as well.

Note that these customized tabs do not appear in the Ribbon editor, so the
users are not able to edit them. If the administrator has updated the contents
of a customized tab, the users will receive an update when they restart Tekla
Structures. Tabs are not configuration specific, so they are imported
regardless of the user's Tekla Structures license. If the tab contains commands
that are not available in the user's configuration, they will appear dimmed on

the ribbon.

1. Create the following folder structure in your company's firm folder or in

the system folder.
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Commands

W Ribbons
W CustomTabs
Crawing
Modeling

2. Inthe Ribbon editor, create a customized tab and add some commands to
it.

3. Save the ribbon.

4. Gotothe ..\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\Ribbons folder.

5. In atext editor, open the ribbon file which contains the tab you wish to
share with other users.

6. Remove all the other content from the ribbon file except the first row and
the description of the tab you wish to share.

For example:

<?xml version="1.0" encoding="utf-8" standalone="yes"?>
<Tab Header="My Tab" IsCollapsed="false" IsUserDefined="true">
<SimpleButton X="0" Y="0" Width="3" Height="4"
Command="Common.Interrupt" Text="command:ShortText"
Icon="command:BigIcon" ShowText="true" ShowIcon="true" />
</Tab>
7. Save the file with a new name in the . .\CustomTabs\Modeling

or ..\CustomTabs\Drawing folder.

Tab files have the file name extension *.xm1. We recommend that you
use the same name as for the tab. For example, MyTab. xm1. The file
name is not case sensitive.

The tab will be added to either the modeling or drawing mode ribbons,
depending on the folder it is located in. Note that there can be several
custom tab files in the same folder. They are added to the ribbon one
after the other. Note that if the same tab file exists in both the
environment and firm folders, the firm version overrides the environment
version.

NOTE To avoid file name conflicts, we recommend that administrators
prefix all custom tab files with the company name, and that
extension developers prefix all custom tab files with the name of
the extension (for example, MyExtension TabName.xml).

8. If the tab contains user-defined commands, copy the UserDefined.xml
file from the . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\Commands folder to the \Commands folder
created in step 1.
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9. Restart Tekla Structures.

The customized tab now appears at the end of the ribbon.

4.5 Distribute customized property pane layouts using a
project, firm, or environment folder

Company administrators can distribute the customized property pane layouts
to other users in the company by placing the property pane layout file
PropertyTemplates.xml in a folder called PropertyRepository
\Templates in a project, firm, or environment folder. For example, company
administrators can create company property pane layouts and save them in
the firm folder. These property panes are available in the Tekla Structures user
interface for all users who use the same firm folder.

Add a property pane layout file to a project, firm, or
environment folder

1. Inthe Property pane editor, create the property pane layouts that you
want to share.

The property pane layouts are saved in the PropertyTemplates.xml
file, inthe . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\PropertyTemplates folder.

If you cannot find the folder, ensure that you are able to view the hidden
files and folders (page 337) on your computer.

2. Create a folder called PropertyRepository\Templates eitherin your
company's project folder, firm folder, or in the system folder.

3. Copythe PropertyTemplates.xml file to the PropertyRepository
\Templates folder.

4. Restart Tekla Structures.

Search order of the customized property pane layout files

The PropertyTemplates.xml file contains all the property pane layouts for
different object types. Note that the property pane layouts for different object
types are treated separately. For example, Tekla Structures can read the
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property pane layout for steel beam from a different location than the
property pane layout for steel column.

If different object types are defined in different folder locations, the definitions
are combined. If the same object type is defined differently in different folder
locations, the definition that is higher in the search order is used.

The property pane layout in the . . \Users\<user>\AppData\Local
\Trimble\Tekla Structures\<version>\UI\PropertyTemplates\
folder has the highest priority, and after that Tekla Structures uses the default
search order.

4.6 Distribute customized property pane settings by
using a project, firm, or environment folder

Company administrators can distribute the customized property pane settings
to other users in the company. Place the PropertyPaneSettings.xml file in
a folder called \PropertyPane in a project, firm, or environment folder.

1. Customize the property pane settings that you want to share.

The property pane settings are saved in the
PropertyPaneSettings.xml file, inthe . .\Users\<user>\AppData
\Local\Trimble\Tekla Structures\<version>\UI\PropertyPane
\ folder.

If you cannot find the folder, ensure that you are able to view the hidden
files and folders (page 337) on your computer.

2. Create afolder called \PropertyPane either in your company's project
folder, firm folder, or in the system folder.

3. Copythe PropertyPaneSettings.xml file tothe \PropertyPane
folder.

4. Restart Tekla Structures.

Thefilein . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\PropertyPane\ has the highest priority in
the search order, and after that Tekla Structures uses the default search
order.

If the PropertyPaneSettings.xml file is placed in several different
folder locations, Tekla Structures reads the settings from different folders
and merges them.
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4.7 Distribute customized toolbars using a project, firm,
or environment folder

Company administrators can distribute the customized Selecting, Snapping,
and Snap override toolbars to other users in the company. Place the needed
toolbar . json files in a folder called \Toolbars in a project, firm, or
environment folder. For example, company administrators can create
company toolbars and save them in the firm folder. These toolbars are
available in the Tekla Structures user interface for all users who use the same
firm folder.

1. Customize the toolbars that you want to share.

The toolbars are saved in corresponding . json files, in the . . \Users
\<user>\AppData\Local\Trimble\Tekla Structures\<version>
\Toolbars folder.

If you cannot find the folder, ensure that you are able to view the hidden
files and folders (page 337) on your computer.

2. Create afolder called \Toolbars either in your company's project folder,
firm folder, or in the system folder.

Copy the needed . json files to the \Toolbars folder.
4. Restart Tekla Structures.

The filesin . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\Toolbars have the highest priority in the
search order, and after that Tekla Structures uses the default search
order.

4.8 Customize the material catalog

The material catalog contains information on material types and grades. In the
material catalog, materials are displayed in a hierarchical tree grouped
according to their types. Each material type has material grades listed under
them.

The following material types are available in Tekla Structures:
+  Steel

+ Concrete

* Reinforcing bar

+ Timber

* Miscellaneous
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By default, the material catalog contains standard, environment-specific
materials. You can add, modify, and delete material grades.

Tekla Structures stores the material information in the matdb.bin file.

See also

Important buttons in the material catalog (page 132)

Add a material grade (page 133)

Copy a material grade (page 133)

Modify a material grade (page 134)

Delete a material grade (page 135)

Add user attributes to material grades (page 135)

Create user-defined material definitions (page 136)

Import and export material grades (page 137)

Important buttons in the material catalog

When you work with the material grades, note the usage of the following
buttons in the Modify Material Catalog dialog box:

Button

Description

Update

Saves the changes of a single edited material grade to the
computer’'s memory until you click OK.

Saves the changes in the model folder.

Tekla Structures saves the modified catalog on the hard disk when
you click OK to close the dialog box and then click OK in the Save
confirmation dialog box.

Cancel

PRl

Closes the Modify Material Catalog dialog box without saving the
changes.

Note that all changes made to the catalog will be lost even if you
have clicked Update, because the changes have not been saved on
the hard disk. The changes made to the catalog are visible during
one session, because the catalog is using the computer’'s memory.
When you start Tekla Structures the next time, the previous data is
restored from the hard disk.

Tekla Structures stores the material information in the matdb.bin file. When
you first open a model, Tekla Structures reads the data from the hard disk and
stores it in the computer's memory.

When you select a material, Tekla Structures reads the data from the
computer's memory and displays it in the Modify Material Catalog dialog
box. This is faster than accessing the data from the hard disk.
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See also

Customize the material catalog (page 131)

Add a material grade

1. On the File menu, click Catalogs --> Material catalog to open the Modify
Material Catalog dialog box.

Select a material type, for example, steel.
Right-click and select Add Grade.
A new material grade is added under to the material type you selected.

4. Change the material grade name by clicking the grade and entering a new
name for it.

Enter the material grade properties.

Click OK to save the material grade and close the Modify Material
Catalog dialog box.

7. Click OK in the Save confirmation dialog box to save the changes.

See also

Copy a material grade (page 133)
Modify a material grade (page 134)
Delete a material grade (page 135)

Import and export material grades (page 137)

Copy a material grade

You can add new material grades by modifying a copy of an existing, similar
material grade.

1. On the File menu, click Catalogs --> Material catalog to open the Modify
Material Catalog dialog box.

Select a material grade that is similar to the one you wish to create.
Right-click and select Copy Grade.

A copy of the material grade with the name COPY is added to the material
tree.

4. Change the material grade name by clicking the grade and entering a new
name for it.

5. Modify the material grade properties.
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6. Click OK to save the material grade and close the Modify Material
Catalog dialog box.

7. Click OK in the Save confirmation dialog box to save the changes.

See also

Add a material grade (page 133)
Modify a material grade (page 134)
Delete a material grade (page 135)

Modify a material grade
You can modify existing material grades using the material catalog.

1. Onthe File menu, click Catalogs --> Material catalog to open the Modify
Material Catalog dialog box.

2. Select a material grade in the tree and modify its properties.

+ Use the General tab for entering three alternative names for the
material. The names are usually the material names used in different
countries or standards. The tab also contains the profile and plate
density values.

+ Use the Analysis tab for entering information on the properties used
in structural analysis.

+ Use the Design tab for entering information on the design-specific
properties, such as strengths and partial safety factors.

+ Use the User attributes tab for creating your own attributes for
material grades.

For example, you can define a paint layer thickness, or the maximum
grain size of concrete using a user-defined attribute.

3. When you have finished modifying the material grade, click Update.
4. Click OK to close the Modify Material Catalog dialog box.

Tekla Structures asks if you want to save the changes to the model folder.
5. Click OKin the Save confirmation dialog box to save the changes.

The modified material catalog is saved in the current model folder and is
available only for that model. To make the modified catalog available for
all the other models, use export and import.

See also
Add a material grade (page 133)
Copy a material grade (page 133)
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Delete a material grade (page 135)

Delete a material grade

1.

On the File menu, click Catalogs --> Material catalog to open the Modify
Material Catalog dialog box.

2. Select the material grade that you want to delete.

3. Right-click and select Delete Grade.

4. Click OK to close the Modify Material Catalog dialog box.

5. Click OKin the Save confirmation dialog box to save the changes.
See also

Add a material grade (page 133)

Copy a material grade (page 133)

Modify a material grade (page 134)

Add user attributes to material grades

You can add user attributes and their values to the material grades. The user
attributes can then be used, for example, in filtering.

1.

On the File menu, click Catalogs --> Material catalog to open the Modify
Material Catalog dialog box.

On the User attributes tab, click Definitions to open the Modify
Material Properties dialog box.

Click Add to add a new row.
To define a user attribute, click each item on a row.

a. Inthe Category list, select a material category to which the user
attribute is applied.

b. Inthe Design code list, select a design code to which the attribute is
added.

In the Material type list, select a material type for the attribute.

d. Inthe Quantity type list, select the type of information that the user
attribute contains, for example, weight, area, ratio, or string.

e. Inthe Order column, define the order in which the user attributes are
shown in the dialog box. Smaller values are shown first.

f.  In the Property name column, define a name for the property.

The name is saved in the catalog and can be used in reports and
templates. When Property name is used in a template,
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MATERIAL.PROPERTY NAME indicates where the property name
appears.

g. Inthe Label column, define a label for the attribute.
5. Click Update.
6. Click OK to close the Modify Material Properties dialog box.

See also
Modify a material grade (page 134)

Create user-defined material definitions

You can replace the existing material definitions with your own definitions and
use them, for example, in drawing part marks. Material definitions can contain
text, numbers and symbols.

1. Save the symbol file user material symbols.syminthe symbol folder
(usually the folder . .\ProgrambData\Trimble\Tekla Structures
\<version>\environments\common\symbols\).

2. Create a text file that contains your material definitions.
Create the file using a text editor, for example Microsoft Notepad.

Each row in the file defines a material. Use the following syntax:
material name symbol file name@n, where

* material name is the name of the material used in the material
catalog

* symbol file name is the symbol file name to be used
* nis the number of the symbol.

For example:

5235I1RGL user_material_symbols@l
52351RG2 user_material_symbols@2
52351R  user_material_symbolsal
52751R  user_material_symbols@3
53551r  user_material_symbols@4

mee=mm

WARNING The order of material names in the definition file is relevant
to the conversion. Materials with more specific names need
to be listed before the ones with similar, but simpler names,
for example, S235JRG1 must be listed before S235JR.
Otherwise they both get the same symbol.
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3. Save the file for example with the name
user material definitions.txt

All the named materials in the material catalog will be replaced with the
ones defined in this file.

4. Setthe name of the file as a value for the advanced option
XS MATERIAL SYMBOL REPRESENTATION FILE in File menu -->
Settings --> Advanced options --> Drawing Properties as follows:

set
XS MATERIAL SYMBOL REPRESENTATION FILE=user material defi
nitions.txt

You can also enter a full path to the material definition file. Without the
path Tekla Structures searches for the file in the model, firm, project, and
system folders.

See also
Customize the material catalog (page 131)

Import and export material grades

Use importing and exporting for merging material catalogs. Material catalogs
are imported and exported as . 1is files.

Importing and exporting is useful when you:

+ upgrade to a newer version of Tekla Structures and want to use a
customized material catalog from a previous version

+ want to combine material catalogs that are stored in different locations
+ want to share material catalog information with other users

* want to combine material catalogs across different environments.

TIP You can also download or share material grades using Tekla Warehouse.

See also

Import a material catalog (page 137)

Export an entire material catalog (page 138)
Export a part of the material catalog (page 139)
Units used in import and export (page 152)
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Import a material catalog

Material catalogs are imported to Tekla Structures models as . 11is files. You
can move an exported . 1is file to any model folder and import it to an
existing material catalog.

1.  Open the model to which you want to import a material catalog.

2. On the File menu, click Catalogs --> Material catalog to open the Modify
Material Catalog dialog box.

3. Click Import.
Browse for the folder that contains the import file, and select the file.
5. Click OK.

If a material with a same name as the material being imported already
exists, the Import confirmation dialog box appears and you have three
options:

+ Replace: The existing material is replaced with the imported material.

+ Merge: Material properties that are different in the import file are
added to the existing material. All the other properties remain
unchanged.

Use this option to import only certain elements of the material catalog,
such as user attributes.

+ Leave: The existing material is not replaced and the material
definitions in the import file are ignored.

If you select the Apply for all check box, Tekla Structures uses the same
option (Replace, Merge, or Leave) for all the existing materials that have
the same name as the one being imported.

If a user attribute with a different definition already exists, you are
prompted to Replace or Leave the existing attribute.

Click OK to close the Modify Material Catalog dialog box.
Click OK in the Save confirmation dialog box to save the changes.

See also

Export an entire material catalog (page 138)
Export a part of the material catalog (page 139)
Units used in import and export (page 152)

Export an entire material catalog

Exporting and importing are used to merge material catalogs. Material
catalogs are exported from Tekla Structures models as . 1is files. Note that
the Export command exports the entire catalog.
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1. On the File menu, click Catalogs --> Material catalog to open the Modify
Material Catalog dialog box.

2. Click Export.
3. Browse for the folder where you want to save the exported file.
By default, the file is saved to the current model folder.
4. Enter a name for the file and click OK.
Click OK to close the Modify Material Catalog dialog box.
Click OK in the Save confirmation dialog box to save the changes.

See also
Import a material catalog (page 137)

Units used in import and export (page 152)

Export a part of the material catalog

If you do not want to export the whole material catalog, you can export a
branch of the material tree, meaning all the material grades grouped under
one material type, or a single material grade. Material catalogs are exported
from Tekla Structures models as . 11is files.

1. On the File menu, click Catalogs --> Material catalog to open the Modify
Material Catalog dialog box.

2. Select material grades to be exported.

+ To export a branch of the material tree, right-click the branch and
select Export Grades.

+ To export a single material grade, right-click the material grade and
select Export Grade.

3. Browse for the folder where you want to save the export files.
By default, the file is saved to the current model folder.
4. Enter a name for the file and click OK.
5. Click OK to close the Modify Material Catalog dialog box.
6. Click OK in the Save confirmation dialog box to save the changes.

See also
Export an entire material catalog (page 138)
Import a material catalog (page 137)

Units used in import and export (page 152)
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4.9 Customize the profile catalog

The profile catalog contains information on profiles, their rules and types, and
the analysis and design properties of the profiles. Profiles are displayed in a
hierarchical tree grouped according to rules.

By default, the profile catalog contains standard, environment-specific profiles
and generic parametric profiles. You can add, modify, import, export, and
delete profiles.

You can define your own user-defined profiles, which can be either fixed or
parametric. Use the profile catalog to create new fixed profiles, either from
scratch or by copying an existing one. Use the sketch editor or . c1b files to
create new parametric profiles.

Tekla Structures stores the profile catalog information in the profdb.bin file.

See also

Important buttons in the profile catalog (page 140)
Group profiles together (page 141)

Add user attributes to profiles (page 143)

Associate profile types with a certain material (page 146)
Delete a profile from the profile catalog (page 147)
Import and export profiles (page 148)

Create your own profiles (page 155)

Define standardized values for parametric profiles (page 201)
Create an image of a profile (page 201)

Customize the shape catalog (page 202)

Important buttons in the profile catalog

When you work with the profiles, note the usage of the following buttons in
the Modify Profile Catalog dialog box:

Button Description
Update Saves the changes of a single edited profile to the computer’s

memory until you click OK.

oK Saves the changes in the model folder.

Tekla Structures saves the modified catalog on the hard disk when
you click OK to close the dialog box and then click OK in the Save
confirmation dialog box.
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Button Description

Cancel Closes the Modify Profile Catalog dialog box without saving the
changes.

Note that all changes made to the catalog will be lost even if you
have clicked Update, because the changes have not been saved on
the hard disk. The changes made to the catalog are visible during
one session, because the catalog is using the computer’'s memory.
When you start Tekla Structures the next time, the previous data is
restored from the hard disk.

Tekla Structures stores the information of fixed profiles in the profdb.bin
file. When you first open a model, Tekla Structures reads the data from the
hard disk and stores it in the computer’s memory.

When you select a profile, Tekla Structures reads the data from the computer’s
memory and displays it in the Modify Profile Catalog dialog box. This is faster
than accessing the data from the hard disk.

See also
Customize the profile catalog (page 139)

Group profiles together

In the profile catalog, the profiles are displayed in a hierarchical tree and they

are grouped according to rules ‘&, such as the profile type (for example, I
profiles) and the profile subtype (for example, HEA). To change how the
profiles are grouped in the profile tree, you need to modify the rules.

The order in which you create the rules does not matter, only the location of
the rules in the profile tree.

Tekla Structures reads the rules from top to bottom in the profile tree. Profiles
are in the highest group where they meet the criteria defined in the rule. For
example, a rule that collects All profiles overrides all rules that are below it in
the profile tree.

See also
Add a rule to the profile catalog (page 141)
Modify a rule in the profile catalog (page 142)

Add a rule to the profile catalog

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.
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2. Right-click any existing rule and select Add Rule.
The Profile manager rules dialog box appears.
3. Define the rule properties.
a. Enter arule name in the Rule name box.
b. Select the Profile type to which the rule is applied.
c. Enter the Name filter string that defines the new rule.
By default, the wildcard symbol (*) is entered, meaning “all entries”.

For example, to group all catalog entries with names beginning with
A, enter A* in the Name filter string box, or to group all catalog
entries with names containing 100, enter *100*. Tekla Structures
groups the catalog entries that meet your criteria under the new rule.

4. Click OK to close the Profile manager rules dialog box.
Click OK to close the Modify Profile Catalog dialog box.
Click OK in the Save confirmation dialog box to save the changes.
TIP You can add a next level rule that creates a subgroup under an

existing rule. Use the Add Next Level Rule command to add the
next level rule.

See also
Modify a rule in the profile catalog (page 142)

Modify a rule in the profile catalog

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

2. Right-click any existing rule and select Edit Rule.

The Profile manager rules dialog box appears.

Modify the rule properties.

Click OK to close the Profile manager rules dialog box.
Click OK to close the Modify Profile Catalog dialog box.

o vk w

Click OK in the Save confirmation dialog box to save the changes.

Profiles in the profile tree are listed in an alphabetical order, and rules are
listed in the order you specify. To change the order in which the rules appear,
use the Move up and Move down commands.

TIP If you want to delete a rule, right-click an existing rule and select Delete Rule.
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See also
Add a rule to the profile catalog (page 141)

Add user attributes to profiles

You can add your own attributes to profiles. For example, you can specify
paint layer thickness, define the maximum grain size of concrete, sort out
different profile types by material, or create profile aliases for converting
imperial profiles to metric and vice versa.

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

2. On the User attributes tab, click Definitions.

The Modify Profile Properties dialog box appears.
3. Click Add to add a new row.

To define a user attribute, click each item on a row.

a. Inthe Profile type list, select a profile type to which the user
attribute is applied.

b. Inthe Quantity type list, select the type of information that the user
attribute contains, for example, weight, area, ratio, or string.

c. Inthe Order list, define the order in which the user attributes are
shown in the dialog box. Larger values are shown first.

d. Inthe Property name list, define a name for the property.

The name is saved in the catalog and can be used in reports and
templates. When Property name is used in a template,
PROFILE.PROPERTY NAME indicates where the property name
appears. For example, PAINT LAYER THICKNESS.

e. Inthe Symbol column, define an abbreviation that can be used for
the property, such as Ix or ct.

f. Inthe Label column, define a label for the attribute.
5. Click Update.
6. Click OK to close the Modify Profile Properties dialog box.

See also

Example: Add a user attribute to a profile and use itin a rule (page 143)
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Example: Add a user attribute to a profile and use it in a rule
You can add your own attributes and their values to profiles. The user
attributes can then be used, for example, in profile filtering.

In this example, you will add a user attribute for | profiles’ rule.

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

2. Onthe User attributes tab, click Definitions.

The Modify Profile Properties dialog box appears.
3. Click Add to add a new row.
4. Select the row that was created and modify the properties as follows:

© N oW

Set Profile type to | profiles.

Set Quantity type to String.

Set Property name to HISTORICAL PROFILE.
Set Symbol to Hist.

Set Label to Historical profile.

Modify Profile Properties @
Profile type Quantity type Order  Property name Symbol Label i
All profiles String 0 IS_RECOMMENDED _SIZE IsRecommended Is recommended size
All profiles String 0 I5_STOCK_SIZE IsStockSize Is stock size
All profiles Length 0 MAX_TWIN_SEARCH_DIST Twin profile detection distance
All profiles String 0 METRIC_EQ_NAME Metric Equivalent Name
All profiles String 0 SAP DESCRIPTION SAP SAP Description 2

| T 1profiles String 0 HISTORICAL_SHAPE Hist Historical shape j

OK Cancel

Click Update and OK.
In the profile tree, select | profiles and then HEA.
Right-click and select Add Next Level Rule.

follows:

Set Rule name to Historical profiles.

In Profile type, clear the All profiles check box and select the |

profiles check box.
Enter HEA* in the Name filter string box.

In the Profile manager rules dialog box, set the rule properties as
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+ Set User attribute to HISTORICAL_PROFILE and Equals, and enter
Yes in the box next to the two other boxes.

F

Profile rmanager rules @
Rule name: Historical shapes
O All profiles |
O 7 Unknown profiles
T Iprofiles
O L L profiles
Profile type: | 1 Z profiles
oy U profiles
[ | Plate profiles
[ . Circular sections
[ {3 Circular hollow sections
[ [0 Rectanqular hollow sections o
Mame filter string:  HEA®
User attribute: HISTORICAL_SHAPE i EqLIE'S * Yeg
9. C(lick OK.

Historical profiles appears in the profile tree.

10. Select the required historical profile, for example HEA120, in the profile
tree.

11. Go to the User attributes tab and set Value of Historical profile to ves.

| Feneral | Analysis | User attributes

Property Symbol Value Unit
SAP Description SAP
Metric Equivalent Name
Twin profile detection distance 0.00 mm
Is stock size [s5tockSize
'__TR recomimended size IsRecommended
Historical shape Hist Yes J
b-LIE.t of ractories FactoryList
Design order 0

12. Click Update.
13. Repeat the steps 10 and 11 for any other required profiles.
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14. Click OK to close the Modify Profile Catalog dialog box.
15. Click OK in the Save confirmation dialog box to save the changes.

Next time you open the profile catalog, the profiles appear under Historical
profiles in the profile tree.

See also
Add user attributes to profiles (page 143)
Add a rule to the profile catalog (page 141)

Associate profile types with a certain material
You can define which profiles are available for steel parts, concrete parts, or

both. This affects which profile types are shown in the Select Profile dialog
box when you change the material of a part.
To define the material of a profile type:

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

Select a profile type, for example, L profiles.

To associate the profiles with steel, right-click and select Material -->
Steel .
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A check mark next to Steel indicates that the profiles are available for
steel parts.

Frofile name: General | Analy:
_ Profile type
Filter: * Filter
‘_—/ Profile type:
+I I profiles
;,..5@ I beams (steel) Profile subtype
+L | : Picture
4115 Add Profile
+|J
g Add Rule
0T Add Mext Level Rule
-J1 Edit Rule
L §
. 5 Delete Rule
-3
+]1 Move up
. I Mowve down
+. Property
+|:| Export Profiles
O _
L5a Material »| v Steel
-3 Crane rails Concrete

To make the selected profiles available also for concrete parts, right-click
and select Material --> Concrete .

If needed, you can remove the check mark by clicking the material again.
Click OK to close the Modify Profile Catalog dialog box.
Click OK in the Save confirmation dialog box to save the changes.

Delete a profile from the profile catalog

1.

ik N

On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

Select the profile that you want to delete.

Right-click and select Delete Profile.

Click OK to close the Modify Profile Catalog dialog box.

Click OK in the Save confirmation dialog box to save the changes.

Tekla Structures will continue showing parts in model views using the deleted
profiles until you modify the parts or reopen the model. After that, the parts
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having profiles that are not available in the profile catalog, are shown as sticks
without a profile.

See also
Customize the profile catalog (page 139)

Import and export profiles

Use importing and exporting for merging profiles across profile catalogs.
Profile catalogs are imported and exported as . 11is files, sketched profiles
as .uel files, and user-defined parametric profiles as . c1b files.

When you export an entire profile catalog, Tekla Structures creates three
separate files: profiles.clb, profiles.lis and rules.lis. The .clb file
contains parametric profile definitions, if they are used in the profiles in the
catalog, otherwise it is empty. The profiles.lis file includes the actual
profile definitions and the rules. 1is file the branch rules. When you export a
branch of a profile catalog, the branch name is attached as prefix to the file
names.

Importing and exporting is useful when you:

+ upgrade to a newer version of Tekla Structures and want to use a
customized profile catalog from a previous version

+ want to combine profile catalogs that are stored in different locations
+ want to share profile catalog information with other users

+ want to combine profile catalogs across different environments.

Limitations

* You cannot import or export hard-coded profiles such as PROFILE_ZZ,
PROFILE_CC, and PROFILE_CW.

* You cannot import profiles that do not have a defined cross section.

+ If you have used a sketched profile or a user-defined parametric profile as
the cross section for a fixed profile, you also need to import the sketched
profile or the user-defined parametric profile to the new model.

TIP You can also download or share profiles using Tekla Warehouse.

See also

Export an entire profile catalog (page 150)
Export a part of the profile catalog (page 150)
Import profile catalog items (page 149)

Import and export sketched profiles (page 154)
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Import profile catalog items

Tekla Structures has five types of profile catalog items: fixed profiles, hard-
coded parametric profiles, sketched profiles, user-defined parametric profiles,
and rule sets. Profiles and rule sets are imported to Tekla Structures models
as . lis files, sketched profiles as . uel files, and user-defined parametric
profiles as . c1b files.

If you are importing an entire profile catalog or a branch, we recommend that
you save the related files in a separate folder. This makes the import process
faster.

1.  Open the model to which you want to import profile catalog items.

2. Onthe File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

3. Click Import to import a single file, or Import Directory to import the
contents of a file folder.

4. Select the import file or the import folder.

5. Click OK. Tekla Structures checks if there are duplicates in the profile
names in the import file compared to the profile catalog.

a. Ifthe Review import items dialog box appears, there are duplicate
profile names and you must select each duplicate and assign the
action you want to perform with the following buttons:

+ Leave: The existing profile item is not replaced and the profile
definitions in the import file are ignored.

+ Maerge: Profile properties that are different in the import file are
added to the existing profile. All the other properties remain
unchanged.

Use this option to import only certain elements of the profile
catalog, such as user attributes.

+ Replace: The existing profile item is replaced with the imported
profile item.

+ If you leave Unknown as the action for a profile item, it is not
imported.

You can select more than one profile item at a time by using the Shift
and Ctrl keys and assign the same action to the entire selection.

NOTE Each cross section definition has a unique name and ID
number. If during an import, a cross section with the same
name but different properties is found in the existing profile
catalog, the cross section being imported is renamed by
adding an incremental number at the end of the existing
name.
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b. After you have selected the actions, click Continue to perform them.
6. Click OK to close the Modify Profile Catalog dialog box.
7. Click OK in the Save confirmation dialog box to save the changes.

See also

Import and export profiles (page 148)

Export an entire profile catalog (page 150)
Export a part of the profile catalog (page 150)
Import sketched profiles (page 154)

Units used in import and export (page 152)

Export an entire profile catalog
Profile catalogs are exported from Tekla Structures models as .1is, .uel,
and .c1b files.

1. Onthe File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

Click Export.
Browse for the folder where you want to save the export files.

By default, the files are saved to the current model folder. For faster
profile catalog import, we recommend that you create a separate
subfolder for the catalog files.

4. Click OK to close the Modify Profile Catalog dialog box.

See also

Import and export profiles (page 148)

Export a part of the profile catalog (page 150)
Example of profile export file (page 151)
Import profile catalog items (page 149)

Units used in import and export (page 152)

Export a part of the profile catalog

If you do not want to export an entire profile catalog, you can export a branch
of the profile tree, meaning all the profiles grouped under one rule, or a single
profile. Profiles and rule sets are exported from Tekla Structures models

as . lis files, sketched profiles as . uel files, and user-defined parametric
profiles as .c1b files.

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.
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2. Select profiles to be exported.

+ To export a branch of the profile tree, right-click the branch and select
Export Profiles.

« To export a single profile, right-click the profile and select Export
Profile.

3. Browse for the folder where you want to save the export files.
By default, the files are saved to the current model folder.
If you are exporting a single profile, enter a name for the file.
Click OK.

5. Click OK to close the Modify Profile Catalog dialog box.

See also

Export an entire profile catalog (page 150)
Example of profile export file (page 151)
Import profile catalog items (page 149)
Units used in import and export (page 152)

Example of profile export file

The export . 1is file is divided into specific sections.
The first row in the file is PROFILE CATALOG EXPORT VERSION = n, Wheren
is the version number.

WARNING Do not delete this row. If the row does not appear in the file, the
import is canceled.

The next section defines the hierarchical tree structure that is used to display
the contents of the catalog.

The next section contains the profiles.

Fixed profiles

PROFILE_MNAME = "HEA120";

TYPE = 1; SUB_TYPE = 1001; COORDINATE = 0.000;

"FLANGE _SLOPE_RATIO" 0. 000000000E+000
"ROUNDING_RADIUS_2" 0. 000000000E+000
"ROUNDING_RADIUS_1" 1. 200000000E+001
"FLANGE_THICKMESS" 8. 000000000E+000
"WEB_THICKMESS" 5. 000000000E+000
"WIDTH" 1.200000000E+002
"HEIGHT" 1.140000000E+002
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Fixed user-defined profiles

Fixed user-defined profiles can have more than one cross section. The profile
type for fixed user-defined profiles is 998. SUB TYPE refers to the name of the
cross section definition. When importing fixed user-defined profiles, the
relevant cross section definitions must be in the same import file as the
profile.

PROFILE_NAME = "TAN_HK_TEST_2_CS":

{
TYPE = 998; SUB_TYPE = 253; COORDINATE = 0.000;

"EQUIVALENT_TYPE" 11

"FLANGE_SLOPE_RATIO" 0. 000000000E+000
"ECCENTRICITY_Y" 0. 000000000E+000
"ECCENTRICITY_X" 0. 000000000E+000
"ROUNDING_RADIUS_2™ 0. 000000000E+000
"FLANGE_THICKNESS_2" 0. 000000000E+000
"WEB_THICKNESS_ 2" 0. 000000000E+000

Cross section definitions

CROSS_SECTION_NAME = "MY_OWN_PROFILE"
POINT_NUMBER = 1;
FOINT_X = 200.00;
POINT_Y = -200.00;
CHAMFER_TYPE = 0;
CHAMFER_X = 0.00;
CHAMFER_Y = 0.00;
POINT_NUMEBER = 2;
FOINT_X = 200.00;
POINT_Y = 200.00;
CHAMFER_TYPE = 0;
CHAMFER_X = 0.00;
CHAMFER_Y = 0.00;

See also
Export an entire profile catalog (page 150)
Export a part of the profile catalog (page 150)

Units used in import and export

The table below lists the units Tekla Structures uses when importing and
exporting profile catalogs and material catalogs.

Type Unit (if blank, no unit)

Boolean

Integer

String

Ratio
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Type Unit (if blank, no unit)
Strain
Angle degree
Length mm
Deformation mm
Dimension mm
Radius of inertia mm
Area mm?
Reinforcement area mm?
Transverse reinforcement area mm?2/m
Area/unit length mm?2/m
Volume mm?3
Section modulus mm3
Moment of inertia mm#
Torsion constant mm?#
Warping constant mm?©
Force N
Weight kg
Distributed load N/m
Spring constant N/m
Mass/length kg/m
Surface load N/m?
Strength N/m?
Stress N/m?2
Modulus N/m?2
Density kg/m?3
Moment Nm
Distributed moment Nm/m
Rotation spring constant Nm/rad
Temperature K (°C)
Thermal dilation coefficient 1/K (1/°C)
Factor
See also

Import profile catalog items (page 149)

153

Customize the profile catalog




Import a material catalog (page 137)
Export an entire profile catalog (page 150)

Export an entire material catalog (page 138)

Import and export sketched profiles

To use a sketched profile in other Tekla Structures models, you have to export
the profile to a file (* .uel), and then import the file into another Tekla
Structures model.

We recommend that you use the profile catalog to import and export sketched
profiles. You can also use the Applications & components catalog to import
sketched profiles together with related custom components.

See also
Import sketched profiles (page 154)
Export sketched profiles (page 154)

Import sketched profiles
After you have exported sketched profiles to a file, you can import them to
another Tekla Structures model.

1.  Open the Tekla Structures model you want to import to.

2. Onthe File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

Click Import.

In the Import Profile Catalog dialog box, select *.uel from the Filter list.
Select the file to import.

Click OK.

Click OK to close the Modify Profile Catalog dialog box.

© N o v kW

Click OK in the Save confirmation dialog box to save the changes.

TIP To automatically import all *.uel files from a folder when creating a new model,
use the advanced option XS_UEL_IMPORT_FOLDER.

See also
Export sketched profiles (page 154)

Export sketched profiles

1. Open the Tekla Structures model you want to export from.
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2. Onthe File menu, click Catalogs --> Profile catalog to open the Modify

Profile Catalog dialog box.

3. Right-click the profile you want to export and select Export Profile.

4. Inthe Export Profile Catalog dialog box, enter a name for the export file

in the Selection box.

5. If you want to save the export file to a specific location, browse for the

By default, Tekla Structures saves the export file in the current model

folder.

folder.
6. Click OK.
See also

Import sketched profiles (page 154)

Create your own profiles

You can create your own profiles and save them in the profile catalog.

Use any of the following methods to create user-defined profiles in Tekla

Structures:

Profile type

Creation methods

Fixed profile

Create user-defined cross sections
(page 155)

Create a fixed profile (page 161)

Create a fixed profile by copying
(page 163)

Create a fixed profile based on a
parametric profile (page 164)

Parametric profile

Create parametric profiles
using .clb files (page 165)

Create parametric profiles by
sketching (page 173)

Parametric profile with variable cross
sections

Create parametric profiles with
variable cross sections (page 198)

Create user-defined cross sections

User-defined cross sections can be used for creating fixed profiles. Define the
needed cross sections before creating the profile.
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Use any of the following methods to define a cross section:
+ Define a cross section using polygon.
Use this method to create a cross section with fixed dimensions.
+ Define a cross section using a plate.
Use this method if you have a contour plate in the model.
+ Define a cross section using a DWG file.
Use this method if you have a . dwg file of the profile you want to define.

Define a cross section using polygon
Define a cross section by picking the shape of the cross section.

1. On the File menu, click Catalogs --> Define profiles --> Define cross
section using polygon.

2. Define a cross section without or with inner contours.
+ To create a cross section with no inner contours:

a. Pick the corner points of the cross section to define the shape.
Start at the bottom-right corner and pick the points counter
clockwise.

b. Pick the start point and click the middle mouse button to close the
shape.

c. Pick the center point of the cross section.

3 K 2

4.3 8.1

TIP To make it easier to define the shape, insert a reference
model of the cross section in the model, and use the
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reference model as a basis for picking the cross section
shape.

Alternatively, you can create a few construction lines or
points in the model and use them to define the cross section
shape.

If you do not have any actual points to pick, picking the
center point of the cross section becomes difficult. This is
because the cross section shape disappears after you have
clicked the middle mouse button to close the shape.

* To create a cross section with inner contours:

a. Pick the corner points of the cross section to define the shape.

b. Pick the start point to close the shape.

c. Pick the corner points of the cross section inner contour.
d. Pick the start point to close the shape

e. Repeat until you have picked all inner contours.

f.  Click the middle mouse button.

g. Pick the center point of the cross section.

]

3.  When the User Profile Cross Section dialog box appears, enter a name
for the cross section.

4. Click OK to close the User Profile Cross Section dialog box.
5. Click OK in the Save confirmation dialog box to save the changes.

You can then use this cross section when you add a new profile to the profile
catalog. The Profile type will be User-defined, fixed.

Define a cross section using a plate
You can define a cross section using a contour plate.

1. Create a contour plate that includes all the chamfers.
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2. Onthe File menu, click Catalogs --> Define profiles --> Define cross
section using plate.

The Profile Cross-Section from Plate (10) dialog box appears.

3. Onthe Parameters tab, enter a name in the Section name and Profile
name boxes.

Other properties are optional.
4. Click OK.
5. Select the contour plate.

Tekla Structures creates the cross section with the shape of the contour
plate.

You can then use this cross section when you add a new profile to the
profile catalog. The Profile type will be User-defined, fixed.

Properties: Profile cross-section from plate (10)

Use the Parameters tab to define the profile properties in the Profile cross-
section from plate (10) component.

Option Description

Section name Name of the cross section shown in
the Modify Profile Catalog dialog
box.

If you leave this box empty, no profile
is created.

Profile name Name of the profile shown in the
Beam properties, and in the Modify
Profile Catalog dialog box.

If you leave this box empty, no profile
is created.

Save to The location of the profile catalog.
Select one of the following options:

* Model directory: The current
model folder.

+ Global
directory: . .\ProgramData
\Trimble\Tekla Structures
\<version>\environments
\<environment>\profil

« Do not save: Does not save the
profile. This is useful for testing.
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Option Description

Min distance between points The minimum distance between the
corner points of the cross section.

To create simpler drawings of
complicated cross sections, increase
this value.

Center point offset The origin of the plate defines the
location of the profile reference line.

Enter an offset value to move the
reference line, relative to the cross
section.

Coordinate system Select one of the following options:
+ Use local
+ Use global xy-plane

Mirroring Select one of the following options:
+ Do not mirror

* Mirror to x-direction

* Mirror to y-direction

* Mirror to x- and y-direction

Define a cross section using a DWG file
If a cross section is available in DWG format, you can import the cross section
and add it as a DWG profile to the profile catalog.

Tekla Structures supports DWG files that have been created using version
ACAD2012 or earlier.

Before you start defining a cross section using a DWG file:

« Save the outline of the cross section as a DWG file. Ensure that the DWG
file only contains the outline of the profile.

* Make sure that the cross section is created as a closed polyline.

* Make sure that the outline consists of only one closed polyline. You cannot,
for example, define holes to your cross section with this method. If you
need holes or openings, use the polygon or the plate creation method.

+ Remove hatching and unnecessary lines from the DWG file. Tekla
Structures imports all the lines it finds in the DWG file.

+ Ifthere are blocks in the DWG file, they must be exploded.
1. Open a model.
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2. Onthe File menu, click Catalogs --> Define profiles --> Define cross

section using DWG file.

The DWG Profile to Library (6) dialog box appears.

Click OK.

o vk w

imported.

On the Parameters tab, browse for the DWG file.

Define the cross section properties.

In the model, pick the start and the end points of the cross section to be

Tekla Structures imports the cross section and places the profile reference

line at the origin of the DWG file.

You can then use this cross section when you add a new profile to the
profile catalog. The Profile type will be User-defined, fixed.

Properties: DWG Profile to Library (6)

Use the Parameters tab to define the profile properties in the DWG profile to

library (6) component.

Option

Description

Input file

Browse for the DWG file to be
imported.

Section name

Name of the cross section shown in
the Modify Profile Catalog dialog
box.

Profile name

Name of the profile shown in the
Modify Profile Catalog dialog box.

Save to

The location of the profile catalog.
Select one of the following options:

*  Model directory: The current
model folder.

+ Global
directory: . . \ProgramData
\Trimble\Tekla Structures
\<version>\environments
\<environment>\profil

Do not save: Does not save the
profile. This is useful for testing.

Min distance between points

The minimum distance between the
corner points of the cross section.

To create simpler drawings of
complicated cross sections, increase
this value.
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Option Description

Center point offset The origin of the plate defines the
location of the profile reference line.

Enter an offset value to move the
reference line, relative to the cross
section.

Modify a user-defined cross section
You can modify cross sections that have been defined using a polygon, a plate,
or a DWG file.

1. Onthe File menu, click Catalogs --> Define profiles --> Edit Polygon
Cross Section.

The Modify Cross Section dialog box appears.
Select the cross section you want to modify.
Modify the cross section point properties.

*  Number refers to each point picked when the cross section was
created, in numerical order. The first point picked is 1, the second 2,
and so on.

+ Chamfer refers to the chamfer shape.

« x:andy: apply to the chamfer type. For example, if you want the
chamfer to be equal on both sides of the angle, only enter a value for
X:.

For an uneven chamfer, enter values for x: and y:.
4. Click Update.
Click OK to close the Modify Cross Section dialog box.
Click OK in the Save confirmation dialog box to save the changes.

TIP If you want to delete a cross section, select the cross section and click Delete.

Create fixed profiles
You can create new fixed profiles either from scratch or by copying an existing
one. You can also convert a parametric profile into a fixed one.

Create a fixed profile

You can create fixed profiles with a single cross section or with multiple cross
sections. Note that cross sections affect the total weight of the profile.
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WARNING If you create a profile with multiple cross sections, create the
cross sections with the same number of corner points and in the
same order.

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

2. Right-click anywhere in the profile tree and select Add Profile.
A new fixed profile with the name PROFILE1 is created.

3. Change the profile name by entering a new name in the Profile name
box.

The profile name must be in upper case letters, with no spaces. Tekla
Structures automatically converts lower case letters to upper case letters.

In the Profile type list, select User-defined, fixed.
5. Inthe Profile subtype list, select the cross section you want to use.

If you have created your own user-defined cross sections (page 155), you
can use one of them.

6. Under Equivalent type, select a profile type that matches the new cross
section as closely as possible. This is important because some
connections only work for certain types of profiles.

The equivalent type and the profile dimensions, such as height and width,
affect which connections can be applied to the profile. An unsuitable
equivalent type or missing dimension values may result in problems with
connections.

Click Update.
Modify the dimension values.

Always enter values for the dimensions Height h and Width b, as these
values affect how Tekla Structures displays the profiles. If the values are 0,
the partis drawn as a line.

9. Under Cross section, define a relative location for each cross section:
a. Inthe Number list, select the number of the cross section.
b. Inthe Relative location box, enter the location of the cross section.

This value indicates the location of the cross section along the axis:
0.0 for the start end and 1.0 for the second end. If you only have a
single cross section, select 1 for Number and enter 0.000 for
Relative location.

c. Click Update after defining each cross section.
10. Click Add to add more cross sections, if needed.

11. If you want to use a different cross section in the profile, select a new one
from the Profile subtype list.

Create and distribute customized configurations 162 Customize the profile catalog



12. If you want to remove a cross section, select the cross section from the
Number list and click Remove.

13. Click OK to close the Modify Profile Catalog dialog box.
14. Click OK in the Save confirmation dialog box to save the changes.

Example

For a pitched profile, you need two cross sections with the same center point
height. The Relative location value is 0. 0 for the first cross section, 0.5 for
the second cross section, and 1. 0 for the third cross section.
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Create a fixed profile by copying
You can create new fixed profiles by modifying a copy of an existing, similar
profile.

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

2. Select a fixed profile that is similar to the one you wish to create.
3. Right-click and select Copy Profile.
A new profile with the name <existing_profile_name COPY> is created.

4. Change the profile name by entering a new name in the Profile name
box.

The profile name must be in upper case letters, with no spaces. Tekla
Structures automatically converts lower case letters to upper case letters.

5. Modify the profile properties on the General, Analysis, and User
attributes tabs.

WARNING Under Equivalent type, select a profile type that matches
the new cross section as closely as possible. This is important
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because some connections only work for certain types of
profiles.

Always enter values for the dimensions Height h and Width
b, as these values affect how Tekla Structures displays the
profiles. If the values are 0O, the part is drawn as a line.

The equivalent type and the profile dimensions, such as
height and width, affect which connections can be applied to
the profile. An unsuitable equivalent type or missing
dimension values may result in problems with connections.

6. Click Update.
7. Click OK to close the Modify Profile Catalog dialog box.
8. Click OK in the Save confirmation dialog box to save the changes.

Create a fixed profile based on a parametric profile

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

Select a parametric profile from the list.
Right-click and select Add Profile.

A new standard fixed profile is created, and it has the profile values of the
parametric profile.

Modify a fixed profile

If necessary, you can modify existing fixed profiles using the profile catalog.
Note that the fixed profiles conform to industry standards, and you should not
modify them unless you are an administrator.

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.
2. Select a fixed profile & in the tree and modify its properties.

+ The General tab contains information on profile types and
dimensions.

+ The Analysis tab contains information on the properties used in
structural analysis. The structure can be analyzed with different
analysis software.

« The User attributes tab is for viewing or entering user attributes for
profiles.

3. When you have finished modifying the profile, click Update.
Click OK to close the Modify Profile Catalog dialog box.
Tekla Structures asks if you want to save the changes to the model folder.
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5. Click OK in the Save confirmation dialog box to save the changes.

Create parametric profiles using .clb files
You can create new parametric profiles using . c1b files.

Follow the example workflow below to create a parametric profile with .c1b
files.

How the .clb, components.clb and profitab.inp files work together

When you create new parametric profiles using this method, you need the
following three files:

« .lb

This file contains the cross section definitions. Create a new .c1b file in
the ..\ProgramData\Trimble\Tekla Structures\<version>
\environments\common\inp folder for each parametric profile you
define.

+ components.clb

This file contains a list of all . c1b files that contain cross section
definitions. When you create a new .c1b file, you need to add its file name
to the components.clb file located in the . .\ProgrambData\Trimble
\Tekla Structures\<version>\environments\common\inp folder.

« profitab.inp

This file is the link between the . c1b files and the profile catalog. This file
contains a list of all parametric profiles available in Tekla Structures. The
file controls how the parametric profiles are displayed in the Modify
Profile Catalog dialog box. When you want to take a new parametric
profile into use, you must add the needed profile definitions, such as the
profile type, prefix and the unit of measurement, to the profitab.inp
file. The profitab.inp file is located under the environment folder

in ..\ProgramData\Trimble\Tekla Structures\<version>
\environments\<environment>\. The exact file location may vary
depending on the folder structure of your environment files .

Tekla Structures searches for the profitab. inp file in the standard
search order and then from the folder indicated by the advanced option
XS_PROFDB.

Define the shape and point coordinates of the profile
Start by defining the shape and point coordinates of the new profile.

1. Design the profile on a paper.
a. Draw the cross section outline.
b. Add the needed corner points.
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c. Addthe needed dimensions.

d. Place the y-z coordinate axis center point to the middle of the cross
section.

=
o)

2. Define they and z coordinate directions. For example:
* positive y axis: up
* negative y axis: down
* positive z axis: on the right
* negative z axis: on the left
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3. Define they and z vectors. For example:

* yl,y2,y3
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4. Make coordinate pairs to the points.
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Assign y, z vector pairs to each point. Start from the lower right corner and
define the points in the counter clockwise order. For example:

*  point 1:y1z3
*  point 2:y2 z3
*  point3:y3z2
*  point4:y3z1
*  point5:y1 z1

&
y3, 21 Y+ y3, 22
4 1 :_'.;. v2, z3
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Create the .clb file
After defining the shape and point coordinates of the profile, you can continue
by creating the actual . c1b file.

1. Create a new .clb file using any standard text editor, for example
Microsoft Notepad.

2. Define alibrary name that will be used in the profitab. inp file for this
profile.

For example:

library id "1Gen"

3. Define a cross section name that will be used in the profitab.inp file
for this profile.
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For example:
Section type

name "RectChamfer"”

4. Define the dimensions of the cross section.

For example:
base_attribute

name "h"

description "albl Height"
type dimension

default 1000

5. Define the coordinates of the profile.

The coordinates must be the same as the y and z vectors that you defined
earlier. Define the default values. For example:

EXpression

name "yl1"
tvpe ¥
default -400

formula -h/2

6. Define the geometry of one or several faces of the profile.
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For example:
geometry

name "default”
face
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NOTE The index number refers to the point number: O=start point of
the beam, 1=end point of the beam.

7. Savethe .clbfileinthe ..\ProgramData\Trimble\Tekla
Structures\<version>\environments\common\inp folder.

8. Open the components.clb file.

9. Add your profile definition to the components. clb file by adding the
following line:

Include
“new_file name.clb” // give comment

10. Save the components.clb file.

Add profile definitions to the profitab.inp file
Before taking the new parametric profile into use, you must add the needed
profile definitions to the profitab. inp file.

1. Findtheprofitab.inp file, located under the environment folder
in . .\ProgramData\Trimble\Tekla Structures\<version>
\environments\<environment>\.
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2. Copythe profitab.inp file to a model, project or firm folder.

3. Open the file in the new location using a standard text editor, such as
Microsoft Notepad.

4. Under a suitable category, add a new line for the profile definition.
Use the following syntax:

Prefix
! Type ! SO ! Z ! MI ! MA ! G3-NAME ! Z3-NAME !

5. Save the file.
The profile is now available in the profile catalog. You may have to restart
Tekla Structures for the change to take effect.

Example

An example of a profile definition:

PNL A
' USER ! 0 ! ' 2 I 3 !lGen.RectChamfer !'h*b-[c]

Properties used in profitab.inp
Use the following properties when you define new parametric profiles using
the profitab.inp file:

Property Description

Prefix Prefix of the parametric profile. The
prefix is shown in the profile catalog.

For example, PNL_A.

Type Type of the parametric profile.

The profile types are/include the
following:

I, L, Z U PLD,PD,P, CT,HK HQ, ZZ,
CC, CW, CU, EB, BF, SPD, EC, ED, EE,
EF, EZ, EW, 102, 103, 104, 105, 106,
USER

For example, in the default
environment, parametric profiles with
prefixes PD, EPD, CHS, CFCHS, O, @,
and TUBE all group under the type
PD, and appear under Circular
hollow sections in the profile
catalog.

SO Sorting order. The options are:

+ -1: Decreasing sorting order

* +1:Increasing sorting order

Create and distribute customized configurations 171 Customize the profile catalog




Property

Description

* 0:No sorting order

+ -2:Name increasing, value
decreasing

* +2:Value increasing, name
decreasing

For example, if your profile is
PLT200*10 or PLT10*200 and the
sorting order is +2, the result in the
output (such as a report) for both
cases is PLT200*10. If the sorting
order is -2, the result for both cases
is PLT10*200.

Unit of measurement. The options
are:

: millimeters

rinches

: feet

w N = O

. centimeters

* 4:meters

MI

Minimum number of parameters you
can use with the parametric profile.

For example, the rectangular hollow
section SHS has the following Profile
subtypes: h*t, h*b*t, h1*b1-
h2*b2*t. If you define SHS with a
minimum of two and a maximum of
two parameters, you will only have
the option h*t available in the Select
Profile dialog box.

MA

Maximum number of parameters you
can use with the parametric profile.

G3-NAME

Refers to a cross section file (. c1b
file).

Can be a combination of a library id
and the name of a cross section,
separated by a full stop. For example,
1Gen.RectChamfer.
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Property

Description

Z3-NAME

Defines how the profile parameters
relate to the parameters in the cross
section file.

Parameters in the order of
appearance in the . c1b file, optional
parameters in square brackets. For
example, h*b-[c].

Can also be the name of the detailing
component.

Create parametric profiles by sketching
You can create parametric user-defined profiles by sketching. You can change
the dimensions of parametric profiles each time you use them in a model.

+ Use the cross section sketch editor to create and modify sketched profiles.

+ The Sketch Browser shows the objects of a sketched profile.

+ Use the Variables dialog box to define the properties of a sketched profile.

Open the sketch editor

1. Open a Tekla Structures model.

2. Onthe File menu, click Editors --> Define cross section in sketch editor.

Tekla Structures opens the sketch editor, the Sketch Browser, and the

Variables dialog box.

When you first open the sketch editor, the view is empty. The grid
coordinates and labels that you see in the sketch editor depend on the
grid properties of your actual Tekla Structures model.

Create and distribute customized configurations
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& \iiew 2 - (Cross Section Sketch Editor View) — O >

Sketch Browser

The Sketch Browser shows the objects (lines, arcs, circles, constraints,
dimensions, and chamfers) of a sketched profile in a hierarchical, tree-like
structure. The Sketch Browser automatically opens when you open the

sketch editor.
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When you click an object in the sketch editor, Tekla Structures highlights the
object in the Sketch Browser, and vice versa.

& Sletch Browser 4

Model objects:

=== Cross section objects 2
_,:_é-_'i: Component objects
-3 Sketch
..... ExtrusionType
..... Thickness
_,:_j-_'i: Compenent objects
..... = Line

----- 1. Vertical constraint
+- 5 Chamfer constraint
----- “= Horizontal constraint

+- & Chamfer constraint
i..].. Vertical constraint W

Refresh Close

The Sketch Browser displays the following information about a sketched
profile:

« Extrusion type (0, 1, or 2) and thickness of the sketched profile
« Lines, arcs, and circles

+ Constraints

+ Distances and dimensions and their values

+ Chamfers and their type (O=None, 1=Line ... 7=Line and arc) and
dimensions.

Variables in sketched profiles

Use the Variables dialog box to define the properties of a sketched profile.
Variables can define fixed properties, or they can include formulas, so that
Tekla Structures calculates the property value each time you use the profile in
a model.
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The Variables dialog box automatically opens when you open the sketch

editor.

& \ariables — O X
Category: Mame Formula  Value Valuetype  Variabletype Visibility  Labelin dialog box
h1 20000 30000 Length Distance Show Height

h2 70.00 70.00 Length Distance Show Height

h3 =h2 70.00 Length Distance Hide Height

b1 150,00 150.00 Length Distance Show Width

b2 =h1 150.00 Length Distance Hide Width

P1 20.00 20.00 Length Parameter Show Thickness

P2 10.00 10.00 Length Parameter Show Chamfer

al 270.00 270.00 Angle Angle Hide Angle

Add Delete

Close

NOTE The Variables dialog box functions the same way as the
corresponding dialog box in the custom component editor. For more
information on how to use variables, see .

Sketch the outline of a profile
When you create a new sketched profile, start by sketching the outline and the
holes of the profile using lines, arcs, and circles.

Ensure that you create a closed shape, unless you are creating a profile of a
consistent thickness, such as a cold-rolled profile.

Sketch a polyline

You can create line segments in the sketch editor by picking points. Tekla
Structures automatically creates coincident constraints between the line
segments and displays a chamfer symbol where line segments meet.

1.  Open the sketch editor. (page 173)

2. Click the Sketch polyline button:
3. Pick points to create each line segment.
4. Click the middle mouse button to create the polyline.
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Sketch an arc
You can create an arc in the sketch editor by picking three points.

1. Open the sketch editor. (page 173)

Click the Sketch arc button:

Pick three points to define the arc.

TIP You can use the advanced option XS_CS_CHAMFER_DIVIDE_ANGLE to
define the smoothness of the arc.

Sketch a circle
You can create a circle in the sketch editor by picking two points.

1. Open the sketch editor. (page 173)

Click the Sketch circle button:
Pick a point to indicate the center of the circle (1).

4. Pick a point to indicate the radius of the circle (2).
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Refine the shape of a sketched profile by adding a constraint

After you have sketched the outline of a profile, use constraints to refine your
sketch and lock the shape. For example, you can straighten lines, create 90
degree angles, force lines to meet, close the shape, and add chamfers in
corners.

To straighten the entire profile, use horizontal and vertical constraints in
conjunction with other constraints. Although the shape is locked, you can still
rotate the profile in the model.

Add a parallel constraint
You can force two lines in a sketched profile to be parallel to each other.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

1. Click the Parallel constraint button:
2. Select aline in the sketch (1).
3. Select another line in the sketch (2).
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Add a perpendicular constraint
You can force a line in a sketched profile to be at a 90 degree angle to another
line you select. The lines do not have to intersect.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

u

1. Click the Perpendicular constraint button:
2. Select aline in the sketch (1).
3. Select another line in the sketch (2).

Add a coincident constraint
You can force two lines in a sketched profile to start or end at the same point,
by extending or shortening one or both lines. The lines do not have to

intersect.
NOTE Tekla Structures automatically creates coincident constraints
+ where two lines meet.

* between line segments when you draw them with the Sketch
polyline tool.

* between the start of the first line segment and the end of the last
line segment in a shape, if they are within a certain distance of
each other.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

1. Ensure that the Snap to end points L] snap switch is active.

2. Click the Coincident constraint button:
3. Pick the end of the first line (1).
4. Pick the end of the second line (2).
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Add a fixed constraint
You can lock the position and angle of a line in a sketched profile so that other
constraints do not affect it.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

.-/ .

1. Click the Fixed constraint button:

2. Select aline in the sketch.

Add a horizontal constraint

Use horizontal constraints to force a line in a sketched profile to be parallel to
the local x axis. Tekla Structures automatically creates horizontal constraints
when you create lines that are nearly horizontal.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

1. Click the Horizontal constraint button:
2. Select the lines you want to straighten (1, 2).
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Add a vertical constraint

Use vertical constraints to force a line in a sketched profile to be parallel to the
local y axis. Tekla Structures automatically creates vertical constraints when
you create lines that are nearly vertical.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

1. Click the Vertical constraint button: *-

2. Select the lines you want to straighten (1, 2).

Delete a constraint
You can delete constraints from sketched profiles.

1. Click ’ to open the Sketch Browser.
2. Select the constraint you want to delete.
3. Right-click and select Delete.

4. Click Refresh.

Add dimensions to a sketched profile

After you have sketched a profile, use dimensions to make different distances
in the profile parametric. You can use these dimensions to define the size of
the profile when you use it in a model.

Tekla Structures also adds the dimensions you create to the list of variables

that you can use in calculations.

NOTE Do not create too many dimensions in a sketch, or the dimensions will not be
able to adjust when the values are changed.

In the following example, if you create the dimension marked in red, the
dimension b1 will no longer work:
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Add a radial dimension to a sketch
You can create a radial dimension for an arc or a circle in a sketched profile.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

—~

P
1. Click the Sketch radial dimension button: *

2. Select the arc or circle.

Add an angle dimension to a sketch
You can create an angle dimension between two lines in a sketched profile.
The angle is calculated counter clockwise from the first line you select.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

1. Click the Sketch angle dimension button: t\ .
2. Select the first line (1).
3. Select the second line (2).
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TIP If you are unable to see the angle symbol, scroll with the mouse
wheel to zoom in.

Add a dimension between two points in a sketch
You can add a dimension to a sketched profile, between two points you pick.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

—_

Click the Sketch free dimension button:
Pick a point to indicate the start point of the dimension (1).
Pick a point to indicate the end point of the dimension (2).

A W

Pick a point to indicate the location of the dimension lines and text.

Add a horizontal dimension to a sketch

You can add a horizontal dimension to a sketched profile, between two points
you pick.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

LI}
1. Click the Sketch horizontal dimension button:

2. Pick a point to indicate the start point of the dimension (1).
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3. Pick a point to indicate the end point of the dimension (2).

4. Pick a point to indicate the location of the dimension lines and text.

Add a vertical dimension to a sketch
You can add a vertical dimension to a sketched profile, between two points
you pick.

Before you start, sketch the outline of the profile in the sketch editor.
(page 176)

1. Click the Sketch vertical dimension button:

2. Pick a point to indicate the start point of the dimension (1).
3. Pick a point to indicate the end point of the dimension (2).
4

Pick a point to indicate the location of the dimension lines and text.

Delete a dimension from a sketch
When you want to delete a dimension from a sketch, you can do it in the
sketch editor view, in the Variables dialog box, or in the Sketch Browser.

1. Select the dimension you want to delete.
2. Do one of the following:

* In the sketch editor view or in the Sketch Browser, right-click and
select Delete.
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* In the Variables dialog box, click the Delete button.

Define positioning planes for a sketched profile

When you sketch a profile, you can define positioning planes for it. With
positioning planes you can determine the planes Tekla Structures will use for
positioning parts and components.

Part positioning planes

With part positioning planes you can determine how Tekla Structures positions
parts that have a sketched profile. These planes are used for the On plane
and At depth settings for parts, and also when placing custom components
that are bound to boundary planes.

The part positioning planes are displayed in blue:

The On plane options Left and Right are set according to the vertical blue
planes, and the Middle option is halfway between them.

The same principle applies to the At depth setting: the Front and Behind
options are set according to the horizontal blue planes, and the Middle option
is halfway between them.

¥ Position
On plane | Middle w || 0,00 mm |
Rotation | Top - |
At depth | Middle v || 0.00 mm |
Example

You can define part positioning planes so that an asymmetric profile will be
positioned according to its web only. In the following example, the Middle
option is illustrated in gray dotted lines:
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(1) Middle option

Connection positioning planes

With connection positioning planes you can determine how Tekla Structures
positions components in relation to the component main part that has a
sketched profile.

The connection positioning planes are displayed in green:

Example

The following image shows the default connection positioning planes of a
double tee slab that was created as a sketched profile. The green line
illustrates the default connection positioning planes.

o

ERIERIEE
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To place connections according to the location of the stems of the double tee,
move the connection positioning planes as shown below.

[ 0 O o

o] 0 Q

o

Show and hide positioning planes

To show or hide the positioning planes, do one of the following:

To Do this

Show or hide part positioning planes d
Click ==,

Show or hide connection positioning
planes Click ==,

Move positioning planes

You can move the positioning planes by moving their handles. Note that if you
move the handles away from the outmost corners of the sketched profile, you
must bind them by adding a dimension to each handle. Otherwise the
positioning will not function correctly in the model.

1. Click the positioning plane to display the handles.

The handles are displayed in pink. By default, the handles are at the
outmost corners of the sketched profile. For example:

2. Click a handle to select it.

NOTE The same handle controls both the vertical and horizontal plane,
so you can move them both at the same time.
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3. Move the handle like any other object in Tekla Structures.
For example, right-click and select Move.

4. If the handle is not at the outmost corner of the profile, add a dimension
between the handle and the corner.

Example

In the following examples, the left handle of the positioning plane has been
bound by using a horizontal dimension (b1):

Revert to default positioning planes
You can revert back to the default positioning planes of a sketched profile if
you have moved the planes.

To revert to the default positioning planes, do one of the following:

To Do this

Revert to the default part positioning | 1. a
planes Click =2 to show the part
positioning planes.

2. Select the part positioning
planes.

3. Right-click and select Delete.

4, 4
Click == again to check that the
planes have reverted back to the
default.
Revert to the default connection 1.
positioning planes Click == to show the

connection positioning planes.
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To Do this

2. Select the connection positioning
planes.

3. Right-click and select Delete.

Click - --‘L again to check that the
planes have reverted back to the
default.

Check a sketched profile
You can check that the constraints and dimensions in a sketched profile work
correctly.

1. Double-click a dimension line to open the Distance Properties dialog
box.

2. Change the Value box.
3. Click Modify.
Tekla Structures updates the profile in the sketch editor.

4. Check that the shape of the profile does not change and that the
dimensions adjust correctly.

5. Click Cancel to close the Distance Properties dialog box.

See also
Use sketched profiles in a model (page 192)

Save a sketched profile

Tekla Structures saves the sketched profiles in the current model folder, in the
xslib.dbl file, which is a library file containing custom components and
sketches. Sketched profiles are available in the Others section in the profile
catalog.

NOTE Note the following limitations when naming sketched profiles:
* You cannot use the name of a fixed profile.

* You cannot include numbers, special characters, or blank spaces in
the profile name.

* Lower case letters are automatically converted into upper case
letters.

To save a sketched profile, do one of the following:
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To Do this

Save a new profile 1. Hi
Click Save sketch .

2. Enter a name in the Prefix box, and then click
OK.

Update an existing profile 1. Hi
Click Save sketch

2. Click Yes when prompted to update the
existing cross section.

Save a copy of the profile 1. Hi
under a different name Click Save sketch as )

2. Enter a new name in the Prefix box, and then
click OK.

See also
Import and export sketched profiles (page 154)

Modify sketched profiles

You can modify existing sketched profiles, for example, by modifying chamfers
or dimensions. You can also move corners or holes by moving the handles.
The chamfers are moved automatically when you move the handles.

Modify a sketched cross section
NOTE + You cannot change dimensions that have been calculated using
formulas in the Variables dialog box.
+ Constraints may also prevent you from changing dimensions.
1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.
2. Open the Others branch at the end of the profile tree.

3. Right-click a sketched profile, and then select Edit profile to open the
profile in the sketch editor.

4. Double-click a sketch object to modify its properties.
The sketch objects you can modify appear in yellow.

5.  Modify the properties and then click Modify.

6. Close the sketch object properties dialog box.

Hy

7. Click the Save sketch as icon to save the changes.
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Modlify chamfers in a sketch
You can change the shape and dimensions of chamfers in a sketched profile.
For example, you can create rounded profile corners.

1. Double-click a chamfer symbol @ in the sketch editor.

2. Inthe Chamfer Properties dialog box, change the shape and dimensions
of the chamfer.

3. Click Modify.
Click OK to close the dialog box.

Hy

5. Click the Save sketch as icon to save the changes.

Set the sketch thickness

If you have sketched an open shape, such as a cold-rolled section, you must
define the extrusion type and thickness of the sketch in the Sketch Browser.
The thickness can be either fixed or parametric.

& Cletch Browser pe

Model objects:

=== Cross section objects
—:_)5\ Component objects
5. %6 Sketch
----- ExtrusionType
----- Thickness

1. Inthe sketch editor, sketch an open polyline (page 176).
2. Do one of the following:
+ To set a fixed thickness:

a. Inthe Sketch Browser, right-click Thickness and select Add
Equation.

b. Enter the value of the thickness after =.
+ To define a parametric thickness:

a. Inthe Variables dialog box, add a new parameter variable for
Length (for example, P1).

b. Inthe Formula column, define the default value for the
parameter variable.

c. Inthe Sketch Browser, right-click Thickness and select Add
Equation.

d. Enter the name of the parameter variable (for example, P1) after

3. To define the extrusion type:
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a. Inthe Sketch Browser, right-click ExtrusionType and select Add
Equation.

b. Enter the extrusion type number (0, 1, or 2) after =.

Hy

4. Click the Save sketch as icon to save the changes.

Extrusion types

The extrusion type defines how a sketched profile of a consistent thickness is
extruded. When you change the thickness, the profile grows inwards,
outwards, or symmetrically in both directions, depending on the extrusion
type. You must define the extrusion type for sketches that consist of an open
polyline.

Type Description Image

0 The sketch is extruded
symmetrically to the
outside and inside of the
polyline.

(Default)

1 The sketch is extruded
to the outside of the
polyline.

2 The sketch is extruded
to the inside of the
polyline.

Use sketched profiles in a model

Once you have created a sketched profile and saved it, you are ready to use it
in the model. If you have applied constraints correctly, the shape of the profile
will be maintained when you change its dimensions.

To use a sketched profile for a new part in a model:

1. Open the part properties in the property pane.
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For example, to open the beam properties, on the Steel tab, hold down

Shift and click g

2. Click the ... button next to the Profile box.
The Select Profile dialog box appears.

3. Open the Others branch at the end of the profile tree.
Select a sketched profile.

5. If the profile is parametric, you can define its dimensions in the Value
column on the General tab.

6. Click OK to close the Select Profile dialog box.
7. Pick points to place the part in the model.

See also

Create an image of a profile (page 201)

Example: Create a symmetric C-shaped profile by sketching
This example shows how to create a sketched profile using variables.

After completing the tasks, you will have a symmetric C-shaped profile with
the dimensions b1 = b2 and h2 = h3. When you use the profile in the model,
you can change the following dimensions:

«  Width (b1)

+ Total height (h1)
+  Height (h2)

* Thickness (P1)

+  Chamfers (P2)

e (70.00)

A3 (70.00)
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Example: Sketch a C-shaped profile

Start by sketching the outline of the profile.

1. Open the sketch editor.

2. Use the Sketch polyline command to create a rough C-shaped profile.

At this stage, the profile does not have to be symmetric or have the right
dimensions.

3. Straighten the lines using the Add horizontal constraint =~ and Add

vertical constraint * commands.

4. Save the profile and name it CSHAPE.
Example: Add dimensions to the sketched profile

After sketching the outline of the profile, you can continue by adding
dimensions.

Tt
1. Use the Sketch horizontal dimension' =~ command to create the
distances b1 and b2.
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=

2. Use the Sketch vertical dimension
distances h1, h2, and h3.

W2 (310.16)

13 (350.74)

command to create the

3. Inthe Variables dialog box, enter the following values for the distances:

Name | Formula| Value Value | Variable | Visibility | Labelin
type type dialog
box
b1 150.00 150.00 Length | Distance | Show Width
b2 =b1 150.00 Length | Distance | Hide Width
h1 300.00 300.00 Length | Distance Show Height
h2 70.00 70.00 Length | Distance | Show Height
h3 =h2 70.00 Length | Distance | Hide Height

4. Ensure that Visibility is set to Show for the distances b1, h1, and h2.

5. Save the sketched profile.
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Example: Set the sketch thickness

After adding dimensions to the sketched profile, you can continue by defining
the thickness of the sketch.

1. Inthe Variables dialog box, do the following:

a.
b.
C.
d.

Click Add to add a parameter variable P1.

In the Formula column, enter 20.00.

In the Visibility column, select Show.

In the Label in dialog box column, enter Thickness.

2. Inthe Sketch Browser, set the thickness using the parameter variable P1.

a.
b.

Right-click Thickness, select Add Equation, and then enter =p1.

Right-click ExtrusionType, select Add Equation, and then enter =2 to
get the sketch extruded to the inside of the polyline.

& Sletch Browser >

Model objects:

== Cross section objects
-'_)-_i' Component chjects
5“6 Sketch
..... ExtrusionType = 2
..... Thickness = P1
+')-_'i\' Component chjects

Refresh Cloze

3. Save the sketched profile.

Example: Modlify the chamfers of the sketched profile

After setting the thickness of the sketch, you can continue by modifying the
chamfers of the sketched profile.

1. In the sketch editor, do the following:

C.

Double-click a chamfer symbol @
In the Chamfer properties dialog box, change the chamfer type to
Line . and then click Modify.

Repeat steps 1a-b for all the chamfers.

2. Inthe Variables dialog box, do the following:

a.

Click Add to add a parameter variable P2.
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b. Inthe Formula box, enter 10.00.
c. Inthe Visibility box, select Show.
d. Inthe Labelin dialog box box, enter Chamfer.
3. Inthe Sketch Browser, do the following:
a. Double-click Chamfer constraint to open the chamfer properties.
b. Right-click Chamfer X, select Add Equation, and then enter =p2.
Enter the same value for Chamfer Y.
d. Repeat steps 4a-c for all the chamfers.

-4 Chamfer constraint

' ----- Charmfer type
- Chamfer = p2
“ Chamfer = P2

4. Save the sketched profile.

Example: Use the sketched profile in a model
Your sketched profile is now completed and you can use it in a model.
1. Double-click a part to open the part properties in the property pane.
2. Click the ... button next to the Profile box.
The Select Profile dialog box appears.

3. Open the Others branch at the end of the profile tree, and select the
CSHAPE profile.

4. If needed, modify the dimensions of the profile on the General tab.

General | Analysiz | User attributes

Frofile type

Prafile type: EI Uzer-defined. parametric

Frofile subtype: | CSHAPE B17h1*h2"P17P2

Property Syrnbal YWalue [t
Width b1 150,00 i
Height h1 300.00 mm
Height h F0.00 T
Thickness F1 20.00 mnm
Chamfer P2 10.00 mm

5. Click OK to apply the changes.
6. Pick points to place the part in the model.
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Create parametric profiles with variable cross sections

You can create parametric user-defined profiles with variable cross sections
using the Profile Editor. You can use a profile with variable cross sections like
any other parametric profile.

You can

+ use a cross section with different dimensions at different locations in a
profile

+ modify the variables of the cross sections and the profile

+ save the profile and use it as a parametric profile through the profile
catalog

« import and export variable cross section profiles

NOTE When you use this method, only the dimensions of a variable cross
section can vary, not the actual shape of the cross section. If you want
to use several different cross section shapes in the profile, create a
fixed profile (page 161) with multiple cross sections instead.

Create a profile with variable cross sections
Before you start:
+ Create a sketched profile (page 173) using the sketch editor.
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In the Variables dialog box in the sketch editor, set Visibility to Show for
the dimensions that you want to change when using the profile in a model.

1. On the File menu, click Catalogs --> Define properties --> Define profile
with variable cross section.

The Define Profile with Variable Cross Section dialog box opens.

2. Select the sketch you want to use as the start and end cross section of the
profile.

3. Click OK.

The Profile Editor and the Profile preview view appear.

| Profile: "UNNAMED" - (Profile preview) | = || @ |[w5s]

4. Under Cross sections of the profile, add cross sections or remove
selected cross sections by clicking Add or Remove.

When you click Add, Tekla Structures adds a new cross section at the end
of the profile, at the location 1.0., and moves the existing cross sections
towards the start of the profile. By default, cross sections are located at
0.1 intervals in the profile.

5. Under Cross section variables, define the following:
« The relative location of each cross section in the profile.

Use the *.Location variables. For example, start=0.00, middle=0.5,
end=1.00.

* How the cross sections are aligned in the horizontal and vertical
direction.

Use the *.HorPos and *.VerPos variables.
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* How much the cross sections are offset from the alignment.

Use the * .HorOffset and *.vVerOffset variables.

&3 Profile Editor "UNNAMED" [ -E] (=]
Cross sections of the profile Cross section variables
Manage cross section order Modify dimensions of the profile cross sections
G |Name Formuls Value  Valuetype Variabletype Visibility Lsbel in dislog box
Haka2 HAKALPL 0.00 0.00 Length Parameter  Show  Parameterl
Add HAKAL HorPos Middle Middle  Text Parameter  Hide Haorizontal position (Left, Middle, Right)
HAKAL VerPos Bottom  Bottom  Text Parameter  Hide Vertical position (Tep, Middle, Bottom)
Remaove HAKAL HorOffset  0.00 0.00 Length Parameter  Hide Horizontal offset
HAKAL VerOffset  0.00 0.00 Length Parameter  Hide Vertical offset
[HAKALLocation 000 000 ] Factor  Parameter Hide  Location (000 - 100)
HAKAZPL 0.00 0.00 Length  Parameter Parameterl
|AKA2 HorPos Middle Middle | Text Parameter  Hide Horizontal position (Left, Middle, Right)
EAKAIVEFPDS Bottom Eﬂttnm] Text Parameter  Hide Vertical position (Tep, Middle, Bottom)
AKAZ2 HorOffset 0,00 0.00 Length Parameter  Hide Horizontal offset
EAKM‘VerOﬁ‘set 0.00 0.00 ] Length Parameter  Hide Vertical offset
HAKAZ Location  1.00 1.00 Factor Parameter  Hide Location (0.00 - 1.00)
1 " "
Add variable| | Remove
I Save I l Save As J I Close I

6. If you have added new cross sections, check that they do not overlap any
existing cross sections.

7. Set Visibility to Show for the dimensions that you want to change when
using the profile in a model.

8. If you want to use parameter variables and equations to define the cross
section dimension, click Add variable and define the variable values.

9. Save the profile.
a. Click Save.
b. Inthe Save profile as dialog box, enter a unique name for the profile.

You cannot include numbers in the profile name, or use the name of
a standard profile.

c. Click OK.
Tekla Structures saves the profile in the current model folder.

Modify a profile with variable cross sections

1. On the File menu, click Catalogs --> Profile catalog to open the Modify
Profile Catalog dialog box.

2. Open the Others branch at the end of the profile tree.

3. Right-click a profile with variable cross sections, and then select Edit
profile to open the profile in the Profile Editor.

Modify the profile properties.
5. Click Save.
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Define standardized values for parametric profiles

You can define standardized values for the dimensions of parametric profiles.
The standardized values are visible in the profile catalog where you can select
suitable dimension values for the profiles.

1. Under ..\ProgramData\Trimble\Tekla Structures\<version>
\environments\<environment> folder, locate the
industry standard profiles.inp file. The exact file location may
vary depending on the folder structure of your environment files.

2. Openthe industry standard profiles.inp file using any standard
text editor, for example, Microsoft Notepad.

3.  Moaodify the file.
The file has the following format:
+ profile and profile subtype
* parameters separated by spaces
* units for each parameter
+ standardized values for each parameter.
Each dimension combination has its own row.

4. Save the file.

Example

For example, the standardized combinations of dimension values fora C
profile are as follows:

C h*b*t

b b T
mm mm mm
75 35 5
75 35 5
75 35 7
100 40 7
100 40 8
100 40 2!

Create an image of a profile

To illustrate the shape and dimensions of a profile you have created, you can
create an image of it. Tekla Structures displays the image when you browse for
profiles in the profile catalog. The image must be in Windows bitmap (.bmp)
format and can be created with any bitmap editor, for example Microsoft
Paint.
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1. Take a screenshot of the profile you have drawn or sketched.

For example, press the Print Screen (Prt Scr) key to take a screenshot of
your entire desktop. To take a screenshot of an active window, press Alt
+Print Screen. The screenshot is placed on the clipboard.

2. Open the screenshot in any bitmap editor (for example, Microsoft Paint)
and modify the image if necessary.

3. Savetheimagein .bmp formatinthe . .\ProgramData\Trimble\Tekla
Structures\<version>\Bitmaps folder.

The file name must match the actual profile name. For example, if the
profile name is mysketch, the image must be named mysketch. bmp.

4. Restart Tekla Structures.

The image is now shown in the profile catalog.

Profile bppe

Prafile type: EI Uzer-defined, parametric

Frofile subtype: MYSEETCH B19B2%h1*h2*F1

Pizture

ol

h1 :

i 1 he

4.10 Customize the shape catalog

The Shape Catalog dialog box contains information on shapes. It is used for
viewing shape properties, and for importing and exporting shapes.

The catalog includes default shapes, for example Default and
Concrete_Default. The shapes you download from Tekla Warehouse or create
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using existing geometry (page 204) in the currently open model are also
displayed in the Shape Catalog dialog box.

Shapes are used in defining items. In Tekla Structures, items are similar to
other parts, such as beams and columns. The main difference between items
and other types of parts is that a 3D shape defines the geometry of an item,
whereas a part has a 2D profile that is extruded to create the length of the
part.

The shapes listed in the shape catalog are stored in the current model folder.
There are two files for each shape: one . xm1 file stored in the \Shapes folder
and one .tez or .xml file in the \ShapeGeometries folder.

The shapes that are used for items in a model are automatically copied to the
model folder.

If you have shapes that you would like to have available in the Shape Catalog
dialog box for all new models that are created in your project or company,
copy the corresponding . tez and . xm1 files to the correct subfolders
(\Shapes and \ShapeGeometries)inthe \profil folder under your project
or firm folder.

NOTE If your project, company, or environment uses a common location for shapes
that are used in several Tekla Structures versions including 2017i and older,
use .xml format for shape geometry files. The compressed . tez files do not
work in Tekla Structures 2017i or older versions.

See also

Import a shape (page 203)

Create a shape (page 204)

Compress shape geometry files (page 206)
Clean shape geometry files (page 207)
Export a shape (page 208)

Delete a shape (page 208)

Import a shape

You can import the following types of shape files: dgn, tsc, skp, dxf, dwg,
ifc, ifcZIP, ifcXML, igs, iges, stp, and step.

When using other modeling software to model shapes that you want to import
into Tekla Structures, we recommend that you center parts around the origin
and direct the parts along the x axis.

1. Onthe File menu, click Catalogs --> Shape catalog.
The Shape Catalog dialog box opens.
2. Click Import.
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3. Select the shape file to import.

To select multiple shape files, hold down Ctrl or Shift.
4. Click OK.

Importing a large file can take several minutes.
Shape import has three possible results:

+ Tekla Structures imports the shape as a watertight solid shape. All solid
operations are available.

+ Tekla Structures imports the shape as a non-solid shape. A non-solid shape
means that the object may not be watertight. For example, it has holes, or
is missing a face or an edge.

« Import fails. This can happen, for example, if the shape is very complex or
has no volume. There may also be a tolerance difference between Tekla
Structures and the original software that was used to create the shape. To
find out why the import failed, check the session history log by clicking File
menu --> Logs --> Session history log .

When you import a shape into the Shape Catalog, Tekla Structures creates
two files: one . xm1 file for shape attributes, such as name and GUID, and
one . tez file for geometric properties, such as coordinates. The files are
saved in the current model folder under the \Shapes and
\ShapeGeometries subfolders.

The shape name that is shown in the Shape Catalog dialog box is determined
as follows:

+ Ifyouimport a . tsc file, the shape name is read from the imported file.
+ If you import other file types, the shape name is the name of the imported
file.

TIP You can also download shapes from Tekla Warehouse, or create shapes
using existing geometry (page 204) in Tekla Structures models.

See also

Example: Import a shape from SketchUp Pro (page 209)
Create a shape (page 204)

Compress shape geometry files (page 206)

Clean shape geometry files (page 207)

Export a shape (page 208)

Delete a shape (page 208)

Customize the shape catalog (page 202)
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Create a shape

In addition to importing item shapes or downloading them from Tekla
Warehouse, you can create shapes using existing geometry and parts in Tekla
Structures models. For example, you can create a shape using a single part or
several parts that have been attached to each other.

The part reference point that has the yellow handle determines the origin of
the shape. The positive global x direction determines the direction of the
shape. Later on when you create items using the shape, the shape origin and
direction will align with the yellow and magenta item handles.

Create a shape by using existing geometry in the model
Use this method if you want to create a new shape using an existing part, but
you do not want to delete the part or change it to an item.

1. Using parts, model the geometry from which you want to create a shape.

2. If you want to include more than one part in the shape, attach the parts to
each other.

3. Select the part.
4. Right-click and select Create shape from geometry.

Alternatively, you can go to Quick Launch, search for and select the
Create shape from geometry command, and then select the part.

Tekla Structures adds a new shape to the shape catalog (page 202) using the
part name as the shape name.

You can then use the shape when you create items in the model. You can also
modify items and shapes further in the Geometry editing mode.

Create a shape by converting a part to an item
When you change an existing part in the model to an item, Tekla Structures
also creates a new shape and adds it to the shape catalog.

When you change a part to an item, Tekla Structures deletes the original part
and replaces it with the newly created item in the model. The name, material,
finish, class, pour phase, and the numbering properties of the original part are
saved as the corresponding item properties. Other part type specific
properties and user-defined attributes are not saved. The objects that are
attached to the original part, such as reinforcement and surfaces, are deleted.

Curved beams, spiral beams, bent plates, lofted plates, and lofted slabs cannot
be changed to items.

1. Create the parts that you want to change to an item.

2. If you want to include more than one part in the item, attach the parts to
each other.

3. Select the part.
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4. Right-click and select Convert part to item.

Alternatively, you can go to Quick Launch, search for and select the
Convert part to item command, and then select the part.

Tekla Structures changes the part to an item and adds a new shape to the
shape catalog (page 202). The shape name is generated using the part name
and part location in the format <grid location>_<elevation>_<part name>. For
example:

* 1/D_+0_FOOTING
+ 3/C_+0-+3600_COLUMN
+ 1-2/A-B_+3600_SLAB

If there is already a shape with the same name in the shape catalog, Tekla
Structures adds two underscore characters and a running number at the end
of the new shape name. For example, 1/D_+0_FOOTING__1.

Compress shape geometry files

You can compress shape geometry files by converting the files from . xm1l
format to compressed format . tez. Using the . tez format saves disk space.

In Tekla Model Sharing models, the shape geometry files are automatically
converted from .xml to . tez when you use Tekla Structures 2018 or a newer
version.

In older versions and in models that are not shared, you can manually
compress the shape geometry files that are stored in the \ShapeGeometries
subfolder in the current model folder. The files in the \ Shapes subfolder will
not be compressed.

If you have already used any of the shapes for items in the model, they will
work the same way even after compression.

NOTE Compression is a permanent action, and you cannot undo it even if you do
not save the model.

Do not compress shape geometry files if you need them in models that you
will open using Tekla Structures 2017i or an older version. The . tez files do
not work in those versions.

If your project, company, or environment uses a common location for shapes
that are used in several Tekla Structures versions including 2017i and older,
do not convert those shape geometry files to . tez format. Otherwise the
shapes will not work in all versions.
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How to compress shape geometry files

To compress existing shape geometry files, either re-import the original shape
files (page 203), or use the Compress shape geometries application as
follows:

1. Open the model whose shape geometry files you want to compress.

2. Click the Applications & components button E in the side pane to
open the Applications & components catalog.

3. Search for the Compress shape geometries application, and then
double-click to open it.

4. Inthe Compress shape XML files to TEZ format dialog box, click
Compress.

5. Re-open the model.

Clean shape geometry files

If some previously imported shapes cause missing faces or edges in items or
drawings, you can clean the shape geometry files. Cleaning means that Tekla
Structures investigates and corrects the shape geometry and tries to create
solid objects. This is useful with shapes that have been imported to Tekla
Structures models prior to version 2018i.

The Shape cleaner application provides an option to create backups of the
original shape geometry files and to revert to them, if needed.

How to clean shape geometry files

To clean existing shape geometry files, either re-import the original shape files
(page 203), or use the Shape cleaner application as follows:

1.  Open the model whose shape geometry files you want to clean.

2. Click the Applications & components button E in the side pane to
open the Applications & components catalog.

3. Search for the Shape cleaner application, and then double-click to open
it.
The Shape cleaner dialog box opens.

4. Select the shapes that you want to clean.

5. If you want to create backups of the shape geometry files, select the
Create backups from shapes before cleaning check box.

6. Click Clean.
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Tekla Structures cleans the shapes and shows how many shapes resulted
in being solid objects and how many non-solid.

If you need to interrupt the cleaning process, you can click Stop.

Re-open the model to see the changed shape geometry in the items in the
model.

If you are not happy with the result, and if you have created the backup
files, you can go back to the original shape geometry files.

a. Open the Shape cleaner dialog box again.
b. Select the shapes that you want to restore.

c. Click Revert.

Export a shape

1.

6.

On the File menu, click Catalogs --> Shape catalog .
The Shape Catalog dialog box opens.

Select the shape to export.

To select multiple shapes, hold down Ctrl or Shift.
Click Export.

If you are exporting only one shape, select the folder where you want to
export the shape, and enter a name for the export file in the Selection
box.

If you are exporting multiple shapes, select the folder where you want to
export the shapes.

Tekla Structures will create a separate export file for each shape using the
shape name as the file name.

Click OK.

The shapes are saved in the destination folder as . tsc files.

TIP

You can also upload shapes to Tekla Warehouse.

See also

Import a shape (page 203)

Delete a shape (page 208)

Customize the shape catalog (page 202)
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Delete a shape

Before you start, ensure that the shape you want to delete is not used in your
Tekla Structures model. When you delete a shape from the Shape Catalog,
the shape is no longer available anywhere in the model. If a model includes a
deleted shape, it is only shown as a straight line between its original reference
points.

1. Onthe File menu, click Catalogs --> Shape catalog .
The Shape Catalog dialog box opens.

2. Right-click the name of the shape.

3. Click Delete.

Tekla Structures deletes the shape.

See also

Import a shape (page 203)

Export a shape (page 208)

Customize the shape catalog (page 202)

Example: Import a shape from SketchUp Pro
In this example, you import a solid 3D shape from Trimble SketchUp Pro to a
Tekla Structures model.
1. Create an empty model in SketchUp Pro.

Delete any extra entities, such as the default person on the drawing area.
2. Create a group of entities.

Although Tekla Structures supports importing separate individual entities,
we recommend you create a group of entities or a component in
SketchUp.

All SketchUp groups and components should form watertight solids.
Select the group or component and open Entity Info to check that the
selection is a solid. SketchUp solids have a volume. If there is no volume
listed, the selection is not a solid.

3. Select the group and click Solid Tools --> Union to make the group of
entities into a union of solids.

Your group becomes a single solid volume: a solid.

4. Place the solid in SketchUp so that it lies along the positive x axis (red),
and halfway on both y (green) and z axes (blue). In Tekla Structures, the
yellow and magenta part handles will align with the x axis used in
SketchUp.
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The location and rotation of the solid in SketchUp are important, since
they determine how an item is inserted and positioned in Tekla
Structures. Different positioning in SketchUp causes an offset in Tekla
Structures.

Save the SketchUp file.

In your Tekla Structures model, open the Shape Catalog and click Import.
Select the SketchUp file.

8. Click OK.

Tekla Structures imports the shape to the Shape Catalog and you can use it to
define the shape of an item or a concrete item.

N o w

See also
Customize the shape catalog (page 202)
Import a shape (page 203)

4.11 Customize the bolt catalog

The individual bolt assembly elements, such as bolts of different sizes and
lengths, nuts and washers, are listed in the bolt catalog. Each bolt assembly
then consists of these bolt assembly elements. You cannot use a bolt if it does
not belong to a bolt assembly. The bolt assemblies are listed in the bolt
assembly catalog.

Tekla Structures stores the bolt catalog information in the screwdb. db file
and the bolt assembly catalog information in the assdb. db file.

See also

How the bolt catalog and bolt assembly catalogs work together (page 211)
Manage bolts and bolt assemblies (page 211)

Import and export bolts and bolt assemblies (page 216)

Bolt length calculation (page 221)
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How the bolt catalog and bolt assembly catalogs work

together
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(1) The Bolt standard options are read from the bolt assembly catalog.

(2) The bolt assembly catalog defines which bolt standard is used in the bolt
assembly.

(3) The bolt catalog contains the different bolt diameters, lengths, and other
properties used in the bolt standard.

(4) The Bolt size options are read from the bolt catalog depending on the
selected Bolt standard option.

See also

Customize the bolt catalog (page 210)

Bolt catalog properties (page 224)

Bolt assembly catalog properties (page 226)
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Manage bolts and bolt assemblies

This section describes how to manage bolts and bolt assemblies using the bolt
catalog and the bolt assembly catalog. You can add, modify, and delete bolts
and bolt assemblies.

Click the links below to find out more:

Add a bolt to the catalog (page 212)

Add a stud bolt to the catalog (page 213)

Modify bolt information in the catalog (page 214)

Delete a bolt from the catalog (page 215)

Add a bolt assembly to the catalog (page 215)

Modify bolt assembly information in the catalog (page 216)
Delete a bolt assembly from the catalog (page 216)

Add a bolt to the catalog

You need to add individual bolt elements, such as bolts, nuts, and washers, to
the bolt catalog before you can define bolt assemblies and use them in a
model.

The following steps are for adding bolts, but they also apply to adding nuts
and washers.

1. Onthe File menu, click Catalogs --> Bolt catalog to open the Bolt
Catalog dialog box.

2. Enter the name of the bolt in the following box:

| Add || Update || Delete |

You can enter a maximum of 40 characters in the name box.

3. Inthe Type list, select an option to define the bolt element type.
Define the other properties of the new bolt.
You can enter a maximum of 25 characters in the Standard box.

Use different names for bolt, nut, washer, and stud standards to
distinguish bolt element types from each other when defining bolt
assemblies.

5. Click Add to add the bolt to the bolt catalog.

You cannot use a bolt if it does not belong to a bolt assembly. Therefore,
we recommend checking that the catalog also includes nuts and washers
that work with the new bolt so that you can create a bolt assembly. If the
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catalog does not include suitable nuts and washers, add them the same
way as you added the new bolt.

6. Click OK.
The Save confirmation dialog box appears.

7. Select Save changes to model folder to save the changes in the
screwdb.db file in the current model folder, and then click OK.

TIP  You can also add bolts by importing them to the bolt catalog.

See also

Import bolts to the catalog (page 217)

Add a stud bolt to the catalog (page 213)

Modify bolt information in the catalog (page 214)
Delete a bolt from the catalog (page 215)

Bolt length calculation (page 221)

Bolt catalog properties (page 224)

Add a bolt assembly to the catalog (page 215)

Add a stud bolt to the catalog

A stud is special type of bolt that is welded to steel parts to transfer loads
between steel and concrete. You cannot use studs unless you have defined a
stud assembly that contains the assembly's name and material.

1. Onthe File menu, click Catalogs --> Bolt catalog to open the Bolt
Catalog dialog box.

2. Enter values for the following properties:

+  Name: Name for the stud bolt.

+ Type:
« Standard: This name is needed when creating a bolt assembly for the
stud.

« Diameter: Shank diameter.
+ Length: Stud length.

+  Weight: Stud weight.

+ top thick: Head thickness.
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+ top diameter: Head diameter.

The units depend on the settings in File menu --> Settings --> Options -->
Units and decimals .

3. Onthe File menu, click Catalogs --> Bolt assembly catalog to open the
Bolt Assembly Catalog dialog box.

Select the standard for the stud bolt.

5. Setall the other bolt assembly elements to None.

Mone -

STUD - —l_V |
Dl

Mone - —] . LLI—

Mone -

6. To create studs in the model, create bolts and select the stud assembly
standard.

See also
Bolt catalog properties (page 224)

Modify bolt information in the catalog

1. Onthe File menu, click Catalogs --> Bolt catalog to open the Bolt
Catalog dialog box.

Select a bolt from the list.
Modify the properties.
Click Update.

Click OK.

The Save confirmation dialog box appears.

vk W

6. Select Save changes to model folder to save the changes in the
screwdb.db file in the current model folder, and then click OK.

See also

Add a bolt to the catalog (page 212)
Delete a bolt from the catalog (page 215)
Bolt catalog properties (page 224)
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Delete a bolt from the catalog

1.

On the File menu, click Catalogs --> Bolt catalog to open the Bolt
Catalog dialog box.

2. Select a bolt from the list.
Use the Shift and Ctrl keys to select multiple bolts.
3. Click Delete.
Click OK.
The Save confirmation dialog box appears.
5. Select Save changes to model folder to save the changes in the
screwdb.db file in the current model folder, and then click OK.
See also

Add a bolt to the catalog (page 212)

Modify bolt information in the catalog (page 214)

Add a bolt assembly to the catalog
You can add new bolt assemblies to the bolt assembly catalog. Note that the
bolt assembly can contain only bolts or studs, not both of them.

1.

On the File menu, click Catalogs --> Bolt assembly catalog to open the
Bolt Assembly Catalog dialog box.

2. Enter the name of the bolt assembly in the following box:
| Add || Update || Delete |
3. Define the other properties of the new bolt assembly.
You can enter a maximum of 30 characters in the Standard box. For all
the other properties, you can enter a maximum of 25 characters.
4. Click Add to add the bolt assembly to the catalog.
5. Click OK.
The Save confirmation dialog box appears.
6. Select Save changes to model folder to save the changes in the
assdb.db file in the current model folder, and then click OK.
See also

Import bolt assemblies to the catalog (page 218)

Modify bolt assembly information in the catalog (page 216)
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Delete a bolt assembly from the catalog (page 216)
Bolt assembly catalog properties (page 226)

Modify bolt assembly information in the catalog

1. Onthe File menu, click Catalogs --> Bolt assembly catalog to open the
Bolt Assembly Catalog dialog box.

Select a bolt assembly from the list.

Modify the properties (page 226).

Click Update.

Click OK.

The Save confirmation dialog box appears.

ik N

6. Select Save changes to model folder to save the changes in the
assdb.db file in the current model folder, and then click OK.

See also

Add a bolt assembly to the catalog (page 215)
Delete a bolt assembly from the catalog (page 216)
Bolt assembly catalog properties (page 226)

Delete a bolt assembly from the catalog

1. Onthe File menu, click Catalogs --> Bolt assembly catalog to open the
Bolt Assembly Catalog dialog box.

2. Select a bolt assembly from the list.
3. Click Delete.
4. Click OK.
The Save confirmation dialog box appears.

5. Select Save changes to model folder to save the changes in the
assdb.db file in the current model folder, and then click OK.

See also
Add a bolt assembly to the catalog (page 215)
Modify bolt assembly information in the catalog (page 216)
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Import and export bolts and bolt assemblies

Use importing and exporting for merging bolts and bolt assemblies across
catalogs. Bolts are imported and exported as .bolts files, bolt assemblies
as .bass files, and bolt catalogs as . 1is files.

When you export single bolts or bolt assemblies, you can select the bolts or
bolt assemblies you want to include in the .bolts or .bass file. When you
import and export bolt assemblies, also the related bolts are included in
the .bass file.

You can import and export an entire bolt catalog. You can also import a part of
an exported bolt catalog.

Importing and exporting bolt catalogs is useful, when you:

+ Upgrade to newer version of Tekla Structures and you want to use a
customized bolt catalog from a previous version.

+  Want to combine bolt catalogs that are stored in different locations.

+  Want to share bolt catalog information with other users.

TIP You can also download or share bolt assemblies using Tekla Warehouse.

See also

Import bolts to the catalog (page 217)

Export bolts from the catalog (page 218)

Import bolt assemblies to the catalog (page 218)
Export bolt assemblies from the catalog (page 219)
Import a bolt catalog (page 219)

Import a part of the bolt catalog (page 220)

Export an entire bolt catalog (page 221)

Import bolts to the catalog

Bolts are imported and exported as .bolts files. A .bolts file can include
one bolt or several bolts.

1. Onthe File menu, click Catalogs --> Bolt catalog to open the Bolt
Catalog dialog box.

Right-click in the Bolts list and select Import.

Select the import file.

Click OK.

The bolts are displayed on the Bolts list by their original names.
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5. Click OK.
The Save confirmation dialog box appears.
6. Select Save changes to model folder to save the changes in the
screwdb.db file in the current model folder, and then click OK.
See also

Add a bolt to the catalog (page 212)

Import a bolt catalog (page 219)

Import a part of the bolt catalog (page 220)

Import bolt assemblies to the catalog (page 218)

Export bolts from the catalog (page 218)

Export bolts from the catalog

Bolts are imported and exported as .bolts files. A .bolts file can include
one bolt or several bolts.

1.

3
4.
5
6

On the File menu, click Catalogs --> Bolt catalog to open the Bolt
Catalog dialog box.

Select bolts from the Bolts list.

Use the Shift and Ctrl keys to select multiple bolts.
Right-click in the Bolts list and select Export.

Browse for the folder where you want to save the export file.
Enter a name for the file in the Selection box.

Click OK.

See also

Export bolt assemblies from the catalog (page 219)

Export an entire bolt catalog (page 221)

Import bolts to the catalog (page 217)

Import bolt assemblies to the catalog

Bolt assemblies are imported and exported as .bass files. A .bass file can
include one bolt assembly or several bolt assemblies.

1.

2.

On the File menu, click Catalogs --> Bolt assembly catalog to open the
Bolt Assembly Catalog dialog box.

Right-click in the Bolt assemblies list and select Import.
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3. Select the import file.
4. Click OK.

The bolt assemblies are displayed on the Bolt assemblies list by their
original names.

5. Click OK.
The Save confirmation dialog box appears.

6. Select Save changes to model folder to save the changes in the
assdb.db file in the current model folder, and then click OK.

See also

Add a bolt assembly to the catalog (page 215)
Import a bolt catalog (page 219)

Import bolts to the catalog (page 217)

Export bolt assemblies from the catalog (page 219)

Export bolt assemblies from the catalog

Bolt assemblies are imported and exported as .bass files. A .bass file can
include one bolt assembly or several bolt assemblies.

1. Onthe File menu, click Catalogs --> Bolt assembly catalog to open the
Bolt Assembly Catalog dialog box.

2. Select bolt assemblies from the Bolt assemblies list.
Use the Shift and Ctrl keys to select multiple bolt assemblies.
Right-click in the Bolt assemblies list and select Export.

Enter a name for the file in the Selection box.

3
4. Browse for the folder where you want to save the export file.
5
6. Click OK.

See also

Export an entire bolt catalog (page 221)

Export bolts from the catalog (page 218)

Import bolt assemblies to the catalog (page 218)

Import a bolt catalog
Bolt catalogs are imported to Tekla Structures models as . 11is files.

1. Open the model to which you want to import a bolt catalog.
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2. Copy the screwdb. lis file that you want to import to the current model
folder.

3. Toimport the bolt catalog file screwdb.1is from the current model
folder, go to Quick Launch, start typing import bolt catalog, and
select the Import Bolt Catalog command from the list that appears.

Tekla Structures does not replace the entries that have the same names
as the entries in the import file.

4. Check the status bar for error messages.

To view errors, go to the File menu and click Logs --> Session history
log .

See also
Import a part of the bolt catalog (page 220)
Export an entire bolt catalog (page 221)

Import a part of the bolt catalog
If you do not want to import the entire bolt catalog, you can select the parts to
be imported.

TIP If you only want to import a few bolts or bolt assemblies, use the import
and export commands of the corresponding catalogs.
1. Open the model that contains the bolt catalog you want to use.

2. Go to Quick Launch, start typing export bolt catalog, and select the
Export Bolt Catalog command from the list that appears.

The bolt catalog is saved as the screwdb. 1is file in the current model
folder.

3. Openthe screwdb. 1is file using a text editor, for example, Microsoft
Notepad.

Each entry is listed on a separate row.

4. Delete the unwanted rows from the file.
WARNING Do not delete the STARTLIST and ENDLIST rows.
5. Save the file with the name screwdb.1lis.

6. Open the model to which you want to import the bolt catalog.

7. Copy the screwdb. 1is file that you want to import to the current model
folder.
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8. Toimport the bolt catalog file screwdb.1is from the current model
folder, go to Quick Launch, start typing import bolt catalog, and
select the Import Bolt Catalog command from the list that appears.

See also

Import bolts to the catalog (page 217)

Import bolt assemblies to the catalog (page 218)
Import a bolt catalog (page 219)

Export an entire bolt catalog (page 221)

Export an entire bolt catalog
Bolt catalogs are exported from Tekla Structures models as . 11is files.

1. Open the model that contains the bolt catalog you want to export.

2. Go to Quick Launch, start typing export bolt catalog, and select the
Export Bolt Catalog command from the list that appears.

The exported bolt catalog is the screwdb. 1is file in the current model
folder.

TIP The Export Bolt Catalog command exports the entire bolt catalog.
To export only part of the bolt catalog, modify the export file to
contain only the required elements. You can also export bolts from
the Bolt Catalog dialog box or bolt assemblies from the Bolt
Assembly Catalog dialog box.

See also

Export bolt assemblies from the catalog (page 219)
Export bolts from the catalog (page 218)

Import a bolt catalog (page 219)

Import a part of the bolt catalog (page 220)

Bolt length calculation

Tekla Structures uses values from the bolt catalog and the bolt assembly
catalog when calculating the bolt length. If the bolt catalog does not contain
long enough bolts for your purposes, you need to add them to the bolt
catalog.
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The following Assembly settings in the Bolt properties affect the bolt length
calculation process. If the check box is selected, the bolt element is used in the
bolt assembly.

Bolt assembly Bolt elements

1: If the check box is clear, only a hole
is created

2: Washer (1)
3: Washer (2)
4: Washers (3)
5: Nut (1)

6: Nut (2)

The chart and the detailed steps below explain the process of bolt length
calculation.

Start
v

Tekla Structures caleulates the minimum
possible bolt length

¥

Tekla Structures finds the closest match
in the bolt catalog

.

Tekla Structures calculates the number of washers required

.

-
Is the bolt long enough? ]7
k

O,

h 4 h

[ Can the thread be inside the material? ! ’| Find the next closest match in the bolt catalog

Y

End

")

1. Tekla Structures calculates the minimum possible length of the bolt as
follows:

washer (1) thickness (if the check box is selected) +
material thickness +

washer (2) thickness (if the check box is selected) +
washer (3) thickness (if the check box is selected) +
nut (1) thickness +
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nut (2) thickness +
extra length
2. Tekla Structures searches for the closest match in the bolt catalog.

3. Tekla Structures calculates the number of washers required (must not
exceed 10) so that the length of the shaft is less than:

nut (1) thickness +
material thickness +
nut (2) thickness +
washer (1) thickness +
washer (2) thickness +
(number of washers*washer (3) thickness)
4. Tekla Structures checks that the bolt found in step 2 is longer than:
extra length +
nut (1) thickness +
material thickness +
nut (2) thickness +
add. dist (from the bolt catalog) +
washer (1) thickness +
washer (2) thickness +
(number of fitting washers * washer (3) thickness)

5. If the selected bolt does not fulfill the criteria in step 4, Tekla Structures
returns to step 2, otherwise it continues on to step 6.

6. Tekla Structures checks that the selected bolt fulfills all the following
conditions:

« Can the thread be inside the material to be connected? Even if this is
not allowed, the calculation always allows 3 or 4 mm of thread to be
inside the material, depending on the bolt diameter. If the bolt
diameter is = 24 mm, it allows 4 mm, otherwise it allows 3 mm.

+ Shaft length must be more than:
material thickness +
extra length +
washer (1) thickness (if checked) -

maximum thread in material allowed (if thread in material = no) =
3mmor4 mm

« Shaft length is calculated as:

Screw length - screw thread length - thread end.
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+ Thread end is the part of the bolt between the shaft and the thread. It
is calculated as follows:

Diameter of bolt (mm) Thread end (mm)
>33.0 10.0
>27.0 8.0
>22.0 7.0
>16.0 6.0
>12.0 5.0
>7.0 4.0
>4.0 2.5
<4 1.5

7. If the selected bolt does not fulfill all the above conditions, Tekla
Structures returns to step 2 and tries the next longest bolt.

8. Ifthe advanced option XS BOLT LENGTH EPSILON is set, the epsilon
thickness is added to, or subtracted from, the material thickness to avoid
inaccurate bolt length calculation.

For example, if this value is not taken into account, and the calculated
length is 38.001 mm, a 39 mm bolt might be selected.
See also
How the bolt catalog and bolt assembly catalogs work together (page 211)
Add a bolt to the catalog (page 212)

Bolt catalog properties

Use the Bolt Catalog dialog box to view and modify the properties of
individual bolt elements, such as bolts, washers, and nuts. The units depend
on the settings in File menu --> Settings --> Options --> Units and decimals .

Option Description

Type The type of the bolt element. The options are:

H—mmm
(From
[—m
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Option

Description

@@ (Nut)
@” (Washer)

D: (Stud)

Standard

The name of the bolt element standard.

Used in the Bolt Assembly Catalog dialog box for defining bolt
elements in a bolt assembly.

Use different names for bolt, nut, washer, and stud standards to
distinguish bolt element types from each other.

Diameter

The diameter of the bolt element.

Length

The length of the bolt element.

Weight

The weight of the bolt element.

add. dist

The length of the part of the bolt that protrudes from the nut.
The value is used in bolt length calculation.

top thick

The thickness of the bolt head.

thread len

The length of the threaded part of the bolt shaft.

The value is not used in bolt length calculation (value is 0) if the
bolt is fully-threaded.

washer tol

The tolerance between the washer inner diameter and the bolt
diameter.

The value is used when searching for the correct-sized washer
for the bolt. Not used in bolt length calculation.

span size

The size of the wrench needed.

calc thick

The calculation thickness of a nut or a washer.

This value is used in bolt length calculation.

real thick

The true thickness of a nut or a washer.

This is for information only.

inner diam

The inner diameter of a nut or a washer.

This is for information only.

outer diam

The outer diameter of a nut or a washer.

This is for information only.
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Option Description

top diam The diameter of the hexagon.

©
\~/

This is for information only.

See also
Add a bolt to the catalog (page 212)
How the bolt catalog and bolt assembly catalogs work together (page 211)

Bolt assembly catalog properties

Use the Bolt Assembly Catalog dialog box to view and modify the properties
of bolt assemblies. The units depend on the settings in File menu --> Settings
--> Options --> Units and decimals .

Option Description

Short name | This name is used in drawings and reports. It is usually the
commercial name for a specific bolt.

Standard This name is the full name which is shown in the bolt
assembilies list in the Bolt Assembly Catalog dialog box, and
in the Bolt standard list in the Bolt Properties dialog box.

The value is used in bolt length calculation.

Material The material of the bolt assembly.
Finish The type of the finish.

Grade The grade of the bolt assembly.
Tolerance The tolerances of the bolt assembly.

This is for information only. The values cannot be reported, for
example.

Additional length for bolt calculation

Option Description

Add. dist... The Additional Distance option controls how much of the
bolt protrudes from the nut.

Additional Distance updates the Additional Distance values
of all bolts that use the selected bolt standard and have the
selected diameter.

The value is used in bolt length calculation.
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&= Additional Distance ==
1 Select all®
@) Diam = 12 |:|

j]m-“m 7990 -

LL 0.00 @
Add. dist= value ®v

o) Cisone ]

@ Select whether the value of the additional length affects
all or individual diameters of one bolt assembly.

@ Enter the additional length value.

@ Select whether the value is absolute or relative to the
diameter.

See also

Add a bolt assembly to the catalog (page 215)

4.12 Customize the rebar catalog

The rebar catalog contains definitions for different reinforcement types, such
as reinforcing bars and strands of different grades.

The rebar catalog shows standard, environment-specific reinforcing bars and
strands of the environment (or environments) that you have installed and that
is currently open. The blank project environment only contains undefined
reinforcing bars and strands.

You can add, copy, group, modify, and delete rebar definitions. You can also
import and export single definitions, groups of definitions, or entire rebar
catalogs.

Tekla Structures stores the rebar catalog information in the
rebar database.inp file thatis by default saved to the current model
folder.

Reinforcement meshes are not included in the rebar catalog. Standard meshes
are defined in their own catalog file (page 296), mesh database.inp.
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Work with definitions in the rebar catalog
You can add, copy, modify, and delete rebar definitions in the rebar catalog.

To use the newly added or modified rebar definitions in the model, reopen the
model.

Add a new rebar definition
You can add new definitions to the rebar catalog by defining the bar
properties from scratch.

1. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

2. Click ﬂ New bar.

3. Inthe New bar dialog box, enter the bar properties.

If a property is shown in red, it is missing a value or has a value that is not
valid. For example, Grade and Size must have a value.

4. Click Add.

1
5. Click H Save to save the changes to the rebar catalog.

Add a new rebar definition by copying
You can add new definitions to the rebar catalog by copying an existing
definition and then modifying it.

1. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

2. Browse for and select the definition that you want to copy.

za
3. Click Copy.

Alternatively, you can right-click and select Copy.
4. Inthe Copy dialog box, enter or modify the bar properties.

Modify the property values that are shown in red so that the new
definition is not a duplicate of the original definition.

5. Click Add.

i
6. Click H Save to save the changes to the rebar catalog.
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Select rebar definitions
You can use the following methods when you select rebar definitions in the
Rebar catalog dialog box.

Selecting different sets of definitions is useful when you want to export
(page 232) or add tags (page 236) to certain definitions, or otherwise modify a
sub-set of definitions.

+ Use the following commands on the catalog ribbon:
+ Click Select all to select all the definitions in the currently visible group.
Alternatively, you can select one definition and then press Ctri+A.
+ Click Select none to clear the current selection.

+ Click Invert selection to select the currently unselected definitions and
to deselect the currently selected definitions.

« To select several consecutive definitions, select the first definition, then
hold down Shift and select the last definition.

« To select several non-consecutive definitions, select the first definition,
then hold down Ctrl and select the other definitions.

Modify a rebar definition

1. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

2. Browse for and select the definition that you want to modify.

To modify several definitions, hold down Ctrl or Shift when you select
(page 229).

3. Inthe property area on the right side of the Rebar catalog dialog box,
modify the bar properties.

For example, you can select whether the bar is a main bar, or a tie or
stirrup. You may also want to add tags (page 236) to the bar.

If a property is shown in red, it is missing a value or has a value that is not
valid. For example, Grade and Size must have a value.

i
4. C(lick H Save to save the changes to the rebar catalog.

Delete rebar definitions

1. On the File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

2. Select (page 229) one or more rebar definitions.

3. Right-click and select Delete.
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4. Click Yes to confirm the deletion.

L
5. Click H Save to save the changes to the rebar catalog.

Work with groups in the rebar catalog

In the rebar catalog, the rebar definitions are arranged to groups. You can
add, copy, modify, and delete groups, and arrange the groups according to
different properties. The groups are listed on the left side of the Rebar
catalog and Select rebar dialog boxes.

Rebar catalog
HOME
|
I'l E] ﬂ i ¢ : k- Select all
= %— @ Show columns - | |
n L] K Select
Save Group by Mew bar Copy ; Import Export Elect none
- |:= Fit columns - k Invert selection
(S Stared ) STAR CODE GRADE  SIZE &4 USAGE NOMINAL ACTUAL BENDING
U 14301 B4 ASDOHW 6 main 6.00 3.00 72.00
J 1.4404 B4 ASDOHW 6 tie/stirrup ~ 6.00 3.00 12.00
T0/167!
L 1470/1670 B4  ASO0HW 8 main 8.00 1000 96.00
157041770
B4 ASDOHW 8 tie/stirup  8.00 10.00 1600
L 1630/1860
A B4 ASO0HW 10 main 10.00 12.00  120.00
ASO0HW B4 ASO0HW 10 tie/stirrup 10,00 12.00  20.00
L AlSI304 B4 ASOOHW | 12 main 12.00 1400  144.00
(Y o
B4 ASOOHW | 12 tie/stirup 12,00 1400 30.00
Kl_l B500A J

By default, the definitions in the rebar catalog are grouped according to
reinforcement grades. You can change how the definitions are grouped
(page 234) in the Rebar catalog dialog box or in the Select rebar dialog box.

To use the newly added or modified rebar definition groups in the model,
reopen the model.

Add a new group to the catalog
You can create new groups in the rebar catalog by copying an existing group
and the definitions contained in it.

1. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.
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2. Onthe left side of the dialog box, select a group, and then click L]
Copy.
Alternatively, you can right-click a group and select Copy.

3. Inthe New group name dialog box, enter a name for the new group, and
then click Copy.

Tekla Structures adds the new group to the catalog.

4. Add, modify, and delete definitions (page 228) contained in the new group
as needed.

L
5. Click H Save to save the changes to the rebar catalog.

Modify a group in the catalog

1. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

2. Select the group that you want to modify.
3. Select all definitions in the group.

4. Inthe property area on the right side of the Rebar catalog dialog box,
modify the group properties.

For example, you can change the grade or cranked length type. You may
also want to add tags (page 236) to all definitions in the group.

1
5. Click H Save to save the changes to the rebar catalog.

Delete a group from the catalog
You can delete groups and the definitions contained in them from the rebar
catalog.

1. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

Select a group from the list on the left side of the dialog box.
Right-click and select Delete.
Click Yes to confirm the deletion.

i
5. Click H Save to save the changes to the rebar catalog.

Create and distribute customized configurations 231 Customize the rebar catalog



Import and export rebar definitions

Use importing and exporting for merging rebar definitions across different
catalogs, models, and Tekla Structures environments and versions. To use
reinforcing bars and strands in other Tekla Structures models, you can export
rebar definitions to a file (*. inp), and then import the file into another Tekla
Structures model.

TIP You can also download or share rebar catalog content using Tekla Warehouse.

Import definitions to the rebar catalog
You can customize the rebar catalog by importing rebar definitions from
an .inp file.

1. Open the model to which you want to import rebar definitions.

2. On the File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

3. Click I «

In the Import rebar definitions dialog box, browse for the folder that
contains the import file, select the file, and then click Open.

Import.

Tekla Structures checks if there are duplicates in the definitions in the
import file compared to the rebar catalog.

5. If rebar definitions with the same properties as the definitions being
imported already exist in the rebar catalog, a confirmation dialog box
appears and you have the following three options:

+ Click Overwrite to replace all existing definitions with the newly
imported definitions.

+ Click Keep existing to discard the duplicate definitions being imported
and to only import the new definitions.

+ Click Cancel to not to import any definitions.

L
6. Click H Save to save the changes to the rebar catalog.

7. To use the newly imported definitions in the model, reopen the model.

Export definitions from the rebar catalog
You can export all or selected rebar definitions, or a selected group of a rebar
catalog to afile (. inp).

1. Open the model from which you want to export rebar definitions.
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2. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

3. Do one of the following:

| =

+ To export a certain group only, select the group, right-click and select
Export.

+ To export the entire catalog, click Export --> Export all.

+ To export certain definitions only, select the definitions (page 229) and

| =

Alternatively, you can right-click on one of the selected definitions and
then select Export.

then click Export --> Export selected.

4. Inthe Export as dialog box, browse for a folder, enter a name for the
export file, and then click Save.

By default, Tekla Structures saves the file to the current model folder.

The file name extension is . inp.

Organize the rebar catalog view

You can organize the rebar catalog view in the Rebar catalog dialog box to
suit your needs and ways of working. For example, you can change how the
rebar definitions are grouped, hide certain property columns, or change the
order of the property columns. You can also filter definitions and mark them
with stars and tags.

Some of these methods work the same way also in the Select rebar dialog
box; grouping by some of the properties, showing and hiding property
columns, changing the order of the columns, filtering, and starring. The Select
rebar dialog box opens when you click the ... button next to the Size box in a
reinforcement object's properties, or in a component dialog box to select a
rebar definition.

The status bar at the bottom of the Rebar catalog and Select rebar dialog
boxes shows useful information, such as:

* The number of definitions in the selected group.
* The property by which the definitions are grouped.
* The property by which the definitions are sorted.

The arrow symbol indicates if the sort order is ascending * or descending

v
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In the Rebar catalog dialog box, the status bar also shows the number of the
selected definitions.

The changes you make to the dialog box layout are automatically saved to the
rebar catalog.settings.UI fileinthe ..\Users\<user>\AppData
\Local\Trimble\Tekla Structures\<version>\Catalogs\ folder. Tekla
Structures will use the saved layout next time you open the dialog box.

Show or hide the catalog ribbon
If needed, you can show or hide the ribbon in the Rebar catalog dialog box
and in the Select rebar dialog box.

By default, the ribbon is shown in the Rebar catalog dialog box, but hidden in
the Select rebar dialog box.

+ To show the ribbon, click the down arrow ¥ at the right end of the (Home)
ribbon title bar.

* To hide the ribbon, click the up arrow # at the right end of the (Home)
ribbon title bar.

Change the grouping of rebar definitions
You can select the property by which the rebar definitions are grouped in the
rebar catalog. By default, the rebar definitions are grouped by grade.

1. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

Alternatively, you can use the Select rebar dialog box.

2. Click B Group by, and then select the property by which you want to
group the rebar definitions.

The definitions can be grouped by the properties whose property
columns are visible. For example, you can select Size or Cross section
area.

The properties that are available may vary in the Rebar catalog and
Select rebar dialog boxes.

Work with property columns in the catalog view

You can organize the rebar catalog view in the Rebar catalog dialog box and
in the Select rebar dialog box by showing and hiding the property columns,
and by changing the order, sort order, and width of the columns.
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Create and distribute customized configurations

The Star column is always visible and you cannot hide it.

To

Do this

Show or hide a property column

Click © Show columns to open
a list of the available property
columns.

A check mark in front of a column
name indicates that the column
is visible.

2. Toshow a column, click the
column name to add a check
mark in front of the column
name.

3. To hide a column, click the
column name to remove the
check mark.

Change the order of the property
columns

Drag a column header to a new
location.

Change the sort order of a property
column

Click the column header.

The arrow symbol next to the column
header indicates if the sort order is

ascending * or descending ¥ .

To sort values by two properties and
in two columns:

1. Sort by one column.

2. Hold down Shift and then sort by
the other column.

Resize a property column

Drag the edge between this and the
following column header. For
example:

GRADE <(=DSIZE
In the Rebar catalog dialog box, you

can also click ' Fit columns to
adjust the widths of the visible
columns so that the longest value in
each column is shown.

Filter rebar definitions

You can filter rebar definitions in both the Rebar catalog dialog box and the
Select rebar dialog box. You can use filtering together with the other
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methods, such as sorting, to narrow down the number of definitions shown in
the rebar catalog view.

1. On the File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

Alternatively, you can use the Select rebar dialog box.
2. Inthe Filter box, enter the search term or filtering criteria.

For example, to find rebar definitions that are suitable for stirrups and
ties, enter tie.

Tekla Structures shows the definitions that have Usage set to tie/stirrup.

Add stars to rebar definitions

You can mark important or preferred rebar definitions with stars, so that you
can easily find these definitions later. The definitions that are marked with
yellow stars appear in the Starred group in the rebar catalog. Starring is user-
specific, so it is only visible to you.

The starring settings are stored in the current model folder in the
rebar catalog.settings.user.<username> file, where the <username>
suffix is your username.

If you have starred definitions, the Rebar catalog dialog box opens with the
Starred group selected.

1. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

Alternatively, you can use the Select rebar dialog box.
2. Browse or search for the definitions that you want to mark with stars.

3. Inthe definition list, click the white star symbol in the Star column for
each definition that you want to add to the Starred group.

By default, the Star column is the first column and the star symbol is at
the beginning of each definition row.

STAR  CODE GRADE SIZE
B4 ASOOHW 10

The star symbol turns yellow and the definition is added to the
Starred group.

4. To remove the starring from a definition, click the yellow star symbol on
the definition row.

The star symbol turns white again and the definition is removed from the
Starred group.
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Add tags to rebar definitions
In the Rebar catalog dialog box, you can add tags to rebar definitions. You
can use tags to add keywords or other metadata to the definitions.

For example, you could use tags like stainless and Acid proof.

Tags are model-specific and saved to the rebar catalog.settings filein
the current model folder.

1. Onthe File menu, click Catalogs --> Rebar catalog to open the Rebar
catalog dialog box.

Select the definitions (page 229) that you want to tag.

Enter the tag in the Tags box at the bottom-right corner of the Rebar
catalog dialog box, and then press Enter.

To add several tags to a definition, enter the next tag in the next tag box
and press Enter.

Each group of tagged definitions appears with the A g symbol in the list of
groups, after the Starred group:

Rebar catalog

HOME

W E

Save Group by Mew bar

-

i Starred
‘ Tag1l

J 1.4301
) 1.4404

4. Toremove a tag from a definition, select the definition and click the X
symbol after the tag name in the Tags section in the property area.

5. To delete a tag completely, select the tagged group, select all the
definitions in the group, and then click the X symbol after the tag name in
the Tags section in the property area.

1
6. Click H Save to save the changes to the rebar catalog.
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4.13 Customize the Applications & components catalog

You can modify the catalog definition settings of the Applications &
components catalog using catalog definition files, and set up a group
structure to suit the needs of your company. Always check the settings and the
group structure when upgrading to a new Tekla Structures version.

Catalog definition files (ComponentCatalog.xml) can be located in folders
pointed by XS_SYSTEM, XS_FIRM, XS_PROJECT, and in the model folder. If there
are several catalog definition files, Tekla Structures combines the information
in the files. For more information on the folder search order, see Folder search
order (page 334).

When you create a group structure for the Applications & components
catalog, define the highest level structure in a catalog definition file that is
located in a folder pointed by xs SYSTEM. To hide unnecessary parts of the
group structure and catalog content from certain roles, edit the catalog
definition files of these roles.

For general instructions on how to use the Applications & components
catalog, see How to use the Applications & components catalog.

Edit the catalog

1. Setthe XS_COMPONENT_CATALOG_ALLOW_SYSTEM_EDIT advanced
option to TRUE to edit the catalog definition files.

2. Inthe Applications & components catalog, click E Access advanced
features > Catalog management > Edit mode, and select the catalog
definition file that you want to edit.

The list of files shows all the environment folders, the project and firm
folders if defined, and the model folder. You can define the needed
catalog definition file folder paths in xS SYSTEM.

If XS COMPONENT CATALOG ALLOW SYSTEM EDIT is not setto TRUE, a
small warning icon is shown next to the files in the xs sysTEM folder
locations. The image shows warning icons next to the files that appear
dimmed.
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3. Select the file that you want to edit.
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The check mark in front of the folder name shows the file that is currently
being edited.

[Expand all
Collapse all

Define custorn companent.

Impost custom component...

[Edit custom component

[Ede custom campanent disleg bex
Convert to detailing companient
[Explode companent

New macmo

Recard macre

Manage extensicns

Catalog management

- v - =

DehFirems folder
» [DE\Project folder
CATekbSructuresMedels Mew madel 212

4. Create new groups and subgroups to organize the catalog content, right-
click in the catalog and select New group....

5. Move the content from Ungrouped items to the new groups, or to other
predefined custom groups. To move an item to another group, right-click
the item, select Add to group, and then select the target group.
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It is important to keep the Ungrouped items group empty, because all
items downloaded from Tekla Warehouse are placed in that group. When
you place an item to a predefined group, it is automatically removed from
the ungrouped items.

For instructions on how to collect content to a group and publish itas a
catalog definition file, see .
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Maintain the catalog

To keep the Applications & components catalog structure and content clear
and in order, keep the groups up to date and organized, and remove the
unnecessary items from the catalog definition files.

1. Click @ in the bottom-right corner in the Applications & components
catalog to display the message log:

If an item defined in a catalog definition file is removed from the Tekla
Structures software, the removed item will be included in the
Applications & components catalog error message log.

2. Ifthe log contains references to missing items, edit the relevant
ComponentCatalog.xml file to remove the references manually.

We recommend that you make a back-up copy of the file before you start
editing.
CompenentCacalogltemPlacenciders

tringrCatalogMacroModalingltem?CreateSurfaceView?GLOBALL/ IcemIdString>

| <Compons

«</ComponentCacalogitemPlaceholders
| <ComponentCacalogltemPlaceholders Delete selected lines for each missing plugin
<ItemIdScring>CatalogPloginComponentItem?CopyModelDi rectoryPloging/ ItemIdScrings
</ComponentCacalogicemPlacenolders>
| <CamponentCacalaglitemPlaceholders>

ataloglcemPlaceholders>
CatalagltemPlacehaldars
<ItemldStringrCatalogMacrododal inglten?CloseTemporaryViews ?GLOBAL:/ ItenldStrings

3. Test thoroughly that these changes do not create any further errors, or
mess up the group structure in the Applications & components catalog.
Check at least the Ungrouped items and Legacy catalog groups.

4. Newly added items are placed in the Ungrouped items group. If there are
new items in the group, move them to the appropriate predefined groups,
and hide them from specific roles, if needed.

5. Add suitable thumbnails to the items, if needed.
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5 Files and folders in Tekla
Structures

Sometimes you need to know where Tekla Structures stores information, and
the types of files that Tekla Structures contains, where the files are located,
and how the files should be should be used.

Tekla Structures contains a large amount of files that affect the way the
software works. It is important to know which file controls which functionality,
and also which files we do not recommend that you touch.

The initialization file reading order is also very important. You need to know
the order in which the files are read when you open Tekla Structures, so that
you do not modify the files unnecessarily.

See also

Initialization files (.ini files) (page 246)

Input files (.inp files) (page 276)

File storing options and advanced options (page 254)
Data files (.dat files) (page 290)

Message files (page 291)

Standard files (page 293)

Property files (page 292)

Catalog files (page 296)

Font files and font conversion files (page 299)

Symbol files (page 299)

Image files (page 301)

Files related to templates, reports and drawings (page 300)
Log files (page 301)

Model folder files and file name extensions (page 310)
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5.1

Check and change Tekla Structures file and folder locations in Directory
browser (page 333)

Folder search order (page 334)
Create project and firm folders (page 245)
Location of certain hidden files and folders (page 337)

Create project and firm folders

Use project and firm folders for customized files. These can be custom
ribbons, drawing styles, profile and material catalogs, or any other settings
you want to store for future use. You can use the same files each time you
start a new model or install a new version of Tekla Structures. This also means
you can easily revert back to the default settings, because you have not
overwritten any of the system files.

Use the project folder and its sub-folders to store customized files that are
only used in a particular project. A project may consist of several models done
by separate teams, all spread out in different locations. You can save project-
specific files and settings in the project folder, so that everyone in the project
can use them. A project may also consist of one model that is shared by
different companies.

Use the firm folder and its sub-folders to store customized files for the entire
organization or company. The settings and files in the firm folder are meant to
be used in all projects within the company. For example, let's say you regularly
work for a company that has specific drawing layout standards it expects you
to use. Customize the drawing templates once for the company and save them
in the firm folder or in a sub-folder of the firm folder. You can then use the
customized drawing templates for all future projects for that company.

When working within one company, the firm and project folders are usually
located in network folders so that everyone can access them. In collaborative
projects that include multiple teams or companies, you can use a folder in the
linked .

Project and firm folders are defined by xs FIRM and xS PROJECT. When
working in a model sharing project, each company needs to have its own firm
settings in a folder defined by xs FIRM, and a common project folder for
project settings defined by Xxs PROJECT. It may be useful to create a startup
shortcut (page 19) on your desktop for each project containing all necessary
folders.

WARNING Changing an advanced option value in . ini files located outside the
model folder does not affect the existing models. You can only update
advanced options in the Advanced Options dialog box or in the
options.ini file located in model folder; not from an options.ini file
located in folders defined for the advanced options XS_FIRM or
XS_PROJECT. The . ini files are read also when you open an existing
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5.2

model, but only new advanced options that do not exist in

options model.db Of options drawings.db are inserted, for
example, such options that are not yet in the Advanced Options dialog
box but have been added in the software.

Create a project or firm folder

1. Create an empty folder in a shared location, for example on a network
drive.

Name the folder appropriately.

In Tekla Structures, go to the File menu and click Settings --> Advanced
options.

4. Inthe File Locations category, define the path to the firm or project

folder you created in step 1 for the advanced option XS_FIRM or
XS PROJECT.

5. Restart Tekla Structures for the change to take effect.

See also
Folder search order (page 334)
Typical initialization files (.ini files) and their reading order (page 247)

Initialization files (.ini files)

Initialization files are used for defining Tekla Structures start-up parameters
and default settings. They contain advanced options that are used for
configuring Tekla Structures for different standards, and for your or your
company’s style of working.

Tekla Structures automatically creates the necessary initialization files
(page 247) during installation. The number of initialization files it creates
depends on how many Tekla Structures environments you have installed.

NOTE If you are defining a switch for an advanced option in an . ini file, use double
percent signs %%xxx%% around the switch. If you are defining a switch in the
Advanced Options dialog box, use single percent signs %xxx% around the
switch. For example, $$BOLT NUMBER%%*D%%HOLE.DIAMETER%% for the
advanced option XS BOLT MARK STRING FOR SIZE.

See also
Global default environment settings - env_global_default.ini (page 251)

Local environment settings - env_<environment>.ini (page 252)
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Role settings - role_<role>.ini (page 252)

Typical initialization files (.ini files) and their reading order

Below is a list of all the typical initialization files that are read when Tekla
Structures is started. The numbers indicate their reading order at startup. If
there are conflicting settings, the ones read later override the ones read
earlier.

WARNING Changing an advanced option value in . ini files located outside
the model folder does not affect the existing models. You can
only update advanced options in the Advanced Options dialog
box or in the options.ini file located in model folder; not from
an options.ini file located in folders defined for the advanced
options XS_FIRM or XS_PROJECT. The . ini files are read also
when you open an existing model, but only new advanced
options that do not exist in options model.db or
options drawings.db are inserted, for example, such options
that are not yet in the Advanced Options dialog box but have
been added in the software.

To check the files that have been read and their reading order, go to File
menu --> Logs --> Session history log .

File and reading order Description

1. fonts <lang>.ini This file is optional, and it is only
needed for languages using special
characters. One example is the
fonts jpn.ini file for the Japanese
language.

This file is read from Tekla
Structures\<version>\nt\bin\ if
it is available. It is installed to

the . .\nt\bin folder when Tekla
Structures is installed.

NOTE: Do not change these settings.

2. teklastructures.ini The file teklastructures.ini
starts Tekla Structures. It is read
from . .\Program Files\Tekla
Structures\<version>\nt\bin\.

This file contains basic system
settings, such as the location of
software and environment files. This
file is installed to the . .\nt\bin
folder when Tekla Structures is
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File and reading order

Description

installed. It is always read at Tekla
Structures startup.

NOTE: Do not change these settings.

3.lang <lang>.ini

This file contains the language
settings. Itis read from . . \Program
Files\Tekla Structures
\<version>\nt\bin\.

This file is installed to the . . \nt\bin
folder when Tekla Structures is
installed.

Which lang <lang>.ini files exist
inthe . .\nt\bin folder depends on
which languages you have selected to
install during the software
installation.

The language that is read depends on
the language you have selected in File
menu --> Settings --> Change
language in the previous Tekla
Structures session.

NOTE: Do not change these settings.

4. env_global default.ini

This file is used as a default for all
environments and contains the global
settings. The settings in the
env_global default.ini file
provide the basics for all environment
settings globally. The settings in this
file can be localized and specified
differently in an environment-specific
initialization file that is read later than
this file.

This file is always read at Tekla
Structures startup

from . .\ProgramData\Trimble
\Tekla Structures\<version>
\environments\common\ and is
installed there from the common
environment installation package.

NOTE: Do not change these settings.

5. All .ini files defined in shortcut/
command line with -I <name>.ini

Usually none.

6. env_<environment>.ini
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File and reading order

Description

have environment-specific settings.
They are read from the environment
folder . .\ProgramData\Trimble
\Tekla Structures\<version>
\environments\. The exact location
may vary depending on your
environment.

The env <environment>.ini files
that exist on your computer depends
on which environment packages you
have installed. Which
env_<environment>.ini fileis read
depends on the environment that you
select in the Tekla Structures startup
dialog box.

NOTE: Do not change these settings.

7.role <role>.ini

The role <role>.ini files contain
all the advanced options that have
typical role-specific settings. They are
read from the environment

folder . .\Programbata\Trimble
\Tekla Structures\<version>
\environments\. The exact location
may vary depending on your
environment.

The available roles depend on the
environments you have installed.

You can select the role in the Tekla
Structures startup dialog box.

For example, this file defines that the
US environment imperial role uses
imperial units, shows the fractions
correctly, and understands input as
imperial. In US environment metric
role metric units are used.

NOTE: Do not change these settings.

8. All . ini files defined in shortcut/
command line with -i <name>.ini

Usually none.

9. company.ini
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especially for big companies that
want to unify certain enterprise-level
settings. This file is read from a folder
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File and reading order

Description

This file is read only if the advanced
option

XS COMPANY SETTINGS DIRECTORY
is set.

This file is created by the system
administrator when necessary, it is
not created by the installation.

10. user.ini

The user.ini file is where you can
save your personal user settings.

This file is located in the same
location as the user-specific
options.bin file, for example,
C:\Users\<user>\AppData\Local
\Trimble\Tekla Structures
\<version>\UserSettings.

The user.ini is created in the above
mentioned location when you start
Tekla Structures for the first time and
create and save a model using the
current version. It is read when you
start Tekla Structures.

The changes you make in the
advanced options in the Advanced
Options dialog box override the
settings in all other initialization files,
if the advanced option exists in both
locations.

If user.ini has system options they
are read always when Tekla
Structures is opened.

If user.ini has model-specific
options they are used when new
model is created.

If user.ini has user-specific options
they are used when Tekla Structures
is used for the first time.

11. options.ini in system folder

The folder is specified with the
advanced option XS_SYSTEM.

Files and folders in Tekla Structures

12. options.ini, firm-specific, if any
exist

13. options.ini, project-specific, if
any exist

250

The option.ini files containing
firm- or project-specific model
settings are saved in and read from
user-defined locations specified with
the advanced options XS_FIRM and
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File and reading order Description

XS_PROJECT. They work in the
specified way for the firm in question,
or for the specified project if the
model has been set up to read
settings from these locations, and if
the user has manually moved the
options.ini file to these locations.
An options.ini is created in the
firm or project folder when you copy
or move it there.

Updating of model-specific and user-
specific advanced options can only be
done from the Advanced Options
dialog box or options.ini located in
model folder, not from the firm- or
project-specific options.ini files.

The options.ini in the firm or
project folder is read when you start
Tekla Structures or open the model.

14. options.ini, model-specific The options.ini in the model
folder.

See also
Create start-up shortcuts with customized initializations (page 19)

Settings defined by advanced options (page 274)

Global default environment settings - env_global_default.ini
The env global default.ini file defines the global defaults for advanced
options. The file is read from . . \ProgramData\Trimble\Tekla
Structures\<version>\environments\common\.

WARNING Do not modify the env_global default.ini file. If you need to
modify some environment settings, copy the needed advanced
options from this file to your user.ini (page 253) file and modify
the settings there, or modify the settings in the Advanced
Options dialog box.

For advanced options that are set according to your local standards, see the
environment settings file env_<environment name>.ini (page 252) and the role
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settings file role_<role name>.ini (page 252). The local files override the
advanced options set in env_global default.ini.

If the advanced option in the env_global default.ini fileis preceded by
rem, the software defaults are used and shown as the value. The outdated
advanced options are listed at the end of the file.

See also
Typical initialization files (.ini files) and their reading order (page 247)

Local environment settings - env_<environment>.ini

The env_<environment>.ini file contains advanced options that are set
according to local standards and are different from the global defaults. The file
is read from the environment folder. . \ProgramData\Trimble\Tekla
Structures\<version>\environments\. The exact location may vary
depending on your environment.

WARNING Do not modify the env <environment>.ini file. If you need to
modify some settings, copy the needed advanced options from
this file to your user.ini (page 253) file and modify the settings
there, or modify the settings in the Advanced Options dialog
box.

The global default environment settings file env_global_default.ini (page 251)
contains a complete listing of advanced options. The local files override the
advanced options setin env_global default.ini.

See also
Typical initialization files (.ini files) and their reading order (page 247)

Role settings - role_<role>.ini

The role <role>.ini files contain all the advanced options that have typical
role-specific settings. The file is read from the environment

folder . .\Programbata\Trimble\Tekla Structures\<version>
\environments\. The exact location may vary depending on the
environment.

WARNING Do not modify the role <role>.ini file. If you need to modify
some settings, copy the needed advanced options from this file
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to your user.ini (page 253) file and modify the settings there, or
modify the settings in the Advanced Options dialog box.

The role <role>.ini file contains advanced options that are set according
to typical role requirements in your local area. These settings are different
from your environment settings in env_<environment name>.ini (page 252).
The global default environment settings file env_global_default.ini (page 251)
contains a complete listing of advanced options. The advanced option settings
in role <role>.ini override the onesin env <environment>.ini

See also
Typical initialization files (.ini files) and their reading order (page 247)

Add an advanced option to the user.ini file

You can save your personal user settings to the user. ini file. The user.ini
file is located in the same location as the user-specific options.bin file, for
example, . . \Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UserSettings.

NOTE We recommend that you add only system-specific (page 274)
advanced options to the user. ini file. You can also add model-
specific (page 274) advanced options, but the model-specific advanced
options only affect new models that you create. Adding user-specific
advanced options in user.ini may not work as desired as
options.bin isloaded after user.ini and may override the value.

1. Right-click the user. ini file in Windows Explorer and select Open with.
Select a standard text editor from the list of available programs.

2. Onanew line, enter set, then a space, then the name of the advanced
option followed by an equal sign, and then the value in a single line.

Tekla Structures only reads lines in the initialization file that start with
set.

3. Save user.ini.

4. Restart Tekla Structures for the changes to take effect.

Possible values Example

TRUE set XS DISABLE WELD PREP SOLID=TRUE

FALSE set
XS UNDERLINE AFTER POSITION NUMBER IN HARDSTA
MP=FALSE

1 set XS SINGLE CLOSE DIMENSIONS=1

0 set XS SINGLE USE WORKING POINTS=0
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5.3

Possible values Example

string value set
XS USER DEFINED BOLT SYMBOL TABLE=bolt symbol
_table.txt

switches set

XS ASSEMBLY FAMILY POSITION NUMBER FORMAT STR
ING=%%TPL:PROJECT.NUMBER%%

Use two switches.

TIP When you are moving to a new version of Tekla Structures, you can use
the Migration Wizard to automatically copy your user.ini file to the
new version. The Migration Wizard appears once you start Tekla
Structures for the first time after installation.

See also
Location of certain hidden files and folders (page 337)

Typical initialization files (.ini files) and their reading order (page 247)

File storing options and advanced options

WARNING Changing an advanced option value in . ini files located outside
the model folder does not affect the existing models. You can
only update advanced options in the Advanced Options dialog
box or in the options.ini file located in model folder; not from
an options.ini file located in folders defined for the advanced
options XS_FIRM or XS_PROJECT. The . ini files are read also
when you open an existing model, but only new advanced
options that do not exist in options model.db or
options drawings.db are inserted, for example, such options
that are not yet in the Advanced Options dialog box but have
been added in the software.

What happens at model creation

When a new model is created, Tekla Structures reads model-specific option
and advanced option values from the standard. opt file, and from the .ini
files in a certain reading order (page 247), and creates the databases
options model.db and options drawings.db, and the options.ini file
under the model folder.

Changing a model-specific options or advanced options
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*  When you change a model-specific (page 274) option or advanced option
and press OK or Apply in the Options or Advanced Options dialog box,
the settings are taken into use (otherwise you will get a warning message).

+ The updated model-specific option or advanced option settings are saved
in options model.db and options drawings.db under model folder
when the model is saved.

+ In addition, there are also some special model-specific advanced options
that can be updated from the options.ini file located in the model
folder, for example, new advanced options that are not yet in the
Advanced Options dialog box.

* You can change model-specific advanced options only in the Advanced
Options dialog box or in the options. ini file thatis located in model
folder.

* You can change model-specific options only in the Options dialog box
manually or by loading standard. opt file values in the dialog box.

Changing a user-specific options or advanced options

+  When you change a user-specific (page 274) option or advanced option,
and press OK or Apply in the Options or Advanced Options dialog box,
the settings are saved in options.binin ..\Users\<user>\AppData
\Local\Trimble\Tekla Structures\<version>\UserSettings.

* You can change user-specific advanced options only in the Advanced
Options dialog box.

* You can change user-specific options only in the Options dialog box
manually or by loading standard. opt file values in the dialog box.

Saving customized settings in the Options dialog box

* You can save your own model-specific settings in the Options dialog box by
using the Save button. Then the standard. opt file is saved in the
\attributes folder under the model folder.

Creating a list of advanced options and their values

* You can create a complete list of advanced options in a text file by clicking
Write to file in the Advanced Options dialog box. The list shows the name
of the advanced option, current value and type.

For more information about the standard. opt file, see Standard.opt settings

Settings in the Options dialog box

The Options dialog box (File menu > Settings > Options) contains the current
values for a number of Tekla Structures settings.
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Check the settings before you start modeling and change them, if necessary.

The model-specific (page 274) settings in this dialog box are saved in the
options model.db and options drawings.db databases in the model
folder, and the user-specific (page 274) settings in options.bin in your local
<user> folder. Changing user- or model-specific options in the Options dialog
box does not require Tekla Structures restart.

You can also save your own settings by using the Save button. Then the
standard.opt file is saved in the \attributes folder under model folder.
You may want to copy this file to your firm folder. When you create a model,
the standard.opt is read from the firm folder.

The options in the Options dialog box are described below.

Clash check settings

NOTE: Settings on this page are model specific. Changing the settings does not
require Tekla Structures restart.

Depending on how the objects selected for clash checking have been modeled,
different clash check settings are used. For example, if you have modeled
embeds as studs, steel parts, or reinforcing bars, respectively either bolt
settings, part settings, or reinforcement settings are relevant.

Option Description

Allowed penetration volume Defines the allowed clash check
tolerance if small collisions are
acceptable and can be ignored.

If the clashing volume is smaller than

the given value, for example 1 mm3,
then the clash is not reported.

Enter the value in the current volume

units.
Clash check between bolt and Defines whether the model is checked
bolted part for clashes that occur between bolts

and the related bolted parts.

If you select Yes, Tekla Structures will
check the bolts against the real
geometry of the bolted part profiles
including roundings, and using the
real bolt dimensions.

Files and folders in Tekla Structures 256 File storing options and advanced options




Option

Description

area for bolts

Define the clash check clearance

Use to check if bolts collide with parts
and if there is enough space to fix the
bolts.

Enter the clearance dimensions in
relation to the bolt head or nut
diameter d (the larger value), and the
nut thickness t. The clearance in front
of the bolted parts is the same as the
bolt length.

If you do not enter a value, Tekla
Structures uses the default value.

If you clear the check boxes, the
clearance will be zero.

If Tekla Structures cannot find the
bolt head or nut diameter in the bolt
catalog, it uses the shank diameter
instead.

Exact solid weld clash check

Defines whether the model is checked
for duplicate and overlapping welds
and for clashes that occur between
welds and other objects (such as
parts and bolts).

If you select Yes, Tekla Structures will
check the welds against other welds,
against bolts, and against the real
geometry of the part profiles
including roundings, and using the
weld solid dimensions with normal
accuracy.

overlap)
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Reinforcing bar vs steel part
clearance (negative value to allow
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Defines the minimum clearance or
the allowed overlap for reinforcing
bars when they are checked against
steel parts.

To allow reinforcing bars to overlap
steel parts and to ignore the ribs of
bars, enter a negative value. The
maximum overlap is the actual bar
radius.

Tekla Structures only checks the
distance from bar side to part. Tekla
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Option Description
Structures does not check the
distance from bar end to part.

If you clear the check box, Tekla
Structures will not check the

clearance.
Reinforcing bar clearance (negative | Defines the minimum clearance or
value to allow overlap) the allowed overlap for reinforcing

bars when they are checked against
other reinforcing bars.

To allow reinforcing bars to overlap,
enter a negative value.

If you clear the check box, Tekla
Structures will not check the
clearance.

Reinforcing bar cover thickness Defines the reinforcing bar cover
thickness.

Tekla Structures checks the cover
thickness against the part that the
reinforcing bar belongs to. Tekla
Structures only checks the distance
from bar side to part surface. Tekla
Structures does not check the
distance from bar end to part surface.
If the bar penetrates a part surface, a
clash is reported, even if the bar is
completely inside a cast unit or pour.

If you clear the check box, Tekla
Structures will not check the cover
thickness.

Components settings

Tekla Structures uses the information on the Components tab when it creates
parts using system components.

Component properties defined in component dialog boxes override these
settings. Tekla Structures only uses these settings if the corresponding boxes
in the component dialog boxes are empty.

If you change settings here, Tekla Structures only applies the new settings to
components you subsequently create. Components you created prior to
changing the preferences are not affected.

NOTE: Settings on this page are model specific. Changing the settings does not
require Tekla Structures restart.
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Option

Description

Profile names

Defines parametric profile prefixes
for plates. It is important that profile
names are set up correctly so that
you can use filters and wizards
effectively.

Profile names must exist in the profile
catalog. If you want to use a
parametric profile that does not have
a name in the catalog, first add it to
the Profile Catalog, then enter it
here. Tekla Structures uses the
Folded plate prefix when you use the
folded plates in components.

Bolts

In components, Tekla Structures uses
Factor of bolt edge distance and
Compare edge distance to to check
that the bolts it creates are not too
close to the edge of a part, and warns
you if they are. Check that Factor of
bolt edge distance is set according
to the standard you are using. The
default edge distance setting depends
on your environment.

Compare edge distance defines
whether the edge distance checks are
based on bolt or hole diameter.

To define the default bolt properties
to use in connections, select a Bolt
standard and Bolt size.

Parts

Part material defines the default
part material grade.

Part start numbers defines start
numbers for parts that are Welded to
primary and Welded to secondary,
Loose parts, and Assembly loose
parts.

Cross-check these settings against the
numbering series you define to make
sure they do not overlap. If they
overlap, Tekla Structures may create
two non-identical parts with the same
part number. This generates an error
in the Numbering history log file
(page 307).
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Drawing dimensions settings

NOTE: Settings on this page are model specific. Changing the settings does not
require Tekla Structures restart.

For more information about dimension settings, see

Option Description

Exaggeration This setting defines the default values
for Exaggeration limit and
Exaggeration scaling.

When you enable the exaggeration of
the dimensions, a drawing dimension
that is narrower than the defined limit
is expanded. Exaggeration limit

defines the default value for this limit.

Exaggeration scaling defines
whether you are using Paper or
Model as the exaggeration scaling
method:

+ Ifyou select Paper, the
exaggeration limit is multiplied by
the view scale.

+ If you select Model, and the scale
is 1:10, all the dimensions smaller
than 10 mm are exaggerated
regardless of the drawing scale.

For more information about
exaggerated dimensions, see .

Absolute dimensions Show zero in absolute dimensions
-->Yes shows zero at the zero points
in absolute dimensions.

Draw absolute dimension values
parallel to dimension line --> Yes
shows dimensions parallel to
dimension lines in absolute
dimensions.

For more information, see

Dimensions in tags Units, Format and Precision define
the default unit, format and precision
used in dimension tags.

Available units: mm, cm, m, foot -
inch, cm / m, inch, feet.
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Option Description

Available formats: ###, ###[ #],
HiHH H, BHH] AR, HHHE A, A,

WA S, B and #H7/HEHHT

Available precision: 0.00, 0.50, 0.33,
0.25,1/8,1/16,1/32, 1/10, 1/100,

1/1000
Show dimension in middle tag of Defines whether you want to create
automatic dimension dual dimension tags in assembly,

single-part, cast unit, or general
arrangement drawings.

For more information about
automatic dual dimensions, see .

For more information about manual
dual dimensions, see

When Tekla Structures creates the
drawing, it adds the lower dimension
tag in the selected unit, format and
precision.

Dimension line Dimension line extension length
for line arrow defines the length of
the line extension for dimensions that
have line arrows.

Note that line extensions are not
applied to dimensions that have
different arrows from line arrows,
and certain knock-off dimension

types.

Drawing objects settings

NOTE: Settings on this page are model specific. Changing the settings does not
require Tekla Structures restart.

Option Description

Edge chamfer Line color defines the default line
color of the edge chamfers in
drawings.

Line type defines the default line
type of the edge chamfers in
drawings.
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Option

Description

These values are overridden by the
values set in the Edge Chamfer
Properties dialog box.

For more information about edge
chamfers, see .

General settings

NOTE: On this page, Autosave settings are user specific. All other settings are
model specific. Changing the settings does not require Tekla Structures

restart.

Option

Description

Autosave

Autosave interval: Autosave after
every xx modeling or editing
commands defines how often Tekla
Structures automatically saves a
model and a drawing.

This number represents the number
of commands you have given. For
example, if you create many objects
without interrupting (Esc), it counts as
one command.

Autosave after creating every xx
drawings defines the number of
drawings after which Tekla Structures
automatically saves your work.

For more information, see:

Default adaptivity
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Off means that adaptivity is not
defined.

Relative defines that handles retain
their relative distances to the nearest
part faces in relation to the part’s
overall size.

Fixed defines that handles retain
their absolute distances to the
nearest part faces.

You can also modify the adaptivity
settings for each part separately.
These modifications override the
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Option Description
default settings in the Options dialog
box.

For more information about
adaptivity, see

Load modeling settings
Use the settings on the Arrow length tab to scale loads in model views.

Use the settings on the other tabs of this page to define the building code and
safety factors Tekla Structures uses in load combination.

NOTES:

+ Settings on this page are model specific. Changing the settings does not
require Tekla Structures restart.

* You should not need to change the building code or safety factors during
the project. If you change these settings, you will also need to change the
load group types and check the load combinations.

Numbering settings

NOTE: Settings on this page are model specific. Changing the settings does not
require Tekla Structures restart.

Option Description
Position number separator Defines the default position number

separator. The options are dot (.),
comma (,), slash (/), and hyphen (-).

Rebar position number separator | Defines the default reinforcing bar
position number separator. The
options are dot (.), comma (,), slash (/),
and hyphen (-).

Part number type Defines the default part number type.
The options are Part number and
Combined assembly / part number.

Orientation mark settings

NOTE: Settings on this page are model specific. Changing the settings does not
require Tekla Structures restart.

For details of what affects the part orientation and how, see .
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Option Description

North direction Project north (degrees counter
clockwise from global x) defines
which direction is north in the model.
Enter the value in degrees counter-
clockwise from the global x axis.

7, a0 00

Part viewing direction Defines which direction parts are
viewed from in drawings.

Beam skew limit Tekla Structures uses limit angles to
determine whether a part is a beam
or a column when creating
orientation marks. Tekla Structures
treats parts outside these limits as
braces.

Column skew limit

Parts skewed more than 80° are
columns.

Parts skewed less than 10° are
beams.

Preferred location for mark Defines the location of part marks in
drawings, to the left or right end of
the part.

Mark always to center of column This setting only affects columns.

Yes places part marks in the center of
columns in plan views. To indicate
part orientation, include compass
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Option Description
direction (Face direction) in the part
mark instead.
No places part marks on the same
flange in general arrangement and
assembly drawings.
Rebar set settings

NOTE: Settings on this page are model specific and only apply to rebar sets,
not to single reinforcing bars, reinforcing bar groups, or reinforcement
meshes. Changing the settings does not require Tekla Structures restart, but
you need to use the Rebar set --> Regenerate rebar sets command on the
Concrete tab to apply the changes to existing rebar sets in the model.

Option

Description

Covers and locations tab

Concrete cover

Under Part global coordinate
system, define the default concrete
cover thickness between the rebar set
bars and the following faces of
concrete parts:

+ Top
* Bottom
« Sides

To use the parts' local coordinate
system, under Part local coordinate
system, define the default concrete
cover thickness at the following faces
of concrete parts:

+ Top

* Bottom
* Front

+ Back

+ Start

« End

You can also define concrete cover
settings for each concrete part
separately. These modifications
override the default settings in the
Options dialog box.
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Option

Description

Layer prefix

Under Part global coordinate
system and/or Part local coordinate
system, define the default bar layer
prefixes at different faces of concrete
parts.

You can also define bar layer settings
for individual rebar sets or leg faces,
or for individual bars using the user-
defined attributes of property
modifiers. These modifications
override the default settings in the
Options dialog box.

Links Define the bar layer prefix for rebar
set bars that have four or more legs,
for example closed stirrups.

General tab

Minimum lengths to be created

Define Minimum bar length to
prevent Tekla Structures from
creating reinforcing bars that are too
short. This setting is primarily for
straight bars. Enter the minimum bar
length as Distance or as Coefficient
of bar diameter.

Define Minimum straight start/end
leg length for bent reinforcing bars.
Enter the minimum leg length as
Distance or as Coefficient of bar
diameter.

Rounding and step tapering tab

Rounding

Define whether the lengths of straight
bars, first and last legs, and
intermediate legs are rounded in the
model, and whether the bar lengths
are rounded up, down, or to the
nearest suitable number according to
the rounding accuracy.

At splitter locations, define how much
the bar lengths can be rounded up.

Rounding settings are also available
in the Rebar set properties and in the
Rebar property modifier properties.
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Option Description

Step tapering Define the tapering step values for
straight bars, first and last legs, and
intermediate legs.

Step tapering settings are also
available in the Rebar set properties
and in the Rebar property modifier
properties.

Units and decimals settings

NOTE: Settings on this page are model specific. Changing the settings does not
require Tekla Structures restart.

The number located to the right of each option indicates the number of
decimals. The number of decimals affects the input and storage accuracy.
Always use a sufficient number of decimals.

For more information on unit and decimal settings, see Change units and
decimals.

Option Description

Length mm, cm, m, in (decimal), ft
(decimal), ft-in

Angle ° rad

Spring constant kg/m
kg/cm

kg/mim
T/m
T/cm
T/mm
M
Micm
M/ rmm
dalM/m
daM/cm
dall/rmm
kP m
kM cm
kM mm
Ibfiin
Ibf/ft
kip/in
kip/ft
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Option

Description

Rot. spring constant

kgm,rad
kgm,/*
Tm/rad
Tm/*

M/ rad
Mm,™®
dallm/rad
daMm/*
kMm/rad
kM m,/
Ibf-in/rad
Ibf-in/~
Ibf-ft/rad
Ibf-ft/*
kip-in,/rad
kip-in/®
kip-ft/rad
kip-ft/~

Factor

(unitless)

Force

kg
T

M
dall
kM
Ibf
kip

Distributed load

kgim
T_a'r'n
Mim
dal/m
kM/m
Ibfiin
Ibf/ft
kip/in
kip/ft

Surface load

Ic:5|_e’rr12
T/m*
M/m*
daM/m*
kMN/m®
psi

psf

ks

besf
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Option

Description

Moment

kgm
Tm
Mm
dalMm
kMm
Ibf-in
Ibf-ft
kip-in
kip-ft

Distributed moment

kgm,/m
Trm/m
Mrn/m
daMm/m
kMm/m
Ibf-ft/ft
kip-ft/ft

Temperature

°C, °F, K

Deformation

mm
cm

m

in (decimal)
ft (decimal]
ft-in

Section dimension

rim
cm

m

in (decirmal)
ft (decimal)
in

ft-in

Angle

° rad

Area

Section modulus

Moment of inertia

mm4, cm4, in4
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Option

Description

Radius of inertia

mm

cm

m

in (decirmal)
ft (decirnal)
ft-in

Torsion constant

mm4, cm4, in4

Warping constant

mme6, cme6, in6

Cover area

m&m
mm>/m
cm’/m
'/t
in®/ft
in‘/in

Strength

kg/m®
kg/c m*
kg/mm :
T/m*
T/em®
T/mm®
M/m?
M/cm®
M/mm®
daM/m*
daM/cm®
daM/mm?*
kM/m®
kM/cm?®
kM/mm®
psi

psf

ks

besf
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Option Description

Modulus kg/m*
kg/cm®
h:5|_--’r'r1rr12
T/m*
T/em®
T/mm?
M/m®
M/em?
M/mm®
dal/m’
daM/cm®
dalM/mm?*
kM/m*
kM/em®
kMN/mm®
psi

psf

ki

kesf

Density kg/m’
T/m’
MN/m’
KM/’
Ibf/ft

Weight kg
T
M
Ibf
kip

Strain 0/00, %, (unitless)

Thermal dilat. coeff. 1/°C, 1/°F, 1/K

Ratio 0/00, %, (unitless)

Volume mme
cm’
mE
in’
f_tE

Length mm, cm, m, in (decimal), ft
(decimal), ft-in

Angle ° rad
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Option

Description

Reinforcement area

Transverse reinforc.

mm
mm-/m
cm’/m
o/t
in/ft
in*fin

Weight

kg

It
kip

Mass/Length

kgim
T/m
Mim
dal/m
kM/m
Ibf/ft

Volume

Force

kM
Iaf
kip

Distributed load

kg/m
T/m
Mim
daM/m
kP m
Ibfiin
Ibf,/ft
kip/in
kip,/ft
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Option

Description

Surface load

kg/m®
T/m*
M/m
daM/m*
kM/m?
psi

psf

ksi

kesf

Moment

kgm
Tm
Mrm
daMm
kMm
Ibf-in
Ibf-ft
kip-in
kip-ft

Temperature

°C, °F, K

Stress

Ic:5|,--’r'r12
kg/cm®
kg/mm’
T/m*
T/em®
T/mm*
|"J_-'rr‘|"l2
M/em?®
MN/mm®
daM/m*
daM/cm®
daM/mm*
kMN/m®
kM/em®
kM/rmm®
psi

psf

kesi

kst

Deformation

rim

cm

m

in (decirmal)
ft (decimal)
ft-in
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See also

File storing options and advanced options (page 254)

Settings defined by advanced options

Advanced options can be user-, model-, system or role-specific:

+ User-specific advanced options are saved in your local options.bin file,
which is by default located in C:\Users\<user>\AppData\Local
\Trimble\Tekla Structures\<version>\UserSettings, and workin
the specified way in all models that you have. The folder can be changed
using the advanced option XS_USER_SETTINGS_DIRECTORY. In the
Advanced Options dialog box, the type is USER. Some user-specific
advanced options require restarting of Tekla Structures after changing the
value.

*  Model-specific advanced options work in the specified way only in the
current model. They are saved to options model.db and
options drawings.db under model folder. In the Advanced Options
dialog box, the type is MODEL or DRAWING. Some special model-specific
options that are not visible in the Advanced Options dialog box can be
changed from options. ini file under the model folder.

+ System-specific advanced options are general to all sessions of Tekla
Structures, and work in the specified way for all users and in all models. In
the Advanced Options dialog box, the type is SYSTEM. A system-specific
advanced option can be stored to options database by clicking SYSTEM
next to the option and changing it to MODEL(SYSTEM). Note that the
changed value only works for the current model. A MODEL(SYSTEM)
advanced option can be changed back to SYSTEM by changing it to
SYSTEM, and in this case it will be removed from the options database.
Some system-specific advanced options require restarting of Tekla
Structures after changing the value.

The system-specific advanced options are read from environment . ini
files:

+ Global system settings are read from common env_global_default.ini
(page 251)in . .\ProgramData\Trimble\Tekla Structures
\<version>\environments\common\. These settings are used in all
environments.

+ Environment-specific system settings are read from
env_<environment>.ini (page 252) in your environment folder. They
override any settings that are defined on a global level in
env_global default.ini.

* Role-specific system settings are read from role_<role>.ini (page 252)
in environment folder. They override any settings that are defined on a
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global and environment level in env_global default.ini and
env_<environment>.ini.

+ Company level system-specific system settings override all other
system-specific advanced options. You can save them in the firm or
project folders by setting the folders for the advanced options and .

+  SYSTEM(ROLE) options are typically role specific. The settings are read
from . ini files and are not saved to the databases. When changed or if
the type is changed, the option will become model specific and be saved to
the databases. MODEL/DRAWING(ROLE) options are SYSTEM(ROLE)
options whose type and/or setting has been changed. The change would
be used when you want the SYSTEM(ROLE) option to be saved with the
model to options model.db and options drawings.db under model
folder. These settings can be set back to SYSTEM(ROLE), which will then
take into use the default value.

See also
Typical initialization files (.ini files) and their reading order (page 247)

Change the advanced option values in the Advanced
Options dialog box

Use advanced options to configure Tekla Structures to suit the way you work,
or to comply with specific project requirements or industry standards. Change
the advanced options only in the Advanced Options dialog box. The settings
in the Advanced Options dialog override the settings in any other
initialization file.

1. Onthe File menu, click Settings --> Advanced options to open the
Advanced Options dialog box, or press Ctrl+E.

2. Browse the categories to find the advanced option you want to set.

You can also enter a search term in the Search box. To search the search
term in all categories, select In all categories. You can also use wildcards.
For example, to find all advanced options that have the words anchor
and filter and that have any characters between these two words,
enter anchor*filter.

3. Set the advanced option to the desired value by entering the value or by
selecting the value from the list.

* You can change the type of the role-specific advanced options from
SYSTEM (ROLE) to MODEL (ROLE) or DRAWING(ROLE) and vice versa
from the list next to the option type. When you change the option type
to SYSTEM(ROLE), the value automatically changes to the default
value. When you enter a value for a SYSTEM (ROLE) option, it changes
to MODEL (ROLE) or DRAWING(ROLE).
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You can change the type of system-specific advanced options from
SYSTEM to MODEL(SYSTEM), in which case the value is saved in the
options database. If you reset the advanced option back to SYSTEM,
the value will be removed from the options database and the value
specified in initialization files will be used.

You can use switches with some advanced options, for example, to
define the contents of marks: $TPL: PROJECT . NUMBERS.

If you are defining a switch for an advanced option in the Advanced
Options dialog box, use single percent signs %xxx% around the switch.
If you are defining the switch in an .ini file, use double percent signs %
%xxx%% around the switch.

If you need to enter a folder path, you can type a backslash at the end
of the folder path or leave it out.

Click Apply or OK.

TIP To create a complete list of advanced options in a text file, click

Write to file. The list shows the name of the advanced option
together with its current value and type. Note that writing to afile is
only an export of the current settings, it is not another way of
changing the advanced options.

See also

Settings defined by advanced options (page 274)

Input files (.inp files)

Tekla Structures uses input files for various purposes, for example, to manage
user-defined attributes and some component dialog boxes, and for defining
how components work. All input files have the extension . inp.

Input files that you can use for configuring Tekla Structures are listed below.

File Description
analysis design conf | Contains settings for analysis and design.
ig.inp
fltprops.inp Includes materials and dimensions of available
flat bars (page 286).
mesh database.inp Contains definitions for reinforcement meshes.
objects.inp Used to manage user-defined attributes

(page 280).

objects rebar set.in | Used to manage user-defined attributes of rebar

sets.
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File Description

pop _mark parts.inp Contains settings for pop-marking.

privileges.inp Used to control access rights.

profitab.inp Contains available parametric profiles (page 155).
rebar config.inp Contains settings for reinforcement marks.
rebar database.inp Rebar catalog (page 227). Contains definitions for

reinforcing bars and strands.

rebar schedule confi |Contains internal bending types of reinforcing
g.inp bars and their mapping to area specific bending
codes.

Rebar shape manager is a more versatile way to
define reinforcing bar bending shapes.

Tekla Structures also imports and exports rebar catalogs as . inp files.

See also
Environment database file (page 282)

Properties of the objects.inp file

Here, we explain the structure of user-defined attribute definitions. For
general information on modifying the definitions, such as file locations and
reading order, see Define and update user-defined attributes (UDAS)
(page 280).

The example below shows the main properties of objects. inp.

attribute ("HY INFO 1", "My Info 1", string, "%s2", no, none, "0.0Q", "0.0")
{

value (""", 0)

Property In the example Description
attribute or attribute attribute is a regular
unique attribute attribute, which is

copied with other part
properties.

unique attributeisa
non-copyable attribute.
The value of the
attribute is never copied
to another part. For
example part checking
status attributes usually
cannot be copied.
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Property

In the example

Description

attribute_name

MY INFO 1

Attribute name, used to
find the attribute value.

Ensure that Tekla
Structures does not
already use the attribute
name you use. Consider
using a prefix that
ensures the name is
unique, for example,
your initials, or an
abbreviation of your
company name.

The attribute name is
case-sensitive. Do not
use spaces or reserved
characters in attribute
names. The maximum
length of the name can
be 19 characters.

To include the attribute
in a report or template,
add the name of the
attribute to your layout
in the Template Editor.
When you run a report
or create a drawing,
Tekla Structures displays
the current value of the
attribute.

label_text

My Info 1

Label that Tekla
Structures displays in
the dialog box.

Some default attributes
have prompts like
j_comment, meaning
that the prompt comes
from the joints.ail
message file.

value_type
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string

integer or float for
numbers

string for text

string not modifiab
le for text whose
modification is
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Property

In the example

Description

prevented. A field with
the
string not modifiab
le property is always
displayed as dimmed
and it cannot be
switched on or off. The
value in the field is not
saved when clicking the
Apply button or
modified when clicking
the Modify button.

option for lists

date for date with small
calendar

date time min for

date and time [12:00]
with small calendar

date time sec for

date and time [12:00:00]
with small calendar

If you change the value
type of a field that
already contains values
in the model, make sure
that the values are valid
for the new data type
and verify the results.

field_format

o\
0)]

Definition of the field
format in the dialog box

+  %s for strings

+ 2d for numbers

special_flag

no

no Or yes

For parts: consider in
numbering

For drawings: display the
attribute value in
Document manager

For other elements: no
effect
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Property In the example Description

check_switch none none

This option is not used.

attribute_value_max 0.0 0.0

This option is not used.

attribute_value_min 0.0 0.0

This option is not used.

Define and update user-defined attributes (UDAs)

The property pane and many dialog boxes contain user-defined attributes
(UDAs) for various objects, including beams, columns, bolts and drawings.
Tekla Structures displays these fields when you click the More button in the
property pane or the User-defined attributes button in a dialog box. For
example, comment, locked, and erection status are user-defined attributes.

When you define new user-defined attributes

The user-defined attributes are managed in the objects.inp (page 277) file. To
define new user-defined attributes, create your own objects. inp file in the
model, project or firm folder. After adding your own user-defined attributes,

you need to run the Diagnose and change attribute definitions command

to update the definitions (page 281) in the model.

When you define new user-defined attribute (page 282), make the definition of
the user-defined attribute unique. This is because a user-defined attribute
cannot have different definitions for different object types, such as beams and
columns.

The object.inp files are merged so that if there are user-defined attributes
in any of the files, they are displayed in the user interface. Tekla Structures
merges the files in a way that eliminates duplicate attributes. If Tekla
Structures encounters the same attribute name in different objects.inp
files, the attribute from the first read objects. inp file will be used.

If you need to have several objects. inp files in the same folder, you can use
a suffix in the file name to use all the files. This enables having several
objects <suffix>.inp filesin the same folder. The file name could be
objects precast.inp, for example.

WARNING Do not copy the objects.inpfileinthe . .\environments
\common\1inp\ folder. Copying the file creates unnecessary
duplicates and later objects.inp updates by Tekla Structures
can be lost.
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Tekla Structures reads the objects. inp files from the following folders in the
following order:

1. model folder
project folder
firm folder

system folder

ik W

inp folder

Changing existing user-defined attribute definitions

Updating a user-defined attribute definition in a model does not convert any
values that are already stored in the field. If you change the value type of a
field that already contains values in the model, make sure that the values are
valid for the new data type and verify the results.

The safest approach is to create a new attribute when the format of the values
in the field changes. If you want to convert user-defined attribute values, you
can create a report that lists the values, convert them using external tools and
import the converted values (page 376).

See also

Environment database file (page 282)

Update definitions of user-defined attributes (UDAs) in a model
When you have changed definitions of a user-defined attribute by modifying
the objects.inp file, you need to update the definitions in the model.

1.  Open the model.

2. On the File menu, click Diagnose & repair and in the Utilities area, click
Diagnose and change attribute definitions.

The Diagnose & Change Attribute Definitions dialog box opens.

3. Select an attribute from the list on left side to see the comparison of
current definitions and objects. inp definitions.

4. Select the definitions you want to update in the Object classes with
Objects.inp differences compared to current settings list.

5. Click Change current settings to selected Objects.inp settings.

See also

Define and update user-defined attributes (UDAs) (page 280)
Environment database file (page 282)

Properties of the objects.inp file (page 277)

Example: Create and update a user-defined attribute (UDA) (page 282)
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Environment database file

To guarantee consistent model behavior when a model is used with different
roles, the environment database file (environment . db) contains the
definitions of the user-defined attributes (UDAs) used in the model.

When you create a new model, Tekla Structures merges the definitions from
your objects.inp (page 277) files to the environment . db file. Later, when you
add new user-defined attributes in the objects. inp file, the definitions are
saved in environment.db as you open the model.

You can modify your user-defined attributes (page 280) in an objects.inp
file but the changed definitions do not come into effect automatically. If there
are conflicts, the definitions in environment.db win. You need to run the
Diagnose and change attribute definitions command to see the conflicts
between environment.db and objects.inp, and select the attribute
definitions that you want to update.

See also
Update definitions of user-defined attributes (UDAs) in a model (page 281)
Example: Create and update a user-defined attribute (UDA) (page 282)

Example: Create and update a user-defined attribute (UDA)
This example shows how to create your own user-defined attribute (UDA) and
update the model to use the changed attribute definition.

Create a user-defined attribute

1. Create a new model and save it.

The user-defined attributes in the model are merged from objects.inp
(page 280) files and Tekla Structures saves the attribute definitions in the
environment.db (page 282) file in the model folder.

2. Close the model.

3. Create an input file called objects. inp in the model folder by using a
standard text editor.

4. Enter the following information in objects. inp. For details about the
properties in the attribute string, see objects.inp (page 280).

/

KA KR AR A AR A AR A KRR A AR AR A AR A AR A AR A A A A A A A A A A A A A A A A A Ak A XA kK

******************/

/* Part attributes */
/

RR b b b b b b b b b b b b b b b b I IR b b b b b b b b b b I b b b b b b b b b b b b b b b b b b b b b b b I IR S Y

******************/
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part (0, "Part")

{

/* User defined tab page */
tab page ("My UDA tab")

{

/* User defined attribute */

attribute ("MY UDA", "My UDA", string,"%s", no, none,
"0,0", "0,0")

{

value ("", 0)

}

}

tab page ("My UDA tab", "My UDA tab", 19)
modify (1)

}

/

RR I b b b b b b b b b b b b b I b I IR b b b b b b b b b b I b I I SR IR b b b b b b b b b b b b b b b b b b b b b 4

******************/

/* Column attributes */

/

R R I e S b b b b b b b 2h S dh b 2 dh b S db b b S b 2h b 4b b Sh b 2 S b db b b 2h b dh b b db b db db b db Sb i 2h S 4

******************/

column (0, "j column")

{

/* Reference to the user defined tab page that is defined
above in */

/* the part() section: */

tab page ("My UDA tab", "My UDA tab", 19)

modify (1)

To see the example text file, click objects.inp - example 1.

NOTE If you want to create a user-defined attribute that also affects
numbering, set the special_flag (page 277) property of the
attribute to yes (it is no in the example above). Also, just like in
the example above, the definition of the tab page must be in the

part section, and the column (beam, etc.) section must have only
a reference to it.
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5. Save objects.inp.

Test the user-defined attribute

1. Open the model.

Create a steel column.

Double-click the steel column to open its properties in the property pane.
Click the More button.

Go to My UDA tab.

ik W

My LUDA tab | General Design Tekla Structural Designer

My UDA& 7

Enter a value in the My UDA box.
Click Modify.

Copy the steel column.

0 ® N o

Check the My UDA box of the new steel column.
The attribute value was also copied.
10. Close the model.

Modify the user-defined attribute to make it unique

1. Openthe objects.inp file in the model folder by using a standard text
editor.

2. Enterunique before the user-defined attribute.
/

R g b b b b b b b b b b b b b b b i b b b b b b b b b b b I b b b b b b b b b I b b b I b b b b b b b b b b b b

******************/

/* User-defined attributes */
/

KA KRR AR A AR A AR AR AR A A A A AR A AR A A A AR A A A A A A A A A A A A A A kA kA A Ak A kK

******************/

part (0, "Part")

{

/* Common tab pages for part attributes */
tab page ("My UDA tab")

{

unique attribute ("MY UDA", "My UDA", string,"%s", no,
none, "O0,0", "O0,0™)

{
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value ("", 0)

}

}

tab page ("My UDA tab", "My UDA tab", 19)
modify (1)

}

/

KA KRR AR A AR A AR AR AR AR AR A A A A A A A A A A A A A A A A A A A A A A Ak A Ak Ak A kK

******************/

/* Column attributes */

/

RIR IR b b b b b b b b b ab b b b b b I b b b b b b b b b b b I b b b b b Sb b b b b b Ib b b b b b b b b b b b Ib b b 4

******************/

column (0, "3 column")

{

tab page ("My UDA tab", "My UDA tab", 19)
modify (1)

}

This makes the user-defined attribute unique, meaning that the value of
the user-defined attribute will not be copied to another part.

Save objects.inp.
To see the example text file, click objects.inp - example 2.

Test the unique user-defined attribute

1.

vk N

Open the model.

Enter a value in the My UDA box for a steel column and click Modify.
Copy the steel column.

Check the My UDA box of the new column.

The value was copied, so the user-defined attribute in the model is not
unique. There is a conflict between the environment.db and
objects.inp definitions.

Update the definitions of user-defined attributes

1.

On the File menu, click Diagnose & repair and in the Utilities area, click
Diagnose and change attribute definitions.

The Diagnose & Change Attribute Definitions dialog box opens.
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2. Select My UDA in the Attribute area on the left.

You can see that My UDA is not unique in the current setting, but it is set
to unique in objects.inp.

Object classes with Objects.inp differences compared to current settings

Current settings  Object class names  Objects.inp settings

unigue=no part column unigque=yes

3. Select the definition in the area on the right.
Click Change current settings to selected Objects.inp settings.
Now the definition of the user-defined attribute is updated in the model.

If you now copy a steel column that has a value for My UDA, the value is
not copied to the new column.

See also

Update definitions of user-defined attributes (UDAs) in a model (page 281)
Define and update user-defined attributes (UDAs) (page 280)

Properties of the objects.inp file (page 277)

Show plates as flat bars in drawings and reports

Tekla Structures can show plates as the equivalent flat bars for manufacturing.
Tekla Structures displays the plates as flat bars in reports and drawings.

1. Set the advanced option XS_USE_FLAT_DESIGNATION to TRUE.

2. Indicate the prefix you want to use for flat bars using the advanced option
XS_FLAT_PREFIX.

For example, XS FLAT PREFIX=FLAT.
3. Set other platework-related advanced options as required.

4. Define materials, thickness, and width of available flat bars in the
Fltprops.inp (page 286) file.

TIP « To prevent Tekla Structures from displaying the profile in metric units in the
US environment Imperial role, add the flat bar prefix to the profitab.inp
(page 170) file as a parametric profile.

+ See also page Platework in the Advanced Options dialog box for
information about advanced options related to platework.
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Define flat bar sizes with the Fltprops.inp file

Use the Fltprops.inp file, located in the \profil folder under the
environment folder . .\ProgramData\Trimble\TeklaStructures
\<version>\environments)\, to define flat bar thickness, width and
material. The exact location may vary depending on your environment.

NOTE Copythe Fltprops.inp file to a model, project or firm folder and then
modify the file in the new location as required.

The first row in the file contains flat bar material definitions (enclosed in
quotes " ") followed by plate thicknesses. If you do not define a material, you
can use all materials for all flat bars. The following rows define the widths of
available flat bars.

The units are millimeters.

Example
Fltprops.inp contains the following data:

5,6,"5235",8,10,"5275J0",10,15
40,45

50,55

60,65

70,75

100,110

200,220

With the above data, Tekla Structures displays the following plates as flat bars:

Plate Material
5x40, 5x45, 6x50, 6x55 All materials
8x60, 8x65, 10x70, 10x75 S235
10x100, 10x110, 15x200, 15x220 S275)0

The flat bars get the prefix that is set in the XS_FLAT_PREFIX advanced option.

See also

Show plates as flat bars in drawings and reports (page 286)

Define unfolding parameters in the
unfold_corner_ratios.inp file

The unfolding parameters define the location of the neutral axis when a
profile is unfolded. The neutral axis is a line which runs along the length of a
profile where stress and strain are equal to zero. Tekla Structures uses these
parameters to create NC files and to display unfolded profiles in single-part
drawings.
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To define unfolding parameters, modify the unfold corner ratios.inp
file, located in . .\ProgrambData\Trimble\Tekla Structures\<version>
\environments\common\system, using a standard text editor. You can copy
the unfold corner ratios.inp file to a model, project or firm folder and
then modify the file in the new location as required. Tekla Structures searches
for this file in the default search order.

After modifying the unfold corner ratios.inp file, restart Tekla

Structures for the changes to take effect.

NOTE The settings in the unfold corner ratios.inp file have no effect
in the following cases:

+ If the advanced option
XS_USE_OLD_POLYBEAM_LENGTH_CALCULATION is set to TRUE.

+ If the advanced option
XS_CALCULATE_POLYBEAM_LENGTH_ALONG_REFERENCE_LINE is
set to TRUE. This only applies to polybeams with straight sections.

Unfold parameter properties

See below for an example of unfolding parameters in the
unfold corner ratios.inp file and the descriptions of the parameters.

1 HE300A S235JR 0 180 2 0 1000 .7

Property In the example Description

Type 1 1 is polybeams

2 is plates modeled as
polybeams (for example,
PLT)

3 is for parts which are
not unfolded and follow
the old polybeam
calculation (for example,
the line 3 L* = disables
unfolding of L profiles)

Profile HE300A You can also use
wildcards with profile,
for example, HE300*.

Material S235JR You can also use
wildcards with material,
for example, s235+*,

Rotation / thickness min | 0 For polybeams: the
minimum angle when
the profile is rotated
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Property In the example Description

around its longitudinal
axis

For plates: the minimum
thickness of plate

Rotation / thickness max | 180 For polybeams: the
maximum angle when
the profile is rotated
around its longitudinal
axis

For plates: the maximum
thickness of plate

Flag 2 This property defines
what kind of parts are
affected by the next two
properties.

1 is sharp folds. Only
polybeams with straight
chamfers are affected.

2 is curved bends. Only
polybeams with curved
chamfers are affected.

Angle / radius min 0 For sharp folds: the
minimum angle

For curved bends: the
minimum radius

Angle / radius max 1000 For sharp folds: the
maximum angle

For curved bends: the
maximum radius

Ratio .7 Defines how much the
profile stretches or
shrinks when unfolded.

Ratio = (1 - the relative
location of the neutral
axis).

If only the inner surface
of the profile shrinks,
the ratio is 1. If only the
outer surface of the
profile stretches, the
ratio is 0. By default, the
ratio is 0.5 for length
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Property

In the example Description

calculation and 0.0 for
bending radius
calculation.

Tekla Structures applies
the unfolding ratio if the
profile properties are
within the range
indicated by the
minimum and maximum
values.

See also

Folder search order (page 334)

Data files (.dat files)

Data files contain information used by certain components, or Rebar shape

manager, for example.

WARNING These files affect the operation of components or Rebar shape
manager. Do not modify the files listed here unless you are an

administrator.

File

Description

joints.dat

Contains data used in Handrailing (1024) and
Stanchions (S76) components. Used in the
Stanchion connection type option.

railings.dat

Contains data used in Handrailing (1024). Used in
the Stanchion connection type option.

steps.dat

Contains the data for Stairs (S82) and Stairs
(S71). Used in the Step profile and Catalogue
step options.

std flange plates.d
at

Contains data for Tapered column (599). Used in
the options:

* Outer flange profile
* Inner flange profile
+ Top plate profile

std stiffener plate

s.dat

Contains data used in Tapered column (599).
Used in the Horizontal stiffener profile box.
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File Description

marketsize.dat Contains available market sizes for certain
material grade. Can be used with fMarketSize ()
function in the custom component editor.

import macro data t |Contains the user-defined attributes that you can
ypes.dat include in an input file in attribute import.

RebarShapeManager.C | Contains the custom properties, template
ustomProperties.dat |attributes, and user-defined attributes that you
can use in bending shape rules in Rebar shape
manager.

Note that default data files are read from the environment's system folder, but
user-defined data files are stored in the model's \attributes folder.

See also
Define flat bar sizes with the Fltprops.inp file (page 286)

Message files

Tekla Structures uses the information in the message files to display messages
in the user interface. Message files include, for example, texts used in dialog
boxes.

+ Message files with the .ail extension are located in the folder . .\Tekla
Structures\<version>\messages.

+ Message files with the . xm1 extension are located in the folder . .\Tekla
Structures\<version>\messages\DotAppsStrings.

The files include texts in languages in which the Tekla Structures user interface
is available.

See also

Customize message files (page 291)

Customize message files

You can customize the messages that Tekla Structures displays in the user
interface.

1. Do one of the following:

« To modify an .ail message file, go tothe . .\Tekla Structures
\<version>\messages folder.
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+  To modify an .xml message file, go to the . .\Tekla Structures
\<version>\messages\DotAppsStrings folder.

2. Open the message file you want to customize using a standard text editor.
3. Modify the message as required.
4. Save the message file.

Example: customize a message file

In this example, you will modify a message that Tekla Structures uses for near
side plates in drawings. You want Tekla Structures to display (NS) instead of
(N/S).

1. Gotothe ..\Tekla Structures\<version>\messages folder.
2. Openby number.ail using a standard text editor.

The by number.ail file contains both prompts and default texts that
Tekla Structures uses in drawings.

3. Browse to the following section:
string by number msg no 675

{

entry = ("enu", "(N/S)");
bi
4. Change (N/s) to (NS) in the entry row.

Save and close the file.

See also
Message files (page 291)

Property files

Property files are files that contain the object properties and settings that are
displayed in the property pane or in the dialog boxes of different model
objects or drawing objects.

By default, Tekla Structures uses the standard (page 293) property files when
you apply commands. The default standard property files are read from the
environment's system folder.

In addition to the default property files, you can define user-defined property
files, and load these saved properties later when you create, for example, new
model objects or drawing objects. Tekla Structures stores the saved, user-
defined property files in the current model's \attributes folder.
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To save a user-defined property file, do the following:

In the property pane In a dialog box

1. Enter a name for the property file| 1. Enter a name for the property file

) e in the box next to the Save as
in the box next to the button. button.

2. Click Save or Save as to save the

Click ™ +to save the property file. oroperty file.

Example

Change the standard (page 293) steel column properties so that you create a
new type of column that you call customl.

1. Open the steel column properties in the property pane.
2. Enter or modify the properties you want to save.

3. Inthe box next to the L button, enter a name for the new column
properties, for example, customl.

4. Click ™

Tekla Structures saves the new customl.clm property file in the current
model's \attributes folder.

See also

Model folder files and file name extensions (page 310)

5.8 Standard files

Standard files are property files that Tekla Structures uses by default when you
apply commands.

The standard properties are displayed in the property pane of different model
objects, such as beams, columns or plates, or in the dialog boxes of, for
example, drawing objects.

How to take standard files into use

* Inthe property pane: the properties are loaded when you select the
standard option in the upper part of the property pane. The properties are
in use immediately.

If the values that you loaded are different from the previous values, the
property pane highlights the modified properties.

standard - ﬂ
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+ In dialog boxes: the properties are loaded when you select the standard
option in the list next to the Load button, and click the Load button.

Save| |Load Save as

Standard files are named standard. * where the symbol * is the file name
extension. For example, standard. clmfile is used for steel column
properties. The user-defined attributes are saved with the standard files as
* .morefiles. For example, standard.clm.more file is used for steel column
user-defined attributes.

Tekla Structures reads the default standard files from the environment's
system folder.
Save a set of standard files

If needed, you can save a set of standard files in the current model's
\attributes folder.

You can then copy the standard files to the project folder or the firm folder
for future use, to set up Tekla Structures to suit the way you work.

1. To save a set of standard files, go to Quick Launch.
2. Starttyping save defaults.
3. Select the Save defaults command from the list.

Tekla Structures saves the following list of standard and * .more files in
the . .\TeklaStructuresModels\<model name>\attributes folder:

File Property

standard.bpl Bent plate properties

standard.bpl.more

standard.clm Steel column properties

standard.clm.more

standard.cpl Contour plate properties

standard.cpl.more

standard.crs Orthogonal beam properties

standard.crs.more

standard.dia Twin profile properties

standard.dia.more

standard. fms Plotting frames

standard. fms.more

standard. fpl Folded plate properties

standard. fpl.more
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File Property

standard.ipc Concrete item properties

standard.ipc.more

standard.ips Item properties

standard.ips.more

standard.ler Layer properties

standard.ler.more

standard.mvi Model view properties

standard.mvi.more

standard.num Numbering setup

standard.num.more

standard.prf Project properties

standard.prf.more

standard.prt Steel beam properties

standard.prt.more

standard.scr Bolt properties

standard.scr.more

standard.wld Weld properties

standard.wld.more

4. If you want to load the default property settings from the standard files
that are saved in the attributes folder, go to Quick Launch and use the
Load defaults command.

Create user-defined standard files

You can also create your own standard files. Tekla Structures saves the user-
defined standard files in current model's \attributes folder.

1. To save a user-defined standard file, open the property pane or a dialog
box whose properties you want to save as a standard file.

2. Modify or enter the properties.
3. Save the properties.
* Inthe property pane: enter standard as the name

standard - E . :
, and click = .

Files and folders in Tekla Structures 295 Standard files



5.9

* In adialog box: in the box next to the Save as button, enter standard

Save as

as the name , and click Save as.

Tekla Structures saves the standard file and the related * .more file in
the current model's \attributes folder. If a standard file with the same
file name extension exists in the in the \attributes folder, Tekla
Structures overwrites the previous file.

4. When you want to load the standard file, select it from the list of the

property files in the property pane or in a dialog box.

Alternatively, to load the default property settings from the standard
files that are saved in the attributes folder, go to Quick Launch and
use the Load defaults command.

See also
Property files (page 292)
Settings in the Options dialog box (page 255)

Catalog files

Tekla Structures uses ASCIl and binary files to manage profile, material,
reinforcement, bolt and bolt assembly catalogs.

Each environment has its own folder, where the files related to different
catalogs are stored. For example, . . \environments\uk\general\profil\
contains the files for managing catalog files used in the United Kingdom. The
exact file location may vary depending on the folder structure of your
environment files.

The following table lists files and file types related to catalogs.

File type File name Used for Located in
.inp profitab.inp |Definesthe names| Inthe \profil folder,
that you can use | under the environment
for parametric folders,
profiles. in ..\ProgramData
\Trimble\Tekla
Structures
\<version>
\environments
\<environment>\
rebar databas | The rebar catalog. |Inthe \profil folder,
e.inp under the environment
folders,

Files and folders in Tekla Structures 296 Catalog files




File type File name Used for Located in
in ..\ProgramData
\Trimble\Tekla
Structures
\<version>
\environments
\<environment>\
mesh_database | The reinforcement| In the \profil folder,
.inp mesh catalog. under the environment
folders,
in ..\ProgramData
\Trimble\Tekla
Structures
\<version>
\environments
\<environment>\
You can define | Created when you | You can define the
the file name export rebar folder where to export
while exporting. | catalogs. the files.
.cnv matexp <softw | Contains In the \profil folder,
are>.cnv information to under the environment
convert material | folders,
names when in . .\ProgramData
transferring model \Trimble\Tekla
information using | structures
links. For example, | \<version>
converts S235JRto | \environments
FE360B for DSTV. |\<environment>\
prfexp <softw | Contains In the \profil folder,
are>.cnv information to under the environment
convert profile folders,
names when in . .\ProgramData
transferring model \Trimble\Tekla
information using | Structures
links. For example, | \<version>
converts HEA100 |\environments
to HE100A for \<environment>\
DSTV.
.clb For example, Contains the . .\ProgrambData
RU CF.clb definitions of \Trimble\Tekla
parametric Structures
profiles used in \<version>
profitab.inp. \environments
\common\inp
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File type

File name

Used for

Located in

.1lis

You can define
the file name
while exporting.

Created when you
export bolt, profile
and material
catalogs.

You can define the
folder where to export
the files.

.db

assdb.db

The bolt assembly
catalog.

In the \profil folder,
under the environment
folders,

in ..\ProgramData
\Trimble\Tekla
Structures
\<version>
\environments
\<environment>\

screwdb.db

The bolt catalog.

In the \profil folder,
under the environment
folders,

in ..\ProgramData
\Trimble\Tekla
Structures
\<version>
\environments
\<environment>\

.bin

profdb.bin

The profile
catalog.

In the \profil folder,
under the environment
folders,

in ..\ProgramData
\Trimble\Tekla
Structures
\<version>
\environments
\<environment>\

matdb.bin

The material
catalog.

In the \profil folder,
under the environment
folders,

in ..\ProgramData
\Trimble\Tekla
Structures
\<version>
\environments
\<environment>\

See also

Customize the profile catalog (page 139)

Customize the material catalog (page 131)
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5.11

Customize the bolt catalog (page 210)
Customize the rebar catalog (page 227)

Font files and font conversion files

You can define the location of font files with the advanced option

DXK FONTPATH in the teklastructures.ini or your environment
initialization file. For example, you can use fonts available in the
folder . .\Programbata\Trimble\Tekla Structures\<version>
\environments\common\fonts.

This folder includes the following fonts:

Font Font type
fixfont.fon Tekla Structures system font
romco. fon Tekla Structures system font
romsim. fon Tekla Structures system font
romsim8. fon Tekla Structures system font

Fonts are converted using font conversion files available in the same folder:

File Description

template fonts.cnv Used for converting Tekla Structures
system fonts (Template Editor fonts)
to Windows fonts in DWG/DXF export.

dxf fonts.cnv Used for converting True Type fonts
to SHX fonts (font format understood
by AutoCAD) in DWG/DXF export.

NOTE The Cyrillic fonts GOST 2.304-81 type A.ttfand GOST 2.304-81 type
B.ttf arelocated in the C:\Windows\Fonts folder, not
the . .\ProgramData\Trimble\Tekla Structures\<version>
\environments\common\fonts folder.

See also
Initialization files (.ini files) (page 246)

Symbol files

Symbols are used for example in various places in drawings, for example, as
separate objects, and in marks.
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You can create symbols with Symbol Editor. In this case, the file name
extension is . sym. You can also use symbols of .dwg format.

Tekla Structures symbol files are by default located in the
folder . .\environments\common\symbols.

5.12

Files related to templates, reports and drawings

Tekla Structures has several files that relate to templates, reports, drawings

and printing.

File or file type

Description

Location

created with the
Drawings & reports -->
Drawing properties -->
Drawing layout
command.

.rpt Report templates System folders defined
(page 339) created with | for the advanced option
the Template Editor XS SYSTEM

.tpl Drawing templates Template folders
(page 339) created with | defined for the
the Template Editor advanced option

XS TEMPLATE DIRECTO
RY
.lay Layout definitions The \attributes sub-

folder in the model
folder

plotdev.bin

Printer device definitions
created with the

Printer Catalog printer
instances.

System folders defined
for the advanced option
XS SYSTEM

xdproc

Master Drawing
Catalog rule set

System folders defined
for the advanced option
XS SYSTEM

xdproc.master

Master Drawing
Catalog master drawing
file

System folders defined
for the advanced option
XS SYSTEM

xdproc.master.png

Master Drawing
Catalog sample
(preview) image files

System folders defined
for the advanced option
XS SYSTEM

xdproc.png

Master Drawing
Catalog thumbnail
image files

System folders defined
for the advanced option
XS SYSTEM
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5.14

For more information about the folder search order, see Folder search order
(page 334).

Note that default drawing, report, and template files are read from the system
folders defined with Xs sYSTEM (or from the XS TEMPLATE DIRECTORY
folders), but user-defined files are stored in the model's \attributes folder.

Image files

Tekla Structures uses image files in several places:

+ Intemplates in drawings

* In drawing snapshots

* In component dialog boxes and thumbnails

* Indrawing line types

* In the surface treatment dialog box

* In the Master Drawing Catalog for thumbnails and sample images
+ In profile properties dialog boxes

The following image file formats are supported in Tekla Structures:
* Intemplates: bmp, gif, grd, jpg, ppm, pgm, rle, tiff and xkrl

+ Indrawing snapshots, and int thumbnail and sample images for the
Master Drawing Catalog: png

* Other situations: bmp

See also
Add images in a template (page 354)

Log files

Tekla Structures writes information to log files when you, for example, number
a model or save a model.

File Description

analysis.log Tekla Structures stores information in
this file when you run the analysis.
The file also contains information on
the errors that occurred during load
distribution. This log file is saved in
the current model folder.
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File

Description

check database.log

Tekla Structures stores information in
this file when you run the Repair
command in File menu --> Diagnose
& repair --> Model . This log file is
saved in the current model folder.

ClashCheck.log

Contains clashes found in the most
recent clash check. This log file is
saved in the current model folder.

ClientLog cat.txt
ClientLog dog.txt

The client log files contain diagnostic
information and error messages
regarding the Tekla Model Sharing
sharing service, such as connecting to
the sharing service or the status of
the sharing service. The client log files
are saved in the \Users\<user>
\AppDatal\Local\Tekla
DataSharing folder.

The client log contains two log files
with the maximum size of 1
megabyte, so that the information will
not use too much disk space. When
the maximum file size is reached in
the ClientLog cat.txt file, log
writing is switched to the
ClientLog dog.txt file, and the
other way around. Each time the
client log file is switched, any
information previously saved in the
current log file is cleared before any
new log information is written into
the log file.

Files and folders in Tekla Structures

ComponentCatalog <user>.log

302

Contains troubleshooting information
related to the Applications &
components catalog and any errors
that have occurred in the
Applications & components catalog.
For example, errors in the catalog
definition files are stored in the
ComponentCatalog <user>.log
file. This log file is saved in the \1ogs
folder under the current model
folder.

Note that a limited number of older
log messages (approximately 1024KB)
related to the Applications &

Log files




File

Description

components catalog are archived
and saved in the
ComponentCatalog
<user>.bak.log file.

conflict.log

Contains conflicts that have occurred
in the multi-user mode when more
than a one user has modified an
object. This log file is saved in the
current model folder.

DocumentManager <user>.log

Contains troubleshooting information
related to the Document manager,
and any errors that have occurred in
the Document manager. This log file
is saved in the \1ogs folder under the
current model folder.

Note that a limited number of older
log messages (approximately 256KB)
related to the Document manager
are archived and saved in the
DocumentManager
<user>.bak.log file.

DPMPrinter <user>.log

Contains troubleshooting information
related to printing, and any errors
that have occurred in printing
drawings or reports to a printer, a
plot file, or a PDF file. This log file is
saved in the \1ogs folder under the
current model folder.

Note that a limited number of older
log messages (approximately 1024KB)
related to printing are archived and
saved in the DPMPrinter2
<user>.log file.

drawing cloning.log

Contains information on cloned
drawings. This log file is saved in the
current model folder.

drawing history.log

Contains information on drawing
history. Use the advanced option XS_
DRAWING_HISTORY_LOG_TYPE to
define the contents of the file. This
log file is saved in the current model
folder.

dstv _nc.log
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Each time you create NC files, Tekla
Structures stores information in this
file about the processed assemblies.
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File Description

This log file is saved in the current
model folder.

error <user> <YYYYMMDD> <HHMM | Each time an error occurs in Tekla
SS>.log Structures, the error is saved in an
error log file. Error log files contain
the description of errors that have
occurred at a particular time. For
example, if an error has occurred on
April 1, 2019 at 9:15:30 AM, the name
of the related error log file is

error <user> 20190401 091530.
log. This log file is saved in the \1ogs
folder under the current model
folder.

filetranerror.log Used only for cold rolled components,
such as Albion, Ayrshire, and Hispan.
If the File Transfer components do
not work as expected, Tekla
Structures stores error messages in
this file. This log file is saved in the
current model folder.

modelsharing.log Contains the sharing operations that
have been performed in Tekla Model
Sharing. For example, opening a
shared model and reading in the
changes made by other users are
stored in the modelsharing. log file.
This log file is saved in the \1ogs
folder under the current model
folder.

numberinghistory.txt Contains full details of each
numbering session carried out on the
model. Each session is in a different
block of the file. This log file is saved
in the current model folder.

save history.log Tekla Structures stores information in
this file each time you save a model.
This log file is saved in the current
model folder.

sharingfacade.log Contains the essential information
from the client log files when an error
has occurred in the Tekla Model
Sharing sharing service. This log file is
saved in the \1ogs folder under the
current model folder.
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File Description

TeklaStructures <user>.log Contains information on the entire

Tekla Structures session from
opening the model to closing it. The
file contains, for example, errors and
information on which catalogs were
used. This temporary log file is saved
inthe \TeklaStructuresModels
folder, and it is removed when you
close Tekla Structures.

wizard.log Tekla Structures stores information in

this file when you run a drawing rule
set (wizard) file. The file contains, for
example, errors and number of
drawings created. This log file is saved
in the current model folder.

See also

View a log file (page 305)

View a log file
The parts that are listed in a log file can be viewed in the model.

1.
2.

Open the model whose log history you want view.

On the File menu, click Logs and select a log file you want to see.
« Clash Check history log (C1ashCheck. 1og)

+ Session history log (TeklaStructures <user>.log)

*  Numbering history log (numberinghistory.txt)

+ Saving history log (save history.log)

+ Drawing history log (drawing history.log)

* Analysis history log (analysis.log)

In the log file, select a row which contains a part or an assembly.
Parts and assemblies have the prefix guid.

Tekla Structures highlights the part in the model. If there are several parts
or assemblies on a row and you select that row, Tekla Structures
highlights all the parts in the model. You can also select parts on different
rows.

If you want to view the log files in a viewer that has been associated with
the file type, for example, in Microsoft Notepad, on the File menu click
Logs and select View with the default application.
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TIP You can access a part's or an assembly’s pop-up menu from the log file
by right-clicking a row that contains a part or an assembly. Tekla
Structures displays the same pop-up menu as when you right-click a part
or an assembly in the model.

See also

Log files (page 301)

Change the name and location of session history log file (page 306)
Numbering history log file (page 307)

Change the name and location of session history log file

You can change the name and location of the session history log file
(TeklaStructures <user>.log).

If someone else manages your installation of Tekla Structures, do not change
these settings unless you are instructed to do so.

Windows username and the . 1og file extension are always added after the
customizable part of the name.

1. Open a suitable initialization file (page 247) for editing.
For example, user.ini Or company.ini.

2. To change the name of the session history log file, add the following line
to the initialization file:

set XS LOG FILE NAME=<name of the file>
For example:
set XS LOG FILE NAME=sessionhistory

If the Windows user name is "achilles", this example would result in a log
file named sessionhistory achilles.log.

The default name is TeklaStructures <user>.log.

3. To change the location of the session history log file, add the following
line to the initialization file:

set XS LOGPATH=<location of the file>

If there is no other location set, the file is stored in the parent folder for
model folders (by default c:\TeklaStructuresModels).

4. Save the initialization file.
5. Restart Tekla Structures for the changes to take effect.

Files and folders in Tekla Structures 306 Log files



See also
Log files (page 301)
View a log file (page 305)

Numbering history log file

The numberinghistory.txt log file contains full details of each numbering
session carried out on the model. Each numbering session is in a different
block of the file.

NOTE If you remove or delete the numberinghistory.txt log file, Tekla Structures
generates a new file with the same name next time when you run numbering.
The new file does not contain a history of previous numbering sessions.

Example

Below is an example of the contents of a numberinghistory. txt log file.

#%% Numbering (haka): Tha Jun 14 13:08:08 2012
Modified numbering
Compare modified to old parts

Compare new to old parts

Check for standard parts

Use old numbers

Tolerance: 1.000000

SteelTolerance: 1.000000

ConcreteTolerance: 2.000000

RebarTolerance: 2.000000
Part guid: IDS10F595D-0000-0017-3133-353939383237 series:Concrete_Cflfl Concrete_cflfo -> Concrete_Cflfl
Bssembly guid: IDS10F535D-0000-0016-3133-353939383237 series:C/1 C/0 -» C/1
#*% Operation finished Thu Jun 14 13:08:08 2012

1 User name, date and time of the numbering.

2 Numbering method.

* Modified numbering is displayed when you run the Number
modified objects command.

* Modified numbering for selected series isdisplayed
when you run the Number series of selected objects
command.

* Diagnose & Repair Numbering: All is displayed when you
run the Diagnose & repair numbering: All command.

* Diagnose & Repair Numbering: Series of selected
objects is displayed when you run the Diagnose & repair
numbering: Series of selected objects command.

* Renumber all isdisplayed when you select the Renumber all
option in the Numbering Setup dialog box.
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3 Some Compare options set in the Numbering Setup dialog box
are displayed in the numbering.history log file only if they are
set differently than the default value:

* Compare modified to old parts

* Compare new to old part

* No holes comparing

* No part name comparing

* Beam orientation

* Column orientation

Some Compare options are not displayed at all:
* Reinforcing bars

+ Embedded objects

+ Surface treatment

4 Numbering options.

* Use old numbers is displayed only when you have selected
the Re-use old numbers option in the Numbering Setup dialog
box.

* Check for standard parts is displayed only when you have
selected the Check for standard parts option in the
Numbering Setup dialog box.

5 Tolerances are set in the Numbering Setup dialog box.

6 Changes in the position numbers and in the numbering series
during one numbering session.
In addition:

If a numbering series overlaps another, the errors are written to the
log file.

See also

Numbering series in the numbering history log file (page 308)

Numbering series in the numbering history log file

Tekla Structures lists information on the numbered parts and assemblies in
the numberinghistory.txt log file.

Example 1

The numberinghistory.txt log after one concrete beam B/20 has been
created and numbered:
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& Concrete Beam Properties

]
B;‘KZG' Save| |Load| standard > |Save as| standard
| Attributes | Position | Cast unit ‘ Deforming |
Murnbering series
i Prefi B Start number: 20
Cast unittype  Precast -
Part guid: ID510F5950-0000-0030-3133-353939383335 SEIiES:CDnCIEt373—20/1 CEHCIEEE73—20/O - CDHCIEtEii—QO/l
Assembly guid: ID510F595D-0000-002F-3133-353939383335 series:B/20 B/0 -> B/20

1 Part position number.

* The part with the GUID
ID510F595D-0000-0030-3133-353939383335 is a part of the
numbering series Concrete B-20/1.

+ The part becomes the first part in the numbering series:
Concrete B-20/0 -> Concrete B-20/1.

2 Assembly position number.

« The assembly ID of the part is
ID510F595D-0000-002F-3133-353939383335.

* The part belongs to the B/20 assembly numbering series, which
is also the cast unit numbering series.

* The part gets the assembly position number: 8/20: B/0 ->
B/20.

Example 2

The numberinghistory.txt log after another concrete beam B/21 has been
created and numbered:

P & Concrete Beam Properties

B/21
| / m— - andard
7
Attributesl Position | Cast unit | Deforming

5 B/ 20
= Mumbering series
B
- Prefix: B Start number: 20
= Cast unittype  Precast -
Part guid: IDS10F595D-0000-0030-3133-353939383335 SEIiES:CDHCIEt873—2OIJ Concret273—20f0 -= CDHCIEt873—20f2
Assembly guid: IDS10F595D-0000-002F-3133-353030383335 series:B/20 B/0 -> B/21
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1 Part position number of the new part.

* The part with the ID
ID510F595D-0000-0030-3133-353939383335 is part of the
numbering series Concrete B-20/1.

+ The part becomes the second part in the numbering series:
Concrete B-20/0 -> Concrete B-20/2.

2 Assembly position number.

+ The assembly ID of the partis
ID510F595D-0000-002F-3133-353939383335.

* The part belongs to the B/20 assembly numbering series, which is
also the cast unit numbering series.

* The part gets the assembly position number: 8/20 B/0 ->
B/21.

See also

Numbering history log file (page 307)

Model folder files and file name extensions

The following tables list the folders, files and file name extensions of files
located in a Tekla Structures model folder.

Files in the Tekla Structures model folder

File or file name extension Description

.dbl Model database

.db2 Numbering database

environment.db Database for user-defined attribute
definitions

xslib.dbl Contains information on user-defined
connections and details, and default
component descriptions.

.idrm Mapping file, which handles IDs. Do
not modify.

xslib.db2 Contains numbering information.

options model.db and
options drawings.db

Contain values for model-specific
options from the Options dialog box
and values for model-specific
advanced options from the Advanced
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File or file name extension

Description

Options dialog box. When a model is
created, Tekla Structures reads
model-specific options and advanced
options values from the
standard.opt fileand .ini filesin
the environment folders and saves
them in these two databases.

history.db

Model history database.

xsdb.xs

File used for displaying the name of
the model in the Open dialog box.

Xs _user. <username>

Contains interface settings specified
by the user.

Each time a model is saved, an
xs_user.<username> file is created
or updated. These settings are user
specific. If the xs _user.<username>
file is not found in the model folder
when you open the model, Tekla
Structures searches for the
xs_user.default file in the
following folder search order: model,
model\attributes, project, XS_FIRM
\attributes, system. If this file is not
found, Tekla Structures default
settings will be used.

This file contains settings for many of
the options in the Options dialog box
and the settings for the icons on the
Selecting and Snapping toolbars.

save history.log

Tekla Structures stores the
information in this file each time the
model is saved. The file includes the
saving time, date and information on
any conflicts during saving.

notification report.xsr

File used for displaying a notification
report of assignments when you open
a model.

TeklaStructuresModel.xml

Contains information on the Tekla

Structures session, for example on
opening, closing and what catalogs
are being used.

dotlog.txt

A log file that contains information on
Tekla Open API application use.
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File or file name extension

Description

.locked A temporary file that locks the model
folder files to prevent modifications
while the model is in use.

.bak A backup copy of the model database.

assert.txt

A log file that contains information on
assertion errors.

ClashCheck. txt

A log file that contains information on
clashes found in the most recent
clash check and the date and time of
the clash check.

ClashCheck.history

A file that contains information on all
clashes found in all clash checks and
the dates and times of the clash
checks.

wizard.txt

Tekla Structures stores information in
this file when you run a drawing rule
set (wizard) file. The file contains, for
example, errors, number of drawings
created, and information on which
commands were used.

.1lis

Different catalogs can be exported
from and imported to different Tekla
Structures models as . 1is files.
These include profile, material and
bolt catalogs.

.tsc

Shapes can be exported from and
imported to different Tekla Structures
models as . tsc files.

.This is multiuser model

Contains information about the PC
running the Tekla Structures multi-
user server.

Do not alter or delete this file in
normal circumstances. If you move a
model to a different server, you
should delete this file. Tekla
Structures generates a new file with
the same name.

ComponentCatalog.xml

Contains the model level catalog
definitions of the Applications &
components catalog.

<user> ComponentCatalogUserSe
ttings.xml

Lists the recently used applications
and components, and their location in
the Applications & components
catalog structure.
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File or file name extension

Description

Worktypes.xml

Lists available task types. Created
when you start Task Manager.

WorkTypeProperties.xml

Lists allowed property types and their
units.

. tmp A file used to store temporary data.

.cnv A file used to map Tekla Structures
profile and material names with
names used in other software.

.colorset Created when you export a color set

from Organizer.

Files in the \Analysis folder

File or file name extension

Description

.ifc The analysis model exported in IFC
format.

.stp The analysis model exported in CIS/2
format.

.map A file used for debugging analysis

models.

analysis results.dbb

Database for analysis load
combination results.

.dbé6

Analysis model database.

Files in the \attributes folder

File or file name extension

Description

.TOop

Reference object properties

.rop.more

Reference object user-defined
attribute properties

.m10000017 FabTrol XML import properties
.m10000015 Import attribute properties
.ncf NC file properties

.ExportIFC.MainDialog

IFC export properties

.m440000004 3D DWG/DXF export properties
.m440000003 3D DGN export properties
.m1000004 FEM export properties

.m10000011 CIS analysis model export properties
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File or file name extension

Description

.m10000026 CIS manufacturing model export
properties
.m1000007 CAD export properties
.m10000016 Cover sheet export properties
.SO0bjGrp Model selection filter properties
.VObjGrp Model view filter properties
.0OrgObijGrp Organizer filter properties
.PObjGrp Object group filter properties
.grd Rectangular grid properties

.grd.more

Rectangular grid user-defined
attribute properties

.rgrd

Radial grid properties

.rgrd.more

Radial grid user-defined attribute
properties

.grdp

Grid line properties

.grdp.more

Grid line user-defined attribute
properties
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.cnl Construction line properties

.cncrl Construction circle properties
.cnarc Construction arc properties
.cnplycrv Construction polycurve properties
.mvi Model view properties that you have

saved for the model.

Default 3D, part, component, custom
component, assembly, and cast unit
view settings files need to be saved
with names used in common
environment:

3D view: basic_view

3D part view: part_basic_view
Part front view: part_front_view
Part top view: part_top_view
Part end view: part_end_view

Part perspective view:
part_persp_view

3D component view:
component_basic_view
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File or file name extension

Description

Component front view:
component_front_view

Component top view:
component_top_view

Component end view:
component_end_view

Component perspective view:
component_persp_view

Custom component front view:
custom_object_editor_front_view

Custom component top view:
custom_object_editor_top_view

Custom component end view:
custom_object_editor_end_view

Custom component perspective view:
custom_object_editor_perspective_vie
w

3D assembly or cast unit view:
assembly_basic_view

Assembly or cast unit front view:
assembly_front_view

Assembly or cast unit top view:
assembly_top_view

Assembly or cast unit end view:
assembly_end_view

Assembly or cast unit back view:
assembly_back_view

Assembly or cast unit bottom view:
assembly_bottom_view

Assembly or cast unit perspective
view: assembly_persp_view

.gvi Saved properties for creating views
along grid lines

.rep Object representation properties

.clm Steel column properties

.clm.more

Steel column user-defined attribute
properties

.prt

Steel beam properties
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File or file name extension Description

.prt.more Steel beam user-defined attribute
properties

.sb Steel spiral beam properties

.sb.more Steel spiral beam user-defined
attribute properties

.crs Orthogonal beam properties

.Crs.more Orthogonal beam user-defined
attribute properties

.dia Twin profile properties

.dia.more Twin profile user-defined attribute
properties

.cpl Contour plate properties

.cpl.more Contour plate user-defined attribute
properties

.blp Bent plate properties

.blp.more Bent plate user-defined attribute
properties

.1pl Lofted plate properties

.1lpl.more Lofted plate user-defined attribute
properties

.ips Item properties

.ips.more Item user-defined attribute properties

.cpf Pad footing properties

.cpf.more Pad footing user-defined attribute
properties

.csf Strip footing properties

.csf.more Strip footing user-defined attribute
properties

.ccl Concrete column properties

.ccl.more Concrete column user-defined
attribute properties

.cbm Concrete beam or concrete polybeam
properties

.cbm.more Concrete beam or concrete polybeam
user-defined attribute properties

.csb Concrete spiral beam properties

.csb.more Concrete spiral beam user-defined
attribute properties

.csl Concrete slab properties
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File or file name extension Description

.csl.more Concrete slab user-defined attribute
properties

.cpn Concrete panel properties

.cpn.more Concrete panel user-defined attribute
properties

.1sl Concrete lofted slab properties

.1sl Concrete lofted slab user-defined
attribute properties

.ipc Concrete item properties

.ipc.more Concrete item user-defined attribute
properties

.rbr Reinforcing bar properties

.rbr.more Reinforcing bar user-defined attribute
properties

.rbg Reinforcing bar group properties

.rbg.more Reinforcing bar group user-defined
attribute properties

.rcu Curved reinforcing bar group
properties

.rci Circular reinforcing bar group
properties

.rbm Reinforcement mesh properties

.rbm.more Reinforcement mesh user-defined
attribute properties

.rbs Reinforcement strand pattern
properties

.rbs.more Reinforcement strand pattern user-
defined attribute properties

.rsp Reinforcement splice properties

.rsp.more Reinforcement splice user-defined
attribute properties

.rst Rebar set properties

.rst.more Rebar set user-defined attribute
properties

.rst.zones Rebar set spacing zone properties

.rst_pm Rebar set property modifier
properties

.rst_pm.more Rebar set property modifier user-
defined attribute properties
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File or file name extension

Description

.rst_edm

Rebar set end detail modifier
properties

.rst _edm.more

Rebar set end detail modifier user-
defined attribute properties

.rst sm

Rebar set splitter properties

.admodel

Analysis model properties

.admodel .more

Analysis model user-defined attribute
properties

.1ml Point load properties

.1m2 Line load properties

.1m3 Area load properties

.1m4 Uniform load properties
.m10000028 Wind load properties

.1m6 Temperature load properties
.1lco Load combination properties
.adnode Analysis node properties

.adnode.more

Analysis node user-defined attribute
properties

.prt_ad, .prt design

File types associated with steel beam
analysis property settings. .prt ad
contains information associated with
the analysis part properties

and .prt_design contains
information associated with the
actual steel beam design.

.crs_ad, .crs_design

File types associated with orthogonal
steel beam analysis property
settings. .crs_ad contains
information associated with the
analysis part properties

and .crs_design contains
information associated with
orthogonal steel beam design.

.clm ad, .clm design

File types associated with steel
column analysis property
settings. .clm ad contains
information associated with the
analysis part properties

and .clm design contains
information associated with the
actual steel column design.
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File or file name extension

Description

.dia_ad, .dia design

File types associated with steel twin
profile analysis property

settings. .dia_ ad contains
information associated with the
analysis part properties

and .dia design contains
information associated with actual
twin profile design.

.cpl _ad, .cpl design

File types associated with contour
plate analysis property

settings. .cpl ad contains
information associated with the
analysis part properties

and .cpl design contains
information associated with actual
contour plate design.

.cpf ad, .cpf design

File types associated with pad footing
analysis property settings. .cpf ad
contains information associated with
the analysis part properties

and .cpf design contains
information associated with the
actual pad footing design.

.csf ad, .csf design

File types associated with strip footing
analysis property settings. .csf ad
contains information associated with
the analysis part properties

and .csf design contains
information associated with the
actual strip footing design.

.ccl _ad, .ccl design

File types associated with concrete
column analysis property

settings. .ccl ad contains
information associated with the
analysis part properties

and .ccl design contains
information associated with the
actual concrete column design.

.cbm_ad, .cbm design
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File types associated with concrete
beam analysis property

settings. .cbm_ad contains
information associated with the
analysis part properties

and .cbm design contains
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File or file name extension

Description

information associated with the
actual concrete beam design.

.csl ad, .csl design

File types associated with concrete
slab analysis property

settings. .csl1 ad contains
information associated with the
analysis part properties

and .csl design contains
information associated with the
actual slab design.

.cpn_ad, .cpn _design

File types associated with concrete
panel analysis property

settings. .cpl ad contains
information associated with the
analysis part properties

and .cpl design contains
information associated with the
actual concrete panel design.

.srf

Surface treatment properties

.srf.more

User-defined surface treatment
attribute properties

.srfo

Surface properties

.srfo.more

User-defined surface attribute
properties

.cha

Edge chamfer properties

.cha.more

User-defined edge chamfer attribute
properties

.SCr

Bolt properties

.SCr.more

User-defined bolt attribute properties

.wld

Weld properties

.wld.more

User-defined weld attribute
properties

*  udwcs User-defined weld cross sections
(UserDefinedWeldCrossSections.udwc
s)

.m1000009 Control number properties

.m1000010 Control number locking properties

.num Numbering setup properties

.rpr Report properties

.4d Project status visualization properties
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File or file name extension

Description

standard.opt

Settings are saved in standard.opt
in the \attributes folder only when
you save your own settings in the
Options dialog box using Save.

There is a standard. opt file in the
environment folder that gives the
initial values to be loaded when a
model is created.

Component properties files in the \attributes folder

Properties files for components available in the Applications & components
catalog, for example .5310000063 for 2L Splice (63) component properties.
These files are stored in the attributes folder under the model folder.

Object level drawing settings, saved in \attributes folder

File or file name extension Description

.dprt Object level part properties

.dim Object level dimension properties

. pm Object level part mark properties

.Jm Object level connection mark
properties

.sm Object level bolt mark properties

.rm Object level reinforcement mark
properties

.Mrms Object level merged reinforcement
mark properties

.pom Pour object mark properties

.surfm Object level surface treatment mark
properties

.note Object level associative note
properties

.wls Object level weld mark properties

.lev Object level level mark properties

.rev Object level revision mark properties

.drmsh Object level reinforcement mesh
properties
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File or file name extension Description

.drbr Object level reinforcement properties

.po Object level pour object properties

.sc Object level bolt properties

.srf Object level surface treatment
properties

.dgr Object level grid properties

.sbl Object level symbol properties

.wls Object level weld mark properties

.drtxt Object level text properties

.gln Object level line properties

.grt Object level rectangle properties

.gci Object level circle properties

.gar Object level arc properties

.gpl Object level polyline properties

.gpg Object level polygon and cloud
properties

View level drawing settings, saved in \attributes folder

.vclassif.copt

File or file name extension Description
.vi View level view properties
.vi.copt
.vclassif View level detailed object level

settings

.vpm View level part mark properties

.vsm View level bolt mark properties

.vnpm View level neighbor part mark
properties

.vsurfm View level surface treatment mark
properties

.vim View level connection mark
properties

.vrm View level reinforcement mark
properties

.vnrm View level neighbor reinforcement

mark properties
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File or file name extension Description

. vpom View level pour object mark
properties

.Vp View level part properties

. VS View level bolt properties

.vnp View level neighbor part properties

.vsurf View level surface treatment
properties

VW View level welding properties

.Vr View level reinforcement properties

.vnr View level neighbor reinforcement
properties

.vrmp View level reference object properties

.Vpo View level pour object properties

.vg View level grid properties

.vE View level filter properties

.vnf View level neighbor part filter
properties

Files related to single-part drawings, drawing level
properties, saved in \attributes folder

File or file name extension Description

.wd Single-part drawing properties

.wd.copt

.wd.more Single-part drawing user-defined
attributes

.wdf Single-part drawing filter properties

.wdnf Single-part drawing neighbor part
filter properties

.wdl Single-part drawing layout properties

.wdl.more Single-part drawing user-defined
layout attributes

.wdv Single-part drawing view properties

.wdv.more Single-part drawing user-defined view
attributes

.wdc Single-part drawing section view
properties
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File or file name extension

Description

.wdc.more

Single-part drawing user-defined
section view attributes

.wdd

Single-part drawing dimension
properties

.wdd.more

Single-part drawing user-defined
dimension attributes

.wdcd

Single-part drawing dimensioning
properties

.wdcd more

Single-part drawing user-defined
dimensioning attributes

.wWpm Single-part drawing part mark
properties

.Wsm Single-part drawing bolt mark
properties

.Wnpm Single-part drawing neighbor part
mark properties

.wdsurfm Single-part drawing surface treatment

mark properties

.wdsurfm.more

Single-part drawing user-defined
surface treatment mark attributes

.wjm Single-part drawing connection mark
properties

.wdp Single-part drawing part properties

.wds Single-part drawing bolt properties

.wds.more

Single-part drawing user-defined bolt
attributes

.wdnp

Single-part drawing neighbor part
properties

.wdnp.more

Single-part drawing user-defined
neighbor part attributes

.wdsrf

Single-part drawing surface treatment
properties

.wdsrf.more

Single-part drawing user-defined
surface treatment attributes

.wdgr

Single-part drawing grid properties

.wdgr.more

Single-part drawing user-defined grid
attributes

.wdr

Single-part drawing protection
properties

.wdr .more

Single-part drawing user-defined
protection attributes
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Files related to assembly drawings, drawing level
properties, saved in \attributes folder

File or file name extension

Description

.ad Assembly drawing properties

.ad.more Assembly drawing user-defined
attributes

.adf Assembly drawing filter properties

.adnf Assembly drawing neighbor part filter
properties

.adl Assembly drawing layout properties

.adl.more Assembly drawing user-defined
layout attributes

.adv Assembly drawing view properties

.adc Assembly drawing section view
properties

.add Assembly drawing dimension
properties

.add.more Assembly drawing user-defined
dimension attributes

.adcd Assembly drawing dimensioning

properties

.adcd.more

Assembly drawing user-defined
dimensioning attributes

.apm Assembly drawing part mark
properties

.asm Assembly drawing bolt mark
properties

.anpm Assembly drawing neighbor part
mark properties

.adsurfm Assembly drawing surface treatment

mark properties

.adsurfm.more

Assembly drawing user-defined
surface treatment mark attributes

.ajm Assembly drawing connection mark
properties
.adp Assembly drawing part properties
.adp.more Assembly drawing user-defined part
attributes
.ads Assembly drawing bolt properties
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File or file name extension Description

.adnp Assembly drawing neighbor part
properties

.adnp.more Assembly drawing user-defined
neighbor part attributes

.adsrf Assembly drawing surface treatment
properties

.adsrf.more Assembly drawing user-defined
surface treatment attributes

.adw Assembly drawing welding properties

.adw.more Assembly drawing user-defined
welding attributes

.adgr Assembly drawing grid properties

.adgr.more Assembly drawing user-defined grid
attributes

.adr Assembly drawing protection
properties

Files related to cast unit drawings, drawing level
properties, saved in \attributes folder

File or file name extension Description

.cud Cast unit drawing properties

.cud.copt

.cud.more Cast unit drawing user-defined
attributes

.cudl Cast unit drawing layout properties

.cudl.more Cast unit drawing user-defined layout
attributes

.cudv Cast unit drawing view properties

.cudv.more Cast unit drawing user-defined view
attributes

.cudc Cast unit drawing section view
properties

.cudc.more Cast unit drawing user-defined
section view attributes

.cudd Cast unit drawing dimension
properties

.cudd.more Cast unit drawing user-defined
dimension attributes
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File or file name extension

Description

.cudcd

Cast unit drawing dimensioning
properties

.cudcd.more

Cast unit drawing user-defined
dimensioning properties

.cupm Cast unit drawing part mark
properties

.cusm Cast unit drawing bolt mark
properties

.cunpm Cast unit drawing neighbor part mark
properties

.cudsurfm Cast unit drawing surface treatment

mark properties

.cudsurfm.more

Cast unit drawing user-defined
surface treatment mark attributes

.cudrm

Cast unit drawing reinforcement mark
properties

.cudrm.more

Cast unit drawing user-defined
reinforcement mark attributes

.cudp

Cast unit drawing part properties

.cudp.more

Cast unit drawing user-defined part
attributes

.cuds

Cast unit drawing bolt properties

.cuds.more

Cast unit drawing user-defined bolt
attributes

.cudnp

Cast unit drawing neighbor part
properties

.cudnp.more

Cast unit drawing user-defined
neighbor part attributes

.cudsrf

Cast unit drawing surface treatment
properties

.cudsrf.more

Cast unit drawing user-defined
surface treatment attributes

.cudr

Cast unit drawing reinforcement
properties

.cudr.more

Cast unit drawing user-defined
reinforcement attributes

.cudw

Cast unit drawing welding properties

.cudw.more

Cast unit drawing user-defined
welding attributes

.cudgr

Cast unit drawing grid properties

Files and folders in Tekla Structures 327

Model folder files and file name extensions




File or file name extension

Description

.cudgr.more

Cast unit drawing user-defined grid
attributes

.cudrp

Cast unit drawing protection
properties

.cudrp.more

Cast unit drawing user-defined
protection attributes

.cuf

Cast unit drawing filter properties

.cunf

Cast unit drawing neighbor part filter
properties

Files related to general arrangement drawings, drawing
level properties, saved in \attributes folder

File or file name extension

Description

.gclassif.copt

.gd General arrangement drawing
gd. copt properties
.gclassif General arrangement drawing

detailed object level settings

.gd.more General arrangement drawing user-
defined properties

.gdl General arrangement drawing layout
properties

.gdl.more General arrangement drawing user-
defined layout attributes

.gdv General arrangement drawing view

properties

.gdv.more

General arrangement drawing user-
defined view attributes

.gdd General arrangement drawing
dimension properties

.gdd.more General arrangement drawing user-
defined dimension attributes

.gdcd General arrangement drawing

dimensioning properties

.gdcd.more

General arrangement drawing user-
defined dimensioning attributes

. gpm

General arrangement drawing part
mark properties
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File or file name extension Description
.gsm General arrangement drawing bolt
mark properties
.gnpm General arrangement drawing
neighbor part mark properties
.gdsurfm General arrangement drawing surface

treatment mark properties

.gdsurfm.more

General arrangement drawing user-
defined surface treatment mark
attributes

.gjm General arrangement drawing
connection mark properties
.gdrm General arrangement drawing

reinforcement mark properties

.gdrm.more

General arrangement drawing user-
defined reinforcement mark

attributes

.gnrm General arrangement drawing
neighbor reinforcement mark
properties

.gpom General arrangement drawing pour
object mark properties

.gdp General arrangement drawing part
properties

.gdp.more General arrangement drawing user-
defined part attributes

.gds General arrangement drawing bolt
properties

.gds.more General arrangement drawing user-
defined bolt attributes

.gdnp General arrangement drawing

neighbor part properties

.gdnp.more

General arrangement drawing user-
defined neighbor part attributes

.gdsrf General arrangement drawing surface
treatment properties

.gdw General arrangement drawing
welding properties

.gdw.more General arrangement drawing user-
defined welding attributes

.gdr General arrangement drawing
reinforcement properties
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File or file name extension

Description

.gdr.more

General arrangement drawing user-
defined reinforcement attributes

.gnr General arrangement drawing
neighbor reinforcement properties

.gpo General arrangement drawing pour
object properties

.gpbr General arrangement drawing pour
break properties

.gdrmp General arrangement drawing

reference object properties

.gdrmp.more

General arrangement drawing user-
defined reference model attributes

.gdgr

General arrangement drawing grid
properties

.gdgr.more

General arrangement drawing user-
defined grid attributes

.gdrp

General arrangement drawing
protection properties

.gdrp.more

General arrangement drawing user-
defined protection attributes

.gdf General arrangement drawing filter
properties
.gdnf General arrangement drawing

neighbor part filter properties

Files related to multidrawings, drawing level properties,

saved in \attributes folder

File or file name extension Description
.md Multidrawing properties
.md.more Multidrawing user-defined attributes
.mdl Multidrawing layout properties

.mdl.more

Multidrawing user-defined layout
attributes

.mdr

Multidrawing protection properties

.mdr .more

Multidrawing user-defined protection
attributes
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Files common to all drawings, and files in the \drawings
folder

File or file name extension Description

.dg Drawing files

.1db Drawing export layer properties

.1ldr Drawing link properties

.Cs Section symbol properties

.detail Detail symbol properties

.fas Text file properties

.fhl Hyperlink properties

.dsf Drawing selection filter properties.
This file is saved when you select the
Drawing --> Selection filter check
box in the Filter or Selection Filter
properties.

.GridsDimXml Dimensioning rules

.ShapeDimXml

.HolesDimXml

.FilterDimXml

.OverallDimXml

.RecessesDimXml

.SecPartsDimXml

.dg.DPM Drawing snapshot files in the
\<model>\drawings\snapshots
subfolder. The files are created either
automatically or based on a user
request.
To create a snapshot of a drawing
automatically at the same time that
you create the drawing, set the the
advanced option
XS_DRAWING_CREATE_
SNAPSHOT_ON_DRAWING_CREATION
to TRUE. For more information about
creating snapshots, see.
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Files related to IFC export in \IFC folder

File or file name extension

Description

.ifc

Exported IFC files

Files related to NC in the \DSTV _Profiles folder

File or file name extension

Description

.ncl

NC (numerical control) files

Files in the \ModelSharing folder

File or file name extension

Description

ModelSharingService. key

Key file that is needed to perform
sharing in Tekla Model Sharing.

FileSharing.ini

File sharing settings in Tekla Model
Sharing.

FileSharing.xml

File needed for file sharing in Tekla
Model Sharing.

Files in the \ProjectOrganizer folder

File or file name extension

Description

.db

Created when Organizer is opened
for the first time. Contains all
property template and category
information used in the model.

The database name shows the
version of the database, for example,
ProjOrg000020.db.

.propertytemplate

Created when you export a property
template from Organizer.

.category

Created when you export a category
from Organizer.
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Files related to reports in the \Reports folder

File or file name extension

Description

.XSr

Tekla Structures reports

Files in the \SessionFileRepository folder

File or file name extension

Description

Files in the
SessionFileRepository folder

Backup copies of the files that are
updated or deleted in Tekla Model
Sharing read in.

SessionFile.db

Database for managing model folder
files in Tekla Model Sharing.

.storage

Configuration file of
SessionFile.db.

Files related to shapes in the \ShapeGeometries and

\Shapes folders

File or file name extension

Description

.tez Shape geometry descriptions in the
\ShapeGeometries folder.

.xml

.xml Shape descriptions in the Shapes

folder.

Files in the \screenshots folder

File or file name extension

Description

.png

Screenshot taken in Tekla Structures.

Files related to Unitechnik export in the \UT files folder

File or file name extension

Description

.uni

Exported Unitechnik files
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5.17

Check and change Tekla Structures file and folder
locations in Directory browser

Directory browser is a tool that helps you to find and modify the location of

the various Tekla Structures files and folders, and customize user settings.

NOTE Generally, only administrators should change these settings. If you

change them yourself, and you are sharing the same model with other
users, and your settings differ from those of the project, you will have
problems. Also, adding or modifying files in some of these folders may
require administrator rights.

To locate files and folders, and customize your Tekla Structures settings:

Click the Applications & components button m in the side pane to
open the Applications & components catalog.

Click the arrow next to Applications to open the applications list.
Double-click Directory browser.

The Directory browser dialog box opens. You can check the most
common folder paths, and customize the settings in your user. ini file,
or in the user-specific or model-specific options.ini file.

Check the folder paths and change them if necessary by clicking the
buttons on the left of the Basic tab.

If you click the Project or Firm button and you have not set your firm and
project folder, Tekla Structures will prompt you to do so and add the
folder path definition to your user. ini file.

Check the settings in the user.ini and options.ini files and change
them if necessary by clicking the buttons on the right of the Basic tab.

Go to the Advanced tab and define the folder paths for additional folders
that you may need to access, such as custom components and macros.

Folder search order

When you open a model, Tekla Structures searches for the associated files in

specific folders in a set order.

It is important that you keep files in correct folders. Once Tekla Structures

finds the associated files, it stops searching. This means that files that have the

same name but are located lower down the search order are ignored.
The folder search order is:
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Folder

Defined by

Current model

The open model

Project

Advanced option XS_PROJECT.

If property files are stored in user-
defined sub-folders under the project
folder, Tekla Structures searches the
sub-folders for files in alphabetical
order. The first associated file is
selected. After that, each file with the
same file name suffix and file name
prefix as the selected file is ignored.
The names of the ignored files are
stored in the error log.

Firm

Advanced option XS_FIRM.

If property files are stored in user-
defined sub-folders under the firm
folder, Tekla Structures searches the
sub-folders in alphabetical order. The
first associated file is selected. After
that, each file with the same file name
suffix and file name prefix as the
selected file is ignored. The names of
the ignored files are stored in the
error log.

System

Advanced option XS_SYSTEM

Tekla Structures does not search for certain files in exactly this order. The

exceptions are listed below.
The exceptions are:

File (type)

Search order

objects.inp (page 280)

*  Model folder

+ Project folder (xs_PROJECT)
+  Firm folder (xs_FIRM)

+ System folder (xS_SYSTEM)
« inp folder (XS_INP)

privileges.inp

*  Model folder
+ Project folder (XS PROJECT)
+ Firm folder (xs_FIRM)

+ System folder (xS SYSTEM)

+ inp folder (xs_INP)
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File (type)

Search order

.dat files (page 290)

System folder (xs_SYSTEM)

Templates (page 339)

Folder containing your templates
indicated by the advanced option
XS_TEMPLATE_DIRECTORY

Model folder
Project folder (xS PROJECT)
Firm folder (xs_FIRM)

Environment-specific system
templates indicated by the
advanced option
XS_TEMPLATE_DIRECTORY_SYSTE
M

System folder (xs_SYSTEM)

Catalogs

Profile (page 139), bolt (page 210),
material (page 131), and rebar
(page 227) catalogs:

Model folder
Project folder (XS PROJECT)
Firm folder (xs_FIRM)

Folder indicated by the advanced
option XS_PROFDB

Shape catalog (page 202):

Model folder

Project folder (xS PROJECT)
Firm folder (xs FIRM)
System folder (xs_SYSTEM)

Folder indicated by the advanced
option XS_DEFAULT_BREP_PATH

Printer catalog:

Model folder
Project folder (xS PROJECT)
Firm folder (XS FIRM)

Folder indicated by the advanced
option XS_DRIVER
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5.18

WARNING Do not store customized files in the system folder. That way, you
will avoid having problems or doing a lot of unnecessary work
when you upgrade to a newer version of the software.

Location of certain hidden files and folders

When Tekla Structures is installed in the . . \Program Files folder, some of
the files needed to run Tekla Structures are located in hidden folders and are
therefore invisible. You can see the hidden files and folders if you make them
visible in the Windows Folder Options.

NOTE You can always check the settings below. If you run into problems with the
settings, ask your administrator or local support for assistance.

Files related to the software

Software and, for example, the following files are installed under
the . .\Program Files\Tekla Structures\<version>\ folder.

* contentattributes global.lst
* contentattributes userdefined.lst

(in the USA environment: contentattributes customer.lst)

Files related to environments

Environments and, for example, the following files are installed under

the . .\Programbata\Trimble\Tekla Structures\<version>
\environments\<environment>\ folder. The exact file location may vary
depending on the folder structure of your environment files.

* analysis design config.inp
* contentattributes.lst

* dimension marks.sym

* InquiryTool.config

* objects.inp

* oObjects.inp

* privileges.inp

* product finishes.dat

* rebar config.inp

* TeklaStructures.lin

* TilePatternCatalog.dtd
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* TilePatternCatalog.xml

Files related to user settings

User settings and, for example, the following files are installed under
the . .\Users\<username>\AppData\Local\Trimble\Tekla Structures
\<version>\ folder.

* user.ini

* options.bin

* customized property pane layout PropertyTemplates.xml file
+ customized ribbon and customized tab . xm1 files

+ customized contextual toolbar . xm1 files

+ customized toolbar .json files

See also

Model folder files and file name extensions (page 310)
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6 Templates

Templates are descriptions of forms and tables that can be included in Tekla
Structures. Templates are either graphical or textual. Graphical templates are
inserted in drawing layouts as tables, text blocks, and drawing headers, for
example. Textual templates are used for creating reports. The contents of the
template fields are filled in by Tekla Structures at run time.

Tekla Structures includes a large number of standard templates you can use.
Use Template Editor to modify existing templates, or create new ones to suit
your needs. Graphical template definitions have the file name extension . tpl.
Textual template definitions have the file name extension . rpt.

The ready-made textual and graphical templates are located under the
environment folders, in .. .\ProgrambData\Trimble\Tekla Structures
\<version>\environments\. The exact file location may vary depending on
the folder structure of your environment files. Text and graphical report
templates, except mark templates, can also be read from any subdirectory of
XS _FIRMOr XS PROJECT directories.

Examples
Example of a title block:

MO | REWV MARK |REM‘18ION DESCRIPTION CREAFED'#PPROVED' REV. DATE
& Tekla
Structures

DRAWING TITLE STANDARD

CONTRACT Trimble Solutions Corparation

MODELLED BY Dean Designer ISSUED

CONTRACT MO 1 SCALE 110

DRAWING No <) REVISION No 2 4 l2

Example of an inquiry report:
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& nguire Object EI@

GUID: ID552CB981-0002-3944-3134-323839393435  Type: 2 Assembly phase: 1 Part phase: 1
|_ _______________________________________________________________________________________ -~
Hame Brofile Material Grids Part Assembly
position position
BERM IEFEZ00 SZ35JRGZ A-B/5> Ms0(2) B/5E9(?)

Part GUID: IDS52ZCBS81-0002-35R4-3134-3238353593435

m

Globkal coordinates:

Start point : H= 4210.2 mm ¥= Z7447_.0 mm Z= 35775.0 mm

End point : H= &6580.1 mm Y= Z7847.3 mm Z= 35775.0 mm

Center of gravity : ¥= 5535.2 mm Y= Z7647_.2 mm Z= 35675.0 mm

Top level : +35.775

Bottom level = +35.575

Local coordinates, UC5:

Start point : H= 4210.2 mm ¥= Z7447.0 mm Z= 35775.0 mm

End point : ¥= &5%80.1 mm Y= 27847.3 mm Z= 35775.0 mm

Top level = +35_775

Bottom level : +35.575

Part positiomn . MS0(7)

Assembly position = BS563(2)

Net length : Z7%8.7 mm

Gross length : Z7%8.7 mm

Weight : 8Z.€l1 kg

Weight (Net) : 59.86 kg

Weight (Gross) : 8Z2_61 kg

Volume = 0.008 m?

Area : 2Z130.33 cm®

Name : BEAM

Material :  SZ35JREZ

Example of a part list report:
Report
TEELA STEUCTUERES FARTS LIST FOR CONTRACT NO: 1 Page: 1
CONTRACT: Trimble Sclutions Co Date: 28.10.2014&
PartPos Profile Ha Material Length  Area(md) Weight (ka)
1001 FL10#*230 2 5235JR 270 0.1 4.9
lao2 FL20+*140 14 5235JR 352 0.1 7.6
b/l HER300 1 5235JR 0 9.6 493.7
cfl HER400 2 5235JR 7200 13.8 898.7
Total for 15 members: 38.6 2376.7

For more information on using templates, see Template Editor User's Guide or
open the Template Editor Help in Template Editor by clicking Help -->
Contents .
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6.1

See also

Create a template (page 341)

Create a template

1. On the File menu, click Editors --> Template Editor.
2. In Template Editor, click File > New.
3. Select the template type and click OK. A new empty template is created.
4. Add new rows in the template.
a. Click Insert --> Component --> Row to add a new row.
b. Select a content type for the row and click OK.
C. Repeat steps a-b for each new row.
5. Add value fields to get the required data from your Tekla Structures
database.
a. Click Insert --> Value field .
b. Click a point to define the location of the field within the row.
The Select Attribute dialog box appears prompting you to select an
attribute for the value field.
c. Select an attribute and click OK.
d. Repeat steps a-c for each value field.
6. Save the template.
a. Click File --> Save as.
b. Browse to the template folder defined for the advanced option
XS TEMPLATE DIRECTORY.
In the File name field, enter a name for the template.
d. Click OK.
See also
Templates (page 339)

Create a template in HTML format (page 341)

Create a template for nested assemblies (page 346)

Create a template for bending schedules or pull-out pictures (page 350)

Add images in a template (page 354)
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6.2 Create a template in HTML format

Templates in HTML format give you more possibilities for different layout,
fonts, and images. Templates that generate output in HTML format are
graphical and have the file name extension * .html. rpt.

1.

2
3.
4

On the File menu, click Editors --> Template Editor.

In Template Editor, click File > New.

Select Graphical template and click OK.

Add new rows in the template.

a.
b.

C.

Click Insert --> Component --> Row to add a new row.
Select a content type for the row and click OK.

Repeat steps a-b for each new row.

Add value fields to get the required data from your Tekla Structures
database.

a.
b.

Click Insert --> Value field .
Click a point to define the location of the field within the row.

The Select Attribute dialog box appears prompting you to select an
attribute for the value field.

Select an attribute and click OK.

Repeat steps a-c for each value field.

Add a header for each value field.

e.

Click Insert --> Component --> Header...

Click Insert --> Text...

Enter a heading for the template, and then click OK.

Click a point to define the location of the heading in the header row.

Repeat steps a-d to create headings for all the value fields.

Save the template:

a.
b.

Click File --> Save as

Browse to the template folder defined for the advanced option
XS _TEMPLATE DIRECTORY.

In the File name field, enter a name for the template.

Include the extension *.html.rpt in the file name. For example,
Part list.html.rpt.

Click OK.
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NOTE If you add images in your HTML template, the images should be located
in . .\Program Files\Tekla Structures\<version>\nt\TplEd
\bitmaps folder, otherwise they are not shown in the HTML output.

Example

-
™
7
|'_|
.
o
iz
L,
=
=
2
=

1. Header that contains text fields
2. Row that contains two value fields

See also
Templates (page 339)
Add images in a template (page 354)

Create a .pdf report template
You can create graphical templates to be used for .pdf reports.

1. Onthe File menu, select Editors --> Template editor.
2. Select File --> New --> Graphical template.

3. Click Edit --> Properties.
4

In Template page properties dialog box, set the page size to match the
target page size (for example A4):
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Ternplate Page Properties @

Output Margins

Width: 210 mm Top: ] mm
Height: 297 mm Bottorm: 0 mm
Workarea Left: 0 i
Yiew height: 120 i Right: ':'l— mm

Information

Yersion; 3.21 | Created: 3.6.2016 10:39 |Free attributes...

Motes:

[ QK ” Cancel |

The size must match a size defined in the PaperSizesForDrawings.dat
configuration file.

20, 1188, 841
a1, 841, 594
a2, 594, 420
a3, 420, 297
24, 297, 210
as, 210, 148

5.  Add new rows and value fields to get the required data from your Tekla
Structures database. For more information about adding new rows and
value fields, see Create a template (page 341).

6. Click File --> Save as, and save the report with the filename
extension .pdf.rpt.

7. Copy the new template to your template folder, such as model or your
company settings folder (XS_FIRM).

Now you can create a .pdf report using the new .pdf report template.
For more information about creating a report, see .

Example .pdf report
In this report example, the following page size is used:
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Temnplate Page Properties @

Output Margins

Width: 180 i Top: 10 M
Height: 255 A Bottorn: 10 il
Workarea Left: 10 mim

View height: 127 M Right: 0 e

Information

Version: 321 | Created:  3.5.200413:23

Meodified: 11.3.2016 15:36

Motes:  Converted termplate

| ok || cancel |

Below is an example of a report that has been created using this particular
report template. To open the report in a browser, click here.
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https://teklastructures.support.tekla.com/system/files/manual/rebar_bending_schedule_A4.pdf

REBAR BENDING SCHEDULE
Project:  Rebar fabrication 1
P Diamater | Mumber | Grade Langth Kgp | Weght Banding shaps Balorgs o
WA 10 16 | Undefined goo| oas| 7a B Wi
wris | 18 B | Undefined 7130 11.25| s00 i |
W4 12 8 | Undefined 3400 310| 248 — e
WRE | 18 4 | Undetned 7600 1214| 4ps| TS0
WRIT | 12 4 |undetned 4090| 383| 145 4092
WRM1 | 10 B |undesned g50| 0s8| 47 _ 0 Wia
WR/12 | 10 12 | Undefined 2080| 128 154 32089
WRI3 | 10 12 | Undesned 20| i78| 23| 2889
5 ]
w2z | 8 42 | Undefined gan| o33 38| = wn
wRZz | 8 9% | Undefned B30| 033 35| g i
o
WRIS | 12 24 | Undesned ge0| os7| 209 B
AN

WrRE | 6 14 | Undefined x| o018 28| & Wi3

s |ws
wWRe | B 22 | Undefned B10| 0.8 40 - /

S
WRMD | 8 T8 | Undesned g10| 032 250 — Wi3

=
WRMD | & 184 | UndeSned B10| 032 =85 : Wi

Tost 5320 Tast 3837

6.4 Create a template for nested assemblies

This example shows how to produce a template that displays the hierarchical
structure of nested assemblies. You will create a nested assembly structure in

a textual template similar to the one in the following picture:
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ASSEMBLY

A w o=

PART

ASSEMBLY

N

On the File menu, click Editors --> Template Editor.

In Template Editor, click File > New.

Select Textual template and click OK.

Add four new rows in the template.

a.
b.

C.

Click Insert --> Component --> Row to add a new row.
Select a content type for the row, and then click OK.

For the first and third row, select the ASSEMBLY content type, and for
the second and fourth row, select the PART content type.

Repeat steps a-b for each new row.

Use the arrow buttons under Sorting and drawing order to create a
nested assembly structure for the template.

a.
b.

Move the second and third row down one level.
Move the fourth row down two levels.

Sorting and drawing order
By
= T ernplafer | 2hift row down a level |
C7 Fow
=
1 Row_2
1 Row_3

The structure should now look like this:

Sorting and drawing order
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6. Add value fields to get the required data from your Tekla Structures
database.

In this example, the added value fields are assembly or part position,
number, and weight.

a. Click Insert --> Value field .
b. Click a point to define the location of the field within the row.

The Select Attribute dialog box appears prompting you to select an
attribute for the value field.

c. Select an attribute and click OK.
d. Repeat steps a-c for each value field.
7. Modify the layout of the template. For example:

a. Move objects to display the nested assembly structure in the printed
report. To do this, select the object you want to move and drag it to
the desired position.

b. Align objects. To do this, select all the objects you want to align, right-
click and select the appropriate option from the pop-up menu, for
example Align --> Right .

c. Add a header and a footer. To do this, click Insert --> Component -->
Page header and Page footer. Add the required information to the
header and footer.

8. Save the template.

Example

Below is an example textual template and a report that has been created
using the template:
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T/4
T/6
T/7
T/2
T/9
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T/1L1
T/1E
T/1E
T/16
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5 I el s LY o B T T T . Y Y w I IO TN S AR B L |

Total weight E77.E

NOTE You can create graphical templates for nested assemblies in the same
manner as textual templates. The difference between graphical and textual
templates is that in a graphical template you can display project and company
information and graphics, such as table outlines, pictures, or symbols.

See also
Templates (page 339)
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6.5 Create a template for bending schedules or pull-out
pictures

You can use Template Editor for creating bending schedules or pull-outs
pictures on reinforcement bars and bent meshes, and control the type of
information that is shown in the bending schedules.

o Uk w N =

11.

On the File menu, click Editors --> Template Editor.
Click File --> New .

Select Graphical template and click OK.

Click Insert --> Component --> Row to add a new row.
Select REBAR or MESH as the content type for the row.

Add value fields to get the required data from your Tekla Structures
database.

a. Click Insert --> Value field .
b. Click a point to define the location of the field within the row.

The Select Attribute dialog box appears prompting you to select an
attribute for the value field.

c. Select an attribute and click OK.

d. Repeat steps a-c for each value field.

Insert a graphical field to your REBAR or MESH content type row.
a. Click Insert --> Graphical Field...

b. Click and drag with the mouse to draw a frame.

Double-click the graphical field to open the Graphical Field Properties
dialog box.

Click Free attributes and go to the User tab.

. Add the required bending diagram attributes.

For a list of attributes and values that can be used for bending schedules
in templates, see Bending schedule attributes (page 352).

Save the template.
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Example

. Project numbe r 1
Rebar list Project nams Trimble Date: (D016
Pasition Szt Chuntity Cracle Length {mm) Weight (kg ) Weight/Tot Tull-out pic ture
1 12 1 AsCOHW 23100 21 21 3 l
3 12 1 AsooHwW 10300 a9 ae {_
"
4 12 1 ASCoHW 11500 LO L0 L .
~ -
r# -
7 12 1 AsooHwW 25400 3 13 /:r
e
. R
8 12 1 AsOHW 15700 14 1.4 LS
e
g 12 1 ASOHW 17000 L5 L5 C___L;.
I

Autoscaling pull-out pictures

There is a free attribute available for the PULLOUT attribute in graphical
templates that you can use to define the scale type. If you set the free
attribute scaleType to 1 on the User tab in the Free attributes dialog box,
the pull-out pictures will be scaled to fit the available space in both X and Y
dimensions. As a result, the shape becomes out of proportion, but small
segments can be seen more easily.

15 Tekla Template Editor - tpled_templatel
File Edt View Insert Window Options

Do daax|Pee TESiE/ rr000em x| B = EHR

tpled_templatel

Scn.ing and d_uwing order
+| ¥ [F[#
=0 Template: tpled_templatel
£ REBAR
i# GraphicalField

Graphical Field Properties
Field

MName: .G-raph-ita-lﬁe-l-ﬂ :

Attribute: PULLOUT

Layout
Width: 50 mm
Height: 20 mm

[7] Set as default for new graphical fields

Properties: | pame Value

Scetype

Lt

Preview Pane
|
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A bending shape may look like this if you do not define the free attribute
ScaleType:

45° &

@_f

The same bending shape that uses the free attribute ScaleType with value 1.

11930

45°

0 [ =
N

Change the appearance of the pull-out pictures

11930

Tekla Structures uses the settings in the rebar config.inp file in the system
folder defined by the advanced option XS _sYsSTEM to define the appearance of
the pull-out pictures. You can change the colors, lines, and dimension unit,
format, and precision used in pull-out pictures, for example. For a list of
settings and values in rebar config.inp, see Reinforcement settings for
drawings (rebar_config.inp)

Bending schedule attributes

The following table lists the attributes and values that can be used for bending
schedules in templates.

Attribute Default value Available values
FontName romsim Available template fonts
FontSize 2.0 Available font sizes
FontColor 1 (black) 1 = black

2=red

3 = bright green

4 =Dblue
5=cyan
6 = yellow
7 = magenta
8 = brown
9 =green
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Attribute Default value Available values

10 = dark blue
11 = forest green

12 =orange

13 = gray
RotationAxis 2 0 = by view

1 = by global Z

2 = by local axis
ScaleType 0 0 =no

1 =yes

If you set the free
attribute ScaleType to
1 for the PULLOUT
attribute, the pull-out
pictures will be scaled to
fit the available space in
both Xand Y
dimensions. As a result,
the shape becomes out
of proportion, but small
segments can be seen

more easily.
Exaggeration 1 0 =no

1 =yes
EndMark 1 1 = straight

2 = half arrow

3 =full arrow

Dimensions 1 0=no
1 =yes
BendingRadius 0 Shows the bending

radius in form of
diameter of the bending

roll.
0=no
1 =yes
BendingAngle 1 0=no
1 =yes
Templates 353 Create a template for bending schedules or pull-
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6.6

Attribute Default value Available values

ImageWidth Width of the graphical Number of pixels

field multiplied by 4.

ImageHeight Height of the graphical | Number of pixels

field multiplied by 4.

See also

Create a template for bending schedules or pull-out pictures (page 350)

Add images in a template

You can add images in graphical templates. For example, you might want to
include a company logo in your drawings. Tekla Structures supports the
following image formats in graphical

templates: .bmp, .jpg, .jpeg, .tif, .tiff and .png.

1.

Open an existing graphical template or create a new graphical template in
Template Editor.

Add a new row in the template:
a. Click Insert --> Component --> Row to add a new row.
b. Select a content type for the row and click OK.

Ensure that you have the row selected, and click Insert > Picture to open
the Select Picture File dialog box.

If a local symbols folder exists, the contents of that folder are shown by
default. You can browse for the contents of the common\symbols folder
by selecting that folder. If a local symbols folder does not exist, Tekla
Structures displays the contents of the common\symbols folder.

If you have images in other folders, you can display these folders in the
Select Picture File dialog box:

a. InTemplate Editor, click Options --> Preferences.

b. Go to the File Locations tab and on the Symbols, pictures row, add
a new folder separated by a semicolon (;), for example:

Symbols, pictures (¥} LA \commontsymbolsh: \bitmaps; C:\TeklaStructuresTemplatelmagesh, _

The folder you defined is displayed in the Directory list:
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5.

Select Picture File
Directory File
C:\ProgramData‘\Tekla Scruccures\ 2016 Dail Company logo.png
\bitmaps®
C:\IsklaStructuresTemplac

Cancel |

Select an image from the File list and click OK and add the image.
You can adjust the size by dragging from the image handles.

Things to remember when adding images in templates

Do not add very large images because they update very slowly.

The image may look different in the image editor and in the printout or in
the exported DWG file.

When you export the drawing to DWG, Tekla Structures copies the images
in the same folder as the DWG file. If the image for some reason is not in
the same folder, only the name of the image is displayed together with an
empty frame instead of the image in the DWG.

If environments have local symbols, the local symbol folder is also included
in the search path with the common\symbols folder. If the local symbols
folder contains files with the same name as common\symbols folder, then
the local symbol file is used.

When you open the drawing that contains images inserted in the template,
Tekla Structures first looks for the images in the model folder and then in
the \symbo1ls folder in the current environment.

You can define a folder where Tekla Structures always looks for images
using the advanced option DXK SYMBOLPATH. You can also define a firm
folder for your images.

Example

Below are some examples of the Select Picture File dialog box showing folder
structure in different environments.
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-
Select Picture File

Directory

b atehgettingsh, . .\ e -
mlatehsettingsh . oh. ..

A A “uk

common', s ymbolsh,

B

File

T 3

Tekla Structures_logo.jpg
T5_R PMS5 RedBlue.jpg

T5_R PMS RedBlue row.]jpg
Hi-Span Logo-CHMYE.png
Eingspan Metl-Con.png
Eingspan.png

Steadmans Logo.png
Steadmans 5 Logo.png

L

-

Select Picture File

-
Directory

- oM Jhusimphus commont templatehbitmapa’,
Lo -h - husimphus commont symbolsh

File

tekla structures.jpg
tekla structures wvertical.jpg

L

In the following example, a company logo has been added in a template.

No |REV MARK

| REVISION DESCRIPTION

| REV. DATE

[ E AR R NN NERNENEDRNREH:RN:EHNLH:.)

§Co1«upawg£ogo—§

LR R N RN NN R NNERENRNNEDNDN)

DRAWIMG TITLE

GA-drawing

COMNMTRACT

Corporation

MODELLED BY

ISSUE DATE

COMNTRACT NO 1

SCALE

1:50

DRAWIMG Mo

REWISION No. 0

Templates 356

Add images in a template




6.7

See also
Templates (page 339)

Content types

When you create a new row in the template, you must select a content type for
the row. For example, when you add a row and then add a value field,
Template Editor is asking for the content type. The content type determines
which template attributes you can use on that row.

The available content types are:

Content type Description

ANALYSIS RIGID_LINK | Use to create lists of analysis rigid links.

ANTIMATERIAL Use to create lists of holes and recesses, or parts
removed as a result of a cut.

In Template Editor, the same attributes that are
available for PART are available for ANTIMATERIAL.
However, only the attributes that are useful to be
used with ANTIMATERIAL are shown, including
NAME, LENGTH, WIDTH, HEIGHT, AREA, PROFILE,
and NUMBER, and user-defined attributes.

ASSEMBLY Use to create lists of assemblies and single parts.
Includes all assemblies containing the selected
parts and bolts.

BOLT Use to create screw and bolt lists. Includes all bolts
connected to selected parts.

CAST UNIT Use to create lists of cast units.

CHAMFER Use to create lists of the length of the chamfers.

COMMENT Use to create empty rows or rows that only have
textual data or lines anywhere on a template.

CONNECTION Use to create lists of connections.

DRAWING Use to create drawing lists without revision history
information. Use for reports and included
drawings.

HIERARCHIC CAST UNI | Use to create reports listing subassemblies of

T concrete.

HIERARCHIC OBJECT Use to create lists of various types of hierarchies.
For example, lists hierarchical objects in Organizer.

Templates
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Content type

Description

HISTORY

Use to retrieve history information of the model.
You can use this content type with PART, REBAR,
CONNECTION and DRAWING rows.

The following template attributes can be used with
this content type:

* TYPE: the type of the historical action, for
example update or numbering.

* USER: the user who made the change.
* TIME: the time the change was made.

¢ COMMENT: the comment which was entered
upon clicking Save.

* REVISION CODE:the revision code which was
entered upon clicking Save.

HOLE

Use to create lists of holes.

LOAD

Use to create lists of loads.

LOADGROUP

Use to create lists of load groups.

MESH

Use to create lists of meshes.

NUT

Use to create lists of nuts. Contains all nuts for
bolts associated with the selected parts.

PART

Use to create lists of parts.

POUR BREAK

Use to create lists of pour breaks.

POUR_OBJECT

Use to create lists of pour objects.

POUR_UNIT

Use to create lists of pour units.

REBAR

Use to create lists of reinforcing bars.

REFERENCE MODEL

Use to list the reference models.

REFERENCE OBJECT

Use to list the reference model objects in a
reference model.

Only reference model objects that have user-
defined attributes are displayed in reports.

REFERENCE ASSEMBLY

Use to list the reference assemblies in a reference
model.

REVISION

Use to create lists of revision marks.

SIMILAR ASSEMBLY

SIMILAR CAST UNIT

SIMILAR PART

Templates

Use to create lists of similar parts.

To use this content type, you need to have an
empty (hidden in output) ASSEMBLY, PART Or
CAST UNIT row in the row hierarchy above the
row with SIMILAR * content type:
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Content type

Description

PART

I
I SI M[LAR_PARTI

You cannot have any rows below SIMILAR * row
content type in the row hierarchy.

Note: Used in drawings to collect similar object
information from the model. All the other attribute
information is collected from visible drawing
objects.

SINGLE REBAR

Use to create lists of individual bars in reinforcing
bar groups.

For example, use it to get the lengths of the
individual bars in tapered reinforcing bar groups.

For rebar sets, SINGLE REBAR works in the same
way as REBAR.

SINGLE STRAND

Use to create lists of individual prestressed
strands.

STRAND Use to create lists of prestressed strands.
STUD Use to create lists of studs.
SURFACE Use to create lists of surfaces.
SURFACING Use to create lists of surface treatments.
SUMMARY Use to summarize the contents of the row(s) that
are above SUMMARY in the hierarchy.
PART
|
I SUMMARY I
For example, use PART - SUMMARY hierarchy to
summarize the contents of the PART rows.
TASK Use to create lists of tasks.
WASHER Use to create lists of washers. Contains all washers
for all bolts associated with the selected parts.
WELD Use to create lists of welds.
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6.8

See also

Template attribute files (contentattributes.Ist) (page 360)

Template attribute files (contentattributes.lst)

Template attributes represent object properties. You can use template
attributes in value fields, formulas, and row rules to get the required data

from your Tekla Structures database.

When you output the template, Tekla Structures replaces the attribute with
the actual value of the corresponding object property. For example, if you
include the attribute WEIGHT in a report template, Tekla Structures displays
the weight of the model object in the report.

Template attributes are defined in the following files:

File name

Description

contentattributes.lst

This is a container file listing all the
files that contain the actual attribute
definitions. The files are added with
INCLUDE sentences. The order of the
files included in
contentattributes.lst defines
the reading order of the files.

This file is overwritten in the
installation when you install a newer
version of Tekla Structures. Ensure
that you make a copy of this file
before updating.

Generally, there is no need to modify
contentattributes.lst. Do not
modify it if you are not an
administrator.

contentattributes global.lst

This file contains attributes that are
hard-coded into the program. Do not
edit this file.

contentattributes userdefined
.1lst

Templates 360

This file contains user-defined
attributes, the same as in the
objects.inp file.

This file is overwritten in the
installation when you install a newer
version of Tekla Structures. To use
your own attributes in templates and
reports, create a copy of this file and

Template attribute files (contentattributes.lst)
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File name Description

add the necessary attributes to that
file.

By default, these files are located in . .\Program Files\Tekla Structures
\<version>\nt\bin\TplEd\settings, butthe location may be different in
your environment.

The search order for the contentattributes.1st fileis the following:

1.

ik W

Model folder

Project folder defined by XS_PROJECT

Firm folder defined by XS_FIRM

Folder defined by XS_TPLED_INI

Folder defined by XS_TEMPLATE_DIRECTORY/settings

See also

User-defined template attributes (page 361)

Location of certain hidden files and folders (page 337)

User-defined template attributes

User-defined template attributes are defined in the

contentattributes userdefined.lst file. By default, this file includes
most of the user-defined attributes that are visible in the part properties
dialog boxes. To use your own attributes in templates and reports, you should
make a copy of the file, rename it appropriately, and add the necessary
attributes to that file.
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The contentattributes userdefined.lst fileis divided into two sections:

« Alist of attribute names and default settings:

£d Hame Datatype Justify Cacheable Length
A EEITEE FLOLT RIGHT TRUE g
N —_-—_—— .
axiall FLOAT RIGHT TRUE 8
axialZ FLOAT RIGHT TRUE 8
BOLT COMMENT CHARACTER  LEFT TRUE 54
EOLT USERFIELD 1 CHARACTER  LEFT TRUE 54
EOLT USERFIELD 2 CHARACTER  LEFT TRUE 54
BOLT USERFIELD 3 CHARACTER  LEFT TRUE 64
BOLT USERFIELD 4 CHARACTER  LEFT TRUE 64
BOLT USERFIELD 5 CHARACTER  LEFT TRUE 64
BOLT USERFIELD & CHARACTER  LEFT TRUE 64
BOLT USERFIELD 7 CHARACTER  LEFT TRUE 64
BOLT USERFIELD & CHARACTER  LEFT TRUE 64
cambering CHARACTER  LEFT TRUE 64
CHECEED EBY CHARACTER  LEFT TRUE 20
CHECEED DATE CHARACTER  LEFT TRUE 20
COmmEnt CHARACTER  LEFT TRUE 30
CONN_CODE ENDA CHARACTER  LEFT TRUE i0
CONM_CODE ENDE CHARACTER  LEFT TRUE i0
DREAWING USERFIELD 1 CHARACTER  LEFT TRUE 64
DRAVING USERFIELD 2 CHARACTER  LEFT TRUE 64
DRAWING USERFIELD 3 CHARACTER  LEFT TRUE 64
TRITITELS TIRFRFTFI.M 4 CTHIRLITTER T.FFT TRITF A4

+ Alist of attributes assigned to content types:

® ©)

MATINFART.

®

UTSERDEFINED .I[Para.meters]‘.

O]

comnent

= (ASSEHBLY.

= LA33EMELY.
= AL3SEMEBELY.
= A33EMELY.
= ASSEMELY.
= L33EMELY.
= LA33EMELY.
= AL3SEMEBELY.
= L33EMELY.
= LA33EMELY.
= L33EMELY.

FART
FART
FART
PART
FPART
FART
FART
FART
FART
FPART

HMATNFART.
MATNFPART.
MAINFART.
MATMNPART.
MATNFART.
HMATNFART.
MATNFPART.
MATINFART.
HMATNFART.
MATNFART.

TSERDEFINED.
TSERDEFINED.
TSERDEFINED.
T3ERDEFINED.

T3ERDEF INED
T3ERDEF INED
TSERDEF INED

[Farammeters]
[Parammeters]
[Paratneter=]
[Parammeters]

[Parameter=]
[Farammeters]
[Parameters]

1.  The content type of the row in Template Editor

2. The attribute hierarchy in Template Editor

L 1= _shorten

L carber ing

L PRELTH MALRK

. OBJECT LOCEED
. [Farameters] |
. [Farameters=]
. [Faramsters]
USERDEFINED.
USERDEFINED.
USERDEFINED.

fabhricator

L USER_FIELD 1
L USER_FIELD 2
| USER_FIELD 3
L USER_FIELD 4
L ISER_PHASE

3. Customizable comments, such as the tab name in the user-defined
attributes dialog box

4. The name of the user-defined attribute, must be the same as in the
objects.inp file

See also

Add user-defined template attributes to Template Editor (page 363)
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Add comments to user-defined template attributes (page 364)
Add hierarchy to user-defined template attributes (page 365)

Add user-defined template attributes to Template Editor

This example shows how to add your own user-defined attributes to the
attribute tree in Template Editor.

Before you start, add your user-defined attribute to the objects. inp file. For
example, you might add an attribute named MY ATTRIBUTE to the user-
defined properties of drawings.

E Tekla Structures Assembly drawing (1 @
Workflow | Parameters |
Comment
My attribute
User field 2
User field 3

1. Openthe contentattributes userdefined.lst filein a text editor.

2. Save the file with an appropriate name, for example
MY contentattributes userdefined.lst, inthe same folder.

3. Add MYy ATTRIBUTE to the list of attribute names and, define the settings

as follows:

MORTAR WIDTH FLOAT RIGHT TRUE
(M7_ATTRIEUTE CHARACTER  LEFT TRUE )
OBEJECT LOCEED CHARACTER  LEFT TRUE

4. Add MY ATTRIBUTE to the list of attributes assigned to content types.

Select the content type according to which object the attribute is
associated to in the objects. inp file. In this example, the content type is
DRAWING. Add the attribute in the format

USERDEFINED.<ATTRIBUTE NAME>.

## ===s=s=s=============z==z==z==z==z============
oy Drawihg attributes

oy

£ tab_page( "DE_Paramsters")

## =S========================================

(DRAHIHG = USERDEFIHED.H?_ATTRIEUTE]

Save the changes.
Open the contentattributes. 1st file.
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7. Add the following line in the file:
[INCLUDE MY contentattributes userdefined.lst]

8. Save the changes.

The attribute is shown in the attribute tree in Template Editor, under
DRAWING > USERDEFINED:

+-[@ PROJECT

+-[@ REVISION

=@ USERDEFINED
DR&WING_ISERFIELD_1
DRAWING_USERFIELD_2
DRAWING_USERFIELD_2
DRAWING_USERFIELD_4
DRAWING_USERFIELD_S
DRAWING_USERFIELD_E
DRAWING_USERFIELD_7
DRAWING_USERFIELD_&
Mv_ATTRIBUTE )

) e ) P

See also
User-defined template attributes (page 361)

Add comments to user-defined template attributes

You can add your own comments to the user-defined attibutes in the
Template Editor attribute tree.

1. Openyour copy of the contentattributes userdefined.lst file.

For example, MY contentattributes userdefined.lst. Do not
modify the original contentattributes userdefined.lst file.

2. Scroll down to the list of attributes assigned to content types.
3. Addyour comment inside quotation marks, after the attribute name.

For example:

DRAWING = U3ER-DEFINED.MY ATTRIBUTE["m? comment"” ]

4. Save the changes.
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The comment you added is displayed in the attribute tree in Template
Editor:

= (@ USERDEFIMED
DR&WING_USERFIELD 1
DR&wWING_USERFIELD 2
DR&WING_USERFIELD 3
DR&WING_USERFIELD 4
DR&wWING_USERFIELD 5
DR&WING_USERFIELD 6
DR&WING_USERFIELD 7
DR&wWING_USERFIELD S

(MY_ATTRIEUTE -my comment )

I P e e

See also
User-defined template attributes (page 361)

Add hierarchy to user-defined template attributes
You can add your own hierarchy to the Template Editor attribute tree.

1. Openyour copy of the contentattributes userdefined.lst file.

For example, MY contentattributes userdefined.lst. Do not
modify the original contentattributes userdefined.lst file.

2. Scroll down to the list of attributes assigned to content types.

3. Define the hierarchy in square brackets, between USERDEFINED. and the
attribute name.

For example:

DRAWING = [USERDEFINED. [Folder 1.Folder 2] .M?_ATTRIEIUTE] "my comment "

NOTE Notice the periods after the brackets, and between the
hierarchies.

4. Save the changes.
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6.10

The new hierarchy is shown in the attribute tree:

= LUSERDEFIMED
DR&WING_USERFIELD 1
DR&WIMG_USERFIELD 2
DR&WING_USERFIELD_3
DR&WIMG_USERFIELD 4
DR&WIMG_USERFIELD &
DR&WING_USERFIELD B
DR&WIMG_USERFIELD ¥
DR&WIMG_USERFIELD &
=W [Folder1 -

= Falder 2]

] MY_ATTRIBUTE-my comment

I P e

WARNING User-defined attributes are case sensitive. Ensure that you enter the
attribute name using the correct case for all characters.

See also
User-defined template attributes (page 361)

Tips for templates

There are some things that you might consider to be able to use templates
more efficiently.

Click the links below to find out more:
Use text type attribute in calculations (page 366)
Change value field content to use imperial units (page 367)
Define customized date format (page 367)
Assembly or cast unit drawing sheet number (page 368)
Use format functions in value fields (page 368)

Use text type attribute in calculations

Change text to numeric format
double (GetValue ("ASSEMBLY TOP LEVEL"))
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Change into correct format for calculation (double=decimals)

format (double (GetValue ("ASSEMBLY TOP LEVEL")), "Length",
1)

Add all above into calculation formula

format (double (GetValue ("ASSEMBLY TOP LEVEL")), "Length",
1)+15000

Another example of the same for part elevation

(double (GetValue ("TOP_ LEVEL")) -
(double (GetValue ("BOTTOM LEVEL"))))*1000

Change value field content to use imperial units

Advanced option to check if imperial units are in use:

GetValue ("ADVANCED OPTION.XS IMPERIAL")==TRUE

Translated string call for multi lingual text:

GetValue ("TranslatedText ("albl Diameter ")")

Formatting of units:

format (GetValue ("DIAMETER"), "Length", "inch-frac", 1/16)
format (GetValue ("DIAMETER") , "Length", "mm", 1)

Combine all above in a rule:

if GetValue ("ADVANCED OPTION.XS IMPERIAL")==TRUE then

GetValue ("TranslatedText ("albl Diameter ")")+
format (GetValue ("DIAMETER"), "Length", "inch-frac", 1/16)
Inches"

else

GetValue ("TranslatedText ("albl Diameter ")")+
format (GetvValue ("DIAMETER"), "Length", "mm", 1)+" mm"

endif

Define customized date format

Use mid function to find year, month and day:

mid("","","") string, offset, n

year:

"mm" ,

"mm" ,

_I_ "

mid (format (GetValue ("DATE"), "Date","dd.mm.yyyy", ),"6","4")
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month:

mid (format (GetValue ("DATE"), "Date","dd.mm.yyyy", ),"3","2")
days:

mid (format (GetValue ("DATE"), "Date","dd.mm.yyyy", ),"0","2")
Combine all above in rule:

mid (format (GetValue ("DATE"), "Date","dd.mm.yyyy", ),"6","4")
UL L [

mid(format (GetValue ("DATE"), "Date","dd.mm.yyyy", ),"3","2")
+n_n+

mid (format (GetValue ("DATE"), "Date","dd.mm.yyyy", ),"0","2")

Assembly or cast unit drawing sheet number

Use match function to find "-" character
match (GetValue ("NAME BASE"),"*-*")
Use of mid function to return only characters after "-"

mid (GetValue ("NAME BASE"), (1+
(find (GetValue ("NAME BASE"),"-"))),2)

Combine all above in rule
if (match(GetValue ("NAME BASE"),"*-*"))

then mid(GetValue ("NAME BASE"), (1+
(find (GetValue ("NAME BASE"),"-"))),2)

else nmn

endif

Use format functions in value fields

You can define the format used in a value field in two ways: In the Value Field
Properties dialog box by filling in the fields for Datatype, Meaning, Unit and
Decimals, or by creating a formula in the Formula field. In formulas, you can
use the format function that converts an attribute value to a formatted
information string.
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When you use a format function in a formula, always set the Datatype to Text
in the Value Field Properties dialog box. Leave the other fields in the Format
area empty.

For example, if you want to convert the attribute value to numbers with
decimals in the report, you need to include the conversion function double in
the format function:

Value Field Propesties *
Content
Formula: | if Getvabue{ ADVANCED_OPTION.XS_IMPERIAL")=="TRUE" then fommat(doubde(GetValue"LENGTH™)), "Length™, “ft-frac”, 1/16) else fermatideuble|GetValue LENGTH ), "Length™,"mm”, 0}« " mm™ endif
— —r —— e r——
Attribute.. | Formula...

Farmat
Mame: MyLength|

Dsts type: | Text . Order: | Mone -

] Output 0 as empty string|
] Hide in eitput When rows are combined

Peaning:
| unet: None

1 Ipecimats: [0 B Free stributes...

Layout

| Font:  CourierMew | . | | Lengtn: [12 [2] charisy

Justify: | Left

) 5et as default for neve valus fislds

The default values for unit and decimals are defined in the
contentattributes global.lst file. The format function converts the
attribute value to a formatted information string on the basis of what you have
defined in the format function. The format function overrides the definitions in
the contentattributes global.lst file and settings that you have defined
in the Format area of Value Field Properties dialog box.

Example of the result in a report when you use the formula above:
Mesh Information:

Geometry Size: 4/4-150/150-2750*2000

Length: 9'-1/4"

Height: 6'-6 3/4"

Example of the result of the formula, when you use set the advanced option
XS IMPERIAL to FALSE instead of TRUE:

Mesh Information:

Geometry Size: 4/4-150/150-2750%2000
Length: 2750 mm

Height: 2000 mm

For a list of valid unit and precision strings, see the valuefieldclasses.1lst
file located inthe . .\Program Files\Tekla Structures\<version>\nt
\TplEd\settings folder. Do not make changes in this file. Below is an
example of the file content, which may change between Tekla Structures
versions.
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// — Use only letters, numbers, slashes and underlines.

//

//

//

// Class = units { presicions }

Length = mm, dm, cm, m, inch, ft, yd, inch-frac
{1/2, 1/4, 1/8, 1/16 }, ft-frac { 1/2, 1/4, 1/8, 1/16 }

Angle = Degrees, radians

Area = mm2, cm2, dm2, m2, sqg.inch, sqg.ft, sqg.yd
Area/length = mm2/m, cm2/m, dm2/m, m2/m, in2/in,
in2/ft, ft2/ft, sq.yd/ft

Volume = mm3, cm3, dm3, m3, cu.in, cu.ft, cu.yd
Weight = kg, T, N, 1lbf, kip

Weight/length = kg/m, T/m, N/m, daN/m, kN/m, lbf/ft
Density = kg/m3, T/m3, N/m3, kN/m3, 1lbf/ft3

Temperature = Kelvin, Celsius, Fahrenheit

Section modulus = mm3, cm3, in3

Moment of inertia = mm4, cmé4, in4

Warping modulus = mmé6, cm6, 1in6

Force = kg, T, N, daN, kN, 1lbf, kip

Force/length = kg/m, T/m, N/m, daN/m, kN/m, lbf/in,
1bf/ft, kip/in, kip/ft

Force/area kg/m, kg/cm, kg/mm, T/m, T/cm, T/mm, N/m,

N/cm, N/mm, daN/m, daN/cm, daN/mm, kN/m, kN/cm, kN/mm, lbf/in, 1lbf/ft,
kip/in, kip/ft

Moment = kgm, Tm, Nm, daNm, kNm, lbf-in, 1lbf-ft,
kip-in, kip-ft

Moment/length = kgm/m, Tm/m, Nm/m, daNm/m, kNm/m, lbf-
ft/ft, kip-ft/ft

Stress = kg/m2, kg/cm2, kg/mm2, T/m2, T/cm2, T/

mm2, N/m2, N/cm2, N/mm2, daN/m2, daN/cm2, daN/mm2, kN/m2, kN/cm2, kN/mm2,
psi, psf, ksi, kst

Date = dd.mm.yyyy, mm.dd.yyyy, mm/dd/yyyy,
yyyy/mm/dd, dd-mm-yy, dd-mm-yy, yyyy-mm-dd, dd/mm/yy

Time = hh:mm:ss, hh:mm:ss:am/pm
Date&&Time = dd.mm.yyyy, mm.dd.yyyy, mm/dd/yyyy,

yyyy/mm/dd, dd-mm-yy, dd-mm-yyyy, yyyy-mm-dd, dd/mm/yy

Date local = dd.mm.yyyy, mm.dd.yyyy, mm/dd/yyyy,
yyyy/mm/dd, dd-mm-yy, dd-mm-yyyy, yyyy-mm-dd, dd/mm/yy

Time local = hh:mm:ss, hh:mm:ss:am/pm

Date&&Time local = dd.mm.yyyy, mm.dd.yyyy, mm/dd/yyyy,
yyyy/mm/dd, dd-mm-yy, dd-mm-yyyy, yyyy-mm-dd, dd/mm/yyLeadingZeroes
LeadingZeroes

DistancelList mm, dm, cm, m, inch, ft, yd, inch-frac

{1/2, 1/4, 1/8, 1/16 }, ft-frac { 1/2, 1/4, 1/8, 1/16 }

For more information about value fields, formats, format functions and other
functions, see Template Editor User's Guide.
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7 Tekla Model Sharing and multi-

7.1

user for administrators

You can find a table of the differences between Tekla Model Sharing and multi-
user models here.

Tekla Model Sharing

Tekla Model Sharing enables efficient global collaborative modeling within a
shared Tekla Structures model. Tekla Model Sharing gives users the freedom
to work with the same model at the same time in different locations and time
zones.

In Tekla Model Sharing each user has a local version of the model on their
computer, or on a network drive, and the model data is shared and
synchronized over the Internet using a Microsoft Azure cloud sharing service.
When a model is shared, it is connected to the cloud-based sharing service.
You can check the status of the service at any time.

NOTE The users of the same shared model need to have the same Tekla Structures
version, and use the same latest service pack.

When a user starts to share a model, the organization the user belongs to gets
the model ownership. In Tekla Model Sharing, an organization always owns all
the models shared by the users in the organization. A shared model is always
owned by only one organization. You can manage and view all the shared
models owned by your organization with the web-based Management Console
for Tekla Model Sharing. Logging in requires Trimble Identity administrator
rights.

Tekla Model Sharing requires a valid Tekla Model Sharing license and a
Trimble Identity which is part of a valid organization. Based on the Trimble
Identity information, you can assign and manage Tekla Model Sharing licenses
in the web-based Tekla Online Admin Tool. For more information, see
Managing Trimble Identities and Tekla Model Sharing licenses.
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Tekla Model Sharing cloud sharing service status is publicly available at Tekla
Model Sharing Status. On this web-site, you can also find information about
any service breaks.

For more information on how Tekla Model Sharing works, see

*  Manage models in Management Console for Tekla Model Sharing

NOTE Tekla Model Sharing requires a single-user model. A model cannot be
simultaneously shared and used in the multi-user mode. If you want to start
using multi-user mode to share your model instead of Tekla Model Sharing,
you first need to exclude your local version of the model from the sharing
service and then convert it to a multi-user model.

The excluded model has no connection to the original shared model in the
sharing service. This means that if you exclude your local version of the model
from the sharing service and start to use the model in multi-user mode, you
cannot later merge the original shared model and the multi-user model.

7.2 Multi-user models

You can work on Tekla Structures models in either single-user or multi-user
mode. Multi-user mode allows several users to access the same model at the
same time. Several users can work on the same project and be aware of the
others' progress, so that copying and merging models is not needed.

The multi-user model consists of a single master model that can be located
anywhere in the network. Each user can access this model, and open their
own local view of the model on a client computer. This local view is called a
working model. Any changes that a user makes to the working model are local,
and not visible to other users, until the working model is saved to the master
model.

The multi-user model is locked during opening, saving, and numbering. When
one of the users performs any of these operations, other users cannot
perform them during that time. For more information, see .

NOTE All users of the multi-user model should use the same settings and
the same version and service pack of Tekla Structures.

Tekla Structures multi-user server runs as a service that is started
automatically when you start the computer. You do not need to log in to the
service. We recommend that you use the latest multi-user server version
available regardless of the Tekla Structures version that you use.
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Setting access rights to a multi-user model

You can protect user-defined attributes using privileges. You can also prevent
your model and drawings from being accidentally modified by using the
Locked user-defined attribute (UDA). You can use the UDA for parts
(separately for beams, columns, and so on), bolts, welds, specific drawing
types, project properties, and phase properties.

Using the Locked UDA and privileges together you can even restrict some
users or organizations from modifying your model. For more information on
access rights, see .

The Locked UDA has three values: Yes, No, and Organization. When set to
Yes, the object is locked and you cannot modify its properties. You can only
change the object's user-defined attributes that do not affect numbering. If
you try to modify a locked object, Tekla Structures displays the following
warning message:

There are locked objects, see report. The operation could not
be performed.

To add the lock attribute to the user interface, you need to add the following
line in the object's section in the objects. inp file:

attribute ("OBJECT LOCKED", attribute ("OBJECT LOCKED",

"Locked:", option,"%s", none, none, "0.0", "0.0")
{
value ("No", 1)
value ("Yes", 0)
value ("Organization”, 0)
}
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Import Tekla Structures model
and drawings into another
mode]

You can use the Import model command to import a Tekla Structures model
and drawings to another model. If the imported model is later updated, you
can re-import the updated model.

It is not possible to import a model or parts of it directly into the same
model (for example, if the model folder has been copied in the file system
and then worked on separately). You can work around this, for example, by
first importing the model into a new empty model or by using the Save as
command to create a copy of the model.

If you import to an existing model, fix the possible numbering conflicts by
adding prefixes in numbering series.

Importing models from older versions of Tekla Structures is not allowed.
When you try to import an old model, the following message is displayed:
"Importing models from previous versions is not supported. First save the
model with the current version. Note that you will not be able to use Tekla
Structures of previous version to edit the model." Click Open for upgrade
to open and save the model in the new version, or click OK.

You can use the Import model command as a replacement to the old
model dump import. Import the model to an empty Tekla Structures model
created without a model template.

Open the Tekla Structures model into which you want to import the other
model.

2. Go to Quick Launch, start typing import model, and select the Import
model command from the list that appears.
Import Tekla Structures model and drawings into 374

another model



3. Select a model folder to import and click OK.

The model objects and drawings are imported and the changes are
displayed using the same listing as is used in Tekla Model Sharing.

With default settings, the Locked attribute is set to Yes in the imported
objects. Locking is controlled by the advanced option

XS MODEL IMPORT LOCK OBJECTS in the Import category of the Advanced
Options dialog box.
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Import user-defined attribute
values

You can import user-defined attribute (UDA) values to a model from a text file.
For example, you can import a list of manufactured or checked assemblies.
You can also clear existing user-defined attribute values through attribute
import.

You can import attribute values to Tekla Structures model objects, drawings,
and some reference model objects. In addition to defining matching criteria in
the import file, you can also limit the import scope to objects you select in the
model or to reference model objects.

The input file can be:
+ Exported from other software.

+ Created manually using any standard text editor, for example, Microsoft
Notepad.

+ Created from Microsoft Excel by saving the file with the Save as command
to Text (Tab-delimited) (*.txt) format.

« Asimple Tekla Structures report containing the part GUIDs and user-
defined attributes.

NOTE There are alternative ways to import data into user-defined attributes. For
example, user-defined attributes can be filled in when you import IFC objects
and convert them to native Tekla Structures objects. There are also several
extensions in Tekla Warehouse that allow you to modify user-defined
attribute data.
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1 0 Uninstall Tekla Structures

When you no longer need a version of Tekla Structures or related
components, you can uninstall to save space on the computer.

Before you uninstall the license server, deactivate the licenses (page 67).

10.1 Uninstall Tekla Structures

Uninstall the Tekla Structures software and environments in the Windows
Control Panel.

You can have many Tekla Structures versions on your computer. When you
install and start using a new version, you do not need to uninstall the older
versions.

When you no longer use a Tekla Structures version, you can uninstall it
without affecting other installed Tekla Structures versions.

1. Go to the Windows Control Panel --> Programs --> Programs and
Features.

2. Select a component, click Uninstall and follow the prompts. Follow this
order:

a. Uninstall the service packs.
b. Uninstall the Tekla Structures environments.

The environment . tsep packages are uninstalled and the
environment files are removed.

When you uninstall an environment of a Tekla Structures software
version you are still using, the uninstalled environment is not shown
in the Tekla Structures setup dialog box anymore.

For more information, see Installing .tsep packages (page 15).
Uninstall the main Tekla Structures software.
d. [Ifinstalled, uninstall the offline help package.
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3.

e. If needed, delete the additional files or extensions related to Tekla
Structures manually from the installation folders.

If you no longer wish to run any version of Tekla Structures on the
computer, uninstall the components that are not version-specific.

a. The Tekla Warehouse service and content components.
b. The Tekla License Borrow Tool.

Return a borrowed Tekla license (page 105) before you uninstall the
license borrowing tool.

The Tekla License Administration Tool.

d. Foruninstalling a Tekla license server, see the instructions below.

10.2 Uninstall the license server

Follow the instructions below when you want to permanently remove the
licensing server from this computer. If you are upgrading to a new version on
the same computer, see instead.

10.3

1.

Make sure that all borrowed licenses are returned (page 105). You can use
LMTOOLS to check who has borrowed licenses.

Deactivate Tekla licenses (page 67).

Deactivating releases the license so that the license can be later activated
on another license server installation (applies even to licenses that have
expired or updated to a new Tekla Structures version).

Go to the Windows Services snap-in and stop the Tekla Licensing Service.
You can find the snap-in using the Windows start menu search.

Go to the Windows Control Panel --> Programs --> Programs and
Features.

Select the Tekla license server and click Uninstall.

If the license server uninstallation fails, uninstall the license server
manually.

Uninstall the license server manually

Automatic Tekla license server installation can normally be uninstalled from
the Control Panel.

If the automatic uninstallation cannot be performed, like in the case of manual
installation, you need to uninstall the license server manually.
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Before you start license server uninstallation, stop FlexNet licensing services
and other licensing services.

To manually uninstall the licensing server:

1.

Make sure that all borrowed licenses are returned (page 105). You can use
LMTOOLS to check who has borrowed licenses.

Deactivate Tekla licenses (page 67).

Deactivating releases the license so that the license can be later activated
on another license server installation (applies even to licenses that are
updated to a new Tekla Structures version).

Go to Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

Go to the Service/License File tab tab, select Configuration using
Services, and ensure that Tekla Licensing Service is selected in the list.

Go to the Start/Stop/Reread tab and click Stop Server to stop the license
server.

Go to the Config Services tab, ensure that Tekla Licensing Service is
shown in the Service name box and then click Remove Service.

At the command prompt, enter the following command:
uninstallanchorservice.exe

Uninstall Tekla license server from the Control Panel to complete the
uninstallation.

The Tekla license server is uninstalled.
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1 1 Develop applications using
Tekla Open API

You can develop your own applications and additional features for Tekla
Structures through the Tekla Open API (Application Programming Interface).
Tekla Open APl is implemented using Microsoft .NET technology.

Applications that are developed using Tekla Open API to work with Tekla
Structures are called extensions. To use the power of the Tekla Open API, you
must write program code outside Tekla Structures. If you do not know how to
program, you can still benefit from the Tekla Open APl by downloading
extensions created by others from Tekla Warehouse.

With Tekla Open APl you can:
* Record and run user interface actions

By recording and running user interface actions you can automate routine
tasks, such as creating daily reports.

* Create automation tools

You can create automation tools for frequently needed objects. With
automation tools you can, for example, create basic structures or add
typical details to drawings.

+ Integrate Tekla Structures to other software

You can utilize the Tekla Open APl and .NET in transferring information
between Tekla Structures and other software, such as Analysis & Design
software.

+ Create new functionality.

For more information on Tekla Open API and extensions, visit the Tekla
Developer Center.
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1 2 Disclaimer

© 2020 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced
Software. Use of the Software, and use of this Software Manual are governed
by a License Agreement. Among other provisions, the License Agreement sets
certain warranties for the Software and this Manual, disclaims other
warranties, limits recoverable damages, defines permitted uses of the
Software, and determines whether you are an authorized user of the
Software. All information set forth in this manual is provided with the warranty
set forth in the License Agreement. Please refer to the License Agreement for
important obligations and applicable limitations and restrictions on your
rights. Trimble does not guarantee that the text is free of technical
inaccuracies or typographical errors. Trimble reserves the right to make
changes and additions to this manual due to changes in the software or
otherwise.

In addition, this Software Manual is protected by copyright law and by
international treaties. Unauthorized reproduction, display, modification, or
distribution of this Manual, or any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla Structures, Tekla Model Sharing, Tekla PowerFab, Tekla Structural
Designer, Tekla Tedds, Tekla Civil, Tekla Campus, Tekla Downloads, Tekla User
Assistance, Tekla Discussion Forum, Tekla Warehouse and Tekla Developer
Center are either registered trademarks or trademarks of Trimble Solutions
Corporation in the European Union, the United States, and/or other countries.
More about Trimble Solutions trademarks: http://www.tekla.com/tekla-
trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in
the European Union, in the United States and/or other countries. More about
Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product
and company names mentioned in this Manual are or may be trademarks of
their respective owners. By referring to a third-party product or brand, Trimble
does not intend to suggest an affiliation with or endorsement by such third
party and disclaims any such affiliation or endorsement, except where
otherwise expressly stated.

Portions of this software:
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EPM toolkit © 1995-2006 Jotne EPM Technology a.s., Oslo, Norway. All rights
reserved.

Open Cascade Express Mesh © 2015 OPEN CASCADE S.A.S. All rights reserved.
PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.
FLY SDK - CAD SDK © 2012 Visuallntegrity™. All rights reserved.

Teigha © 2002-2016 Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

FlexNet Publisher © 2014 Flexera Software LLC. All rights reserved.
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